
What is a Bitmap Image?
{button Steps...,PI(`',`HT_What_is_a_Bitmap_Image')}

A bitmap is an image made of tiny dots called pixels. Some examples of bitmap images include the wallpaper 
used in Windows, drawings created in paint programs, and scanned photographs.
You can combine bitmap images with your Designer drawings to create exceptional illustrations.
By comparison, objects created in Designer are vector-based, relying on lines and mathematical calculations to 
create drawings. Vector drawings are more precise, usually create smaller file sizes, and are generally better for 
computer-based drawing because they always appear (in print or on screen) at the highest possible resolution.
Bitmap images are best for "real life" images such as photographs. Unlike vector drawings, a bitmap's resolution 
can change when you resize the image. For example, if you enlarge the bitmap in the illustration above, the 
pixels become larger and more pronounced. On the other hand, if you enlarge the vector drawing, the resolution 
does not change.
Types of Bitmaps

Bitmap images are stored in a variety of formats. These different formats were developed for the software or 
hardware that first used them. For example, the TIF (Tag Image File Format, also known as TIFF) format is the 
type of bitmap originally produced by scanners.
Designer imports the following bitmap formats: TIF, BMP, PCX, TGA, PCD, JPG, and GIF. To learn more about 
importing, see Importing and Exporting Files
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Using Bitmap Images in Your Drawings
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Bitmaps can add variety and visual appeal to your drawings. Here are some examples of what you can do with 
bitmaps.

Add scanned photographs to a report or presentation.
Use a bitmap as a background for your illustration.
Create a library of bitmap images to use in your drawings.
Trace bitmaps and then edit the tracing like an ordinary Designer object.
Add text, borders, or a drop shadow to enhance the bitmap.

Tip
You can print a bitmap on a printer, but not on a pen plotter.
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Manipulating Bitmap Images
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You can move, resize, delete, reorder (move it to the front, for example), flip horizontally or vertically, duplicate, 
and crop a bitmap. You can also color a bitmap image if you have imported it as monochrome.
Use your bitmap editor when you want to edit a bitmap image extensively. For example, if you want to change a 
frown to a smile in a photograph, use Picture Publisher.
Tips

You cannot rotate or skew bitmap images in Designer. Use Picture Publisher to rotate or skew a bitmap 
image.

You cannot edit bitmap images like vector drawings. However, you can trace a bitmap to produce a 
Designer object that you can edit.
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Bitmap Import Options
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You can import the following bitmap formats into a Designer document: BMP, DIB, GIF, JPG, PCD, PCX, RAS, TGA, 
and TIF.
You can click Setup in the Import dialog box to change how a bitmap looks when you import it. For example, you 
can import a color image as a grayscale image if you intend to reproduce it on a non-color printer. Changing an 
import option does not change the original bitmap file. 
By default, Designer imports the image as it was originally saved. If you change the import options by using 
Setup in the Import dialog box, the new import options become the new default for all bitmap images.
To learn more about importing, see Importing and Exporting Files
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Editing a Bitmap Image
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You can edit a bitmap image by selecting it, clicking the Bitmap tool , and choosing an editing option in the 
Bitmap ribbon. If you want to make more extensive edits to an image, you can use a bitmap-editing program 
such as Picture Publisher.
A bitmap image that is pasted as an OLE object (that is, it is embedded or linked) cannot be edited in Designer.
Making White Areas Transparent

You can make white areas of a monochrome image transparent with the Transparency button . Select the 
image, click the Transparency button 

 in the Bitmap ribbon, and then select Transparent. This feature is especially useful when you are editing black 
and white images such as logos or signatures.
Coloring Monochrome Images

You can change the foreground and background of a selected monochrome bitmap image with the Foreground 
button and Background button. Select the image, click the Foreground button or Background button, and click a 
color from the color palette.
The foreground color changes the color of the image itself. The background color changes the color of the 
surrounding area.
Tip

To import an image as monochrome, select Monochrome from the setup options in the Import dialog box. 
The newly imported image is black (foreground color) and white (background color).
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Editing OLE and Non-OLE Bitmap Images
{button Steps...,PI(`',`HT_What_is_a_Bitmap_Image')}

You can use Designer to crop or trace a bitmap image that is not an OLE object. When you double click a non-
OLE bitmap image, your selected bitmap editor opens to edit the bitmap image.
If you want to edit a bitmap image that is an OLE object (as indicated in Designer's status bar), you cannot edit it
with Designer's cropping or tracing tools. When you double click the OLE object, the program that supplied the 
object automatically opens to edit the object.

You can open your selected bitmap editor with the Edit Bitmap button  in the Bitmap ribbon. Images can also 
be moved between your bitmap editor and Designer using the Clipboard or the Import and Export commands.
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Cropping a Bitmap Image
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Cropping lets you show only the part of the bitmap image you want; the rest is hidden. Cropped portions of the 
bitmap are retained so you can uncrop them later.
Cropping is an editing technique that can improve your final drawing. For example, you can eliminate distracting 
areas of an image to help focus on the center of interest. You also can crop to eliminate errors or to help fit the 
bitmap into the layout.
Cropping an image in Designer involves two steps: creating a rectangular mask large enough to show the 
desired area, and moving the image so that the correct area shows through the mask.
Tip

In Designer 3.1 and before, you moved the mask instead of the image.
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To crop an image in Designer

1 Select the bitmap image you want to crop.

2 In the Toolbox, click the Bitmap tool .

3 Click the Crop button  in the ribbon. The bitmap is highlighted and handles appear around the crop mask.
4 Resize the crop mask until it is the size you want.
5 Move the pointer onto the image. Press and hold the mouse button, and position the image under the crop 

mask.
6 Release the mouse button when you finish.
7 Repeat steps 4 through 6 to adjust the crop, if necessary.
8 Double click or press ESC to stop cropping.
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Why Trace Bitmaps?
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Tracing a bitmap image creates a vector copy that closely resembles the original image. When using a simple 
bitmap image, it is often easier and less space consuming to trace it and then edit the vector tracing. 
Vector drawings use less disk space and memory than bitmaps. Since drawing files containing bitmaps can be 
quite large, converting bitmap images to vector drawings saves disk space.
You can create interesting visual effects by tracing. For example, with a little experimentation, you can create 
stylized graphics or drawings that look like etchings.
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Basics of Tracing
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Designer traces an image by searching it for color or grayscale variations. When the color difference is great 
enough, Designer draws a line between the different colors.
When Designer finishes tracing, the original bitmap image is behind the tracing and the tracing is selected.
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Setting Tracing Options
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Tracing options let you determine the method and degree of detail Designer uses to trace bitmap images. You 
set tracing options in the Bitmap ribbon. Options remain in effect until you change them.
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Showing and Hiding the Bitmap
{button Steps...,PI(`',`HT_What_is_a_Bitmap_Image')}

Use the Show Bitmap button  to show or hide the bitmap. Choose Show (the default) to display the original 
bitmap image as it appeared before the trace. Choose Hide to conceal the bitmap image after it is traced so that 
only the traced objects appear.
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Setting the Trace Quality
{button Steps...,PI(`',`HT_What_is_a_Bitmap_Image')}

Use the Trace Quality button  to adjust how accurately and smoothly Designer traces a bitmap.
Choose Fine for the highest quality trace. Fine tracings use the largest number of reshape points. Fine tracings 
can use a lot of memory and be difficult to edit because they create a large number of anchors.
Average setting is the default. In most situations, average tracing is the best choice.
Coarse produces the least accurate tracing because it uses the fewest points. Coarse tracings use the least 
memory and are the easiest to edit.
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Setting the number of colors and noise for tracing
You can restrict the number of colors in the result of a trace. Click the Colors box on the Bitmap ribbon, and then 
click the maximum number of colors that you want the trace to have.
The noise control on the Bitmamp ribbon helps eliminate stray pixels introduced by a poor-quality image. You can
enter a value ranging from 1 through 100. Larger numbers exclude larger groups of stray pixels.



Setting the Line Type
{button Steps...,PI(`',`HT_What_is_a_Bitmap_Image')}

Use the Line Type button  to choose whether Designer uses lines or curves to create the tracing.
Choose Lines to create tracings with straight line segments (no curves). Use this setting when the image has few
curves.
Choose Curves to create tracings with curves. It is slightly more accurate than using lines.
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Tracing Methods
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You can trace an entire bitmap image, or only a portion of it. Use the following methods while the Trace button
 is selected to choose which part of the image you want to trace.

Tracing an Entire Bitmap Image

Press and hold SHIFT and click the bitmap image.
Tracing the Rectangular Area of a Bitmap Image

Select the bitmap image and drag a rectangle over an area of the image. The area in the rectangle is traced.
Tracing an Object in a Bitmap Image

Well-defined areas in an image are called objects. For example, in an image containing a beach ball in the ocean,
the beach ball is an object. The more an object contrasts with its surrounding area, the more successful the 
tracing will be.
To trace an object, select the image and click inside the object to trace it.
Stop Tracing

Press ESC to stop a trace before it is completed.
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To trace a bitmap

1 In the Toolbox, click the Bitmap tool .
2 Select the bitmap image you want to trace.
3 Drag a rectangle over an area of the image. The area in the rectangle is traced. A border appears around the 

image, and Designer draws the tracing in front of the original image.
4 After tracing, click outside of the border, point to the image and drag the tracing off of the bitmap, if 

necessary.
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Tracing Tips
Keep the following in mind when tracing images.

Bitmaps with few colors generally trace best. Use your bitmap editor to reduce the number of colors in a 
bitmap image before you trace.

Grayscale images trace better than color images. Monochrome images, however, trace best of all.
Don't trace bitmap text. Add text to a drawing with Designer's Text tool 

. Scanned text and text added with an image editor are of lower quality.
Simple, uncomplicated images trace better than complicated ones.
Dark objects on light backgrounds are best. If you have a dark background, lighten it with your bitmap 

editor before tracing.
Tips

Remember, you can press ESC at any time to stop the trace.
For details on reducing the number of points in traced bitmaps, see Smoothing an Object.
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Blending Effects
{button Steps...,PI(`',`HT_Blending_Effects')}

Blending lets you blend one shape and color into another. You can produce two types of effects by blending 
objects: a transformation effect, and a highlighting effect.
You can specify the number of transformations, or steps, between the two objects in the Blend dialog box. Each 
step is a different object slightly changed to look more like the second object. The more steps you use, the closer
(and smoother) the transforming objects are. You can use as many as 1000 steps.
Designer blends a point on the first object to a corresponding point on the second object. You can change the 
origins on the objects.

Objects are drawn either clockwise or counterclockwise from a starting point. For example, closed objects are 
drawn counterclockwise. When Designer blends objects, it matches corresponding points of the two objects so 
that the order the points were drawn determines the appearance of the blend. You can reverse the way Designer
normally compares points if you don't like the results of the blend

Objects blend from the back to the front object (the object in front is the one you drew last). (You can change the 
order of objects.) Designer cannot blend patterns, but it blends the pattern color and places the pattern in all the 
transformations.

If the objects have different patterns (for example, a hatch and a gradient), Designer places the pattern of the 
front object in all the transformations. Designer does not place bitmap patterns in transformations.
Tips

Blending results are usually better with uncomplicated objects.

Large numbers of steps can slow redraw time.

You may have to try several different settings to find the ones that give the effect you want.

Designer cannot blend grouped, bitmap, or text objects. You can convert text to curves and then blend it.

{button Related Topics,PI(`',`RT_Blending_Effects')}



To blend two objects
To change the origins before blending
To reverse the blend direction



Transformation Effects
Highlighting Effects
Warping Effects



Transformation Effects
This blending effect gives the illusion of one object changing into another.



Highlighting Effects
This blending effect lets you give "spot" highlights and shadows to your drawings to help give them depth. 
Blending to create a highlight gives a gradient-like effect, but it lets you create highlights and shadows with 
more transitions.



To blend two objects

1 Select the objects you want to blend.
2 On the Change menu, click Blend. The Blend dialog box opens.
3 Choose the settings you want.
4 Click Apply. The objects are blended. The dialog box stays open so you can continue to blend objects.
Tip

You may have to try several different settings to find the ones that give the effect you want.
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To change the origins before blending

1 Select the objects you want to blend.
2 On the Change menu, click Blend. The Blend dialog box opens.
3 Click Choose Origins.
4 On the back object, click a hollow box to select that position as the origin.
5 On the front object, click the hollow box in the position you want to correspond to the point you clicked on the

back object.
6. Click Choose Origins again to deselect it.
7 Choose the other settings you want.
8 Click Apply. The objects are blended. The dialog box stays open so you can continue to blend objects.
Tip

You may have to try several different settings to find the ones that give the effect you want.
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To reverse the blend direction

1 Select the objects you want to blend.
2 On the Change menu, click Blend. The Blend dialog box opens.
3 Click Reverse Direction.
4 Choose the other settings you want.
5 Click Apply. The objects are blended. The dialog box stays open so you can continue to blend objects.
Tip

You may have to try several different settings to find the ones that give the effect you want.

{button Related Topics,PI(`',`RT_To_blend_two_objects')}



Palettes Included with Designer
Designer includes predefined color palettes plus the flexibility to design and assemble your own palettes that 
best match how you work.
A default palette, called the master palette, is automatically installed when you install Designer. To protect 
against accidental changes, the master palette cannot be changed, deleted, or merged. However, you can make 
a copy of it, give it a new name, and then make additions, deletions, or other changes.
You select the current palette on the Palette Options menu on the Style ribbon. If the master palette is the 
current palette, and you attempt to add a color, delete a color, rename the master palette, or rename a color in 
the master palette, a dialog box reminds you that you must save a copy of the master palette.

If you click Yes, the Palette Name dialog box opens. Type a new name for the copy of the master palette 
and press ENTER. You can then make changes to the new palette, whose name is added to the list of available 
palettes on the Palette Options menu and the Palette Manager dialog box.

If you click No, you cancel the operation and are not allowed to change the palette.
Designer lets you mix your own colors and add them to an existing palette, or you can create a new palette that 
includes only the colors you want.
Designer also includes the PANTONE® spot and process colors, which are available on the Spot Color tab of the 
Color Picker dialog box.
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Storing Color Palette Information
Designer normally stores palettes as a part of your profile, not as separate files. Designer, beginning with version
4.0, stores colors in the color model (HLS, CMYK, or RGB) in which they were originally created, whereas earlier 
versions of Designer only store colors in the RGB format. This capability is especially important for graphic 
designers, who typically create colors with the CMYK color model, because it ensures precise matching between 
color definition and storage.
Designer lets you import and export palette files using either a PL4 or PAL file type (extension). For more 
information on importing and exporting, see Importing and Exporting Palette Files.
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Using the Color Picker
{button Steps...,PI(`',`HT_Using_the_Color_Picker')}

Designer offers state-of-the-art color mixing capabilities and the flexibility to let you easily choose and use any 
color from the full spectrum.
You can use a color model to choose any color. You can use whichever color model you prefer (HLS, RGB, or 
CMYK) to choose colors. The Color Picker is a tool that lets you choose a color from the full range of possible 
colors and add it to the Color Palette.
You can click one of the first three buttons at the top of the dialog box to select a color model (RGB, CMYK, or 
HLS). (The fourth button is for spot colors using a color matching system such as PANTONE.)
Numeric values for the current color appear along the right for each color model. The values show the amount of
color used to create the displayed color. For example, 255 Red, 128 Green, and 179 Blue create pink. The same 
pink can be created with 0% Cyan, 50% Magenta, 30% Yellow, and 0% Black. You can use whichever color model 
you prefer to choose colors.
The numeric values for the selected model appear in black. The values for the models not selected are gray. As 
you make changes to the values of the selected color model, all of the values reflect corresponding changes.
The underlying model that represents the full range of colors is like a three-dimensional cube. The color refiner 
box shows two of these dimensions, while the slider below the color refiner box shows the third dimension.
The list box gives you choices for two of the components of the selected color model. These two components are
illustrated as width and height in the color refiner box. The third component of the color model (depth in the 
cubical color model) is controlled by the horizontal slider.
For example, if you select the HLS color model and select Hue-Lightness in the list box, hue is width (left and 
right), lightness is height (up and down), and saturation is depth (the slider).
Tip

If you are new to color models, start with the HLS model.
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To open the Color Picker dialog box

1 Click Style  in the Toolbox.

2 Click Palette Options  on the ribbon. A menu opens.
3 Click Add Color.
4 If the current palette is the master palette, you are asked if you want to make a copy of the master palette. 

Click Yes. The Palette Name dialog box opens.
5 Enter a new name for the copy. The Color Picker dialog box opens.

{button Related Topics,PI(`',`RT_To_open_the_Color_Picker_dialog_box')}
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Options
{button Steps...,PI(`',`HT_Using_the_Color_Picker')}

Click Options  to open a menu that lets you change the resolution of the dialog box display, change the color 
grid, or change the way CMYK colors are automatically "normalized" for undercolor removal. If Spot Color is 
selected, you can choose to show or hide the color names.
Display

If the update of the display in the Color Picker dialog box is too slow on your computer, you can change the 
resolution to speed it up. The choices are Fine, Average, and Coarse. Coarse, which displays fewer colors, is the 
fastest; Fine, which displays more colors, is the slowest.
Color Grid

The color grid setting displays colors in numeric increments; the choices are 1, 2, 4, 5, 8, and 10. Increasing the 
color grid setting forces the color model values to increase or decrease in larger increments.
Black Component

This command is available only if the CMYK color model is selected. (See Choosing CMYK Colors for details.)
Show Names

This command is only available if Spot Color  is selected. (See Color Matching Systems.)
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Naming a Color
{button Steps...,PI(`',`HT_Using_the_Color_Picker')}

The color swatch at the top right of the dialog box shows the new color as you mix it. You can assign a name to 
this color swatch. Names can include numbers and spaces.
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To name a color

1 Click the color swatch in the Color Picker dialog box. A blinking cursor appears.
2 Type a name.
3 Press TAB or click another field. The name is displayed on the color swatch.
Tip

When you click Add to add the color to the current palette, Designer stores the assigned name with the 
color.
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Using a Color Model
{button Steps...,PI(`',`HT_Using_the_Color_Picker')}

Designer, beginning with version 4.0, stores colors in the color model (HLS, CMYK, or RGB) in which they were 
originally created, whereas earlier versions of Designer only store colors in the RGB format. This capability is 
especially important for graphic designers, who typically create colors with the CMYK color model, because it 
ensures precise matching between color definition and storage.
You can use a color model to choose any color. You can use whichever color model you prefer (HLS, RGB, or 
CMYK) to choose colors. The Color Picker is a tool that lets you choose a color from the full range of possible 
colors and add it to the Color Palette.
Tip

If you are new to color models, start with the HLS model.
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To choose colors with a color model

1 Click Style  in the Toolbox.

2 Click Palette Options  on the ribbon.
3 Click Add Color.
4 If the current palette is the master palette, you are asked if you want to make a copy of the master palette. 

Click Yes and enter a new name for the copy. The Color Picker dialog box opens.

5 Click a color model button (HLS , CMYK 

, or RGB 

).
6 Click the down arrow at the right of the list box to choose the first two dimensions for the color refiner box 

(for example, Hue-Lightness).
7 Enter the desired value in the current color model's scroll boxes.
8 Continue to adjust the settings in the selected color model until you have mixed the desired color.
9 Click Add to add the new color to the current palette.
10 Repeat steps 5 through 9 to add more colors to the palette.
Tip

You can use the mouse or the arrow keys to move the color pointer in the color refiner box. You can double 
click to simultaneously choose a color in the color refiner box and add the color to the current palette.

In step 7, you can also press and hold the mouse button, and drag the color refiner cursor and the slider.

{button Related Topics,PI(`',`RT_To_open_the_Color_Picker_dialog_box')}



Choosing HLS Colors
{button Steps...,PI(`',`HT_Using_the_Color_Picker')}

Click HLS  in the Color Picker dialog box to use the HLS (Hue, Lightness, Saturation) color model.
If you start with black (highlight black in the palette), you can choose gray scales (shades of gray) by leaving the
saturation at zero and changing the degree of lightness.
The Hue values for primary colors are red (0), yellow (60), green (120), cyan (180), blue (240), and magenta 
(300).
The Hue values range from 1 to 360 degrees (equivalent to settings on a color wheel, where 0 is the same as 
360). The Hue setting selects a starting color value. The Lightness value adds a percentage of white or black to 
the hue and shows the percentage of lightness in the shade. Increasing lightness adds white; decreasing 
lightness adds black. The Saturation value decreases or increases the percentage of color in a selected hue. 
Increasing saturation adds color; decreasing saturation adds gray.
The standard setting for a hue is 50% lightness and 100% saturation. If you highlight pure red in the palette, the 
HLS values display Hue at 0 degrees, Lightness at 50%, and Saturation at 100%.
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Choosing RGB Colors
{button Steps...,PI(`',`HT_Using_the_Color_Picker')}

You can click RGB  in the Color Picker dialog box to use the RGB (Red, Green, Blue) color model.
The numeric values for R, G, and B represent amounts of the additive primary colors red, green, and blue. The 
value for each primary color can range from 0 through 255. When these three colors are combined (maximum 
values of each), the result is white. When none of the colors are present (zero values for each), the result is 
black. The RGB model is an additive color model because the three primary colors are combined to produce pure
white.

{button Related Topics,PI(`',`RT_Choosing_RGB_Colors')}
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Choosing CMYK Colors
{button Steps...,PI(`',`HT_Using_the_Color_Picker')}

Click CMYK  in the Color Picker dialog box to use the CMYK (Cyan, Magenta, Yellow, Black) color model.
As with the other color models, you can choose a color combination from the list box (Cyan-Magenta, Cyan-
Yellow, or Yellow-Magenta) to use as the height and width of the model as illustrated in the color refiner box. The 
third color is controlled by the slider directly below the color refiner box. The fourth color, black, is controlled by 
the bottom slider.
The numeric values for C, M, and Y represent percentages of the subtractive primary colors cyan (light blue), 
magenta, and yellow, which are complements of red, green, and blue. When these three colors are combined 
(100% of each), the theoretical result is black, but impurities in printing inks result in a muddy brown. When 
none of the colors are present (0% of each), the result is white. The CMYK model is a subtractive color model 
because the three primary colors are removed to produce black.

{button Related Topics,PI(`',`RT_Choosing_CMYK_Colors')}
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Black Component
{button Steps...,PI(`',`HT_Using_the_Color_Picker')}

The K value (true black) is added to compensate for ink impurities in process color printing. The percentage of 
black in a color is theoretically equivalent to the same percentage of cyan, magenta, and yellow.
By default, the Color Picker displays the black component slider to let you manually adjust the percentage of 
black in a color. You also can choose to let Designer normalize the CMYK percentages automatically. That is, the 
percentages for C, M, and Y are reduced or increased so that the percentage for black is as high as possible. This
technique is known as undercolor removal (UCR). If you add a color and then reopen the dialog box, the 
percentages may differ even though the color is the same. 

{button Related Topics,PI(`',`RT_Black_Component_2')}
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To change the way Designer normalizes CMYK percentages

1 Click Options  in the Color Picker-CMYK dialog box.
2 Click Black Component. The Black Component submenu opens.
3 Click Manual if you want to prevent Designer from normalizing the CMYK percentages.

or

Click a percentage if you want to allow Designer to normalize the CMYK values. (For example, click 100% for 
complete normalization or 50% for half normalization.)

Tip

If you click a percentage in step 3 above, the black component slider at the bottom of the dialog box 
disappears.

{button Related Topics,PI(`',`RT_To_open_the_Color_Picker_dialog_box')}



Color Matching Systems
{button Steps...,PI(`',`HT_Color_Matching_Systems')}

Spot colors (also called custom colors or solid colors) are predefined colors from a system such as the 
PANTONE® MATCHING SYSTEM.
Color matching systems provide basic inks, color charts, and mixing formulas so that colors can be specified and 
reproduced accurately in conventional offset printing. Color matching systems include colors for both spot and 
process colors.
Designer includes a spot color palette file for the PANTONE MATCHING SYSTEM, used by many conventional print 
shops. Check with your print shop ahead of time to verify that is uses this color matching system.

{button Related Topics,PI(`',`RT_Color_Matching_Systems')}
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To select spot colors

1 Open the Color Picker dialog box.

2 Click Spot Color .

{button Related Topics,PI(`',`RT_To_select_spot_colors')}
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Tint
{button Steps...,PI(`',`HT_Color_Matching_Systems')}

You can adjust the Tint slider control to set a percentage tint value, which is useful to indicate a color to be 
screened as a halftone at color separation. The Tint values range from 100% (solid color, no tint) to 0% (no color 
at all).
To make fine adjustments with the Tint slider, click to the left or to the right of the slider or use the arrow keys. 
The Tint value decreases or increases by one percentage point.

{button Related Topics,PI(`',`RT_Tint')}
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Options
{button Steps...,PI(`',`HT_Mixing_Colors')}

Click Options  when Spot Color is selected to open a menu that lets you show or hide the color names and 
numbers.

{button Related Topics,PI(`',`RT_Options_2')}
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Mixing Colors
{button Steps...,PI(`',`HT_Color_Matching_Systems')}

In addition to choosing colors with a color model and selecting spot colors, Designer lets you choose two or four 
colors and mix them together as a painter mixes paints. This method is similar to the way you can mix colors in 
the Fill-Solid dialog box.
Tip

After you mix colors, the next time you open the Palette Manager dialog box, the colors for 2-color and 4-
color mixing are the same ones you last used.



To mix two colors with the Palette Manager
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To mix two colors with the Palette Manager

1 Click Style  in the Toolbox.

2 Click Palette Options  on the ribbon and click Palette Manager. The Palette Manager dialog box opens.
3 Double click the name of the palette that you want to modify in the palette list box.

4 Click Details  to expand the dialog box, if necessary.
5 Under Palette Mixer, click the button until it reads 2 Color. When it reads 2 Color, you will see a scrollable 

color band with a color swatch at each end and the number of transition steps above it.
6 Click the button at the right to choose RGB Mix or HLS Mix. This specifies the color model used as a mixing 

method.
7 Click a color in the palette at the left.
8 Click the color swatch at one side of the color band. The color swatch changes to the color you chose from 

the palette.
9 Repeat steps 7 and 8 to choose a second color at the other side of the color band.
10 Highlight the number of steps and enter a number from 2 to 64. The shades of color in the color band change

to reflect the new mix.
11 Click one color in the color band or press and hold the mouse button and drag over multiple colors. Click Add 

to store the selected colors in the palette.
or

Click Add All to store all of the colors in the color band in the palette.
The colors are displayed in the color palette in the dialog box. If the current palette is the master palette, you
are asked if you want to make a copy of the master palette. Click Yes and enter a new name for the copy.

{button Related Topics,PI(`',`RT_Options_2')}
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To mix four colors with the Palette Manager

1 Click Style  in the Toolbox.

2 Click Palette Options  on the ribbon and click Palette Manager. The Palette Manager dialog box opens.
3 Double click the name of the palette that you want to modify in the palette list box.

4 Click Details  to expand the dialog box, if necessary.
5 Under Palette Mixer, click the button until it reads 4 Color. A mixing palette appears with a color swatch at 

each corner.
6 Click the button at the right to choose RGB Mix or HLS Mix. This specifies the color model used as a mixing 

method.
7 Click a color in the palette at the left.
8 Click a corner swatch outside of the mixing palette. The color swatch changes to the color you chose from the

palette.
9 Repeat steps 7 and 8 to choose a color for each corner of the mixing palette. The shades of color change to 

reflect the new mix.
10 Select one or more color squares in the mixing palette, and click Add to add the selected colors to the color 

palette.
or

Click Add All to add all of the colors in the mixing palette to the color palette. The colors are displayed in the 
color palette in the dialog box.

Tip

If you want to add a selected object's colors to the current palette, you can select the object, and click Add 
to Palette on the Object menu. You can then choose to add the object's foreground color, background color (if any), 
line color, or all three of these colors.

{button Related Topics,PI(`',`RT_To_mix_four_colors_with_the_Palette_Manager')}



Mixing Colors



Finding an Object's Color Values
{button Steps...,PI(`',`HT_Finding_an_Object_s_Color_Values')}

If you want to know what colors are already used in a drawing, you can select each object and find its colors.

{button Related Topics,PI(`',`RT_Finding_an_Object_s_Color_Values')}
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To find the interior and line color of an object

1 Deselect all objects.

2 Click Style .

3 Click the Interior Fill button and click Solid .
4 Click Custom. The Fill-Solid dialog box opens.
5 Select an object. The color values for the interior fill of the selected object appear above the color palette in 

the dialog box.

6 Click Line Fill  in the dialog box. The color values for the line fill of the selected object appear above the 
color palette in the dialog box.

Tip

The set of color values is stated in the color model originally used to create the color. For example, the 
value for yellow might be either RGB 255, 255, 0, or CMYK 0, 0, 100, 0, depending on whether the color was created
in the RGB or CMYK color model.

{button Related Topics,PI(`',`RT_To_find_the_interior_and_line_color_of_an_object')}
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Finding a Color by Name or Number
{button Steps...,PI(`',`HT_Finding_an_Object_s_Color_Values')}

If you know the name or number of a particular color in a palette, you can find it quickly by showing the names 
of the colors and then typing the first character. You can do this in either the Style ribbon or the Color Palette.

{button Related Topics,PI(`',`RT_Finding_a_Color_by_Name_or_Number')}
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To find a color in the Style ribbon's Color Palette

1 Deselect all objects.

2 Click Style  in the Toolbox.

3 Click Palette Options  on the ribbon.
4 Click Show Names. The Color Palette displays one color swatch, with the color model values and name.
5 Click on the color swatch on the ribbon.
6 Type the first character of the name you want to find. If necessary, press the letter again to display the next 

name beginning with that character. 
Tip

For example, type L for Lime. If Lavender is displayed, press L again until the desired color is displayed. 
Type 2 for 25% Gray.

{button Related Topics,PI(`',`RT_To_find_the_interior_and_line_color_of_an_object')}



To find a color on the Color Palette toolbar

1 If the Color Palette toolbar is not visible, click Toolbars on the View menu, and then click Palette.
2 On the palette's Control menu, click Show Names. The Color Palette displays one color on each line, with a 

color swatch, color model values, and name.
3 Type the first character of the name you want to find. A color whose name begins with that character is 

highlighted. If necessary, press the letter again until the desired color is highlighted.
Tips

When you show names in the Color Palette, what you see depends on the width of the toolbar and whether
the colors have been given names. If the colors are not named, only the numeric color values are displayed. If the 
colors are named, only the names display unless you resize the toolbar so that it is wide enough to display both the 
names and the numeric color values. You must undock the toolbar before you can resize it.

When you point to a color in the palette, the color's name (if any) and numeric color values are displayed 
on the Hint toolbar.

{button Related Topics,PI(`',`RT_To_find_the_interior_and_line_color_of_an_object')}



To delete a color from the Color Palette

1 Click Style  in the Toolbox.
2 Select a color in the Color Palette that you want to delete.

3 Click Palette Options  on the ribbon.
4 Click Delete Color. The color you selected is removed from the Color Palette.
Tips

You also can select a color in the Palette Manager dialog box and click Delete.

If the current palette is the master palette, you are asked if you want to make a copy of the master palette.
Click Yes and enter a new name for the copy.

You cannot undo the deletion of a color.

{button Related Topics,PI(`',`RT_To_find_the_interior_and_line_color_of_an_object')}



Sorting Colors in a Palette
{button Steps...,PI(`',`HT_Finding_an_Object_s_Color_Values')}

Sometimes it is useful to put the colors of a large palette in a different order. For example, your palette may 
contain several shades of colors that are not grouped together. In this case, if you choose hue as the "key" by 
which to sort, all colors with similar hues (yellows, blues, and so on) are grouped together.
Designer sorts colors by the component, or key, that you specify. Every color is broken down into its component 
values and sorted accordingly. For example, sorting by blue does not mean that all the blue hues are together, 
but that all the different colors (such as purples or greens) comprised of 20% blue are grouped together, all the 
colors comprised of 40% blue are grouped together, and so on.
Designer sorts by one or more keys to achieve the order you want. The most appealing for Designer's master 
palette is to sort first by lightness, then by saturation, and finally by hue. The Palette Manager lets you do this by
using primary, secondary, and tertiary sort keys.
You can sort colors using the Style ribbon, the Color Palette toolbar, or the Palette Manager dialog box.

{button Related Topics,PI(`',`RT_Finding_a_Color_by_Name_or_Number')}
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To sort colors in the Style ribbon's Color Palette

1 Click Style  in the Toolbox.

2 Click Palette Options  on the ribbon.
3 Click Sort Colors By. The Sort submenu opens with the currently selected key and sort order (Ascending or 

Descending) checked.
4 Click a key with which to sort (for example, Hue, Cyan, Blue, or Names). The colors are sorted according to 

the key you choose.
5 Repeat steps 3 and 4 to choose Ascending or Descending, if desired. The colors are sorted in the order that 

you select.

{button Related Topics,PI(`',`RT_To_find_the_interior_and_line_color_of_an_object')}



To sort colors on the Color Palette toolbar

1 If the Color Palette toolbar is not visible, click Toolbars on the View menu, and then click Palette.
2 If the toolbar is docked, drag it away from the window edge.
2 On the palette’s control menu, click Sort Colors By. The Sort submenu opens with the currently selected key 

and sort order (Ascending or Descending) checked.
3 Click a key with which to sort (for example, Hue, Cyan, or Names). The colors are sorted according to the key 

you choose.
4 Repeat steps 2 and 3 to choose Ascending or Descending, if desired. The colors are sorted in the order that 

you select.
Tip

The Palette Manager lets you specify one, two, or three keys for sorting colors. These are treated as 
primary, secondary, and tertiary keys.

{button Related Topics,PI(`',`RT_To_find_the_interior_and_line_color_of_an_object')}



To sort colors in the Palette Manager dialog box

1 Click Style  in the Toolbox.

2 Click Palette Options  on the ribbon.
3 Click Palette Manager. The Palette Manager dialog box opens.
4 Point to Sort and click Sort Colors.
5 Point to Sort again and click Primary sort key. The Primary Sort submenu opens with the currently selected 

key checked. Click a key with which to sort. The colors are sorted according to the key you choose.
6 Repeat step 5 for the Secondary and Tertiary sort keys, if desired. When you display the Secondary Sort 

submenu, the key already chosen for the Primary sort is gray. When you display the Tertiary Sort submenu, 
the keys    already chosen for the Primary and Secondary sorts are gray. 

7 Point to Sort and click Descending Sort or Ascending Sort, if desired. The colors are sorted in the order that 
you select.

{button Related Topics,PI(`',`RT_To_find_the_interior_and_line_color_of_an_object')}



Converting Color Model Values
{button Steps...,PI(`',`HT_Finding_an_Object_s_Color_Values')}

Designer stores a color with the numeric values in the color model in which it was created. When you display the 
names of colors in the current Color Palette, the color model and corresponding values are displayed with a 
sample swatch of the color and a name, if any. 
For example, you can add a color to a palette using the Color Picker, specifying RGB values of 0, 125, and 255. 
Then you can convert the color to CMYK values (100, 50, 0, and 0).

{button Related Topics,PI(`',`RT_Converting_Color_Model_Values')}



Finding an Object's Color Values
Finding a Color by Name or Number
Sorting Colors in a Palette



To convert values to another color model

1 Click Style  in the Toolbox.

2 Click Palette Options  on the ribbon.
3 Click Palette Manager. The Palette Manager dialog box opens.
4 Click the color you want to convert and click Model. A menu opens with a check mark by the name of the 

color's current model.
5 Click the color model to which you want to convert.
6 Click OK. The selected color is stored with the new color model.

{button Related Topics,PI(`',`RT_To_find_the_interior_and_line_color_of_an_object')}



Using the Color Palette
{button Steps...,PI(`',`HT_Using_the_Floating_Palette')}

The Color Palette is a toolbar containing the current colors you can use in a drawing. It is especially convenient 
when you’re working with large palettes or named colors.
You can dock, move, resize and reshape the Color Palette to keep it handy but out of your way. Colors in the 
current palette are always available, no matter which tool you select or which ribbon you display.

{button Related Topics,PI(`',`RT_Using_the_Floating_Palette')}



To open the Color Palette
To arrange colors by either row or column
To change the cell (color swatch) size



Customizing the Color Palette



To open the Color Palette

1 On the View menu, click Toolbars. The Toolbars dialog box opens.
2 Click Palette. The Color Palette opens.
Tips

As a shortcut, you can press CTRL+F to open the Color Palette. Pressing CTRL+F opens the palette when it 
is not displayed and closes it when it is displayed.

{button Related Topics,PI(`',`RT_To_open_the_floating_palette')}
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Customizing the Color Palette
{button Steps...,PI(`',`HT_Using_the_Floating_Palette')}

The control menu (top left corner) of the Color Palette gives you quick access to many of the same commands as
on the Palette Options menu. This menu also provides commands that let you customize your Color Palette.
The control menu is only displayed when the palette is floating, not when it’s docked.

{button Related Topics,PI(`',`RT_Converting_Color_Model_Values')}



Using the Color Palette



To arrange colors by either row or column

1 On the Color Palette's control menu, click Arrange Colors By. A submenu opens.
2 Click Row to fill the width of the window with rows of color cells.

or

Click Column to fill the height of the window with columns of color cells.
Tip

If you want quick access to more colors in a large palette, you may want to decrease the cell size of the 
colors in the Color Palette.

{button Related Topics,PI(`',`RT_To_open_the_floating_palette')}



To change the cell (color swatch) size

1 On the Color Palette's control menu, click Cell Size. A submenu opens.
2 Click Small, Medium, or Large to choose the size of the color swatches in the palette.

{button Related Topics,PI(`',`RT_Converting_Color_Model_Values')}



Managing Palettes
{button Steps...,PI(`',`HT_Managing_Palettes')}

Designer helps you manage color palettes in many ways, including choosing a palette or set of palettes, creating
a new palette, and deleting, renaming, recalling, and merging palettes.

{button Related Topics,PI(`',`RT_To_open_the_floating_palette')}
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To choose a palette from the Palette Options menu

1 Click Style  in the Toolbox.

2 Click Palette Options  on the ribbon. The Palette Options menu opens.
3 Click the name of the palette to use.

{button Related Topics,PI(`',`RT_To_choose_a_palette_from_the_Palette_Options_menu')}
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To choose a palette from the Palette Manager

1 Click Style  in the Toolbox.

2 Click Palette Options  on the ribbon. The Palette Options menu opens.
3 Click Palette Manager. The Palette Manager dialog box opens.
4 Click the down arrow in the Current Palette list box and click the name of a palette. The new palette is 

displayed.
5 Click OK. The palette you chose is now the current palette.
Tip

As a shortcut, you can double click the name of a palette to choose it as the current palette.

{button Related Topics,PI(`',`RT_To_choose_a_palette_from_the_Palette_Options_menu')}



Creating a New Palette
{button Steps...,PI(`',`HT_Managing_Palettes')}

You can either create a new palette to store new colors or you can add new colors to an existing palette.

{button Related Topics,PI(`',`RT_Creating_a_New_Palette')}



Managing Palettes
Deleting a Palette
Merging Two Palettes



To create a new palette

1 Click Style  in the Toolbox.

2 Click Palette Options  on the ribbon.
3 Click Palette Manager. The Palette Manager dialog box opens.
4 Click New in the Current Palette area. The Palette Name dialog box opens.
5 Type a new palette name and press ENTER. The new palette becomes the current palette, and the palette 

area is ready for you to mix and add new colors.

{button Related Topics,PI(`',`RT_To_choose_a_palette_from_the_Palette_Options_menu')}



To rename a palette

1 Click Style  in the Toolbox.

2 Click Palette Options  on the ribbon.
3 Click Palette Manager. The Palette Manager dialog box opens.
4 Select the palette you want to rename from the Current Palette list box.
5 Click Rename. The Palette Name dialog box opens.
6 Type the new name and press ENTER. The current palette is renamed with the new name.
Tip

If the current palette is the master palette, you are asked if you want to make a copy of the master palette.
Click Yes and enter a new name for the copy.

{button Related Topics,PI(`',`RT_To_choose_a_palette_from_the_Palette_Options_menu')}



Deleting a Palette
{button Steps...,PI(`',`HT_Managing_Palettes')}

You can delete a palette in the Palette Manager dialog box. You cannot delete the master palette or the current 
palette.

{button Related Topics,PI(`',`RT_Deleting_a_Palette')}
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To delete the palette

1 Click Style  in the Toolbox.

2 Click Palette Options  on the ribbon.
3 Click Palette Manager. The Palette Manager dialog box opens.
4 Highlight the name of the palette you want to delete.
5 Click Delete in the Current Palette area. The palette is deleted.

{button Related Topics,PI(`',`RT_To_choose_a_palette_from_the_Palette_Options_menu')}



To recall the master palette

1 Click Style  in the Toolbox.

2 Click Palette Options  on the ribbon.
3 Click Master Palette. The current palette is replaced with the full contents of Designer's original master 

palette.

{button Related Topics,PI(`',`RT_To_choose_a_palette_from_the_Palette_Options_menu')}



Merging Two Palettes
{button Steps...,PI(`',`HT_Managing_Palettes')}

You can merge a selected palette with the current palette in the Palette Manager dialog box. You can merge a 
copy of the master palette.

{button Related Topics,PI(`',`RT_Merging_Two_Palettes')}
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To merge two palettes

1 Click Style  in the Toolbox.

2 Click Palette Options  on the ribbon.
3 Click Palette Manager. The Palette Manager dialog box opens.
4 Highlight a palette name (other than the current palette).
5 Click Merge. The highlighted palette is merged with the current palette.
Tip

If the current palette is the master palette, you are asked if you want to make a copy of the master palette.
Click Yes and enter a new name for the copy.

{button Related Topics,PI(`',`RT_To_choose_a_palette_from_the_Palette_Options_menu')}



Importing and Exporting Palette Files
{button Steps...,PI(`',`HT_Importing_and_Exporting_Palette_Files')}

Designer lets you import and export palette files. You can use palette sets created earlier, or share palette files 
with other people. Palette files can have a PAL or PL4 extension.

{button Related Topics,PI(`',`RT_To_import_a_palette_file')}
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Storing and Sharing Color Palettes
{button Steps...,PI(`',`HT_Importing_and_Exporting_Palette_Files')}

Designer normally stores palettes as a part of your profile, not as separate files. Designer, beginning with version
4.0, stores colors in the color model (HLS, CMYK, or RGB) in which they were originally created, whereas earlier 
versions of Designer only stored colors in the RGB format. This capability is especially important for graphic 
designers, who typically create colors with the CMYK color model, because it ensures precise matching between 
color definition and storage.
Designer lets you share PAL and PL4 files with other Micrografx applications such as Picture Publisher and 
Windows Draw. Designer does not import or export PAL or PL4 files from applications developed by other 
software companies.
The more advanced PL4 format stores colors in the color model (HLS, CMYK, or RGB) in which they were 
originally created, just as Designer stores them. You can export to the PL4 format if you want to share palettes 
with another user of Designer, who can in turn import the PL4 file.
The earlier PAL format stores colors as RGB values only. You can use it to export Designer palettes or to import 
palettes created in other Micrografx programs.
Tip

RGB values in Picture Publisher, Designer 3.1, and other Micrografx applications range from 0% to 100%. 
Designer gives you increased precision, with RGB values ranging from 0 to 255. If you import a PAL file into 
Designer that was created and saved in a program that uses the 0% to 100% range, the RGB values convert 
automatically. For example, an orange color created in Picture Publisher with the RGB values 100, 50, 0 converts to 
255, 128, and 0 when imported into Designer.

{button Related Topics,PI(`',`RT_Storing_and_Sharing_Color_Palettes')}



Importing and Exporting Palette Files
Importing a Palette File
Exporting a Palette File



Importing a Palette File
{button Steps...,PI(`',`HT_Importing_and_Exporting_Palette_Files')}

Import  lets you import palette files for use with Designer. 

{button Related Topics,PI(`',`RT_Importing_a_Palette_File')}
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To import a palette file

1 Click Style  in the Toolbox.

2 Click Palette Options  on the ribbon.
3 Click Palette Manager. The Palette Manager dialog box opens.
4 Click Import. The Import Palette dialog box opens.
5 Click the down arrow in the List Files of Type list box. 
6 Select the type of file you want to import (either PL4 or PAL).
7 Change to the desired drive and directory.
8 Select Replace Current Palettes only if you want to erase all of your palettes and replace them with all the 

palettes in the imported file.
9 Highlight the file you want to import. 
10 Click Open. The dialog box closes, and all of the palette names from the imported palette set are listed in the 

Palette Manager.
11 Click the down arrow in the Current Palette list box and click the palette you want to display. The palette's 

colors are displayed in the dialog box and the ribbon.

{button Related Topics,PI(`',`RT_To_import_a_palette_file')}
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Exporting a Palette File
{button Steps...,PI(`',`HT_Importing_and_Exporting_Palette_Files')}

Export lets you export palette sets to share with other Designer users or for use in Picture Publisher or other 
Micrografx programs.

{button Related Topics,PI(`',`RT_Exporting_a_Palette_File')}



Importing and Exporting Palette Files
Storing and Sharing Color Palettes
Importing a Palette File



To export a palette file

1 Click Style  in the Toolbox.

2 Click Palette Options  on the ribbon.
3 Click Palette Manager. The Palette Manager dialog box opens.
4 Click Export. The Export Palette dialog box opens.
5 Choose a drive and directory for the exported file's destination.
6 Type a name for the file.
7 Choose either PL4 or PAL in the Save as Type list box.
8 Click Save. All your palettes are exported to the named file.

{button Related Topics,PI(`',`RT_To_import_a_palette_file')}



CSH_DLOG.DOC
This document contains the context-sensitive popup topics for all Designer 6.0 dialog boxes and their controls.



Generic dialog-box controls



No help topic is associated with this item.



No help topic is associated with this item.



Accepts the current choices and closes the dialog box.



Applies the current settings in the dialog box.



Closes the dialog box without making further changes.



Lets you add a button to a toolbar to display this dialog box.



Closes the dialog box without applying any changed settings.



Displays a description of this dialog box, along with information about how to use it.



Displays or hides additional options for this dialog box.



Customize dialog box



To display the button images associated with each category, click the category name.



To display the description of a button in this list, click the button. To place the button on a toolbar, drag it to the 
toolbar and drop it.



Unable To Read From File dialog box



Designer is not able to open the specified file. Try importing the file (use the Tools menu).



Transition Effects dialog box



Transition Effects dialog box
This dialog box lets you control special effects (wipes) that Designer uses to replace one screen with the next 
during your slideshow. You can choose from special-effect transitions such as spiral and rain, and you can set the
speed and direction of the transition.



Standalone Setup dialog box



Standalone Setup dialog box
This dialog box lets you select from available screen color and resolution options for your standalone slideshow. 
To see the options and select one, click the Number of Colors and Target Screen boxes.



Choose the number of colors you want in the standalone presentation. Currently, your only choice is the number 
of colors on the computer you are using.

Remember that a higher number of colors requires more disk space. A lower number of colors uses less 
disk space.



Choose the resolution of the monitor that will be used for the standalone presentation.



FileCloseConfirmation dialog box



You are about to close a document that contains unsaved changes.
You can:

Save the changes and then close the document. Click Yes.

Close the document without saving the changes. Click No.

Return to the document without closing it. Click Cancel or press the ESC key.



Saves the changes and then closes the document.



Closes the document without saving the changes.



Closes this dialog box without closing the document or saving the changes.



The Layers dialog box



Layers dialog box
This dialog box lets you manage layers in your document. You can:

Name the layers

Add and remove layers

Change the order of layers

Lock layers (so that objects cannot be changed)

Display or hide selected layers

Specify layers as printable or non-printable

Use one color (for easy identification) or multiple colors on a layer

Move objects from one layer to another

Edit all the layers or edit one layer at a time

{button Related Topics,PI(`',`RT_The_Layers_dialog_box')}



Basic Layer Tasks
Managing Layers



Shows the name of the currently selected layer, if you have named the layer.



Accepts the name you enter in the Name box to the left.



Shows the number and name of the currently selected layer. Unless you click the Edit All Layers option, this is 
the only layer in which you can select and edit objects.



Shows the numbers and names of all layers in the document. The current layer is shown in red.
Note

Clicking a layer in this list only selects that layer for moving, hiding, locking, renaming, and so forth. It 
does not make that layer the current layer.



Lets you move currently selected objects to a specific layer. Select the objects you want to move, click this 
button, and then select the destination layer in the Current Layer list. The items are moved to the selected layer.



Lets you edit all objects, regardless of which layer they belong to.



Adds a new layer behind all other layers in the document.



Deletes the layer highlighted in the list on the left. When you delete a layer, all objects in that layer are also 
deleted. You cannot delete the currently selected layer (the layer selected in the Current Layer box).



Moves the layer highlighted in the list on the left forward.



Moves the layer highlighted in the list on the left backward.



Locks the layer highlighted in the list on the left. You cannot select or edit objects in a locked layer, even by 
making it the current layer or clicking the Edit All Layers option. 



Unlocks the layer highlighted in the list on the left. Before you can select or edit objects in the layer, you must 
either make it the current layer (in the Current Layer box) or select the Edit All Layers option. 



Hides all objects in the layer highlighted in the list on the left.



Shows all objects in the layer highlighted in the list on the left. Useful if you have previously hidden that layer.



Marks all objects in the layer highlighted in the list on the left as non-printable.



Marks all objects in the layer highlighted in the list on the left as printable. Useful if you have previously marked 
the layer as non-printable.



Shows all objects in the layer highlighted in the list on the left using one color. You select the color from a drop-
down color palette connected to the Layer Color button .



Shows all objects in the layer highlighted in the list on the left using their normal colors. Useful if you have 
previously marked the layer as a single-color layer.



Displays a drop-down color palette. Use the palette to select a color for a single-color layer.



The Pages dialog box



Pages dialog box
This dialog box lets you choose which page of the document you want to view. You also can add, delete, and 
name pages.
Note

If you want to rearrange the pages in a document, click the Page Manager button 

 in the Toolbox, and then drag the thumbnail view of each page to its new position.



Shows the name of the currently selected page, if you have named the page.

To name (or rename) a page, enter the name in this box and then click the  button. You cannot rename the 
Master Page.



Accepts the page name you have entered in the box to the left.



Lists the pages in the current document. To go to a page, click its name and then click the Select button.



Adds a new page to the end of your document.



Deletes the currently selected page. You cannot delete the Master Page or the last page in the document.



Closes the Pages dialog box and goes to the selected page.



Closes the Pages dialog box without changing to a different page.



The Toolbars dialog box



Toolbars dialog box
This dialog box lets you choose which toolbars you want to view. You also can choose whether to view Tool Tips, 
color buttons, and large buttons.
You can create new toolbars and customize existing ones.



Shows the names of available toolbars and whether each is selected for viewing.
To show or hide a specific toolbar, click the box to the left of the its name.



Lets you create and name a new, custom toolbar.



Lets you rename a custom toolbar. You cannot rename the toolbars provided initially with Designer.



If the currently selected toolbar is a custom toolbar, deletes the toolbar. If the currently selected toolbar is one of
those provided initially with Designer, resets the toolbar to its initial settings.



Displays a dialog box with buttons that you can drag to the currently selected toolbar.



Select this option if you want to see color buttons in your toolbars.



Select this option if you want to see large buttons in your toolbars.



Select this option if you want to see Tool Tips.
Tool Tips, when enabled, show you the name of a tool or button when you pause the pointer on the button.



The split-pages-or-enlarge-drawing dialog box



The document you are opening consists of multiple pages. You can either retain the page divisions (click Split Up 
Pages) or combine the pages into a single, large drawing (click Enlarge Document).



The Find Files dialog box



Find Files dialog box
This dialog box lets you search folders for a specific filename or all filenames that match a wildcard specification.



Type the name of the file you want to search for in this text box. You can use the wildcard character ? (question 
mark) as a substitute for an individual character and the wildcard character * (asterisk) as a substitute for any 
number of characters.



Select this option if you want to start the search from a specific path instead of searching entire drives. Enter the
pathname in the box to the right.



If you want to start the search from a specific path instead of searching entire drives, enter the pathname in this 
box.



Click    this option if you want to search entire drives. You can choose from Removable, Fixed, and Remote drives.



Click    this option if you want to search all your removable-media drives.



Click    this option if you want to search all your fixed-media drives (such as hard disks).



Click    this option if you want to search all your network drives.



During the search, Designer lists the names and locations of files that match the entry in the Search For box.



Click this button to begin the search.



Click the name of the file in the Files Found list that you want to open, and then click this button to open the file.
Tip

If Designer lists multiple files found in a search, you can use CTRL+click to select as many as nine files and 
then open all the files in one operation, even if the files are in different folders.



The Files Found dialog box



Files Found dialog box
This dialog box shows the number of files that matched your search specifications. Click OK to return to the Find 
File dialog box.



The Page Setup dialog box



Page Setup dialog box
This dialog box lets you change the size, margins, and orientation of the active window's on-screen page. You 
can change page settings before, during, or after creating a drawing.
New page settings are applied immediately to the current page in the active window.
Individual pages in your document can have different sizes, orientations, and page fills, if desired. To apply the 
same size, orientation, and page fill to all pages in the document, select Apply to All Pages (on the Margins tab). 
This option, like Use Master Page, forces all pages to be uniform.
Tip

If you change the page setup, and you plan to print your work, you should change the printer setup to 
match.



Sets the size of the current page. You can choose from standard page sizes or choose Custom Size and create 
your own by adjusting the Width and Height measurements.
Tip

Use the Screen Size selection when preparing on-screen presentations (slideshows) to be used with the 
Page Manager tool. Choosing this option sets the page size to match the size, proportions, and resolution of your 
monitor.



Match the size, orientation, and page fill (if any) of the master page. To edit the master page, you must click the 
Page button (at the bottom left of the Designer window), and choose Master Page



Forces the on-screen page to reflect your printer's page size and margins. For example, if your printer uses an 
8.5" x 11" page with one-half inch margins, the on-screen page matches it.



Lets you change the measuring increment to change the page size. The units match the ruler by default.
To change the units, click the Units button. A menu opens, displaying the units available, along with the More 
Units command.



Changes the page size. Use the scroll arrows in the Height and Width list boxes.



Changes the page size. Use the scroll arrows in the Height and Width list boxes.



Shows the number of columns of tiles used when the current page size is printed to the target printer. If the page
size is set to use the printable area and the page orientation matches the orientation of the target printer, no 
tiling is used, and the number of columns is set to 1.
If you enter a new value for columns, the page size changes to match the number of columns. To display tile 
lines on your screen as you work, open the View menu, point to Workspace, and click Show Printer Page Tiles.



Shows the number of rows of tiles used when the current page size is printed to the target printer. If the page 
size is set to use the printable area and the page orientation matches the orientation of the target printer, no 
tiling is used, and the number of rows is set to 1.
If you enter a new value for rows, the page size changes to match the number of columns. To display tile lines on
your screen as you work, open the View menu, point to Workspace, and click Show Printer Page Tiles.



Opens a dialog box that lets you choose a color fill for the page.



Applies all of the page setup options to all of the pages in the document.



Lets you change the page's orientation to either portrait (tall) or landscape (wide).



Lets you change the page's orientation to either portrait (tall) or landscape (wide).



Lets you choose page margins (border widths). You can use margins as boundary guides for creating drawings. 
Type the margins you want, or use the scroll arrows to change the widths.
Most printers do not print to the edge of the paper. Margins include this nonprinting area. For example, if your 
margin is 1/2 inch and the nonprinting area is 1/4 inch, the margin is 1/2 inch from the edge.



Lets you choose page margins (border widths). You can use margins as boundary guides for creating drawings. 
Type the margins you want, or use the scroll arrows to change the widths.
Most printers do not print to the edge of the paper. Margins include this nonprinting area. For example, if your 
margin is 1/2 inch and the nonprinting area is 1/4 inch, the margin is 1/2 inch from the edge.



Lets you choose page margins (border widths). You can use margins as boundary guides for creating drawings. 
Type the margins you want, or use the scroll arrows to change the widths.
Most printers do not print to the edge of the paper. Margins include this nonprinting area. For example, if your 
margin is 1/2 inch and the nonprinting area is 1/4 inch, the margin is 1/2 inch from the edge.



Lets you choose page margins (border widths). You can use margins as boundary guides for creating drawings. 
Type the margins you want, or use the scroll arrows to change the widths.
Most printers do not print to the edge of the paper. Margins include this nonprinting area. For example, if your 
margin is 1/2 inch and the nonprinting area is 1/4 inch, the margin is 1/2 inch from the edge.



Prints crop marks on the paper.



Shows a preview of the page and margins when you click the Details button.
Note

If you change the page setup, and you plan to print your work, you should change the printer setup to 
match.



Invalid Page Definition dialog box



The current page definition contains an invalid setting (such as a margin that is larger than the paper size). 
Please check the Page Setup settings on both the Margins and the Paper Size tabs.



The PageSetupDefault dialog box



Page Setup - Default dialog box
This dialog box lets you make the current Page Setup settings the default settings. If you click Yes, the current 
page and all new pages will use these settings. You are returned to the document.



Makes the current Page Setup settings the default settings. The current page and all new pages will use these 
settings. You are returned to the document.



Closes this dialog box without changing any default settings.



The Print Document dialog box



Print Document dialog box
This dialog box lets you print the document in the active window. You can specify the current page, all pages, or 
selected pages from the document; the number of copies to be printed; whether to collate the copies; whether to
include page labels; and whether to use vector clipping (for use with a pen plotter).
You also can print multiple documents.
If the current page size is larger than the paper size of your printer or plotter, the entire drawing page is printed 
with as many printer pages as needed. This process is called tiling.



Prints the currently displayed page. If more than one page is displayed, prints the last page to have an object 
selected.



Prints every page of a document.



The Range option lets you print specific pages in the document.
Examples:
Enter this: To print pages:
1,2,6-9 1, 2,    and 6 through 9
6- 6, 7, 8, to the end of the document
Note: If you choose the Fit To Page option and the page is tiled, all of the tiles are reduced to fit on a single page
rather than the pages you specify.



The Range option lets you print specific pages in the document.
Examples:
Enter this: To print pages:
1,2,6-9 1, 2,    and 6 through 9
6- 6, 7, 8, to the end of the document
Note: If you choose the Fit To Page option and the page is tiled, all of the tiles are reduced to fit on a single page
rather than the pages you specify.



Lets you choose the number of copies to print.



Prints a complete copy of a document before printing the next copy. This option is available only when you print 
more than one copy of a multiple-page document.
When the Collate option is not selected, Designer prints all copies of the first page, then all copies of the second,
and so on.
Note

Collating can slow the print speed on some printers.



Prints the document's file name, page number, and page name (if any) at the top of the page in the margin.



Flips a drawing so that it prints reversed--as though you were viewing it in a mirror. Use this option to print T-
shirt transfers or other drawings that must be given to a print shop reversed.
This option is available only with certain printer drivers. This option is grayed if the printer driver does not 
support mirroring.



Improves the output of drawings on plotters. This option does not allow plotted lines to cross, causing the top 
object of overlapping drawings to completely cover the bottom object (this is done automatically with non-
plotting printers).
Vector Clipping also prevents the damage to plotter pens that can occur when different colors are drawn over 
each other. For example, a yellow line drawn over a black line can permanently stain the yellow pen.
The Vector Clipping option is available only when you are using a plotter. This option increases the time it takes 
to plot your drawing.



Adds PostScript code to the printer output to make it compatible with DSC color-separation programs. Those 
programs can then separate the colors in your drawing. The code allows separation of spot and process colors.
You should use this option only if you are printing to an EPS file.



Clear this option only if all of the fonts in your document have been downloaded to your PostScript printer.
Bypassing font downloads can greatly reduce the size of a print job. It tells Designer that the printer has resident
font descriptions for all the fonts in the current print job, and that it is not necessary to dowload the font 
description for any font encountered in this Designer document.
This option is enabled only for PostScript printers where Designer handles the PostScript generation. 



Displays the Windows property sheet for the current printer. You can use the property sheet to examine or 
change your printer setup before printing the Designer document.



Reduces or enlarges the drawing proportionately to fit the printout, if necessary. If this option is not selected, the
drawing is tiled on as many pages as necessary.
Note

If you select this option, all pages are printed on a single page rather than only the pages you specify in 
the Range area.



Center the document page horizontally and vertically on the printer page. You use this option when you are 
printing a document page that is smaller than the printer page. If you do not choose this option, the page prints 
at the upper left of the paper.



Prints using the options you selected.



The Print Multiple Files dialog box



Print Multiple Files dialog box

The Print Multiple Files dialog box prints one copy of all pages in each selected document. Designer handles 
mixed page orientations (portrait and landscape) automatically.



The Save As dialog box



Save As dialog box

The Save As dialog box lets you name a new document, save a document with a new name, or replace an 
existing document with the current document.
If you type a filename without an extension, DSF is used.
Alternatively, you can choose the file format you want (in the file type list box).
Tips

Pressing a character key when a filename is highlighted in the text box makes the name disappear. To edit 
the filename, press the RIGHT ARROW to remove the highlight. Then press the RIGHT or LEFT ARROW to move the 
cursor. To delete characters to the left of the cursor, press BACKSPACE.

If you enter or select an existing filename, Designer asks if you want to replace the existing file. Click No to
return to the Save As dialog box. Click Yes to replace the file.



The Target Printer dialog box



Target Printer dialog box
This dialog box lets you choose which of your installed printers to use for printing your Designer documents.



Lists the currently installed Windows printer drivers. Click the name of the printer you want to be the currently 
active printer. You can choose any installed printer.



The Select dialog box



The Select dialog box lets you select objects based on their attributes and properties.
For example, you can use this command to select all objects with red interiors and blue edges. If you've named 
the objects in your drawing, you also can search for objects by name.



Shows a list of physical characteristics possible for an object, such as interior fill style, line end style, line style, 
line weight, line fill, font, and font size. Before you open the dialog box, select an object, then in the dialog box 
highlight the attributes you want to search for. Designer selects other objects on the page with matching 
attributes.



This list shows the properties assigned to all objects on the current layer. For example, if the two properties 
"Cost" and "Weight" are associated with an object, you can select the property of "Cost" and type a cost in the 
Property Value text box to select objects based on their cost.
Tip

 In most cases there is only one property: "Name." You can ignore this option if you haven't assigned 
multiple properties.



Specifies the value that you want to select. You can either select other objects with the same value or use 
wildcard characters to designate the portions of names to search for.
For example, if the value (name) of the object is "widget1," but you want to select all widgets, you can type 
"widget*" to select widget1, widget2, and so on.
Wildcard characters let you search for partial matches. Use "?" for single characters; use "*" for multiple 
characters.



Selects all objects on the current page that match the selected properties and attributes, or selects the matching
objects one at a time. Click the Select button to select the next matching object (and deselect the first).



Selects the objects based on the attributes and property values you selected.



Appends newly selected objects with those previously selected. 
For example, suppose you have a red circle with a line weight of 2.0, a blue circle with a line weight of 2.0, and a 
yellow circle with a hairline. Change the default fill color to red. Open the Select dialog box, choose Interior Fill 
Style, and then choose Select. Designer selects the red circle. Choose Line Weight, then choose Append. 
Designer adds the blue circle to the selection, because it has the same line weight as the red circle.



Deselects the currently selected objects.



The Links dialog box



Links dialog box

The Links dialog box lists each linked OLE object in your document, including the name of the source application,
the type of linked object (for example, picture or text), the filename, and whether the object updates 
automatically or manually.
You can changes the settings, update an object to match its source file, or break the link between an object and 
its source file.



The Paste Special dialog box



Paste Special dialog box

Lets you choose how you want to paste an object from the Clipboard.
Optionally, you can choose to display an icon of the pasted object rather than the object.



Paste Special db Source

Lets you enter or edit the source application and filename of the object you are pasting.



Paste Special db Data Type

Lists the format, or type, of the object you are pasting. You can select a different data type from the list to paste 
the object in a different format. For example, you can select a non-OLE data type if you don't want to embed the 
object.
The data types supported are as follows.
Type Description
Rich Text Format Encoded text that contains information such as attributes (bold, italic, color, etc.)
Text Standard ANSI character set
OEM Text Text that is in a different character set
Paintbrush Picture Bitmap from Windows Paintbrush
Bitmap Device dependent bitmap
DIB Device independent bitmap
Picture Windows metafile
Note

You must choose the highlighted data type if you want to link the object to its source file.



Paste Special db Paste

Pastes (and embeds) the object from the Clipboard into the drawing, using the format selected in the Data Type 
list box.



Paste Special db Paste Link

Pastes the object from the Clipboard into your drawing and maintains a link between the pasted object and the 
object's original file. When you edit a linked object, the object's original file also updates.
This button is gray if the object comes from a program that cannot link to Designer.



The Insert Object dialog box



Insert Object dialog box

The Insert Object dialog box lets you create and insert an OLE object into your Designer drawing. You can create 
the object either from a file or by using an OLE server application such as Picture Publisher or ABC FlowCharter.



The Align dialog box



Align dialog box
This dialog box contains three panels to let you align objects to one another, to the page edges, or to a selected 
path.
Notes

The Align To Path panel is used only to align objects (or text that has been converted into curves) to a path.

Designer removes warps, rotations, and skews of objects that are aligned to a path. Convert the objects to 
curves (keyboard shortcut CTRL+R) before aligning them if you want to keep their previous transformations.



Uses the bounding box that surrounds all selected objects as the basis for alignment. For example, if you select three objects 
and align them at top left, they align to the top left corner of the surrounding bounding box.



Lets you use buttons to change the alignment of objects on the page. When you choose an alignment button, the preview box 
displays the object alignment.



Lets you align text and non-text objects along the path of other objects. For example, you can draw a curve and align other 
objects along it.

You also can change how text and shapes align to a path with the alignment orientation options.

Note

Text aligned to a curve is treated as a single object. To align individual characters to a path, use the Path Fit
button 

.



Returns the objects to their original positions.



When Aligning Objects: Aligns all selected objects to the left of their bounding box.

When Aligning To Page: Aligns all selected objects to the left page margin.



When Aligning Objects: Aligns all selected objects to the horizontal center of their bounding box.

When Aligning To Page: Aligns all selected objects to the horizontal center of the page.



When Aligning Objects: Aligns all selected objects to the right edge of their bounding box.

When Aligning To Page: Aligns all selected objects to the right page margin.



When Aligning Objects: Distributes the selected objects horizontally within their bounding box so that they are equally 
spaced.

When Aligning To Page: Distributes the selected objects horizontally on the page so that they are equally spaced.



When Aligning Objects: Aligns all selected objects to the top edge of their bounding box.

When Aligning To Page: Aligns all selected objects to the top page margin.



When Aligning Objects: Aligns all selected objects to the vertical center of their bounding box.

When Aligning To Page: Aligns all selected objects to the vertical center of the page.



When Aligning Objects: Aligns all selected objects to the bottom edge of their bounding box.

When Aligning To Page: Aligns all selected objects to the bottom page margin.



When Aligning Objects: Distributes the selected objects vertically within their bounding box so that they are equally
spaced.
When Aligning To Page: Distributes the selected objects vertically on the page so that they are equally spaced.



Selects the previous object to use as a path for the other objects. The initial path selection is the object that 
provides the longest path.
The Previous button cycles through objects in the opposite order from the order in which they were drawn.



Selects the next object to use as a path for the other objects.
The Next button cycles through objects in the order in which they were drawn.



Align db Justification Left

Positions objects so the left edge of each object aligns to the alignment point (the point on the object around 
which other objects align).



Align db Justification Center

Centers objects horizontally around the alignment point (the point on the object around which other objects 
align).



Align db Justification Right

Positions objects so the right edge of each object aligns to the alignment point (the point on the object around 
which other objects align).



Align db Justification Justify

Distributes objects evenly on the path (the object around which other objects align).



Places objects along the path without skewing or rotating the shapes.



Aligns the objects along a path by rotating, but not changing the shapes.



Aligns objects in the opposite direction in which the path was drawn (the alignment direction is endpoint to 
origin).



Aligns objects in the direction in which the path was drawn (the alignment direction is origin to endpoint).



Controls where the objects vertically rest on a path. An offset of 100 aligns the bottom of the objects to the path,
an offset of 0 aligns the middle of the objects to the path, and an offset of -100 aligns the top of the objects to 
the path.
An offset greater than 100 (to the limit of 200) aligns the bottom of the objects above the path. An offset less 
than -100 (to the limit of -200) aligns the top of the objects below the path.



Sets the alignment point to the leftmost edge of the path you are using to align objects.
To set the alignment point to a custom location, click Choose Position and drag the red Alignment Point to the 
location that you want. To complete the selection of the alignment point, click Choose Position a second time.



Sets the alignment point to the horizontal center of the path you are using to align objects.
To set the alignment point to a custom location, click Choose Position and drag the red Alignment Point to the 
location that you want. To complete the selection of the alignment point, click Choose Position a second time.



Sets the alignment point to the rightmost edge of the path you are using to align objects.
To set the alignment point to a custom location, click Choose Position and drag the red Alignment Point to the 
location that you want. To complete the selection of the alignment point, click Choose Position a second time.



Sets the alignment point to the top edge of the path you are using to align objects.
To set the alignment point to a custom location, click Choose Position and drag the red Alignment Point to the 
location that you want. To complete the selection of the alignment point, click Choose Position a second time.



Sets the alignment point to the bottom edge of the path you are using to align objects.
To set the alignment point to a custom location, click Choose Position and drag the red Alignment Point to the 
location that you want. To complete the selection of the alignment point, click Choose Position a second time.



The Blend dialog box



Blend dialog box
This dialog box lets you transform one object into another. You can specify the number of transformations, or 
steps, between two objects. Each step is a different object slightly changed to look more like the second object. 
The more steps you use, the closer (and smoother) the transforming objects are. You can use as many as 1000 
steps.
Tips

Blending results are usually better with uncomplicated objects.

Large numbers of steps can slow redraw time.

You may have to try several different settings to find the ones that give the effect you want.

Designer cannot blend grouped, bitmap, or text objects. You can convert text to curves and then blend it.



Specifies the number of transformations, or steps, between the two objects you are blending. Each step is a different object 
slightly changed to look more like the second object. The more steps you use, the closer (and smoother) the transforming 
objects are. You can use as many as 1000 steps.

Note

A large number of steps can slow redraw time.
Objects blend from the front to the back object (the front object is the one you drew last). Select an object and press F10 to move
it to the front. Designer cannot blend patterns, but it blends the pattern color and places the pattern in all the transformations.

If the objects have different patterns (for example, a hatch and a gradient), Designer places the pattern of the top object in all the
transformations. Designer does not place bitmap patterns in transformations.

Tip

Blending results are usually better with uncomplicated objects.
Designer cannot blend grouped, bitmap, or text objects. You can convert text to curves and then blend it.



Lets you reverse the way Designer normally compares points if you don't like the results of a blend.

Objects are drawn either clockwise or counterclockwise from a starting point. For example, closed objects are drawn 
counterclockwise. When Designer blends objects, it matches corresponding points of the two objects so that the order the points 
were drawn determines the appearance of the blend.



Designer blends a point on the first object to a corresponding point on the second object. Use this button to change the default 
origins.



The Transform dialog box



Transform dialog box
This dialog box contains five panels to let you move, scale, flip, rotate, or skew an object or group of objects.
Tip

To leave a trail of copies of the transformed object, set the number of copies in the Copies box.



Lets you set options for moving selected objects.



Lets you select the horizontal distance to move the object, or the ruler coordinate on which to place the object.

You also can use polar coordinates. To change to polar coordinates, click the Units button and click Use Polar Coordinates.



Lets you select the vertical distance to move the object, or the ruler coordinate on which to place the object.

You also can use polar coordinates. To change to polar coordinates, click the Units button and click Use Polar Coordinates.



Lets you change the measuring increment used to transform the object. You can change the units when you want to move the 
object in units other than those used by the ruler. For example, even if the ruler is shown in inches, you can transform the object 
in centimeters.

To change the units, click the Units button. A menu opens, displaying the units available, along with More Units and Custom 
Units commands.



Bases the object's movement on its present location. For example, you can move the object one centimeter up and two 
centimeters to the right.



Move an object to a specific ruler coordinate.



Lists points of reference that you can select as the origin for an object. The default origin is the object's pivot point (usually the 
center of the bounding box). Designer uses the origin as a guide for moving and placing the object. For example, if you select the
lower right point and move the object to ruler coordinate 4 cm horizontal and 3 cm vertical, the lower right point positions itself on
(4,3).

Note

In the Move tab, this list box is only available when the Move Along Ruler option is selected.



Lets you enter the number of copies to make while transforming an object. If the number of copies is 0, then the original object is 
affected. Each copy is spaced or resized from the previous copy as defined by your settings.



Automatically groups all the copies after a transform, but not the original object.



Shows the Multiple Transforms area.



Applies multiple transformations to an object.



Deletes the highlighted transform.



Deletes all remembered transforms.



Sets a remembered transform to the current settings. Choose the remembered transform you want to change, make the changes
you want, and then click Modify. The new settings appear.



Lets you precisely resize a selected object. You can resize an object proportionally or nonproportionally.



Defines the percentage change in the current horizontal size of an object. The current size is 100%. A number below 100% 
decreases the object size, and a number above 100% increases the size.

The horizontal and vertical sizes are the same unless you deselect the Proportional Scale option.



Defines the percentage change in the current vertical size of an object. The current size is 100%. A number below 100% 
decreases the object size, and a number above 100% increases the size.

The horizontal and vertical sizes are the same unless you deselect the Proportional Scale option.



Lets you choose between proportional and nonproportional resizing. Proportional scale is selected by default. Deselect the 
Proportional Scale option to resize an object nonproportionally. For example, you can increase the vertical size without 
automatically increasing the horizontal size.



Lets you choose where the transform originates. The default origin is the pivot point (usually the center of the bounding box). 
Designer uses the origin as a guide for transforming the object.



Lets you numerically flip (reflect) selected objects. To numerically flip an object, you specify an imaginary line that passes 
through or beside an object at any angle. The object behaves as though it is hinged to the line and flips over it.



Precisely rotates an object. This method lets you specify the object's degree of rotation.



Enter the angle of rotation that you want, or drag the red dial at the right.



Lets you specify a degree of skew, or slant. You can specify a horizontal and vertical skew.



Use the up and down arrows to change the horizontal angle that the object is skewed, or drag the red dial at the right.



Use the up and down arrows to change the vertical angle that the object is skewed, or drag the red dial at the right.



Transform db FlipAngleUse the up and down arrows to change the angle of the line around which the object is reflected, or 
drag the red dial to specify an angle.



Transform db Units

Lets you choose the units of measurement (degrees or radians) for the reflection you want.



Flips the object like a page in a book. The keyboard shortcut for Reflect Horizontal is F7.



Creates a horizontal (0-degree) axis. The keyboard shortcut for Reflect Vertical is SHIFT+F7.



The Unable to Apply the Transform dialog box



You are trying to apply a transformation that Designer does not support for the selected object or objects. For example, you 
cannot skew a bitmap image. 

If you have selected multiple objects, try selecting each object separately, and check the object type displayed on the Status Bar.



You have specified a transformation value that would exceed the visible boundaries. Click OK and then double-check your 
settings in the Transform dialog box.



The Properties dialog box



Properties dialog box
This dialog box lets you assign names to objects and groups of objects in your drawing. This lets you create a list
of objects, select objects by name, and create your own library of clip art. You can assign names, costs, and 
other properties to objects in your drawing.
Properties are like categories of information about the objects in your drawings. "Name" is a predefined property.
When you assign a name to an object, you create a value for the property "Name."



Shows the current value for the property. You can type a different value. Alternatively, you can enter a new property in the 
Property text box in the Edit ribbon.



Shows the current properties available. Name is always available when an object is selected. You can add additional properties 
using the New button.



Opens the New Property dialog box to let you create a new property.



Deletes the highlighted value for a property.

Note

You can delete the values for any properties you have created by selecting a property and clicking the Delete button. The 
properties themselves are not deleted.



The New Property dialog box



New Property dialog box
This dialog box lets you define a new name for a property. After you enter the new name, you are returned to the
Properties Dialog box, where you can assign a property value.



Lets you enter a name for the new property.



The List Objects dialog box



List Objects dialog box
This dialog box alphabetically lists the names (the values assigned to the property "name") for the objects selected in the current 
drawing, and shows the number of times each object appears (quantity).

If no objects are selected, the list contains the names for all the objects in the drawing. Objects without names are listed as 
"other."



Lets you choose any property that has been created. To see the value and quantity for that property for selected objects, click 
the down arrow. If no objects are selected, Designer lists all objects with the selected property.



Opens the Titles dialog box. You can enter a main title by typing it in the Main Title field, and enter column titles 
by typing them into the Value Column and Quantity Column fields. You can use the column separator to create 
leader dots.
Note

You can see a title only when you print an object list, or in the Clipboard Viewer.



Copies the object list to the Clipboard. Paste the data into the drawing area or into any Windows-compatible program.



Prints the parts list.



Opens the Save As dialog box. You can save the parts list as a text (TXT), DIF, or SYLK (SLK) file.



The Titles dialog box



Titles dialog box
This dialog box lets you change the column titles in the object list, and you can change the column separator character used 
when the list is saved.



Lets you enter a main title for the object list. You can see a title only when you print an object list, or in the Clipboard Viewer.



Lets you enter a title for a value column.



Lets you enter a title for a quantity column.



If you want to print leader characters, such as periods, between the two columns, you can enter one or more 
characters in this field.



The Replace dialog box



Replace dialog box
This dialog box (click Replace on the Object menu) lets you control how selected objects are replaced by those 
from the Clipboard.
For example, you can use the Scale to Fit option to force a Clipboard object to scale up or down to completely fill 
the bounding area of the object you are replacing.



Forces a Clipboard object to scale up or down to completely fill the bounding area of the original object.



Lets you keep the original proportions of the Clipboard drawing. Use the list box to select a handle on the original object to which
Designer can align the Clipboard replacement.

You can only use the Origin list box when the Align to Border option is deselected.



Lets you choose one of two ways to replace multiple selected objects with the contents of the Clipboard.

Select this option if you have several objects selected but only one in the Clipboard. Each selected object is
replaced with a copy of the Clipboard object.

Deselect this option if you have several objects selected and several in the Clipboard. The first object (from
left to right) in the Clipboard replaces the first original object, the second Clipboard object replaces the second 
original object, and so on.



Pastes the Clipboard's contents over the original object.



Cuts the object to the Clipboard.



Copies the object to the Clipboard



Pastes the object into your drawing.



The Reduce Points dialog box



Reduce Points dialog box
This dialog box lets you smooth an object's appearance by eliminating some of its anchors.
Objects produced by tracing bitmaps sometimes have an undesirably large number of anchors. By reducing the 
number of anchors in a traced object, you often can improve the object’s appearance. Reducing the number of 
anchors in an object also can improve its printing speed.



Shows the current number of anchor points in the object. Adjusted Number of Points shows the number of anchor 
points in the modified object after you drag the slider.



Decreases the number of points in the object as you drag toward Fewer Points.



Decreases the number of points in the object as you drag toward Fewer Points.



The Import dialog box



Import dialog box

The Import dialog box lets you specify which file you want to import. You can select the folder and the type of 
file, and then select the filename.



Opens a dialog box that lets you set options for the import format you have chosen.



The Export dialog box



Export dialog box

The Export dialog box lets you specify the folder, the file format, and the filename of the resulting file.
Note

If no objects in the drawing are currently selected, the entire drawing is exported. If one or more objects 
are selected only those objects are exported.



Opens a dialog box that lets you set options for the export format you have chosen.
Note

If the Designer file has more than one page, only the current page is exported.



The Options dialog box



Options Dialog box
This dialog box has tabs that let you set many different categories of options. The categories include general 
options, ruler and snap options, rotation options, input (primarily mouse) options, settings for the system 
registry, and changing your profile (a collection of your personal settings).



The Rulers/Snap tab on the Options dialog box



Options db RulersSnaptab

xxx



Lets you choose the measurement units to be used in the rulers and grid. The grid appears as a pattern of dotted
lines that corresponds to divisions in your ruler settings. You can use the grid as a guide for aligning objects or 
measuring distances. When you choose settings for the ruler units, all other measurements change as 
appropriate for your ruler measurements. If necessary, you can change each individual unit measurement to the 
units you prefer in the appropriate dialog box.



Lets you choose the measurement units to be used in the rulers and grid. The grid appears as a pattern of dotted
lines that corresponds to divisions in your ruler settings. You can use the grid as a guide for aligning objects or 
measuring distances. When you choose settings for the ruler units, all other measurements change as 
appropriate for your ruler measurements. If necessary, you can change each individual unit measurement to the 
units you prefer in the appropriate dialog box.



Lets you change the number of snaps per unit used for the horizontal ruler. This setting sets the number of 
divisions per unit, which affects the number of grid dots that appear when the grid is displayed and also affects 
how objects snap to the ruler if Snap to Rulers is selected.
Note

To prevent the drawing area from becoming too cluttered, Designer limits the number of grid dots and ruler
tick marks that appear at one time. For example, if you have a large number of snaps per unit such as 100 per inch,
Designer displays only about 16 per inch at full-page view.



Lets you change the number of snaps per unit used for the vertical ruler. This setting sets the number of 
divisions per unit, which affects the number of grid dots that appear when the grid is displayed and also affects 
how objects snap to the ruler if Snap to Rulers is selected.
Note

To prevent the drawing area from becoming too cluttered, Designer limits the number of grid dots and ruler
tick marks that appear at one time. For example, if you have a large number of snaps per unit such as 100 per inch,
Designer displays only about 16 per inch at full-page view.



Specifies the number of units per division in the horizontal ruler, which controls how frequently a number 
appears to label the ruler's units. This option prevents overcrowding the ruler when it is set to small units. For 
example, when a ruler is set to inches, you might use a value of 1, but when a ruler is set to millimeters, you 
might prefer a value of 10.



Specifies the number of units per division in the vertical ruler, which controls how frequently a number appears 
to label the ruler's units. This option prevents overcrowding the ruler when it is set to small units. For example, 
when a ruler is set to inches, you might use a value of 1, but when a ruler is set to millimeters, you might prefer 
a value of 10.



Sets the decimal precision of the horizontal coordinate displayed in the status bar. To change a value, click the 
down arrow next to the box and choose the desired setting.



Sets the decimal precision of the vertical coordinate displayed in the status bar. To change a value, click the 
down arrow next to the box and choose the desired setting.



If you select this option, clicking the Add Points button in the Edit ribbon places snap points at the four corners of
an object’s bounding box (a rectangular area that completely encloses the object).



If you select this option, clicking the Add Points button in the Edit ribbon places snap points at the geometric 
center of an object.



If you select this option, clicking the Add Points button in the Edit ribbon places a snap point at the object’s pivot 
point.



If you select this option, clicking the Add Points button in the Edit ribbon places snap points at an object’s anchor
points.



If you select this option, clicking the Add Points button in the Edit ribbon places snap points at an open object’s 
end points. No snap points are added for closed objects.



If you select this option, clicking the Add Points button in the Edit ribbon places a snap point at the middle of 
each line segment in the object. If the object has no line segments, no snap points are added.



If you select this option, clicking the Add Points button in the Edit ribbon places snap points at the control points 
of all curved anchors in the object.



Ordinarily only the mouse pointer snaps to snap points. Select this option to add having the bounding box of an 
object snap to snap points as you drag the object.



The General tab on the Options dialog box



Options db GeneralTab

xxx



Makes the window scroll automatically when you drag an object beyond the window borders. This is especially 
useful when you have zoomed in for close work.



OptionsGeneral db Confirm File Delete

Specifies whether or not you want a confirmation message to appear each time you delete files. If you turn off 
the confirmation message, files are deleted as soon as you issue the command.



Retains a copy of the previous version of all document files. Designer appends the extension BAK to the filename
and saves the backup in the same folder as the original file. When the Make Backups option is selected, you have
two copies of the document on disk--the current version and the previously saved version. The backup version is 
overwritten each time you save the document.



Specifies whether or not you want to start with a new, blank document each time you start designer. Selecting 
this option lets Designer open faster, which saves time when you plan to open an existing document rather than 
creating a new one.



By default, the Undo and Redo commands in the Edit menu reverse (Undo) or repeat (Redo) the most recent five 
actions. However, Designer can remember from 0 to 100 undo and redo steps since the last save. Setting a 
higher number of steps gives you the freedom to try multiple changes and the capability to undo those changes 
if desired, but takes up memory.



Lets you select small, medium, or large handles to suit your preference.



Lets you specify the number of recently used files that Designer displays in the Files menu.



The Input tab on the Options dialog box



Options db InputTab

xxx



Uses SHIFT+DRAG for constrained mouse movement, and CTRL+DRAG for duplicating the dragged object.



Uses CTRL+DRAG for constrained mouse movement, and SHIFT+DRAG for duplicating the dragged object.



Configures Designer so that repeated left mouse-button clicks alternate between selecting and object and 
placing the object in the rotate/skew mode.
To select an object from a stack of overlapping objects, use ALT+click.



Configures Designer so that repeated left mouse-button clicks select each object in turn from a stack of 
overlapping objects.



Configures Designer so that:

Clicking the right mouse button opens a shortcut menu tailored for the currently selected tool and editing 
mode.

Clicking ALT+right mouse button executes the command that you select from the command list.



Configures Designer so that:

Clicking the right mouse button executes the command that you select from the command list.

Clicking ALT+right mouse button opens a shortcut menu tailored for the currently selected tool and editing 
mode.



Lists the commands that you can assign to the right mouse button or to ALT+right mouse button.



Lets you use the keyboard shortcuts from Designer 3.x instead of the standard Designer 6.0 keyboard shortcuts.



The Spelling tab on the Options dialog box



Options db SpellingTab

xxx



Shows suggested spellings for misspelled words found during a spelling check.



During a spelling check, shows correct spellings suggested from the main dictionary, but not from any open 
custom dictionaries.



Ignores words in which all of the characters are uppercase letters.



Ignores words that contain numbers.



Uses the Microsoft Office dictionary for spelling checks.



Uses the Micrografx dictionary for spelling checks.



Shows the list of dictionaries you can use to check spelling. To add an existing dictionary, click Add. To create a 
new custom dictionary, click New.



Creates a new custom dictionary. You can add words to the dictionary during a spelling check.



Adds a custom dictionary to the list so that you can use it to check spelling.



Removes the selected dictionary from the Custom Dictionaries list.



The Registry tab on the Options dialog box



Options db RegistryTab

xxx



Select a Key from this list when you need to examine, change, or add a value.
Note

You should not modify Designer registry entries unless you are instructed to do so by Micrografx.



Shows the current value of the selected Value Name. Also lets you modify the value.
Note

You should not modify Designer registry entries unless you are instructed to do so by Micrografx.



Shows the name (or names) of values for the currently selected key. You can delete the name or add new names.
Note

You should not modify Designer registry entries unless you are instructed to do so by Micrografx.



Lets you add a new value for the currently selected registry key.
Note

You should not modify Designer registry entries unless you are instructed to do so by Micrografx.



Lets you delete the currently selected value name from the current registry key.
Note

You should not modify Designer registry entries unless you are instructed to do so by Micrografx.



Accepts the data entered in the box to the left.
Note

You should not modify Designer registry entries unless you are instructed to do so by Micrografx.



The Profile tab on the Options dialog box



Lets you manage "option profiles" (which are PRO file types that contain all of your Designer option settings). 
When you change to a different profile, the changes take effect immediately.
You may want to change settings for one particular session or project, and then restore your normal settings. If 
more than one person is running Designer from a file server or sharing a computer, each person can save and 
use his or her own settings.
You can choose a different profile, save your settings when you close Designer, and enter or edit a description of 
a profile. You also can create a new profile, and you can copy, delete, rename, and update profiles.



Lists the .PRO files from which you can choose. To create a new .PRO file, or to delete, rename, or otherwise 
manage your profiles, click the File Options button .

When you select a profile, its settings take effect immediately.



Displays a menu for managing .PRO files. You can create, copy, delete, rename, and update .PRO files. 



Displays a menu that lets you specify the folder where Designer should look for .PRO files. Also lets you copy the 
current .PRO file.



Shows the pathname of the folder where Designer looks for .PRO files. To change the pathname, click the button 
to the right, and click Open From.



Accepts the description you enter in the Description box to the left.



If you select this option, all your current Designer settings will be saved in the current .PRO file each time you 
exit Designer.



Displays a description of the selected .PRO file. When you create a new .PRO file, enter its description in this box.
For example, you could enter "Ginger’s profile for technical illustrations" or "Jack’s profile for the Kremmins 
Project."



The Rotation tab on the Options dialog box



Lets you set the rotation angle of the F8 rotation key and constrain rotations to increments of the rotation angle.



Lets you select a unit for rotations.



Lets you change the F8 rotation angle. You can click the arrows beside the text box, or enter a new value in the 
text box, or drag the red needle in the dial control.



Lets you set the increments when you rotate by dragging. For example, if you set the rotation angle to 12 
degrees, an object rotates in increments of 12 degrees. The minimum is 0.1 degrees.



The Text Attributes dialog box



Text Attributes dialog box
This dialog box contains panels for setting font attributes (such as typeface, color, and size), text margins and 
alignment options, text spacing options, and tab-stop settings.



Text Attributes - Fonts panel



Displays options for selecting type attributes such as size and style.



The typeface list box contains the available fonts in Designer. Click the down arrow to open the list box, then 
click the font you want.



You can select a type size from a list of two to 3000 points, or you can type a custom size (10.5, for example).



Lets you change the measuring increment for type. When you click this button, a menu opens, displaying the 
units available, including points, inches, centimeters, millimeters, picas, picas and points, and ciceros. You also 
can select More Units.



The Position list box lets you choose the position of type: Normal, Superscript (CTRL+K), or Subscript 
(CTRL+SHIFT+K).



The Attributes area contains the attributes buttons: Bold, Italic, Underline, and Small Caps. Click a button to 
select it to be applied to the selected text.



Displays the current color palette. Click the color you want for the foreground of your text.



Displays the current color palette. Click the color you want for the background of your text.



Text Attributes - Fonts panel



Displays options for setting margins, first-line indents, and alignment for block text in the Margins tab of the Text 
dialog box.



Defines the amount of space between the right edge of block text and its bounding box. You can highlight 
paragraphs to give different paragraphs in the same block different margins. The default margin is none.



Defines the amount of space between the left edge of block text and its bounding box. You can highlight 
paragraphs to give different paragraphs in the same block different margins. The default margin is none.



Moves the first line of each selected paragraph to the left or right of the left margin. If you select a text object, 
the first line of each paragraph separated by a carriage return (ENTER key) is indented. If you highlight a portion 
of one or more paragraphs, only the first lines of those paragraphs are indented.
A positive value moves the first line of text to the right of the left margin; a negative indent moves the text to 
the left of the left margin.



Aligns each line of text in selected paragraphs to the left text margin.



Centers each line of text in selected paragraphs between the left and right text margins.



Aligns each line of text in selected paragraphs to the right text margin.



Adds space between words as necessary to align lines of text in selected paragraphs with both the right and the 
left text margins. The last line of the paragraph aligns to the left margin.



Adds space between words as necessary to align lines of text in selected paragraphs with both the right and the 
left text margins. Unlike with the Justify alignment, Force Justify justifies the last line of the paragraph.



Aligns text to the top margin of the text bounding box.



Aligns text between the top and middle margins.



Aligns text to the bottom margin of the text bounding box.



Equally spaces lines of text between the top and bottom margins of the text bounding box.



Spacing Tab (Text dialog box)



Displays options for setting the spacing between characters, words, lines, and paragraphs.



The space between lines of text is called leading. Leading is measured (in points) from baseline to baseline. The 
default is the current font size plus approximately 15% of the font size (the percent may vary from font to font). 
For example, if the current font is 10 points, then the default leading is approximately 11.5 points.
Note

Because each line in freeform text is treated as a separate paragraph, the Leading area is gray, and 
leading does not affect freeform text. To change the spacing between lines in freeform text, use the Before and 
After Parag areas.

You can change the leading in selected block text or specify leading for block text you are going to enter. If a 
selected block text contains different sizes of text, Designer displays leading for the largest font.



Type a percentage to change the spacing between words. The default is 100% spacing. Decreasing this 
percentage decreases the spacing between words; increasing the percentage increases the spacing.



Type a percentage to change the spacing between characters. A percentage below 100% decreases spacing; a 
percentage above 100% increases spacing.



Use this area to change the default spacing above paragraphs. If this amount is set to zero (0), the current 
leading will be used as the spacing between paragraphs.



Use this area to change the default spacing below paragraphs. If this amount is set to zero (0), the current 
leading is used as the spacing between paragraphs.
Note: If you have amounts entered in both the Before Parag and After Parag areas, Designer adds these 
amounts and applies the spacing amount between the selected paragraphs. For example, if you enter 40 in the 
Before Parag area and 30 in the After Parag area, Designer uses 70 for the spacing between the selected 
paragraphs.



Drop caps are typically used at the beginning of magazine articles and other places where you want to mark a 
change in the material without a title. Click this option to make the first character of a selected paragraph lower 
and larger than other text in the paragraph.



Adjust the percentage in this area to change the size of the first letter as a percentage of its normal height 
(normal height is 100%). For example, 200% doubles the size of the first letter of the paragraph.



Designer can automatically hyphenate words to help decrease the amount of raggedness of left justified text, 
and to help maintain character and word spacing in left justified text. Select the Use Automatic Hyphenation 
option to automatically hyphenate words. You can manually add or remove hyphens later, if you want.



Tab Stops tab (Text dialog box)



Displays options for setting tab stops.
Tab stops are measured from the left margin of the text object. For example, if the second tab stop is 1.0 picas, it
is 1.0 picas from the left margin.



Displays the current tab stops and the type of tab stops.



Deletes the currently selected tab stop.



Deletes all tab stops.



Lets you use the TAB key in your text to align text to the left of the tab stop.



Lets you use the TAB key in your text to align text to the center of the tab stop.



Lets you use the TAB key in your text to align text to the right of the tab stop.



Lets you use the TAB key to align decimal points in your text to the tab stop.



Choose a tab type from the Types area, enter a position for the new tab stop, and then click the Add Tab button 
to add a single tab stop.
To repeat the tab stop at uniform intervals, click the Repeat Tab button.



Adds a single tab stop at the position you have entered in the box to the left.
If you want to repeat the tab stop at uniform intervals, click the Repeat Tab button.



Repeats the tab stop you have entered in the box to the left at uniform intervals.



Leaders are characters such as periods (...), hyphens (---), and underscores (_) that appear to the left of 
tabulated text. Select a tab in the Current Tabs area and click the down arrow to display the leader options. 
Choose None to have no leaders, or choose a type of leader.



Spelling dialog box



Spelling dialog box
The Spelling dialog box gives you options for handling a misspelled or unrecognized word in your text.



Designer checks spelling by comparing words in your document with words in a dictionary. The default dictionary
is a file containing thousands of words. If Designer finds a word in your drawing that is not in the dictionary, the 
word is displayed as a possible misspelling.



Displays possible correct spellings. You can edit the word in this box.



Displays a list of words similar to the misspelled word from the currently used dictionary.



Lets you ask for a suggested change from the dictionary for the displayed word. This button is enabled only if 
you have turned off the Always Suggest option.



Skips the word in the Change To box without changing it.



Ignores the current word and all other occurrences of the word without prompting you.



Changes the highlighted word to the word in the Change To box.



Changes the highlighted word to the word in the Change To box and makes the same change to all subsequent 
occurrences of the word without prompting you.



Adds the word in the Change To box to the current dictionary. The current dictionary appears in the Add Words To
list box.



Displays the dictionaries being used to detect misspellings. Designer uses all the dictionaries here, but only adds
words to the top dictionary.



Displays the Spelling tab of the Options dialog box, where you can specify which dictionary to use, whether to 
ignore words in all uppercase, and other settings.



Ends the spelling check without checking any more words. Keeps spelling corrections you have made.



Spell Check Rest Of Document dialog box



The spelling checker has checked the currently selected text. Click Yes if you want the spelling checker to check 
all text in the document. Click No if you want to exit the spelling checker.



Spelling Check Is Complete dialog box



The spelling checker has finished checking the spelling. Click OK to return to the document.



Line Style dialog box



Line - Style panel of the Line dialog box
This panel lets you select from a list of dotted and dashed line styles for the currently selected object. You also 
can choose to make the object's line invisible.



Choose this option to make the line invisible.



Choose the line style that you want to apply.



Line-Weight dialog box



Line - Weight panel of the Line dialog box
This panel displays the width and height of the pen tip, using the current units setting. A preview of a weighted 
line is shown using the settings you choose.
If you choose a weighted line, the dialog box shows a preview of the line's current cap style to illustrate the 
effect of the different cap options.
If you click Calligraphic, the dialog box shows a preview of how the calligraphic pen will look with the angle 
setting. You can drag the red line in the preview to change the angle.



Makes the line weight (thickness) of selected lines a hairline, the narrowest line supported by the display screen 
or the printing device.



Lets you specify a weight (thickness) for lines.
Also lets you specify the type of line cap and line join, and lets you select calligraphic lines.



Lets you set the thickness of lines using the setting in the Units button. Use the scroll arrows to set the line 
thickness you want.



Opens a menu to let you change the measuring units used for line weight.



Causes the selected object’s line weight to increase or decrease proportionally if the object is resized. If you do 
not select this option, the line weight remains the same when the object is resized.



Controls how the ends of lines appear. Repeatedly click this button to cycle through the three options: Round, 
Square, and Flat.

The Round option (the default) caps each line end with a semicircle whose center point is at the line’s end 
point. (The diameter of the semicircle matches the width of the line.)

The Square option caps each line end with a square whose center point is at the line’s end point. (The 
width of the square matches the width of the line.)

The Flat option ends the line with a flat cap that is perpendicular to the line.
Tip

To achieve a dotted (rather than dashed) line style, experiment with a round cap and a line style of short 
dashes.



Lets you set how the corner intersection of lines appears in an object. Repeatedly click this button to cycle 
through the three options: Round, Mitre, and Bevel.

The Round option (the default) places the center point of a circle at the vertex of two line ends. (The 
diameter of the circle matches the width of the lines.)

The Mitre option creates a pointed intersection that is the true intersection of two lines.

The Bevel option averages the angles of the two lines, creating a blunt intersection.
Note

When you select the Mitre join option in the Line-Weight dialog box, lines that meet at angles sharper than 
11 degrees are drawn with beveled joins. This prevents objects from having extremely pointed joins.



Lets you create lines of varying thickness. You can set the angle and size of the calligraphic "brush." When you 
select this option, the dialog box shows a preview of the calligraphic pen according to the current settings. You 
can enter a new angle or drag the red line in the preview to change the angle.



Lets you set the height of lines using the setting in the Units button. Use the scroll arrows to set the line height 
you want.



Lets you enhance the effects created with the Width and Height settings. In a calligraphic line, the Pen Angle 
setting forces the pen tip to stay at the chosen angle, much as a calligraphic pen is held at particular angles to 
achieve lines of varying thickness.



Line-Ends dialog box



Line - Ends panel of the Line dialog box
This panel lets you select from several line-ending symbols to use with a selected open object. You also can 
change the size and position of the symbol at the end of the line.



Shows a preview of your line end settings. If you are setting the two line ends with different symbols or 
attributes, click the end that you want to change, and then make the change.



Lists the available symbols you can use as line ends. Use the scroll arrows at the right to see additional symbols.



Lets you choose to set both ends as the same symbol (square, triangle, etc.).



Lets you choose to set both ends with the same attributes (such as angle and offset).



Lets you paste any object from the Clipboard as a line end to be added to the gallery.



The Remove button lets you remove selected line ends from the dialog box. You can only remove line end styles 
that you have added.



Adjusts the width of a line end to a percentage of its original width. Setting this value to 50% makes the line end 
width half the original size; changing the value to 200% makes the line end width twice the original size.



Adjusts the height of a line end to a percentage of its original height. Setting this value to 50% makes the line 
end height half the original size; changing the value to 200% makes the line end height twice the original size.
Tip

To resize the line end proportionally, set Width % and Height % the same value.



Repositions the line end symbol along the line in either direction. Enter a positive value to move away from the 
center of the line. Enter a negative value to move toward the center of the line.



Repositions the line end symbol above or below the line. Enter a positive value to move above the line. Enter a 
negative value to move below the line.



Lets you rotate the line end symbol by a specific angle.



Lets you flip the line end symbol horizontally.



Lets you flip the line end symbol vertically.



Sets the line end to the same as the line style. If this option is selected, the preview displays the line ends with 
the same attributes as the line. If this option is deselected, the preview displays the line ends with the original 
attributes of the line end.



Fill dialog box buttons



Displays options for filling the line of an object.



Displays options for filling the interior of an object.



Displays options for filling the interior or line of an object with a solid color.



Displays options for filling the interior or line of an object with a color gradient.



Displays options for filling the interior or line of an object with a hatch pattern.



Displays options for filling the interior or line of an object with a bitmap image.



Displays options for filling the interior or line of an object with another object.



both Fill - Invisible panels



Fill - Invisible panel
This panel of the Fill dialog box lets you fill the line or interior of a selected object or group of objects with a 
transparent (invisible) color.
Tips

To see the outline of an object that has invisible fill for both its line and its interior, point to Preview on the 
View menu, and click Wireframe.

If you want a solid fill for either the line or interior of an object, click the Solid Fill button 

 to turn it on.



Fill - Solid panels



Interior Fill - Solid panel
This panel of the Fill dialog box lets you fill the interior of a selected object or group of objects with a solid color.
You can use any of these methods to choose the solid color:

Click a color on the current color palette at the bottom of this panel.

Use the Mixing Palette on the upper part of this panel to mix any four colors from the current color palette. 
You can then choose your solid-fill color from the Mixing Palette.

Click the Edit Color button 

 to specify a custom color.
Tips

If you want a transparent (invisible) fill, click the Solid Fill button 

 to turn it off.

You can apply the color to the selected object either by clicking the color and then clicking Apply or by 
double-clicking the color.

You can leave the Fill dialog box open while you select or edit objects in your drawing.



Line Fill - Solid panel
This panel of the Fill dialog box lets you fill the line of a selected object or group of objects with a solid color.
You can use any of these methods to choose the solid color:

Click a color on the current color palette at the bottom of this panel.

Use the Mixing Palette on the upper part of this panel to mix any four colors from the current color palette. 
You can then choose your solid-fill color from the Mixing Palette.

Click the Edit Color button 

 to specify a custom color.
Tips

If you want a transparent (invisible) fill, click the Solid Fill button 

 to turn it off.

You can apply the color to the selected object either by clicking the color and then clicking Apply or by 
double-clicking the color.

You can leave the Fill dialog box open while you select or edit objects in your drawing.



You can use the four color swatches on the four corners of the Mixing Palette to create a customized palette. 
Click a color in the Color Palette, then click a color swatch beside the Mixing Palette to add that color to the 
Mixing Palette.



Opens a menu that lets you manage Designer's colors and palettes.



Opens the Color Picker dialog box. The dialog box lets you choose a color from the full range of possible colors 
and add it to the Color Palette.



Shows the colors available in the current color palette. You can resize the palette by dragging its bottom edge. 
Drag it out to show more colors; drag it in to show fewer colors. If all the colors in the palette cannot be 
displayed at once, a scroll bar appears at the right to give you access to all the colors.



Fill-Gradient panels



Interior Fill - Gradient panel
This panel of the Fill dialog box lets you fill the interior of a selected object or group of objects with a color 
gradient.
Click the left mouse button on a color to make it the starting color for the gradient. Click the right mouse button 
on a color to make it the ending color.
You can:

Click colors on the current color palette at the bottom of this panel.

Use the Mixing Palette on the upper part of this panel to mix any four colors from the current color palette. 
You can then choose your starting and ending color from the Mixing Palette.

Click the Edit Color button 

 to specify a custom color.
 You can set up multiple gradients by clicking above the preview bar.

Multiple gradients

Tips

To apply the color to the selected object, click Apply.

You can leave the Fill dialog box open while you select or edit objects in your drawing.



Line Fill - Gradient panel
This panel of the Fill dialog box lets you fill the line of a selected object or group of objects with a color gradient.
Click the left mouse button on a color to make it the starting color for the gradient. Click the right mouse button 
on a color to make it the ending color.
You can:

Click colors on the current color palette at the bottom of this panel.

Use the Mixing Palette on the upper part of this panel to mix any four colors from the current color palette. 
You can then choose your starting and ending color from the Mixing Palette.

Click the Edit Color button 

 to specify a custom color.
 You can set up multiple gradients by clicking above the preview bar.

Multiple gradients

Tips

To apply the color to the selected object, click Apply.

You can leave the Fill dialog box open while you select or edit objects in your drawing.



Displays the gradient patterns available in Designer.



Opens the Gradient-Edit dialog box.



Deletes the selected gradient. You cannot remove any of the gradient patterns originally included with Designer.



Lets you use many colors in a gradient fill instead of only two colors. You can select a new point above the color 
band and then choose a color in the palette to set. You can drag the point to a new location on the band to 
control how the fill graduates from one color to another. To delete the color point, drag it off of the dialog box.



Gradient-Edit dialog box



Gradient-Edit dialog box
This dialog box lets you change the angle and origin of linear and square gradients and the center point of radial 
gradients. You also can add a new gradient pattern or replace a gradient you previously added with a new one. 
You can add a gradient or replace an existing one with a gradient you have created. The Gradient-Edit dialog box
can contain a maximum of 63 gradient fills.



Lists the three types of gradients available in Designer: Linear, Radial, and Square. Click a gradient type, then 
adjust the gradient using the appropriate options.



Adjusts the x-axis of radial and square gradients. When editing radial and square gradients, you adjust the x- and
y-axes of the center point with a setting from 0 to 100. A setting of less than 50 moves the center point to the 
left of the center of the object. A setting of more than 50 moves the center point to the right of the object.



Adjusts the y-axis of linear and square gradients. The y-origin setting adjusts the starting and ending points of 
linear gradients. A setting of less than 50 moves the center point above the center of the object. A setting of 
more than 50 moves the center point below the object.



Adjusts the angle of linear and square gradients. You also can drag the red needle.



Adds the gradient to the Fill-Gradient dialog box.
Note

You cannot add a particular gradient pattern if an identical pattern is in the dialog box.



Removes the gradient from the Fill-Gradient dialog box. You cannot replace any of the original gradient patterns 
included with Designer.



Fill-Hatch panels



Interior Fill - Hatch panel
This panel of the Fill dialog box lets you fill the interior of a selected object or group of objects with a two-color 
hatch pattern.
You choose the hatch pattern from the gallery of predefined patterns. You can change the foreground and 
background color, and you can vary the line thickness and spacing in the pattern.
Tips

To apply the hatch pattern to the selected object, click Apply or double-click the pattern.

You can leave the Fill dialog box open while you select or edit objects in your drawing.



Line Fill - Hatch panel
This panel of the Fill dialog box lets you fill the line of a selected object or group of objects with a two-color hatch
pattern.
You choose the hatch pattern from the gallery of predefined patterns. You can change the foreground and 
background color, and you can vary the line thickness and spacing in the pattern.
Tips

To apply the hatch pattern to the selected object, click Apply or double-click the pattern.

You can leave the Fill dialog box open while you select or edit objects in your drawing.



Displays the hatch patterns available in Designer.



Lets you change the line weight of hatch fills. The default value is 100%. Changing this value to 200% makes the
lines twice as heavy; setting it to 50% makes the lines half as heavy.



Lets you change the spacing between hatch lines. The default value is 100% (no change). Setting this value to 
200% doubles the space between lines; setting it to 50% cuts the space in half.



The background color is opaque by default (not selected). Select this option to make the background color 
transparent.



Lets you set the hatch pattern color (foreground color). Click the Foreground button, then click a color in the 
color palette.



Lets you set the color behind the hatch pattern. Click the Background button, then click a color in the color 
palette. The background color is transparent by default.



Fill-Image panels



Interior Fill - Image panel
This panel of the Fill dialog box lets you fill the interior of a selected object or group of objects with a two-color or
multicolor bitmap image.
You can either choose the image from the gallery of predefined images or create your own fill images using the 
Clipboard. For two-color images, you can change the foreground and background color.
Tips

To apply the image fill to the selected object, click Apply or double-click the pattern.

You can leave the Fill dialog box open while you select or edit objects in your drawing.



Line Fill - Image panel
This panel of the Fill dialog box lets you fill the line of a selected object or group of objects with a two-color or 
multicolor bitmap image.
You can either choose the image from the gallery of predefined images or create your own fill images using the 
Clipboard. For two-color images, you can change the foreground and background color.
Tips

To apply the image fill to the selected object, click Apply or double-click the pattern.

You can leave the Fill dialog box open while you select or edit objects in your drawing.



Displays the image patterns available in Designer.



Adds an image pattern that you have created and copied to the Clipboard.



Removes a selected pattern from the Image Pattern gallery. You can only remove the image patterns that you 
create.



The default value for Image Scale % is 100%. Setting this value to 200% makes the image twice as large; setting
it to 50% makes the image half as large.



Fill-Object dialog box



Interior Fill - Object panel
This panel of the Fill dialog box lets you fill the interior of a selected object or group of objects with another 
object. You can fill with a single instance of the fill object or with repeating rows and columns of the fill object.
You can either choose the fill object from the gallery of predefined objects or create your own fill objects using 
the Clipboard. For two-color fill objects, you can change the foreground and background color.
Tips

To apply the object fill to the selected object, click Apply or double-click the fill object.

You can leave the Fill dialog box open while you select or edit objects in your drawing.



Line Fill - Object panel
This panel of the Fill dialog box lets you fill the line of a selected object or group of objects with another object. 
You can fill with a single instance of the fill object or with repeating rows and columns of the fill object.
You can either choose the fill object from the gallery of predefined objects or create your own fill objects using 
the Clipboard. For two-color fill objects, you can change the foreground and background color.
Tips

To apply the object fill to the selected object, click Apply or double-click the fill object.

You can leave the Fill dialog box open while you select or edit objects in your drawing.



Displays the image patterns available in Designer.



Opens the Edit Object Fill dialog box.



Adds an object pattern that you have created.



Remove a selected pattern from the Object Pattern gallery. You can only remove the image patterns that you 
create.



Copies the selected object to the Clipboard and automatically paste it into your document.



The background color is opaque by default (not selected). Select this option to make the background color 
transparent.



Lets you set the object pattern color (foreground color). Click the Foreground button, then click a color in the 
color palette.



Lets you set the color behind the object pattern. Click the Background button, then click a color in the color 
palette. The background color is transparent by default.



Edit Object Fill dialog box (Interior Fill)



Edit Object Fill dialog box
This dialog box lets you change the arrangement, flip characteristics, rotation, size, and spacing of an object fill. 
You can add a new object-fill pattern or replace a pattern you previously added with a new one. You can even use
multiple objects of different shapes.
Note

You cannot replace any of the original fill objects included with Designer.



Uses a single, centered copy of the fill object, rather than a pattern.



Forms the object pattern by repeating the fill object horizontally, as a series of rows.



Forms the object pattern by repeating the fill object vertically, as a series of columns.



To flip objects within an object fill pattern, you can choose from the following.
Flip Selection Effect
None No flip
All Flip all the objects in the fill
Every Other Flip every other object
Row or Column Flip every other row or column
To flip objects, you must select either About X (vertical) or About Y (horizontal). This specifies the coordinate axis
about which the objects are flipped.



The zoom factor is displayed above the preview window. A ratio of 1:1 is actual size (100%), a ratio of 2:1 is 
twice the actual size (200%), and so forth.



Click this button and then click the Preview button to zoom in on the object fill. Each click on the Zoom In button 
changes the view to the next higher 100% view (200%, 300%, and so forth).



Click this button and then click the Preview button to see more of the object fill. Above 100%, each click on the 
Zoom Out button changes the view to the next lower 100% view (300%, 200%, and so forth). Below 100%, each 
click on the Zoom Out button changes to the next fractional view (1/2, 1/3, 1/4, and so forth).



Lets you see the effects of your editing before you add the new object fill to the gallery.



Updates the Preview window.
The Preview window shows the effects of your editing.



Rotates the whole object-fill pattern.



Rotates each individual object in the object-fill..



Lets you set the angle of rotation. You can either enter a value directly in this box or drag the red dial.



Lets you set the angle of rotation. You can either enter a value directly in the Angle box or drag the red dial.



Lets you change the width of the object by a percentage of its original width.
The default value is 100%. Changing the value to 50% makes the object half the original width; changing the 
value to 200% makes the object twice the original width. To scale the object proportionally, change Width % and 
Height % the same amount.



Lets you change the height of the object by a percentage of its original height.
The default value is 100%. Changing the value to 50% makes the object half the original height; changing the 
value to 200% makes the object twice the original height. To scale the object proportionally, change Width % and
Height % the same amount.



Lets you adjust the horizontal spacing between tiled objects. Entering a negative value causes objects to 
overlap; entering a positive value creates space between objects. A value of zero makes the bounding boxes of 
the objects flush with one another.



Lets you adjust the vertical spacing between tiled objects. Entering a negative value causes objects to overlap; 
entering a positive value creates space between objects. A value of zero makes the bounding boxes of the 
objects flush with one another.



Shifts the entire object-fill pattern horizontally within the containing object. This lets you control how the fill 
pattern looks at the left and right edges of the containing object.
A positive value shifts the pattern to the right; a negative value shifts the pattern to the left.



Shifts the entire object-fill pattern vertically within the containing object. This lets you control how the fill pattern
looks at the top and bottom edges of the containing object.
A positive value shifts the pattern down; a negative value shifts the pattern up.



Lets you stagger the position of every other row or column. For example, to illustrate a brick wall, you could tile a
brick-shaped object by row and then set the Stagger to 50%.



Sets the interior color of the object to the current foreground color for object fills.
Note

If you want to retain all the original colors of an object you are adding to the gallery, deselect both Modify 
Fill Color and Modify Line Color.



Sets the line color of the object to the current line color for object fills.
Note

If you want to retain all the original colors of an object you are adding to the gallery, deselect both Modify 
Fill Color and Modify Line Color.



Palette Name dialog box



Palette Name dialog box
This dialog box lets you name a palette. Type a name for the palette you are adding, then click OK. The Color 
Picker dialog box opens.
The Color Picker dialog box opens if you chose the Add Color command in the Palette Options menu.



Color Picker dialog box



Color Picker dialog box
This dialog box lets you choose a color from the full range of possible colors and add it to the Color Palette.

Click the RGB button to select the RGB color model.

Click the CMYK button to select the CMYK color model.

Click the HLS button to select the HLS color model.

Click the Spot button to select another color model, such as PANTONE.
Numeric values for the current color appear along the right for each color model. The values for the RGB model 
are from 0 to 255. For example 255 Red, 128 Green, and 179 Blue create pink.
The values for the CMYK numbers show the percentage of color used to create the displayed color. The same 
pink can be created with 0% Cyan, 50% Magenta, 30% Yellow, and 0% Black.
The first value for the HLS model is a number from 0 to 360, based on the color wheel. The second two numbers 
show the percentage of color used to create the displayed color. The same pink can be created with 335 Hue, 
75% Lightness, and 100% Saturation.
You can use whichever color model you prefer for choosing colors.
Tip

If you are new to color models, start with the HLS model.
The values for the selected model appear in black. The values for the models not selected are gray. As you make 
changes to the values of the selected color model, all the values reflect corresponding changes.
The underlying model that represents the full range of colors is a three-dimensional cube. The color refiner box 
shows two of these dimensions, while the slider below the color refiner box shows the third dimension.
The list box lets you choose two of the components of the selected color model. These two components are 
illustrated as width and height in the color refiner box. The third component of the color model (depth in the 
cubical color model) is controlled by the horizontal slider.
For example, if you select the HLS color model and select Hue-Lightness in the list box, hue is width (left and 
right), lightness is height (up and down), and saturation is depth (the slider).
If you choose the CMYK model, an additional slider lets you choose the amount of black (K) to be included in the 
color if you choose manual black component.



Color Picker dialog box buttons



Displays controls that let you define a color in terms of its Hue, Lightness, and Saturation.



Displays controls that let you define a color in terms of its Red, Green, and Blue content.



Displays controls that let you define a color in terms of its Cyan, Magenta, Yellow, and Black content.



Displays controls that let you select a color by its Pantone spot-color name or process-color name. Color 
swatches are available that show the pantone colors exactly as they will print.



Color Picker dialog box numeric values



Shows the hue of the current color in a numeric range of 0 through 360. The value 0 is red, 120 is green, 240 is 
blue, and 360 cycles back to red.
This value is updated automatically when you change other values that affect it. However, you must select the 
HLS color model to edit the value directly.



Shows the amount of lightness of the current color. The range is 0 (black) through 100 (white).
This value is updated automatically when you change other values that affect it. However, you must select the 
HLS color model to edit the value directly.



Shows the amount of saturation of the current color. The range is 0 (no saturation) through 100 (maximum 
saturation).
This value is updated automatically when you change other values that affect it. However, you must select the 
HLS color model to edit the value directly.



Shows the amount of red in the current color. The range is 0 through 100.
This value is updated automatically when you change other values that affect it. However, you must select the 
RGB color model to edit the value directly.



Shows the amount of green in the current color. The range is 0 through 100.
This value is updated automatically when you change other values that affect it. However, you must select the 
RGB color model to edit the value directly.



Shows the amount of blue in the current color. The range is 0 through 100.
This value is updated automatically when you change other values that affect it. However, you must select the 
RGB color model to edit the value directly.



Shows the amount of cyan in the current color. The range is 0 through 100.
This value is updated automatically when you change other values that affect it. However, you must select the 
CMYK color model to edit the value directly.



Shows the amount of magenta in the current color. The range is 0 through 100.
This value is updated automatically when you change other values that affect it. However, you must select the 
CMYK color model to edit the value directly.



Shows the amount of yellow in the current color. The range is 0 through 100.
This value is updated automatically when you change other values that affect it. However, you must select the 
CMYK color model to edit the value directly.



Shows the amount of black in the current color. The range is 0 through 100.
This value is updated automatically when you change other values that affect it. However, you must select the 
CMYK color model to edit the value directly.



Additional Color Picker dialog box controls



Opens a menu containing commands that let you change the resolution of the dialog box display, change the 
color grid, and change the way CMYK colors are automatically "normalized" for undercolor removal. If Spot Color 
is selected, you can choose whether to show the color names.



Lets you change the resolution of the display in the Color Picker dialog box. The choices are Fine, Average, and 
Coarse. Coarse, which displays the fewest colors, is the fastest; Fine, which displays the most colors, is the 
slowest.



Displays colors in percentage increments; the choices are 1%, 2%, 4%, 5%, 8%, and 10%. Increasing the color 
grid setting forces the color model values to increase or decrease in larger increments.



This option is available only if the CMYK color model is selected.



Lets you show the names of the colors rather than color swatches. This command is only available if the Spot 
Color button is selected. 



Sets a percentage tint value, which is used to indicate a color to be screened as a halftone at color separation. 
The tint values range from 100% (solid color, no tint) to 0% (no color at all).
The Tint slider only displays in the dialog box if you choose the Spot Color button. 
To make fine adjustments with the Tint slider, click to the left or to the right of the slide or use the arrow keys. 
The Tint value decreases or increases by one percentage point.



Adds the new color to the current palette.



Palette Manager dialog box



Palette Manager dialog box
This dialog box helps you manage color palettes in many ways, including choosing a palette or set of palettes, 
creating a new palette, and deleting, renaming, recalling, and merging palettes.



List names of available palettes. To display a specific palette, click its name.



Opens the Palette Name dialog box and lets you create a new palette to store new colors.



Lets you rename a palette.



Deletes the selected palette.



Merges a selected palette with the current palette.



Lets you import palette files for use with Designer.



Lets you export Designer palette files to share with other Designer users or for use in Picture Publisher, 
PhotoMagic, or other Micrografx programs.



Lets you create a new color.
If the current palette is the Master Palette, choosing the New button opens the Palette Name dialog box.
If you have already created a new palette, choosing the New button opens the Color Picker dialog box.



Displays the sort menu to let you sort the colors in the palette.



Deletes the selected color.



Opens a menu that lets you change the color model in which the color is stored. You can choose RGB, CMYK, or 
HLS.



Lets you choose two colors or four colors and mix them together as a painter mixes paints. 



Import Palette dialog box



Import Palette dialog box

The Import Palette dialog box lets you import color-palette files for use with Designer.



Erases all of your current palettes and replace them with all the palettes in the imported file.



Export Palette dialog box



Export Palette dialog box

The Export Palette dialog box lets you export Designer color-palette files for use with other programs.



Coordinates dialog box



Coordinates dialog box
This dialog box gives you the effect of precise mouse movements using the current Designer action. For 
example, with the Rectangle tool selected you can use the coordinates dialog box to, in effect, click and drag 
precisely to draw a rectangle exactly the size you want.



Choose a method from this box for drawing, or specifying the movement of the mouse using the current tool. The
result of the method you choose depends on the current drawing tool.
Method Description
Width/Height Lets you simulate clicking a mouse at a specific point, dragging, and then releasing the 

mouse button at a specific distance (width and height) from the first point.
Length/Angle Lets you simulate clicking a mouse at a specific point, dragging, and then releasing the 

mouse button at a specific distance and angle from the first point.
Range Lets you simulate clicking a mouse at a specific point, dragging, and then releasing the 

mouse button at a second specific point.
Current Position Lets you specify a position for the mouse pointer.
Click Applies the equivalent of a mouse click at the current position of the mouse pointer.
Double click Applies the equivalent of a double mouse click at the current position of the mouse pointer.
Ruler Origin Lets you specify the exact point for the placement of the ruler origin relative to the current 

origin.
X Guide Lets you specify the position on the horizontal ruler (X-axis) to place a vertical guideline.
Y Guide Lets you specify the position on the vertical ruler (Y-axis) to place a horizontal guideline.



Opens a menu that lets you choose a coordinate system.
You can choose

Cartesian (rectangular) coordinates.

Polar coordinates with angles measured in radians.

Polar coordinates with angles measured in degrees.



Opens a menu to let you change the measuring increment. The menu displays the units available, including 
points, inches, centimeters, millimeters, picas, cicero, and didot, along with the More Units and Custom Units 
commands.



Type a measurement in one of these boxes, or use the up or down scroll arrows to change the measurement. The
boxes available depend on the selected Method.



Type a measurement in one of these boxes, or use the up or down scroll arrows to change the measurement. The
boxes available depend on the selected Method.



Type a measurement in one of these boxes, or use the up or down scroll arrows to change the measurement. The
boxes available depend on the selected Method.



Type a measurement in one of these boxes, or use the up or down scroll arrows to change the measurement. The
boxes available depend on the selected Method.



Available Units dialog box



Available Units dialog box
This dialog box Lets you choose units of measure.
The standard linear units are inches, centimeters, millimeters, points, picas and points, and ciceros. The 
standard radial units are degrees and radians. Standard units are used for the actual dimensions of objects on a 
page or the page size.



Opens the Custom Units dialog box to let you define your own units of measurement.



Custom Units dialog box



Custom Units dialog box
This dialog box lets you define a custom unit and set a scale for it. You also can define a secondary unit that is 
measured by your primary custom unit.



Sets the current unit as the new default unit for the drawing. Pressing this button saves the unit definition (if it 
hasn't already been saved) and applies the unit to the rulers.



Lists pre-defined units. You can create custom units and add them to this list. Pre-defined units include feet, feet 
and inches, kilometers, meters, miles, weeks and days, and yards and feet. You can set a different unit of 
measure for an individual dialog box, such as the Page Setup dialog box, Text Attributes dialog box, or the Line 
Weight dialog box. Changing this setting does not change other settings or affect the rulers or grid until you 
select the unit definition in that setting's Unit button.
Units preceded with a plus sign (+) are definitions saved to the PRO file for use in all drawings. All others will be 
saved with the current drawing.



Saves the changes made in the dialog box to the current drawing. For example, you can edit the name or label of
a defined unit by choosing it from the Defined Units list, making your changes, and then clicking this button. If 
this button is gray, then the definition has already been saved to the drawing.



Saves the changes made in the dialog box to the PRO file for use in all drawings. For example, you can edit the 
name or label of a defined unit by choosing it from the Defined Units list, making your changes, and clicking the 
Save to profile button. If this button is gray, then the definition has already been saved to the profile.



Remove the highlighted unit from the profile or drawing, consequently removing it from Defined Units list box.
Note

Deleting custom units only affects the current file. However, if you delete something with a + sign, then it 
affects all files because it deletes it from the profile.



Type a name for the custom unit in this text box. If you also are defining secondary units for this unit, type a 
comma and the name of the secondary units.



Type the label that you want Designer to display for dimension lines measured in your custom unit.



Select the actual unit by which your custom unit is to be measured, and enter values that define the ratio of the 
custom unit to the actual unit.
For example, suppose you are creating a timing diagram in which you want to define a custom unit 
"milliseconds," where every 2 inches of your diagram represents 50 milliseconds. You would enter:
Scale         50           per         2                     INCH.



Select the actual unit by which your custom unit is to be measured, and enter values that define the ratio of the 
custom unit to the actual unit.
For example, suppose you are creating a timing diagram in which you want to define a custom unit 
"milliseconds," where every 2 inches of your diagram represents 50 milliseconds. You would enter:
Scale         50           per         2                     INCH.



Select the actual unit by which your custom unit is to be measured, and enter values that define the ratio of the 
custom unit to the actual unit.
For example, suppose you are creating a timing diagram in which you want to define a custom unit 
"milliseconds," where every 2 inches of your diagram represents 50 milliseconds. You would enter:
Scale         50           per         2                     INCH.



Type the label that you want Designer to display for dimension lines measured in the secondary custom unit.



Type a value for the scale of the secondary custom unit, if any. The secondary unit is measured by the primary 
unit.
For example, suppose you are creating a timing diagram in which you want to define a custom unit 
"milliseconds" and the secondary unit "microseconds," where every 2 inches of your diagram represents 50 
milliseconds, and 1000 microseconds = 1 millisecond. You would enter:
Scale        50                     per      2                 INCH              for the 
primary unit, and
Scale        1000        per Primary Unit                    for the secondary
unit

Click the down arrow to the right of this box and choose the displayed precision for the custom unit you are 
defining.



Add xxx to List of Defined Units dialog box



Click the Yes button to add your custom unit to Designer's list of defined units. Click No or Cancel if you don't 
want to add the custom unit.



Save Changes to Custom Unit dialog box



You have changed a value that defines the named custom unit. To save the change, click Yes. To return to the 
Custom Units dialog box without saving, click Cancel. To return to the designer drawing without saving, click No.



Image Information dialog box



Image Information dialog box
The Image Information dialog box displays information about the open image. The information includes format 
(such as 24-bit True Color), cropped width and height, total width and height, and size.



Dimensions dialog box



Dimensions dialog box
This dialog box lets you set options and defaults for dimensions. Click the tab you want information about.
If a dimension line is selected when you click Apply, your changes are applied to that dimension line. If no 
dimension lines are selected, your choices become the defaults for new dimension lines you draw.

Displays options for setting a dimension line's general appearance.

Displays options for setting the orientation of the dimension units in relation to the dimension line.

Displays options for setting the position of the dimension units in relation to the dimension line.



Dimensions-General tab



Lets you set options affecting a dimension line's general appearance.



Lets you select the unit of measure used by a dimension line.
When you click this button, a submenu opens, displaying the units available, along with the More Units 
command.



Lets you enter text to appear before the units of a dimension line.



Lets you enter text to appear after the units of a dimension line.



Specifies the amount of space between an offset dimension line and the start of its extension lines.



Specifies how far extension lines protrude beyond a dimension line.



Controls whether extension lines are shown or hidden.



Controls whether dimension units are shown or hidden.



Determines whether dimension lines show arrows pointing inwards.



Specifies the length of outside arrows.



Sets the orientation of the dimension units in relation to the dimension line.



Forces the dimension text to be aligned with the dimension. However, the text is always rotated so that it faces 
up or to the right.



Forces dimension units to display so that the text is oriented along the dimension line. The text always faces the 
line being measured.



Forces the dimension units to display horizontally, even for vertical and aligned (diagonal) dimension lines.



Forces the dimension units to display horizontally for horizontal and aligned (diagonal) lines, and vertically for 
vertical lines.



Displays dimension units at a specific angle. To set the custom angle, you can either drag the red needle in the 
dial control or double click in the Angle text box and enter a specific value.



Displays dimension units at a specific angle. To set the custom angle, you can either drag the red needle in the 
dial control or double click in the Angle text box and enter a specific value.



Dimensions-Text Position tab



The Text Position tab of the Dimensions dialog box sets the position of the dimension units in relation to the 
dimension line.



The Horizontal Text Position options determine whether the units display on the text point of the dimension line 
or are aligned left, center, or right.



The Vert Text Position options determine whether the units display above, on, or below the dimension line.



Line Length Options dialog box



Line Length Options dialog box
This dialog box lets you specify options for dimension line-length text. You can specify a text prefix and suffix, as 
well as horizontal and vertical position for the text.



You can enter a prefix for the dimension line-length text in this box. For example, if you would like to display the 
date before the line length of a selected line, you can enter the date.



You can enter a suffix for the dimension line-length text in this box. For example, if you would like to display the 
date after the line length of a selected line, you can enter the date.



Lets you change the measuring increment used in dimension line-length text.
To change the units, click the Units button. A menu opens, displaying the units available, including inches, 
centimeters, millimeters, points, picas, and ciceros, along with the More Units and Custom Units commands.



Shows choices for the precision of the displayed line-length value. Click the precision you prefer.



Click a horizontal option and a vertical option to align the dimension line-length text in relation to the line.



Places the dimension line-length text even with the left edge of the line.



Places the dimension line-length text in the center of the line.



Places the dimension line-length text even with the right edge of the line.



Places the dimension line-length text above the line.



Places the dimension line-length text on the line.



Places the dimension line-length text below the line.



Unused controls



Open db Description

Lets you enter or edit a description of the file.
Note

The Open dialog box does not show a file preview for DRW files. When you open a DRW file, it is 
automatically converted to a DSF file, and the extension is changed to DSF.



Links db Links

Lists all the OLE objects in the current file. For each object, the list provides the object type, original file name, 
the type of link, and whether it is updated automatically or manually.



Links db Update options

Lets you choose to update the selected link either automatically each time you open the Designer file or 
manually when you open or save the Designer file.



Links db Update Now

Immediately updates the selected link.



Links db Cancel Link

Breaks the OLE link between an object and its original program (server).



Links db Change Link

Opens a dialog box that lets you select a new file path for the selected link. The new file can be identical to the 
old file, but can be in a different location or it may be a completely new file.



Links db Edit

Lets you edit the object selected in the Links list box. Designer launches the object's source application for you 
to edit the object.



Links db Activate

Plays the object (for example, sound).



Links db Done

Closes the dialog box.



Insert Object db Object Type list

Lists the types of OLE object you can insert. Designer uses the type you select to determine which application to 
launch.



Transform db Origin

Lets you place the line, or reflection axis, through any of the nine object origin points. For example, select the center origin to flip 
an object around a central axis, or select the right middle origin to reflect the object around its right side.



Horizontal Angle

Lets you change the angle that the object is skewed (you can also drag the red arrow).



Vertical Angle

Lets you change the angle that the object is skewed (you can also drag the red arrow).



Units

Lets you change the increment used to skew the object. The units default to degrees. You can change the units if you want to 
rotate the object in units other than degrees. For example, you can change the units to radians.



Units button

Lets you change the measuring increment for type. To change the units, click the Units button. A menu opens, 
displaying the units available, including points, inches, centimeters, millimeters, picas, picas and points, and 
ciceros. You also can select More Units.



CSH_MENU.DOC
This document contains the context-sensitive popup topics for all Designer 6.0 menu and submenu items.
For testing, make topic headings visible and red. For final release, use a macro to change red Heading 2 text to 
blue and hidden, and delete the paragraph mark that separates the heading from the text of the topic. Footnote 
markers must always be visible and black (the default for Heading 2 text).
When final, a topic should look like this:
# File mnu NewCreates a new, empty Designer document. The new document is untitled until you save it.



Palette menu (pops up from several places)



Lets you create your own color palettes.

If the current palette is the Master Palette, this command opens the Palette Name dialog box.

If you have already created a new palette, this command opens the Color Picker dialog box.



Opens a dialog box that lets you manage Designer's palettes in many ways, including choosing a palette or set 
of palettes, creating a new palette, and deleting, renaming, recalling, and merging palettes.



Coordinates menu (pops up from the coordinates button on the status bar)



Displays the value of the symbol's width and height. The values display in the status bar next to the Coordinates 
button.



Displays the value of the symbol's length and angle. The values display in the status bar next to the Coordinates 
button.



Displays the coordinates of two points of a selected symbol: the symbol origin, and the symbol end. The 
coordinates display in the status bar to the right of the Coordinates button.



Displays Cartesian coordinates in the status bar. Cartesian coordinates use the familiar vertical and horizontal 
axes. The vertical axis is called Y and the horizontal axis is called X.
You can quickly reset the ruler origin to its default position at the corner of the page by double-clicking the 
button at the intersection of the two rulers.



Displays polar coordinates in the status bar, with angles measured in radians. Polar coordinates measure the 
distance from the center, and the angle from the axis.



Displays polar coordinates in the status bar, with angles measured in degrees. Polar coordinates measure the 
distance from the center, and the angle from the axis.



Line Length menu (pulls down from a button on the Drawing ribbon)



Displays the length of the selected line, using current line-length viewing options. You can set these options by 
clicking the Line Length button  and then clicking Options.



Hides the length of the selected line.



Displays a dialog box that lets you specify how you want the line length of an object displayed.



File menu



Creates a new, empty Designer document. The new document is untitled until you save it.



Displays the File Open dialog box, which lets you open a previously saved Designer document. (Keyboard 
shortcut CTRL+O) The folder shown is the last folder in which a Designer document was opened.
Tip

On the dialog box, you can open more than one document as a time by holding down the CTRL key as you 
click each filename.



Closes the active Designer document. If you have made changes that you have not saved, Close prompts you to 
save the changes.



Closes all open Designer documents.



Saves the document on which you are working. If this is the first time you have saved the document, Save 
displays the Save As dialog box to let you give the document a file name.



Opens a dialog box that lets you assign a file name to the current document or make a copy of the document 
under another file name.
If the current document was opened from a file, the Save As dialog box opens to the document's directory. 
Otherwise, it opens to last directory in which you saved a file using Save As.



Restores the document to the most recently saved version, discarding all changes made since you last saved the
file.



Displays the Page Setup dialog box to let you set the size, margins, and orientation of the active window's on-
screen page. You can change page settings before, during, or after creating a drawing.
Note

If you change the page setup, and you plan to print your work, you should change the printer setup to 
match the page.



Lets you print the current page, selected objects, a specific area or view, the entire document, or multiple files, 
and lets you change the target printer.



Displays a dialog box to let you send the current Designer document as mail, using MS Mail.



Lists the four most recently used Designer documents so you can quickly open them without using the File Open 
dialog box.



Closes all open documents and then closes Designer.
If you have made changes to any documents, Designer prompts you to save the changes before the window 
closes.



File/Print submenus



Immediately prints the currently displayed page.



Lets you print an area that you define (by dragging a rectangle). If necesssary, Designer scales the area to fit the
printable area of the printer page.



Prints only the selected objects from the current page. Does not resize the objects.



Displays the Print dialog box to let you print the current document.



Lets you print multiple documents without opening each one. When you print multiple documents, Designer 
prints one copy of all pages in each selected document. 
Designer handles mixed page orientations (portrait and landscape) automatically.



Lets you select a target printer from a list of your installed printing devices. You also can change the printer’s 
properties as needed.
Properties vary from one printer to another, but common options include changing the orientation (portrait or 
landscape), paper size, and paper source.



 Edit menu



Reverses the last edit or change to an object.
To set the number of events that Designer remembers
1 On the Tools menu, click Options.
2 Enter the number of events in the Undo Event Limit box.



Lets you redo the last undo you made to an object.



Cuts the selected object(s) to the Clipboard.



Copies the selected object(s) to the Clipboard.



Pastes the selected object(s) from the Clipboard.



Lets you choose how you want to paste objects from the Clipboard.



Deletes the selected objects.



Selects all objects on the current layer of the current page. If Edit All Layers is selected in the Layers dialog box, 
Select All selects all objects on all layers of the current page. (Keyboard shortcut CTRL+A or F2)



Selects objects based on specific attributes and properties.



Opens the Insert Object dialog box, which lets you insert an OLE object into the current Designer document.
You can:

Create the OLE object from an existing file.

Open an OLE compatible program, create the object in the program, then close the program and 
automatically insert the object into Designer.

Note

If you want to insert an OLE object that you have copied to the Clipboard, use Paste Special from the Edit 
menu.



Opens a dialog box that lets you manage linked OLE objects contained in the current document.
You can

Manually update an object to reflect recent changes made to the its source file.

Set an object to update automatically when the object’s source file has changed.

Break the link between an object and its source file. The object remains in the Designer document, but can
no longer be updated.

Note

This item is dimmed if the current document does not contain any linked OLE objects.



Displays a submenu that lets you edit the currently selected OLE object, using its associated program. You also 
can convert some type of objects so that you can edit them using a program that you select.



View menu



Lets you show or hide various display workspace items such as guides, crosshairs, and rulers.



Displays options for viewing the status bar as a single line or two lines.



Displays the Task Manager dialog box, which lets you monitor and control Designer’s background tasks.



Lets you choose proof, draft, or wireframe viewing. The view does not affect how the document is printed.



Lets you choose how gradients are displayed.



Lets you show or hide bitmap images.



Lets you show or hide object fills.



Lets you show or hide hatch fills.



Lets you show or hide image fills.



Lets you select which toolbars are displayed, and lets you choose other toolbar-related options.



View/Workspace submenu



Turns the grid on and off. Use the grid as a guide for aligning symbols or measuring distances. The grid appears 
as a pattern of dots that correspond to divisions in your ruler settings.



Turns guides on and off. A guide is a horizontal or vertical line you can use for alignment or visual reference. 
Guides can help organize the layout of your drawing by guiding the placement of your symbols. You can use 
guides as visual cues for where to place symbols, or you can snap symbols to guides for more exact placement. 
Guides appear on screen but do not print.



Turns the crosshairs pointer on and off.



Displays non-printing guidelines that show the target printer's current page size and orientation.



Turns on the rulers. When the rulers are on, you can change the ruler origin by dragging from the ruler origin. 
The ruler origin is the point, on or off the page, where the two rulers intersect at zero. The default position for the
ruler origin is at the upper left corner of the page.



Turns the ruler position indicators on and off. The ruler position indicators are blue and yellow lines in the ruler. 
The blue lines show the position of your ruler. The yellow lines show the position of symbols as you drag them.



View/Status Bar submenu



Displays Designer’s status bar information in a single line. The single status bar shows less information than the 
double status bar, but it occupies less space.



Displays Designer’s status bar information in a double line. The double status bar occupies more space than the 
single status bar, but it shows more information.



View/Preview submenu



Shows all colors and fills.



Sets the following view settings for the current document.

Type of fill Shown as
Solid fills Normal
Gradient fills Coarse
Image fills draft
Symbol and hatch fills Not shown

No fills or line ends are displayed; all lines are displayed as hairlines.



View/Show Gradients submenu



Best gradient display, with all colors and smooth gradations from one color to the next.



All colors are shown, but gradations are not as smooth.



All colors are shown, but there are few gradations.



Fastest gradient display. Shows only the first color of the gradient.



Format menu



Displays options for setting the line fill of selected objects



Opens the Line dialog box with the Line - Style panel selected. You can use the panel to change the lines of 
selected objects to dashed, dotted, and other patterns.



Opens the Line dialog box with the Line - Weight panel selected. You can use the panel to change the thickness 
of lines of selected objects.



Opens the Line dialog box with the Line - Ends panel selected. You can use the panel to change the symbols 
attached to the ends of lines of open objects.



Displays options for setting the interior fill of selected objects



Opens the Text dialog box with the Text - Fonts panel selected. You can use the panel to change various 
attributes (such as point size, bold, italic, foreground and background color) of selected text.



Opens the Text dialog box with the Text - Margins panel selected. You can use the panel to change the indent, 
margins, horizontal alignment, and vertical alignment of selected text.



Opens the Text dialog box with the Text - Spacing panel selected. You can use the panel to change the word, 
character, line, and paragraph spacing of selected text. You also can set the first character in a paragraph as a 
drop cap (an enlarged letter that is top-aligned with the paragraph’s first line).



Opens the Text dialog box with the Text - Tab Stops panel selected. You can use the panel to set the positions of 
tab stops for the selected text. You also    can specify tab leaders.



Copies the style attributes of the selected object. You can then apply the style to other objects or set it as the default for all new 
objects.



Applies to selected objects the style attributes that you copied with Pick Up Object Style.



Sets the default styles to the attributes of the currently selected object. New objects you draw will use the new defaults.



Format/Line Fill submenu



Opens the Fill dialog box with the Line Fill - Solid panel selected. You can use options on the panel to set the color
of the line fill for the selected objects.



Opens the Fill dialog box with the Line Fill - Gradient panel selected. You can use options on the panel to fill the 
lines of selected objects with a color gradient.



Opens the Fill dialog box with the Line Fill - Hatch panel selected. You can use options on the panel to fill the lines
of selected objects with a hatch pattern.



Opens the Fill dialog box with the Line Fill - Image panel selected. You can use options on the panel to fill the 
lines of selected objects with a bitmap image.



Opens the Fill dialog box with the Line Fill - Object panel selected. You can use options on the panel to fill the 
lines of selected objects with a Designer object.



Format/Interior Fill submenu



Opens the Fill dialog box with the Interior Fill - Solid panel selected. You can use options on the panel to set the 
color of the interior fill for the selected objects.



Opens the Fill dialog box with the Interior Fill - Gradient panel selected. You can use options on the panel to fill 
the interior of selected objects with a color gradient.



Opens the Fill dialog box with the Interior Fill - Hatch panel selected. You can use options on the panel to fill the 
interiors of selected objects with a hatch pattern.



Opens the Fill dialog box with the Interior Fill - Image panel selected. You can use options on the panel to fill the 
interiors of selected objects with a bitmap image.



Opens the Fill dialog box with the Interior Fill - Object panel selected. You can use options on the panel to fill the 
interiors of selected objects with a Designer object.



Tools menu



Checks the spelling of selected text (or the entire document if no text is selected). Opens a dialog box if a 
misspelling is found.



Lets you create custom units for your rulers and measurements.



Starts ABC Media Manager, which lets you easily locate, access, and organize ClipArt items.



Lets you import files into Designer that were created by other programs.



Lets you export Designer files for use in other programs.



Displays the Customize dialog box to let you add and remove tools on Designer’s toolbars



Lets you customize your working environment. You can set options for many aspects of Designer, and you can 
set and save options in a profile file.



Lets you turn on and off the Snap to Guides and Snap to Rulers options.



Tools/Snap submenu



Causes the closest ruler mark to attract the cursor. Snapping is based on the ruler units: if you change the 
number of snaps per ruler unit, you also change the number of snap points and the appearance of the on-screen 
grid.



Makes a nearby guideline attract the mouse pointer. If you want guidelines to attract points on a symbol, you 
must select the Dragging Snap option on Rulers/Snap tab of the Options dialog box.



Change menu



Lets you align objects precisely within the bounding box of selected objects, to the rulers, to the page, or to a path. You also 
can align text to a path.



Lets you blend two objects together. Designer displays a different transformation at each step of the blend.



Lets you move, scale, reflect, rotate, and skew selected objects, and remove transformations.



Reverses all transformations you applied.



Lets you group and ungroup objects, and connect and disconnect objects.



Gives you options for arranging the stacking order of objects by moving them to the front or back, reversing their order, and 
stepping them forward or backward.



Lets you join and split text, flow text shapes, and make objects repel text objects.



Converts an object such as text, a rectangle, or an ellipse into a conventional object. This lets you edit the object
with reshape points.



Lets you smooth the shape of an object by eliminating some of its anchors.



Change/Align submenu



Opens the Align dialog box with the To Object panel selected. You can use the dialog box to align several 
selected objects to the left, right, top, bottom, or center of one of the objects.



Opens the Align dialog box with the To Page panel selected. You can use the dialog box to align several selected 
objects to the left margin, right margin, top margin, bottom margin, horizontal center, or vertical center of the 
page.



Opens the Align dialog box with the To Path panel selected. You can use the dialog box to align several selected 
objects to the path formed by one of the objects.



Displays the Choose Position ribbon. You use the ribbon to specify how you want to align text to an object's path if
the quick choice buttons do not provide the text alignment that you want.



Change/Transform submenu



Opens the Transform dialog box with the Move panel selected. You can use the dialog box to move selected 
objects with a high degree of precision. You can leave a specified number of evenly spaced copies as you move.



Opens the Transform dialog box with the Scale panel selected. You can use the dialog box to resize selected 
objects with a high degree of precision. You can leave a specified number of evenly spaced copies as you scale 
the objects.



Opens the Transform dialog box with the Flip panel selected. You can use the dialog box to flip selected objects 
horizontally, vertically, or at a specified angle.



Opens the Transform dialog box with the Rotate panel selected. You can use the dialog box to rotate selected 
objects with a high degree of precision. You can leave a specified number of evenly spaced copies as you rotate.



Opens the Transform dialog box with the Skew panel selected. You can use the dialog box to slant selected 
objects with a high degree of precision. You can leave a specified number of evenly spaced copies as you slant 
the objects.



Displays the Transform dialog box showing the transformation that you last applied, so you can apply it to the selected 
objects. You apply a transformation either by using the dialog box or by moving, rotating, or otherwise transforming an object.



Change/Combine submenu



Gathers separate objects together. Use the Group command when you want to create a collection of individual objects. Grouping
does not change an object's appearance.



Breaks objects apart from the group and returns them to their original, ungrouped state.



Closes completely open shapes or connects and fills already closed shapes.



Combines objects with open endpoints by drawing a line between open endpoints, leaving the last side open.



Returns an object to its original, disconnected state.



Change/Order submenu



Moves the currently selected object one level toward the front.



Moves the currently selected object one level toward the back.



Moves the currently selected object to the front of all objects on the layer.



Moves the currently selected object to the back of all objects on the layer.



Reverses the stacking order of the selected objects. For example, the order 1, 2, 3, 4 becomes 4, 3, 2, 1.



Change/Text submenu



Lets you join text blocks and freeform text into a single text object. When you join text blocks, all text conforms to the font and 
size of the first selected text block (or the first created text block, if they are selected at the same time).



Lets you enter several lines of text and position them later. For example, if your drawing has a dozen labels, it is easier to enter 
the labels as a single object, and then split it and move the labels individually.



Flows text between two text blocks or between a text block and a shape.



Forces text to automatically wrap around selected objects.



Object menu



Gives you choices for adding the current object’s color attributes to the color palette.



Lets you assign names, costs, and other properties to objects.



Displays a list of objects in your drawing. You can copy, print, or save a named parts list of all the pieces of your drawing, plus 
lists of other defined properties.



Controls how objects are replaced by those from the Clipboard.



Lets you mask an object or create blocks of text in unusual shapes.



Hides selected objects until you use Show All to show them.



Shows objects that you have hidden with the Hide command.



Locks selected objects until you use Unlock All. Lock objects that you want to avoid accidentally moving or resizing.



Unlocks all locked objects so you can move or edit them.



Opens the Coordinates dialog box, which gives you the effect of precise mouse movements using the current 
Designer action. For example, with the Rectangle tool selected you can use the coordinates dialog box to, in 
effect, click and drag precisely to draw a rectangle exactly the size you want.



Object/Add to Palette submenu



Adds the currently selected object's foreground color to the color palette.



Adds the currently selected object's background color to the color palette.



Adds the currently selected object's line color to the color palette.



Adds the currently selected object's foreground, background, and line colors to the color palette.



Window menu



Opens another window for the current document, so that you can have an additional view of the drawing. You 
can use the additional view to see two different zoom levels at once or to view two different pages at once.



Arranges all open windows so that the title bar of each document is visible.



Arranges all open windows so that a view of each document is visible.



Aligns all of the icons of minimized documents in the Designer window.



Lists all open Designer documents. When you have several documents open, this list gives you a quick way to 
select one.



Help menu



Displays a list of help topics for Designer 6.0.



Displays a help topic that describes Designer’s compatibility with the Microsoft Office standard.



Shows the version number, version date, and other information about your copy of Designer.



CSH_TOOL.DOC
This document contains the context-sensitive popup topics for all Designer 6.0 tools and buttons.



Permanent buttons



Opens the Page menu. Use this menu to add pages, update the master page, move to a different page, or open 
the Pages dialog box to name, add, and delete pages.



Opens the Layer menu. Use this menu to add layers, move to a different layer, or open the Layers dialog box to 
name, add, delete, rearrange, color, hide or unhide, and lock or unlock layers.



Miscellaneous buttons



For help, click this button and then click any tool, button, or menu item.



Displays a help topic that describes Designer’s compatibility with the Microsoft Office standard.



Lets you create custom units for your rulers and measurements.



Opens ABC FlowCharter.



Opens Picture Publisher.



Opens the Transform dialog box with the Move panel selected. You can use the dialog box to move selected 
objects with a high degree of precision. You can leave a specified number of evenly spaced copies as you move.



Opens the Transform dialog box with the Scale panel selected. You can use the dialog box to resize selected 
objects with a high degree of precision. You can leave a specified number of evenly spaced copies as you scale.



Opens the Transform dialog box with the Flip panel selected. You can use the dialog box to flip selected objects 
with a high degree of precision. You can leave a specified number of evenly spaced copies as you flip.



Opens the Transform dialog box with the Rotate panel selected. You can use the dialog box to rotate selected 
objects with a high degree of precision. You can leave a specified number of evenly spaced copies as you rotate.



Opens the Transform dialog box with the Skew panel selected. You can use the dialog box to skew selected 
objects with a high degree of precision. You can leave a specified number of evenly spaced copies as you skew.



Standard Toolbar buttons



Shows or hides the Drawing toolbar.



Shows or hides the Format toolbar.



Shows or hides the Color Palette toolbar.



Shows the current magnification as a percentage of actual size. You can enter a value in the range 1 through 
25400, or you can click the arrow next to the value and choose a zoom level from the menu.



Status Bar Help



The status bar shows current information about your drawing and gives you quick access to various commands 
such as line weight, object fill, and coordinates.
Choose Status Bar on the View menu and choose Single to display the single-line status bar. Choose Double from
the Status Bar submenu to display the double-line status bar.
Note

The Status Bar options on the View menu are available only when the Status toolbar is visible.



Status Bar buttons and indicators



Shows the line style and weight of the currently selected object. If no object is selected, the Line button shows 
the default line style and weight. This button shows only when the status bar is displayed.
Clicking the Line button opens the Line dialog box. The Line dialog box lets you set the attributes of lines, 
including the ends, style, and weight.



Shows the fill of the currently selected object. If no object is selected, the Fill button shows the default fill. This 
button shows only when the status bar is displayed.
Clicking the Fill button opens the Fill dialog box. The Fill dialog box lets you select line or interior colors and any 
type of fill for lines and interiors.



Adds or removes snap points for the selected object. This button is visible only when the status bar is displayed. 
The keyboard shortcut for adding snap points is CTRL+F7. The keyboard shortcut for removing snap points is 
CTRL+SHIFT+F7.
Note

Snap points are not attached to an object. That's why they don't move when you move or delete the 
object. Snap points do not print.



Turns snap-to-rulers/guides on and off. This button shows only when the status bar is displayed.



Opens a menu that lets you change the coordinate system. You can also open a dialog box that lets you use 
numeric coordinates to control editing and drawing actions that usually require the mouse. This button shows 
only when the status bar is displayed. (Keyboard shortcut CTRL+Q)



Designer displays this indicator while redrawing the screen.



Shows the current zoom level as a percent of actual size.



Fits the current page in the window. This button shows only when a double line status bar is displayed. (Keyboard
shortcut SHIFT+F6)



Magnifies the view by a factor of two. This button shows only when a double line status bar is displayed. 
(Keyboard shortcut F6)



Shrinks the view by a factor of two. This button shows only when a double line status bar is displayed. (Keyboard 
shortcut CTRL+SHIFT+F6)



This is both a status indicator and a command button.

As an indicator Displays as  when no background tasks are active. Displays as 

 when one or more task is active.
As a command button Click to display the Task Manager dialog box, which lets you monitor and control 
Designer’s background tasks.



Task Manager buttons



Aborts the selected task.



Pauses the selected task until you click the Resume button  or the Stop button 

.



Resumes a task that you have paused with the Pause button .



Edit tool



Lets you select, resize, rotate, skew, warp, and reshape objects in a document. When you click the Edit tool, the 
ribbon displays a set of buttons specific to this tool. (Keyboard shortcut CTRL+E)



Lets you select, resize, and move objects.



Lets you rotate and skew (slant) selected objects.



Lets you warp selected objects.



Displays buttons that let you choose the warp type (line, curve, or Bézier). This button changes to reflect the 
selected type.



Line Warp button

Lets you use straight edges to edit a warp envelope.



Curve Warp button

Lets you use curves to edit a warp envelope.



Bezier Warp button

Lets you use curves and control points to edit a warp envelope.



Replaces an edited warp envelope with a new one. The object shape does not change under the new envelope.



Removes the last warp envelope and replaces it with the previous one. The object shape changes to reflect the 
previous envelope.



Doubles the number of vertical lines in the warp envelope grid.



Doubles the number of horizontal lines in the warp envelope grid.



Unlocks the control points of a warp envelope so you can move the points independently. (Keyboard shortcut 
CTRL+6)



Locks the angular relationship between opposing control points of a warp envelope so that when you drag one of
the points, the opposite moves as required to keep the angle between the two points the same. (Keyboard 
shortcut Ctrl+4)



Displays an object’s anchors and puts the object in Point Reshape mode. In point reshape mode, you can reshape
the object by dragging its anchors.



Converts an object such as text, a rectangle, or an ellipse into a conventional object. This lets you reshape the 
object by dragging its anchors. It also converts dimension lines to groups, converts Windows metafile to 
Designer objects, and converts other shapes to path objects and changes them so that Designer does not 
remember any previous transformations done to them. (Keyboard shortcut CTRL+R)



Toggles between editing the object with and without fills. Editing with a fill shows the exact results, but editing 
without a fill is faster.



Places an anchor where you click on an object.



Removes highlighted anchors.



Connects two highlighted anchors with a straight line.



Cuts through a line creating two separate anchors with a small empty space between them.



Converts the lines connected to a selected anchor into straight lines. If applied to two selected anchors that are 
adjacent, the Corner button converts    the line between the two points into a straight line. (Keyboard shortcut 
CTRL+5)



Converts lines connected to selected anchors into symmetrically curved lines. (Keyboard shortcut Ctrl+7)



Displays an object’s anchors and puts the object in Curve Reshape mode. In Curve Reshape mode, you can click 
an anchor to display its control points. To reshape the object, drag the control points.



Places Designer in “duplicate” mode so that every object you move or resize creates a duplicate. This button 
remains on until you turn it off.



Lets you name objects and open the Properties dialog box (keyboard shortcut F12). It also lets you choose a 
different property (category) for which to display object values.



Shows the property, such as a name, assigned to selected objects and lets you enter other properties to be 
assigned to the objects.



Selects all objects on the current layer of the current page. If Edit All Layers is selected in the Layers dialog box, 
Select All selects all objects on all layers of the current page. (Keyboard shortcut CTRL+A or F2)



Adds snap points to selected objects. (Keyboard shortcut CTRL+F7)



Removes all snap points from the drawing area. (Keyboard shortcut CTRL+SHIFT+F7)



Draw tool



Lets you draw lines, curves, rectangles, polygons, and ellipses using a variety of methods. When you click the 
Draw tool, the left portion of the ribbon displays five basic shape buttons. When you click a shape button, 
method buttons appear in the ribbon that let you modify how you draw the shape. (Keyboard shortcut CTRL+D)



Lets you draw basic linear and curving shapes.



Lets you draw straight line segments.



Lets you draw lines that are parallel to line segments, or tangent to arcs and ellipses.



Lets you draw lines that are at right angles to line segments, arcs, and ellipses.



Lets you draw an arc that is one quarter of an ellipse.



Lets you draw parabolic shapes.



Opens a menu that lets you show the length of line segments. Click Options in this menu to open a dialog box 
that lets you change the placement, format, and units of the line lengths.



Lets you draw linear and curving shapes that contain multiple points.



Lets you draw shapes that are a "chain" of connected straight lines.



Lets you draw objects that are a "chain" of connected, curved lines.



Lets you draw Bézier spline curves. A B-Spline is a curve drawn inside a wedge created by two construction lines.
For example, "V" shaped construction lines would create a "U" shaped object.



Lets you draw and edit Bézier curves at the same time.



Lets you draw freeform objects.



Lets you draw closed objects with multiple sides.



Lets you draw rectangles, squares, and rounded rectangles.



Lets you draw rectangles by dragging from one corner to its opposite.



Lets you draw squares by dragging only one side.



Lets you draw rectangles by drawing the height and then the width.



Lets you draw rectangles with rounded corners. The rounding radius is determined by the setting in the Rounding
box.



Shows the current curvature radius. You can click the box and type a value, or use the arrows next to the box to 
select a value. A larger radius increases the curvature, a smaller radius decreases it.



Lets you draw polygon and star shapes.



Lets you draw a polygon from the center to a corner.



Lets you draw a polygon from the center of the polygon to the middle of a side.



Lets you draw a polygon by drawing just one side.



Lets you draw a polygon and convert it to a star.



Shows the number of sides on the next polygon that you draw. You can click the box and type a value, or use the 
arrows next to the box to select a value.



Lets you draw ellipses, circles, arcs, and pies.



Lets you draw ellipses by dragging from one corner of the bounding box to its opposite.



Lets you draw ellipses by dragging the height and then the width of the bounding box.



Lets you draw a circle by dragging its diameter.



Lets you draw a circle by specifying three points of its edge.



Lets you draw an arc by specifying two end points and an arching point.



Lets you draw pies by modifying an existing ellipse.



Forces objects and dimension lines to draw only in 15-degree increments.
This button remains on until you click it again to turn it off. You cannot use angle constraint for rotating and 
skewing.



Forces rectangles to draw as squares and ellipses to draw as circles.
This button remains on until you click it again to turn it off.



Reverses the direction that Designer normally draws those objects that are drawn from a single side.



Forces an object to draw from the center outward.



Dimension tool



Lets you draw dimension lines and set dimension options. (Keyboard shortcut CTRL+0 [zero] )



Lets you draw dimension lines to show the diagonal distance between two points.



Lets you draw dimension lines to show the horizontal distance between two points.



Lets you draw dimension lines to show the vertical distance between two points.



Displays a dimension line’s endpoints and units handles. You can reshape the line by dragging its handles.



Lets you set dimension options, including whether units of measurement and extension lines are shown.



Displays options for the type and placement of line ends. You can choose from a variety of arrows, triangles, and 
other line-end symbols.



Shows the current decimal precision of the dimension units of measure. You can use the down arrow next to the 
list box to select a new precision level.



Forces dimension units of measure to center align between dimension line endpoints.



Dimension tool



Lets you enter and edit text. When the Text tool is selected, the ribbon displays a set of buttons specific to this 
tool. (Keyboard shortcut CTRL+T)



Lets you enter and edit text. You can click in the drawing area and enter freeform text, or you can drag a 
container and enter block text.



Lets you enter text along the edge of a selected object.



Lets you fit freeform text to a path or edit the arrangement of text already fit to a path. The Path Fit button 
displays a palette of "quick choice" text alignment buttons, and the Choose Position and Remove Curve buttons.



Quick Choice buttons

Show a sample path and an arrow to indicate the text arrangement. The location of the arrow in relation to the 
sample path indicates the text alignment and position. The direction of the arrow indicates the text orientation 
(which side is up).



Displays the Choose Position ribbon, which lets you separately set the alignment, position, offset, direction, and 
pitch of the text.



Positions text so the left edge of the text aligns to the alignment point.



Centers text around the alignment point.



Positions text so the right edge of the text aligns to the alignment point.



Positions the text above an open path object or outside of a closed path object.



Positions the text below an open path object or inside of a closed path object.



Controls the distance between the text and the path.



Aligns text in a counter clockwise direction. This generally displays the text upside down in relation to the top of 
the path.



Aligns text in a clockwise direction. This generally displays the text rightside up in relation to the top of the path.



Aligns the text by rotating the characters along the path.



Aligns the text by skewing the text characters vertically.



Aligns the text by skewing the text characters horizontally.



Aligns the text without skewing or rotating the text characters.



Removes text from a path. 



Lets you enter text inside of a selected (closed) object.



Lets you select from the last ten fonts used.



Displays the name of the current font or the font of the text that contains the text cursor. Use the down arrow 
next to the Font list box to display a list of available fonts and to choose a font.



Shows the current point size or the point size of the text that contains the text cursor.
To change the font size, you can either use the arrows next to the Font Size box or you can enter a size in the 
range of 2 to 3000 points (10.5, for example).



Increases the size of selected text by two point sizes.



Reduces the size of selected text by two point sizes.



Superscripts the selected text.



Subscripts the selected text.



Converts selected text to bold. (keyboard shortcut CTRL+B)



Converts selected text to bold. (keyboard shortcut CTRL+I)
Note

Text underlines may disappear if you apply italic.



Converts selected text to underlined. (keyboard shortcut CTRL+U)
Note

Text underlines may disappear if you apply some attributes, such as italic, or convert the text to curves, 
rotate it, or change the color of an edge.



Converts selected text to small capital letters. (keyboard shortcut CTRL+M)



Displays buttons that let you change the horizontal alignment of selected text. When you align freeform text, the
text is aligned based on the point where you originally placed the text. For example, if you are aligning to the 
right and click to enter freeform text, the text extends to the left as you type.



Aligns text to the left text margin. This is the default setting. (Keyboard shortcut CTRL+SHIFT+L)



Centers text between the left and right text margins. (Keyboard shortcut CTRL+SHIFT+C)



Aligns text to the right text margin. (Keyboard shortcut CTRL+SHIFT+R)



Aligns text to the left and right margins. The last line in a paragraph aligns to the left margin. (Keyboard shortcut
CTRL+SHIFT+J)



Aligns text, including the last line in a paragraph, to the left and right margins. (Keyboard shortcut 
CTRL+SHIFT+F)



Displays buttons that let you change the vertical alignment of selected text except in text that is not in a 
rectangular container.



Aligns text to the top margin. This is the default setting. (Keyboard shortcut CTRL+SHIFT+O)



Aligns text between the top and bottom margins. (Keyboard shortcut CTRL+SHIFT+M)



Aligns text to the bottom margin. (Keyboard shortcut CTRL+SHIFT+B)



Equally spaces lines of text between the top and bottom margins.



Opens the Text Attributes dialog box. This dialog box lets you change fonts, margins, spacing, and tab settings. 
(Keyboard shortcut CTRL+SHIFT+T)



Checks the spelling of selected text (or the entire document if no text is selected). Opens a dialog box if a 
misspelling is found.



Bitmap tool



Lets you trace and crop bitmap images. You can also open your selected bitmap editor in the Bitmap ribbon. 
(Keyboard shortcut CTRL+W)



Opens your selected bitmap editor, such as Picture Publisher.



Lets you specify a rectangular area of a selected image to show. The rest of the image is hidden.



Lets you create a vector "tracing" of the bitmap image that is placed in front of the image.



Lets you hide the bitmap image after it is traced so that only the traced objects appear.



Opens a menu that lets you adjust how accurately and smoothly Designer traces a bitmap image.



Opens a menu that lets you choose whether Designer uses lines or curves to create the tracing.



Lets you restrict the number of colors in the result of a trace. Click the maximum number of colors that you want
the trace to have.



Helps eliminate stray pixels introduced by a poor-quality image. You can enter a value ranging from 1 through 
100. Larger numbers exclude larger groups of stray pixels.



Opens a palette from which you can choose the foreground color for a monochrome bitmap image. The 
appearance of this button changes to reflect the current selection.



Opens a palette from which you can choose the background color for a monochrome bitmap image. The 
appearance of this button changes to reflect the current selection.



Lets you make the white areas of a monochrome    image transparent.



Shows file and display size information about a selected bitmap image.



Style tool



Lets you select colors, line widths, gradient types, and other styles for objects. (Keyboard shortcut CTRL+L)



Displays options for setting the style of lines (for example, dashed or invisible).



Displays options for setting the thickness of lines.



Lets you choose a line fill. You can fill a line with a solid color, gradient, hatch, image, or object. The appearance 
of this button changes to reflect the current line fill, weight, and style.



Lets you choose how to fill an object that has been folded onto itself. The Fill Options button also lets you choose 
whether to display an object’s lines in front of, or behind the interior fill.



Lets you choose an interior fill. You can fill an object with a solid color, gradient, hatch, image, or object. The 
appearance of this button changes to reflect the current interior fill.



Opens a menu that lets you manage Designer’s colors and palettes.



Page Manager tool



Lets you view, move, and print pages in Designer. It also lets you create slideshows using each page as a slide. 
(Keyboard shortcut CTRL+G)



Lets you save the presentation as an executable program (EXE) that runs when you double click it in File 
Manager.



Lets you copy a standalone slideshow to one or more diskettes.



Lets you set a pointer style and transition preferences.



Runs the slideshow, consisting of all slides in the document or only a selected range of slides.



Opens a dialog box that lets you select the number of colors and screen size to be used for your slideshow.



Opens a dialog box that lets you select the pages to print along with other printing options.



Displays the Page Setup dialog box to let you set the size, margins, and orientation of the active window's on-
screen page. You can change page settings before, during, or after creating a drawing.
Note

If you change the page setup, and you plan to print your work, you should change the printer setup to 
match the page.



Selects all pages in the document.



Deselects all selected pages in the document.



Opens a dialog box that lets you choose transition effects and advancement for slides.



Lets you choose a transition for selected slides.



Lets you change the direction of the selected transition (available when the transition direction can be changed).
The appearance of this button changes to reflect the selected direction.



Lets you change the transition speed for the selected slide.



Lets you choose to advance to the next slide with the mouse or keyboard.



Lets you choose to advance automatically to the next slide at a timed interval.



Lets you enter a duration in seconds for selected slides. The Duration box is available when the Timed button is 
selected.



View toolset



Lets you change your view of a drawing. The View tool set opens when you click the View tool.



Lets you see and edit objects in fine detail. Drag a rectangle to define the area you want to magnify or click the 
left mouse button to magnify the view by two times. (Keyboard shortcut F6)
Note

After selecting Zoom In, you can switch the tool to Zoom Out by holding down the SHIFT key. Releasing the
SHIFT key switches the tool back to Zoom In.



Returns to the view used just prior to the current view. (Keyboard shortcut SHIFT+F3)



Zooms in on the portion of the current page that contains objects. (keyboard shortcut CTRL+SHIFT+F3)



Lets you view just your work, without menus, title bar, or any other part of the Designer window. Press ESC or 
click the mouse button to return to the previous view. (Keyboard shortcut F4)



Enlarges the viewing area by a factor of two. (Keyboard shortcut CTRL+SHIFT+F6)



Displays objects at the same size they print. (Keyboard shortcut CTRL+F8)



Fits the current page in the window. This is the default view. (Keyboard shortcut SHIFT+F6)



Redraws the drawing. This lets you clear the screen of unwanted fragments that sometimes result from 
manipulating objects. If you have used the View menu to display a double-line Status Bar, an indicator ( ) is 
displayed in the Status Bar to show that redrawing is in progress. (Keyboard shortcut F3)



Using Dimensions
Dimension lines show the size, length, distance, or other measurements related to objects in a drawing.
The Designer dimension features are powerful and easy-to-use. The dimension capabilities of Designer include:

Dimension lines can measure the aligned (diagonal), horizontal, or vertical distances between points.

Dimension lines are dynamic objects that automatically recalculate their measurements when scaled, 
moved, rotated, or skewed.

Dimension lines can be offset from their measured points to improve appearance and to aid clarity.

Dimension lines can have a variety of line ends, including arrowheads, bars, and boxes.

Dimension lines can indicate distance with inside or outside arrows.

You can position the dimension units above, on, or below a dimension line, and adjust their orientation.

You can position the dimension units anywhere along a dimension line, or extend the units beyond either 
end of the line.

You can set the degree of precision, font, and font size individually for each dimension line.

You can specify the units of measure, including custom units, for each dimension line. You can also set a 
scale to relate one unit of measure to another.

You can add text before and after the dimension value for a dimension line.

The dimension units that you use with a drawing are saved with the drawing so that you do not have to 
reset them each time you open the file.

{button Related Topics,PI(`',`RT_Using_Dimensions')}



Drawing Dimension Lines
Drawing Dimension Lines
Using Constraint Buttons
Setting Displayed Precision
Reshaping Dimension Lines
Setting Line Ends
Setting Text Attributes
Transforming Dimension Lines
General Options
Text Orientation Options
Text Position Options



Drawing Dimension Lines
{button Steps...,PI(`',`HT_Drawing_Dimension_Lines')}

The Dimension tool  (keyboard shortcut CTRL+0) is used to draw dimension lines. To draw a dimension line, 
you click the Aligned, Horizontal, or Vertical button in the ribbon and then drag the line from one point to another
to measure the distance. To offset the dimension line from the points measured, you drag the pointer away from 
the dimension line. Based upon whether you have selected an aligned, a horizontal, or a vertical measure, 
Designer calculates the distance between the points and displays it in the units you specify.
After drawing a dimension line, you can easily reshape it and edit its other attributes, including text alignment, 
line weight, and line ends.
Tip

Dimension lines are generally added to a drawing after the drawing is created. To make it easy to align 
dimension lines to the endpoints of shapes, select the End Points option in the Rulers/Snap panel of the Options 
dialog box. Then use snap points to force the mouse pointer to move precisely to an endpoint.

The Aligned button  lets you draw dimension lines that measure the diagonal distance between two points.

The Horizontal button  lets you draw dimension lines that measure the horizontal distance between two points. If
two points are diagonal to each other, a horizontal dimension line still measures the horizontal distance between 
the points.
The Vertical button  lets you draw dimension lines that measure the vertical distance between two points. If two 
points are diagonal to each other, a vertical dimension line still measures the vertical distance between the points.

{button Related Topics,PI(`',`RT_Drawing_Dimension_Lines')}



To draw a dimension line



Using Dimensions
Using Constraint Buttons
Setting Displayed Precision



To draw a dimension line

1 Click the Dimension tool     in the toolbox or CTRL+0 (zero).
2 Click the Aligned, Horizontal, or Vertical button in the ribbon.
3 Move the pointer to the starting point of the line you want to measure, and press and hold the left mouse 
button.
4 Drag the pointer to the endpoint of the line you want to measure and release the mouse button. You can 
use CTRL to constrain the angle to increments of 15 degrees. A dimension line appears between the two points. The
blue handle at the cursor location indicates the position of the dimension text.

5 Move the mouse in the appropriate direction to offset the dimension line and to adjust the location of the 
dimension units. You can use SHIFT to force the alignment point to the center.

6 After positioning the dimension line and text, click the left mouse button to finish drawing the dimension line.
Tip

If you make a mistake while drawing a dimension line, you can press ESC to start over.

{button Related Topics,PI(`',`RT_To_draw_a_dimension_line')}



Using Dimensions
Drawing Dimension Lines
Using Constraint Buttons
Setting Displayed Precision



Using Constraint Buttons
{button Steps...,PI(`',`HT_Drawing_Dimension_Lines')}

The Center Text button  forces the dimension units to be centered between the dimension endpoints. 
Deselect the Center Text button to position the dimension units manually.

Note: Press SHIFT while drawing a dimension line to force the opposite state of the Center Text button. For 
example, pressing SHIFT when the Center Text button is deselected turns on the text centering constraint (while 
SHIFT is pressed).
The Angle Constraint button  forces dimension lines to draw only in 15-degree increments.

Note

Press CTRL while drawing a dimension line to force the opposite state of the Angle Constraint button. For 
example, pressing CTRL while the Angle Constraint button is selected turns off the constraint (while CTRL is 
pressed).

{button Related Topics,PI(`',`RT_Using_Constraint_Buttons')}



Using Dimensions
Drawing Dimension Lines
Setting Displayed Precision



Setting Displayed Precision
{button Steps...,PI(`',`HT_Drawing_Dimension_Lines')}

The Displayed Precision list box shows the current decimal precision of the dimension units. You can change the 
number of decimal places shown by clicking the down arrow next to the box and choosing another setting.

{button Related Topics,PI(`',`RT_Setting_Displayed_Precision')}



Using Dimensions
Drawing Dimension Lines
Using Constraint Buttons



Reshaping Dimension Lines
{button Steps...,PI(`',`HT_Reshaping_Dimension_Lines')}

After drawing a dimension line, you can adjust the position of its endpoints and dimension units with the 
Reshape button .

{button Related Topics,PI(`',`RT_Reshaping_Dimension_Lines')}



To reshape a dimension line
To choose a line end



Using Dimensions
Setting Line Ends
Setting Text Attributes



To reshape a dimension line

1 Click the Dimension tool  in the toolbox.
2 Select the dimension line you want to reshape by pointing and clicking the left mouse button.
3 Click the Reshape button  in the ribbon. Solid blue handles appear at the line's endpoints and units 
location.
4 Drag the handles that you want to change to their new positions. You can use SHIFT to force the alignment 
point to the center.
5 Press ESC or double click the mouse button when you finish.

Tip

To enter the dimension reshape mode quickly, double click a dimension line with the select pointer.

{button Related Topics,PI(`',`RT_To_reshape_a_dimension_line')}
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Setting Line Ends
{button Steps...,PI(`',`HT_Reshaping_Dimension_Lines')}

The Line Ends button  lets you control the appearance of the dimension line. The options available include the
following.

The type of line end marker. The predefined types include arrowheads, bars, squares, circles, and triangles.
You can also define custom line ends.

Whether the same or different markers are used at each end of the line.

The size, placement, and angle of the line end markers.

The weight (thickness) of the line.

The style of the line (solid, dotted, or dashed).

{button Related Topics,PI(`',`RT_Setting_Line_Ends_2')}
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To choose a line end

1 Click the Dimension tool  in the toolbox.
2 Select the dimension line you want to modify.
3 Click the Line Ends button  in the ribbon. The Line Ends menu opens.
4 Click the desired line end in the menu. To choose other line ends and other line options, click Ends to open 
the Line Ends dialog box.

Tips

The Line Ends menu displays the most recently selected line ends.

For details on setting the line style and weight, see Setting Line Styles and Using Weighted Lines.

{button Related Topics,PI(`',`RT_To_choose_a_line_end')}



Using Dimensions
Reshaping Dimension Lines
Setting Line Ends
Setting Text Attributes



Setting Text Attributes
{button Steps...,PI(`',`HT_Reshaping_Dimension_Lines')}

To set the text attributes of a dimension line, select the dimension units and then click the Text tool. You can now
set the text attributes just as you would for any other object in your drawings.
For details on setting text attributes, see Using Text.
Tip

To edit dimension line text attributes such as font and font size, select the line and press CTRL+SHIFT+T.

{button Related Topics,PI(`',`RT_Setting_Text_Attributes')}
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Transforming Dimension Lines
{button Steps...,PI(`',`HT_Transforming_Dimension_Lines')}

Dimension lines are dynamic objects. This powerful feature means that no matter how you transform (move, 
rotate, skew, or scale) a dimension line, Designer will accurately calculate its length.
Transforming a dimension line does not change the line's aligned, horizontal, or vertical definition. For example, 
a horizontal dimension line continues to measure the horizontal distance between its endpoints, even when 
rotated into a vertical position (of course, the horizontal distance between two vertically aligned points is zero).

{button Related Topics,PI(`',`RT_Transforming_Dimension_Lines')}
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To rotate a drawing with dimension lines

1 Select the objects that you want to rotate, including the dimension lines.
2 Click the grouped objects a second time to display the rotation handles.
3 Drag the pivot point to a new location, if you want.
4 Drag the handles to rotate the drawing. To preview the current location of the rotated drawing, pause briefly 

while still holding down the left mouse button.
Tip

For details on rotating and skewing objects, see Rotating Manually, Rotating Numerically, Skewing 
Manually, and Skewing Numerically.

{button Related Topics,PI(`',`RT_To_rotate_a_drawing_with_dimension_lines')}
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General Options
{button Steps...,PI(`',`HT_General_Options')}

The General panel of the Dimensions dialog box lets you set options affecting a dimension line's appearance.
The Show Dimension Text option determines whether dimension units are shown or hidden. Select this option to 
show the units. Deselect this option to hide the units.
The currently selected units setting appears in the Units button. Click this button to change this setting.
The Precision list box shows the current decimal precision of the dimension units. To change this setting, click the
down arrow next to the box.
The Prefix and Suffix text boxes let you enter text to appear before and after the units of a dimension line.
The Show Extension Lines option determines whether extension lines are shown or hidden. Select this option to 
show extension lines. Deselect this option to hide extension lines.
The Gap box specifies the amount of space between the points measured by a dimension line and the start of its 
extension lines.
The Extension box specifies how far extension lines protrude beyond a dimension line.
The Use Outside Arrows option determines whether dimension lines show arrows pointing outwards or inwards.
The Outside Arrow Length box specifies the length of outside arrows.

{button Related Topics,PI(`',`RT_General_Options')}
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To add Prefix and Suffix text to a dimension line

1 Click the Dimension tool  in the toolbox.
2 Select the dimension line you want to modify.
3 Click the Dimension Options button  in the ribbon. The Dimensions dialog box opens.
4 Click the General button to display the General panel, if necessary.
5 Click the Prefix text box and enter the text you want to appear before the dimension units.

or
Click the Suffix text box and enter the text you want to appear after the dimension units.

6 Click Apply to add the text to the dimension units.
Tip

To set option defaults so that they apply to all subsequent dimension lines that you draw, deselect all 
dimension lines, click the Dimension Options button, and then select the dimension options that you want.

{button Related Topics,PI(`',`RT_To_add_Prefix_and_Suffix_text_to_a_dimension_line')}



Using Dimensions
General Options
Text Orientation Options
Text Position Options



Text Orientation Options
{button Steps...,PI(`',`HT_General_Options')}

The Text Orientation panel of the Dimensions dialog box sets the orientation of the dimension units in relation to 
the dimension line.
Select Aligned Face Up to force dimension units to display so that the base of the text is oriented along the 
dimension line, but the text is always upright in relation to the line.
Select Towards Object to force dimension units to display so that the base of the text is oriented along the 
dimension line. For a horizontal dimension line in which the extensions are below the line, the dimension units 
are displayed upside down.
Select Horizontal to force the dimension units to display horizontally, even for vertical and aligned dimension 
lines.
Select Horz./Vert. to force the dimension units to display horizontally for horizontal and aligned lines, and 
vertically for vertical lines.
Select Custom Angle to display dimension units at a specific angle. To set the custom angle, you can either drag 
the red needle in the dial control or click in the Angle text box and enter a specific value.

{button Related Topics,PI(`',`RT_Text_Orientation_Options')}
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To set a custom angle

1 Click the Dimension tool  in the toolbox.
2 Select the dimension line you want to modify.
3 Click the Dimension Options button  in the ribbon. The Dimensions dialog box opens.
4 Click the Text Orientation button to display the Text Orientation panel, if necessary.
5 Type a number in the Angle text box or drag the red needle in the dial control to specify a custom angle.
6 Click the Custom Angle option to select it.
7 Click Apply to display the dimension at the custom angle.

Tip

To set option defaults so that they apply to all subsequent dimension lines that you draw, deselect all 
dimension lines, click the Dimension Options button, and then select the dimension options that you want.

{button Related Topics,PI(`',`RT_To_set_a_custom_angle')}
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Text Position Options
{button Steps...,PI(`',`HT_General_Options')}

The Text Position panel of the Dimensions dialog box sets the position of the dimension units in relation to the 
dimension line.
The Horizontal Text Position options determine whether the units display on the text point of the dimension line 
or are aligned left, center, or right.
The Vertical Text Position options determine whether the units display above, on, or below the dimension line.

{button Related Topics,PI(`',`RT_Text_Position_Options')}



Using Dimensions
General Options
Text Position Options



To display units above a dimension line

1 Click the Dimension tool  in the toolbox.
2 Select the dimension line you want to modify.
3 Click the Dimension Options button  in the ribbon. The Dimensions dialog box opens.
4 Click the Text Position button to display the Text Position panel, if necessary.
5 Click Above Line (under Vert Text Position) to select this option.
6 Click Apply to reposition the dimension units.

Tip

To set option defaults so that they apply to all subsequent dimension lines that you draw, deselect all 
dimension lines, click the Dimension Options button, and then select the dimension options that you want.

{button Related Topics,PI(`',`RT_To_display_units_above_a_dimension_line')}
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What is an Object?
An object is the basic element of a Designer drawing. Designer objects are vector-based; their shapes and 
positions are defined geometrically. Unlike bitmapped objects, vector-based objects can be resized with no loss 
of image quality. They print at the resolution of the printer, and they are displayed at the resolution of the 
display device.
You create Designer drawings by creating, arranging, and editing objects.
You can manipulate Designer objects in a variety of ways to enhance and help organize your drawing. For 
example, objects can be colored, combined with other objects, duplicated, and resized.

{button Related Topics,PI(`',`RT_What_is_an_Object')}
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Basics of Drawing
{button Steps...,PI(`',`HT_Drawing_Basics')}

Drawing with Designer is easy. You select the shape you want to draw, and then drag the mouse to draw the 
object. Designer gives you the precision and flexibility you need to draw almost any shape imaginable.
Designer gives you three different methods for choosing the shape you want to draw.
Drawing Using Buttons on the Ribbon

Clicking the drawing buttons on the Ribbon toolbar lets you see the type of object you will draw. Use this method
if you are drawing with Designer for the first time.
Drawing Using a Shortcut Menu

Anytime the Draw tool  and a shape button are selected, you can select another shape and drawing method 
by clicking the right mouse button. On the shortcut menu, click the shape and drawing method you want to use.
Drawing Using the Last Drawing Method

When the pointer is a select pointer , you can automatically return to the previous drawing method. Point to 
an empty area and double click the left mouse button.
For example, if you draw a jointed line, and then double click the left mouse button to complete it, you can 
double click again to draw another jointed line.

{button Related Topics,PI(`',`RT_Drawing_Basics')}
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To draw an object using buttons on the ribbon

1 Click the Draw tool  in the Toolbox (keyboard shortcut CTRL+D).
2 On the Ribbon toolbar, click the button for the shape that you want. For example, click the Simple Line button

 if you want to draw a line. The drawing-method buttons on the Ribbon change to show variations you can
choose for the selected shape.

3 Click a drawing method. For example, click the Line Segment button  to draw a straight line.
4 Move the pointer onto the drawing area and drag to draw the object.
Tip

If you do not see the Toolbox or the Ribbon, click Toolbars on the View menu, and then click the Toolbox 
and Ribbon items.

{button Related Topics,PI(`',`RT_To_draw_an_object_using_the_ribbon_method')}
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Canceling and Redoing Actions
{button Steps...,PI(`',`HT_Canceling_and_Redoing_Actions')}

Sometimes you will want to stop an action that you have not yet finished, or undo the last change you made. If 
you change your mind after undoing and action, you can redo it.
You use the ESC key to interrupt an action before you complete it.
Use Undo to reverse an action, or event, that you just completed (keyboard shortcut CTRL+Z). You can undo up 
to 100 of the last events, depending on the undo event limit setting.
Use Redo to redo an action.
Tip

Undo and Redo affect only actions that have occurred since the last time you saved the drawing. For 
example, if you move an object and then save the drawing, you cannot undo the move.

Use the Reset Transform command to remove all transformations, such as movements or rotations, from selected
objects. Resetting an object transformation:

Returns the object to its originally drawn position and size.

Removes all skews and rotations that you have applied.

Removes warps.

Returns the origin to the object's center.
Tip

Fills and reshaped points are not affected by Reset Transform. Also, duplicating an object is a 
transformation that cannot be reset.
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To undo an action
To redo an action
To reset an object transformation



To cancel an action before completing it
Press the ESC key.

Tip

If you are drawing a line but decide you don't want to draw it after all, press ESC. If you are moving an 
object but decide to cancel the move, press ESC and the object returns to its original position.

{button Related Topics,PI(`',`RT_To_cancel_an_action_before_completing_it')}
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To undo an action
On the Edit menu, click Undo.

Tip

You can set the undo event limit on the General tab of the Options dialog box (on the Tools menu, click 
Options, and click General).

{button Related Topics,PI(`',`RT_To_cancel_an_action_before_completing_it')}



To redo an action
On the Edit menu, click Redo (keyboard shortcut CTRL+SHIFT+Z).

Tip

You can set the undo event-limit on the General tab of the Options dialog box (on the Tools menu, click 
Options).

{button Related Topics,PI(`',`RT_To_cancel_an_action_before_completing_it')}



To reset an object transformation

1 Select the objects to reset.
2 On the Change menu, click Reset Transform.

{button Related Topics,PI(`',`RT_To_cancel_an_action_before_completing_it')}



Choosing Drawing Shapes

Use the Draw tool  to draw almost any shape in Designer. When you click the Draw tool, the shape buttons 
appear on the Ribbon toolbar. Select the type of shape you want to draw and then click a drawing method 
button, if necessary.

For example, to draw a circle, click the Draw tool  and click the Ellipse button 

 Basics of Drawing. Now click an ellipse drawing method button to choose how you want to draw the ellipse (by 
using three points or drawing its diameter, for example).

Designer remembers the last drawing method used for each shape button.
Tip

If you do not see the Ribbon toolbar, click Toolbars on the View menu, and then click Ribbon.

Simple Line  

Lets you draw line segments, parallel lines, perpendicular lines, quarter arcs (one-quarter of an ellipse), and 
parabolas.
Compound Line {compound line.bmp}

Lets you draw connected, multi-line objects 
("W" shapes, for example); connected curves; B-splines (sine-wave shapes, for example); Bézier curves; 
freehand objects; and closed objects with jointed lines.

Rectangle 

Lets you draw rectangles and squares with or without rounded corners.

Polygon 

Lets you draw regular polygons (triangles and octagons, for example) and stars.

Ellipse  

Lets you draw ellipses, circles, arcs, and pie wedges.

{button Related Topics,PI(`',`RT_Choosing_Drawing_Shapes')}
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Moving While Drawing
This useful feature lets you move an object before you finish drawing it.
To move an object while drawing, press and hold the right mouse button without releasing the left mouse button.
Move the outline of the unfinished drawing to its new position. Release the right mouse button and continue 
drawing.

{button Related Topics,PI(`',`RT_Moving_While_Drawing')}
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Constraint Buttons
You can use the constraint buttons on the Ribbon toolbar to restrict or change how Designer draws an object. For
example, selecting the Proportional Constraint button  forces Designer to draw a rectangle as a square. If you 
are drawing ellipses, the same button forces an ellipse to draw as a perfect circle.
A constraint button remains on until you turn it off.
Constraining with the Keyboard

You also can use keystrokes to activate constraints. Keystrokes activate a constraint only while the key is 
pressed.
You can use a key to toggle the effect of a constraint button. For example, if you press and hold SHIFT while 

Angle Constraint  is selected, you turn off the constraint.
Constraining to a 15-degree Angle

You can use the Angle Constraint button  to force lines to draw at angles that are multiples of 15 degrees. 
This constraint is useful for drawing lines (and object edges) that are perfectly horizontal or vertical.
This button also forces horizontal and vertical movements, and rotations and skews of 15-degree increments.
Constraining to a Square or Circle

Use the Proportional Constraint button  (or press SHIFT) to force rectangular or elliptical shapes to draw as 
squares or circles, respectively.
Reversing the Drawing Direction

Use the Reverse Direction button  to reverse the direction Designer normally draws objects created from a 
single side (for example, drawing a square from a single side). See the specific drawing method you are using for
details.
From Center

Use the From Center button  (or press CTRL) to force Designer to draw the object from the center outward. 
Drawing from the center can be useful when you want the center of the object to be at a particular point.



Drawing with Crosshairs
To toggle the pointer to full-screen horizontal and vertical crosshairs, point to Workspace on the View menu and 
click Show Crosshairs. (Keyboard shortcut CTRL+H).



Using Snap Points
{button Steps...,PI(`',`HT_Using_Snap_Points')}

You can use object snap to "snap," or attract, the end of a line to a point on an object. These points, or snap 
points, attract the ends of lines like a magnet when they are near.
Snap points appear as small red squares on an object. You can use snap points to draw a line or other object that
perfectly touches the object. Snap points also can help show the symmetrical form of an object when you need 
to draw, for example, a line through the exact center of a circle. For text and warped objects, snap points appear
only on the object's bounding box.

Snap points do not move when an object is moved or deleted.
Note

Snap points are not attached to an object. That's why they don't move when you move or delete the 
object. Snap points do not print.

{button Related Topics,PI(`',`RT_Using_Snap_Points')}
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To add snap points to an object

1 Select the objects you want to have snap points.

2 On the Ribbon toolbar, click the Add Snap Points button . Snap points are placed at the locations selected 
on the Rulers/Snap tab of the Options dialog box.

Tips

You can select Add Snap Points with the keyboard using CTRL+F7

{button Related Topics,PI(`',`RT_To_add_snap_points_to_an_object')}
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To remove snap points

On the Ribbon toolbar, click the Remove Snap Points button 
. All snap points from the drawing area are removed.

Tips

You can select Remove Snap Points with the keyboard using CTRL+SHIFT+F7 You can also click the Snap 
Points button 

 on the status bar, if displayed.

{button Related Topics,PI(`',`RT_To_add_snap_points_to_an_object')}



Choosing Where Snap Points Appear on an Object
{button Steps...,PI(`',`HT_Using_Snap_Points')}

You can choose where Designer places snap points on an object. For example, you might want snap points to 
appear only at corners. You can change where snap points appear at any time.



To choose snap point placement

1 On the Tools menu, click Options.
2 Click Rulers/Snap to display the Rulers/Snap tab.
3 Choose the locations where you want snap points to appear.

{button Related Topics,PI(`',`RT_To_choose_snap_point_placement')}
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Changing Snap Point Sensitivity
{button Steps...,PI(`',`HT_Using_Snap_Points')}

You can increase or decrease the sensitivity of snap points by changing the handle size. Choose a large handle 
size to increase the snap range; choose a smaller size to decrease the range.



To change snap point sensitivity

1 On the Tools menu, click Options.
2 Select a handle size. A large handle size increases the snap range; a smaller size decreases the range.

{button Related Topics,PI(`',`RT_To_change_snap_point_sensitivity')}
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Snapping to the Ruler
{button Steps...,PI(`',`HT_Using_Snap_Points')}

Snapping to the ruler causes the closest ruler intersection to attract object points.



To toggle Snap to Rulers on or off

On the Tools menu, point to Snap and click Snap to Rulers.

{button Related Topics,PI(`',`RT_To_snap_to_the_ruler')}
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Changing the Number of Snaps
{button Steps...,PI(`',`HT_Using_Snap_Points')}

Snapping is based on the ruler units: if you change the number of snaps per ruler unit, you also change the 
number of snap points and the appearance of the on-screen grid. By default, the number of snaps per unit is the 
same as the standard ruler divisions. For example, an inch has 16 snaps, and a centimeter has ten snaps.

{button Related Topics,PI(`',`RT_Changing_the_Number_of_Snaps')}



Setting Options



To change the number of snaps

1 On the Tools menu, click Options
2 Click the Rulers/Snap tab.
3 Change the number of snaps per ruler unit. The rulers redraw to correspond to the number of snaps per unit. 

For example, a centimeter with five snaps per unit displays five unit-marks on the ruler.

{button Related Topics,PI(`',`RT_To_change_the_number_of_snaps')}
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Snapping to Guides
{button Steps...,PI(`',`HT_Using_Snap_Points')}

Guides are nonprinting horizontal and vertical reference lines that you can drag from the ruler.
By turning on Snap to Guides, you can make nearby guidelines attract points on an object as you draw or move 
it.

{button Related Topics,PI(`',`RT_Snapping_to_Guides')}



Using Guides



To toggle Snap to Guides on or off

On the Tools menu, point to Snap and click Snap to Guides.

{button Related Topics,PI(`',`RT_To_snap_to_guides')}
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Connect-A-Draw
{button Steps...,PI(`',`HT_Connect_A_Draw')}

Connect-A-Draw is a Designer feature that makes it easy to chain the ends of open objects as you draw them. 
You can use this method to create an object made of several different line types. For example, you can draw a 
straight line, then chain it to a curve, then chain it to a freehand object, and so on.



To chain lines while drawing
To chain an existing open object



To chain lines while drawing

1 Draw a segment of the line.
2 Select a different drawing method, if you wish. Hollow boxes appear at both ends of the line.
3 Point to a hollow box at one end of the line and draw the next portion of the object.
4 Repeat steps 2 and 3 to chain more segments.

{button Related Topics,PI(`',`RT_To_chain_lines_while_drawing')}



Connect-A-Draw



To chain an existing open object

1 Select the object you want to augment.

2 Click the Draw tool  if it is not already selected.
3 Select a drawing method. Hollow boxes appear at both ends of the line when an applicable method is 

selected.
4 Point to a box at one end of the line and draw the next portion of the object.
5 Repeat steps 3 and 4 to chain more segments.

{button Related Topics,PI(`',`RT_To_chain_lines_while_drawing')}



Simple Line Drawing Buttons
{button Steps...,PI(`',`HT_Simple_Line_Drawing_Buttons')}

The Simple Line button  lets you draw several different types of linear objects. They are simple because they
are made of only one line or curve.

The Simple Line button  displays buttons that let you draw single, parallel, and perpendicular lines, as well 
as arcs and parabolic lines.

To draw a simple line, click the Draw tool  , click the Simple Line button 

 and a drawing method button, and then drag to draw the line.

{button Related Topics,PI(`',`RT_Simple_Line_Drawing_Buttons')}



To draw a line segment
To draw a parallel or tangent line
To draw a perpendicular line
To extend a straight line
To draw a quarter arc
To draw a parabola
To show line length
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Drawing Single Lines
{button Steps...,PI(`',`HT_Simple_Line_Drawing_Buttons')}

The Line Segment button  lets you draw single, straight lines.

{button Related Topics,PI(`',`RT_Drawing_Single_Lines')}
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To draw a line segment

1 Click the Draw tool  in the Toolbox.

2 On the Ribbon toolbar, click the Simple Line button  and the Line Segment button 

.
3 Move the pointer to the drawing area.
4 Drag to draw the line.
5 Release the mouse button when you finish drawing the line.
Tips

If you do not see the Toolbox or the Ribbon, click Toolbars on the View menu, and then click the Toolbox 
and Ribbon items.

To constrain the line to a 15-degree angle, select the Angle Constraint button 

 . To draw from the center outward, press and hold CTRL while drawing or select the From Center button 

 .

{button Related Topics,PI(`',`RT_To_draw_a_line_segment')}
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Drawing Parallel Lines
{button Steps...,PI(`',`HT_Simple_Line_Drawing_Buttons')}

The Parallel Line button  lets you draw a line that is parallel or tangent to a line segment, arc, ellipse, or 
rectangle.

{button Related Topics,PI(`',`RT_Drawing_Parallel_Lines')}
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To draw a parallel or tangent line

1 Select the object with which you want the line to be parallel.

2 On the Toolbox, click the Draw tool .

3 On the Ribbon toolbar, click the Simple Line button  and the Parallel Line button 

.
4 Move the pointer near the object, and press and hold the left mouse button.
5 Drag the pointer the desired distance from the line or curve to draw the line.
6 Release the mouse button when you finish drawing the line.
Tip

If you do not see the Toolbox or the Ribbon, click Toolbars on the View menu, and then click the Toolbox 
and Ribbon items.

{button Related Topics,PI(`',`RT_To_draw_a_line_segment')}



Drawing Perpendicular Lines
{button Steps...,PI(`',`HT_Simple_Line_Drawing_Buttons')}

The Perpendicular Line button  lets you draw a line that is perpendicular to a line segment, arc, ellipse, or 
rectangle.

{button Related Topics,PI(`',`RT_Drawing_Perpendicular_Lines')}
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To draw a perpendicular line

1 Select the object with which you want the line to be perpendicular.

2 Click the Draw tool  in the Toolbox, if necessary.

3 On the Ribbon toolbar, click the Simple Line button  and the Perpendicular Line button 

.
4 Move the pointer near the object, and press and hold the left mouse button.
5 Drag the pointer the desired distance from the line or curve to draw the line.
6 Release the mouse button when you finish drawing the line.
Tips

If you do not see the Toolbox or the Ribbon, click Toolbars on the View menu, and then click the Toolbox 
and Ribbon items.

To draw from the center outward, press and hold CTRL while drawing, or click the From Center button 

.

{button Related Topics,PI(`',`RT_To_draw_a_line_segment')}



Extending a Line
{button Steps...,PI(`',`HT_Simple_Line_Drawing_Buttons')}

You can extend a straight line at the end of an open object. The added line maintains the slope of the original 
line, or is at a right angle to the original for Parallel and Perpendicular, respectively.

{button Related Topics,PI(`',`RT_Extending_a_Line')}
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To extend a straight line

1 Double click the line you want to extend.

2 On the Toolbox, click the Draw tool 

3 On the Ribbon toolbar, click the Simple Line button , and then click the Parallel button 

 or the Perpendicular button 

 .
4 Point to the end of the line you want to extend, and drag the extended line.
Tip

If you do not see the Toolbox or the Ribbon, click Toolbars on the View menu, and then click the Toolbox 
and Ribbon items.

{button Related Topics,PI(`',`RT_To_draw_a_line_segment')}



Drawing Quarter Arcs
{button Steps...,PI(`',`HT_Simple_Line_Drawing_Buttons')}

The Quarter Arc button  lets you draw one quarter of an ellipse.

{button Related Topics,PI(`',`RT_Drawing_Quarter_Arcs')}
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To draw a quarter arc

1 Click the Draw tool  in the Toolbox.

2 On the Ribbon toolbar, click the Simple Line button  and the Quarter Arc button 

.
3 Drag to draw the arc. The arc appears on the screen and changes size and proportion as you drag the pointer.
4 Release the mouse button when you finish drawing the arc.
Tips

If you do not see the Toolbox or the Ribbon, click Toolbars on the View menu, and then click the Toolbox 
and Ribbon items.

Use the Proportional Constraint button 

 to force Designer to draw radial arcs that are one-quarter of a perfect circle.

Use the Reverse Direction button 

 to control the bowing direction of the arc. When the button is not selected (the default), the arc bows to the 
right as you draw upward and left as you draw downward. The opposite occurs when the button is selected.

{button Related Topics,PI(`',`RT_To_draw_a_line_segment')}



Drawing Parabolas
{button Steps...,PI(`',`HT_Simple_Line_Drawing_Buttons')}

The Parabola button  lets you draw parabolic shapes. You create parabolas by drawing a line and then bowing
the line outward -- much like pulling an elastic string.

{button Related Topics,PI(`',`RT_Drawing_Parabolas')}
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To draw a parabola

1 Click the Draw tool  in the Toolbox.

2 On the Ribbon toolbar, click the Simple Line button  and the Parabola button 

.
3 Point where you want to begin the parabola.
4 Drag where you want to place the other end of the parabola. Release the mouse button.
5 Move the pointer to where you want the highest point of the curve.
6 Click the mouse button to finish drawing the parabola.
Tips

If you do not see the Toolbox or the Ribbon, click Toolbars on the View menu, and then click the Toolbox 
and Ribbon items.

To constrain the line in steps 3 and 4 to a 15-degree angle, select the Angle Constraint button 

 .

To draw the line in steps 3 and 4 from the center outward, press and hold CTRL while drawing, or select the
From Center button 

.

{button Related Topics,PI(`',`RT_To_draw_a_line_segment')}



Line Lengths
{button Steps...,PI(`',`HT_Simple_Line_Drawing_Buttons')}

The Line Length button  provides an easy way to show the length of selected straight lines and new lines 
you draw.

{button Related Topics,PI(`',`RT_Line_Lengths')}
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To show line length

1 Click the Draw tool  in the Toolbox.

2 On the Ribbon toolbar, click the Simple Line button .
3 Select the straight line whose length you want to show.

4 On the Ribbon toolbar, click the Line Length button . A menu opens.
5 Click Show Line Length.
Tips

As a more powerful alternative to showing line lengths, you can show the distance between any two points
in a drawing using dimension lines.

You can set line length attributes with the Line Length Options dialog box. To open the Line Length Options 
dialog box, click the Draw tool 

 , click the Simple Line button 

 , click the Line Length button 

, and click Options.
The Prefix and Suffix text boxes let you enter text to appear before and after the line length units.

The currently selected units setting appears in the Units button . Click this button to change this 
setting.
The Displayed Precision list box shows the current decimal precision of the line length. To change this setting,
click the down arrow next to the box.
The Alignment options let you horizontally and vertically align the units on the line.

{button Related Topics,PI(`',`RT_To_draw_a_line_segment')}



Compound Line Drawing Buttons
{button Steps...,PI(`',`HT_Compound_Line_Drawing_Buttons')}

The Compound Line button  lets you draw objects made of connected lines and curves.

The Compound Line button  displays buttons that let you draw jointed lines, curves, B-splines, Bézier curves,
freehand objects, and irregular closed polygons.

{button Related Topics,PI(`',`RT_Compound_Line_Drawing_Buttons')}
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To prepare to draw a compound line

1 Click the Draw tool  in the Toolbox.

2 Click the Compound Line button  and click a drawing method button.
Tip

If you do not see the Toolbox or the Ribbon, click Toolbars on the View menu, and then click the Toolbox 
and Ribbon items.

{button Related Topics,PI(`',`RT_To_draw_a_jointed_line')}



Drawing Jointed Lines
{button Steps...,PI(`',`HT_Compound_Line_Drawing_Buttons')}

The Jointed Line button  lets you draw objects that are a "chain" of connected straight lines.

Jointed lines are open unless the last point is the same as the first; then Designer automatically closes it. If you 
want to close an open jointed line, select the object, click Combine on the Change menu, and click Connect 
Closed. The ends are connected with a straight line.

Use the Irregular Polygon button  to create closed objects with multiple sides (see "Drawing Irregular 
Polygons").

{button Related Topics,PI(`',`RT_Drawing_Jointed_Lines')}
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To draw a jointed line

1 Click the Draw tool  in the Toolbox. 

2 On the Ribbon toolbar, click the Compound Line button  and the Jointed Line button 

.
3 Point where you want to begin the jointed line.
4 Drag to draw the first line. Release the mouse button.
5 Move the pointer to the endpoint for the second line, and press and hold the left mouse button. Designer 

draws the second line from the end of the first line to the pointer.
6 Drag the pointer (while still holding the left mouse button) to reposition the line endpoint, if necessary.
7 Release the mouse button when the line is where you want it.
8 Repeat steps 5 through 7 for each additional line.
9 Click the left mouse button or press ESC when you finish.
Tips

If you do not see the Toolbox or the Ribbon, click Toolbars on the View menu, and then click the Toolbox 
and Ribbon items.

To constrain the line to a 15-degree angle, click the Angle Constraint button 

.

{button Related Topics,PI(`',`RT_To_draw_a_jointed_line')}
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Drawing Curves
{button Steps...,PI(`',`HT_Compound_Line_Drawing_Buttons')}

The Curved Line button  lets you draw objects that are a "chain" of connected, curving (parabolic spline) 
lines.

Objects drawn with the Curved Line button  are open unless the last point is the same as the first; then 
Designer automatically closes it. If you want to close an open curve, select the object, click Combine on the 
Change menu, and click Connect Closed. The ends are connected with a straight line.

{button Related Topics,PI(`',`RT_Drawing_Curves')}
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To draw a curve

1 Click the Draw tool  in the Toolbox.

2 On the Ribbon toolbar, click the Compound Line button  and the Curved Line button 

.
3 Point where you want to begin the curve.
4 Drag to draw a line.
5 Release the mouse button.
6 Drag the pointer. The line curves in the direction you move the pointer.
7 Release the mouse button when the curve is the shape and length you want.
8 Repeat steps 6 and 7 to add more curved segments.
9 Click the left mouse button or press ESC when you finish.
Tips

If you do not see the Toolbox or the Ribbon, click Toolbars on the View menu, and then click the Toolbox 
and Ribbon items.

To constrain the line to angles that are multiples of 15 degrees, click the Angle Constraint button 

.

{button Related Topics,PI(`',`RT_To_draw_a_jointed_line')}



Drawing B-Splines
{button Steps...,PI(`',`HT_Compound_Line_Drawing_Buttons')}

The B-Spline button  lets you draw B-spline curves. B-splines are smooth curves based on at least three 
points. The curve touches the first and last points and is pulled by the middle point.

Objects drawn with the B-Spline button  are open unless the last point is the same as the first; then Designer 
automatically closes it. If you want to close an open curve, select the object, click Combine on the Change menu,
and click Connect Closed. The ends are connected with a straight line.

{button Related Topics,PI(`',`RT_Drawing_B_Splines')}
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To draw a B-spline

1 Click the Draw tool  in the Toolbox.

2 Click the Compound Line button  and the B-Spline button 

 on the ribbon.
3 Point where you want to begin the curve.
4 Drag to draw the first line of the curve.
5 Release the mouse button.
6 Drag to draw the second line of the curve.
7 Repeat step 6 to draw additional (connected) curves.
8 Click the left mouse button or press ESC when you finish.
Tip

If you do not see the Toolbox or the Ribbon, click Toolbars on the View menu, and then click the Toolbox 
and Ribbon items.

{button Related Topics,PI(`',`RT_To_draw_a_jointed_line')}



Drawing Bézier Curves
{button Steps...,PI(`',`HT_Compound_Line_Drawing_Buttons')}

The Bézier Curve button  lets you draw Bézier curves. After a little practice, you can use this tool to create 
smooth, curving objects in much less time than it takes using other tools.

Tip

Although drawing Bézier curves takes some practice, it's worth the effort. If you are new to Bézier curves, 
practice reshaping some curved objects with them before trying to draw with Bézier curves. (See Introduction to 
Reshaping for more information.)

{button Related Topics,PI(`',`RT_Drawing_B_zier_Curves')}
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To draw a Bézier curve

1 Click the Draw tool  in the Toolbox.

2 On the Ribbon toolbar, click the Compound Line button  and the Bézier Curve button 

.
3 Point where you want to begin the curve.
4 Press the left mouse button for about one second, then release it.
5 Move the pointer where you want to place the second point. Press and hold the left mouse button until 

Designer connects the two endpoints.
6 Drag the pointer to change the curvature of the line. Release the mouse button when you have the curve that

you want.
or

Release the mouse button without dragging to create a cusp (an angle).
7 Repeat steps 5 and 6 to draw more (connected) curves.
8 Click the left mouse button or press ESC when you finish.
Tips

If you do not see the Toolbox or the Ribbon, click Toolbars on the View menu, and then click the Toolbox 
and Ribbon items.

When you draw Bézier curves, the first mouse press places the first anchor; the second mouse press and 
drag places the second anchor and changes that anchor's control points.

Be sure to press the left mouse button for longer than a "click" when placing the second and subsequent 
Bézier points. Pressing the mouse button for one second should be long enough. If you click the mouse button, you 
end the Bézier drawing action.

Objects drawn with Bézier Curve 

 are open unless the last point is the same as the first; then Designer automatically closes it. If you want to 
close an open curve, select the object, click Combine on the Change menu, and click Connect Closed. The ends are 
connected with a straight line.

{button Related Topics,PI(`',`RT_To_draw_a_jointed_line')}



Drawing Freehand Objects
{button Steps...,PI(`',`HT_Compound_Line_Drawing_Buttons')}

The Freehand button  lets you draw freeform objects as if you were drawing with pencil and paper.
This button is especially useful if you are using a digitizing pad and pen to trace drawings. When you finish 
drawing, Designer automatically smoothes the object and converts it to curves. 

{button Related Topics,PI(`',`RT_Drawing_Freehand_Objects')}
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To draw a freehand object

1 Click the Draw tool  in the Toolbox.

2 On the Ribbon toolbar, click the Compound Line button  and the Freehand button 

.
3 Point where you want to begin drawing.
4 Drag to draw the object.
5 Release the mouse button when you finish drawing.
Tips

If you do not see the Toolbox or the Ribbon, click Toolbars on the View menu, and then click the Toolbox 
and Ribbon items.

Freehand objects are open unless the last point is the same as the first; then Designer automatically closes
it. If you want to close an open freehand object, select it, click Combine on the Change menu, and click Connect 
Closed. The ends are connected with a straight line.

{button Related Topics,PI(`',`RT_To_draw_a_jointed_line')}



Drawing Irregular Polygons
{button Steps...,PI(`',`HT_Compound_Line_Drawing_Buttons')}

The Irregular Polygon button  lets you draw closed objects with multiple sides.

See Drawing Regular Polygons and Drawing Stars to draw polygons, such as triangles and stars, in which each 
side is the same length.

{button Related Topics,PI(`',`RT_Drawing_Irregular_Polygons')}
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To draw an irregular polygon

1 Click the Draw tool  in the Toolbox. 

2 On the Ribbon toolbar, click the Compound Line button  and the Irregular Polygon button 

.
3 Point where you want to begin the polygon.
4 Drag to draw the first side of the polygon. Release the mouse button when you have the first side drawn as 

you want it.
5 Move the pointer where you want to place the third point. Press the left mouse button until Designer 

connects the three endpoints.
6 Repeat step 5 to place more points, if you wish.
7 Click the left mouse button or press ESC when you finish.
Tips

If you do not see the Toolbox or the Ribbon, click Toolbars on the View menu, and then click the Toolbox 
and Ribbon items.

Click the Angle Constraint button 

 to constrain the line to a 15-degree angle.

{button Related Topics,PI(`',`RT_To_draw_a_jointed_line')}



Rectangular Drawing Buttons
{button Steps...,PI(`',`HT_Rectangular_Drawing_Buttons')}

The Rectangle button  lets you choose from several different methods for drawing rectangular shapes.
It displays buttons that let you draw a rectangle from opposite corners or from a single side. You can also draw a 
rectangle based on its height and width.
Note

Although "rectangle" refers to both squares and rectangles, "square" means only perfect square shapes.

{button Related Topics,PI(`',`RT_Rectangular_Drawing_Buttons')}
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Drawing a Rectangle or Square
Creating Rectangles with Rounded Corners
Rounding Existing Rectangles



Drawing a Rectangle or Square
{button Steps...,PI(`',`HT_Rectangular_Drawing_Buttons')}

There are three methods for drawing a rectangle: the Diagonal, the Height/Width, and the Single Side methods. 
(The Single Side method draws only squares.)
Using the Diagonal method

The Diagonal method is one of the most intuitive ways to draw rectangles because you just drag diagonally to 
create the rectangle.

Using the Height/Width method

The Height/Width method lets you draw rectangles and parallelograms by specifying the height and width.

Using the Single Side method

The Single Side method draws only squares. Click the Single Side button  and drag to draw one edge of the 
square. The rest of the square draws automatically. When you finish, release the mouse button.
Notes

There are two ways to draw a square. You can use the Single Side method or you can choose the diagonal 
drawing method and activate the Proportional Constraint button 

 (or press SHIFT).

By default, squares draw down as you drag right, and up as you drag left. Select the Reverse button 
 for the opposite to occur.

{button Related Topics,PI(`',`RT_Rectangular_Drawing_Buttons')}
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To draw a rectangle or square using the Diagonal method

1 Click the Draw tool  in the Toolbox.

2 On the Ribbon toolbar, click the Rectangle button  and the Diagonal button 

.
3 Point where you want to begin the rectangle and drag the pointer to the opposite corner.
4 Release the mouse button when you finish the rectangle.
Tip

Press SHIFT while drawing the rectangle to force a square.

{button Related Topics,PI(`',`RT_To_draw_a_rectangle_or_square_using_the_Diagonal_method')}
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To draw a rectangle or parallelogram using the Height/Width method

1 Click the Draw tool  in the Toolbox.

2 On the Ribbon toolbar, click the Rectangle button  and the Height/Width button 

.
3 Point where you want to begin the rectangle or parallelogram.
4 Drag to draw the first edge.
5 Release the mouse button.
6 Move the pointer to draw the rest of the object. To force a rectangle, press and hold SHIFT.
7 Click the right mouse button (and release SHIFT if you drew a rectangle) when you finish.

{button Related Topics,PI(`',`RT_To_draw_a_rectangle_or_square_using_the_Diagonal_method')}



Creating Rectangles with Rounded Corners
{button Steps...,PI(`',`HT_Rectangular_Drawing_Buttons')}

The Rounded Rectangle button  lets you create rectangles and squares with rounded corners. You can 
increase or decrease the curve of the corner (before it is drawn) by increasing or decreasing the radius. A larger 
radius increases the curvature; a smaller radius decreases it.

{button Related Topics,PI(`',`RT_Creating_Rectangles_with_Rounded_Corners')}
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To draw a rounded rectangle

1 Click the Draw tool  in the Toolbox.

2 Click the Rectangle button  and the Diagonal button 

 or the Single Side button 

.

3 On the Ribbon toolbar, click the Rounded Rectangle button .
4 Change the radius in the Radius box, if you wish.
5 Drag to draw the rounded rectangle.
Tip

If you do not see the Toolbox or the Ribbon, click Toolbars on the View menu, and then click the Toolbox 
and Ribbon items.

{button Related Topics,PI(`',`RT_To_draw_a_rectangle_or_square_using_the_Diagonal_method')}



Rounding Existing Rectangles
{button Steps...,PI(`',`HT_Rectangular_Drawing_Buttons')}

You can round the corners of existing rectangles that have not been rotated, skewed, converted to curves, or 

warped. You cannot round the corners of squares drawn with Single Side . Rectangles drawn with the 
Height/Width method must have been drawn at a 90-degree angle before you can round the corners.

{button Related Topics,PI(`',`RT_Rounding_Existing_Rectangles')}
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To add rounded corners to an existing rectangle

1 Double click the rectangle with the select pointer. A blue handle appears near the rectangle's upper left 
corner. If several hollow handles appear on the rectangle, this method cannot be used.

2 Drag the blue handle toward the center of the rectangle.
3 Release the mouse button when you finish rounding the corners.
Tips

You can round rectangles created with Height/Width 

 only if you constrained the rectangle while drawing it.

You can also round rectangle corners by selecting the rectangle and clicking the Point Reshape button 
 on the Ribbon. (See Overview of Special Objects for more information.)

{button Related Topics,PI(`',`RT_To_draw_a_rectangle_or_square_using_the_Diagonal_method')}



Drawing Regular Polygons
{button Steps...,PI(`',`HT_Drawing_Regular_Polygons')}

Regular Polygon Drawing Buttons

The Polygon button  lets you choose from several different methods for drawing regular shapes with multiple
sides. It displays buttons that let you draw a regular polygon from center to corner, from center to side, and from
just one side.
If you want to draw irregular polygons (polygons in which not all the sides are equal), use the Irregular Polygon 

button  (see Drawing Irregular Polygons).
Drawing a Regular Polygon

There are three ways to draw a polygon: the To Corner, To Side, and Single Side methods. You can use the 
method that suits your needs or preferences.
To Corner Method

The To Corner method lets you draw polygons from the center to a corner.

To Side Method

The To Side method lets you draw polygons from the center to a side.

Single Side Method

The Single Side method lets you create polygons by drawing only one side (Designer draws the other sides). 

Drag Single Side  to draw one edge of the polygon. The rest of the polygon is drawn automatically. Release 
the mouse button when you finish.

{button Related Topics,PI(`',`RT_Drawing_Regular_Polygons')}



To draw a polygon from center to a corner
To draw a polygon form the center to a side
To draw a star



Drawing Stars



To draw a polygon from center to a corner

1 Click the Draw tool  in the Toolbox.

2 On the Ribbon toolbar, click the Polygon button  and the To Corner button 

.
3 Enter the number of sides for the polygon in the Sides box (three or more).
4 Point where you want the center of the polygon.
5 Drag to draw the polygon.
6 Release the mouse button when the polygon is the size you want.
Tips

If you do not see the Toolbox or the Ribbon, click Toolbars on the View menu, and then click the Toolbox 
and Ribbon items.

To constrain polygons to multiples of 15 degrees, select the Angle Constraint button 

 .

{button Related Topics,PI(`',`RT_To_draw_a_polygon_from_center_to_a_corner')}
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To draw a polygon from the center to a side

1 Click the Draw tool  in the Toolbox.

2 On the Ribbon toolbar, click the Polygon button  and the To Side button 

.
3 Enter the number of sides for the polygon in the Sides box (three or more).
4 Point where you want the center of the polygon.
5 Drag to draw the polygon.
6 Release the mouse button when the polygon is the size you want.
Tips

To constrain polygons to a 15-degree angle, select the Angle Constraint button 

.

Press SHIFT to quickly switch to drawing from center to corner.

{button Related Topics,PI(`',`RT_To_draw_a_polygon_from_center_to_a_corner')}



Drawing Stars
{button Steps...,PI(`',`HT_Drawing_Regular_Polygons')}

Designer lets you draw star shapes with any number of points.

{button Related Topics,PI(`',`RT_Drawing_Stars')}



Drawing Regular Polygons



To draw a star

1 Click the Draw tool  in the Toolbox.

2 On the Ribbon toolbar, click the Polygon button  and the Star button 

.

3 On the Ribbon toolbar, click the To Corner button , the To Side button 

, or the Single Side button 

 to specify the drawing method.
4 Type the number of points for the star in the Sides box, if you wish.
5 Press and hold the left mouse button and draw a polygon. Release the mouse button when you finish.
6 Move the pointer toward or away from the center of the polygon to create the star's points.
7 Click the left mouse button or press ESC to complete the star.
Tip

If you do not see the Toolbox or the Ribbon, click Toolbars on the View menu, and then click the Toolbox 
and Ribbon items.

{button Related Topics,PI(`',`RT_To_draw_a_polygon_from_center_to_a_corner')}



Drawing Elliptical Objects
{button Steps...,PI(`',`HT_Drawing_Elliptical_Objects')}

The Ellipse button  lets you choose from four different methods for drawing elliptical shapes: the Diagonal, 
Height/Width, Diameter, and 3-Point Circle methods. You can use the method that suits your needs and 
preferences.
Diagonal Method

The Diagonal method lets you draw an ellipse diagonally from one corner of its bounding box to the opposite.

Height/Width Method

The Height/Width method lets you draw an ellipse by specifying the height and width of its bounding box.

Diameter Method

The Diameter method lets you draw circles from one edge of the circle to the opposite edge. Drag to draw the 
circle. Release the mouse button when you finish.
3-Point Circle Method

The 3-Point Circle method lets you draw a circle by specifying three points on its edge.

Tips

"Ellipse" refers to both ellipses and circles, but "circle" describes only perfect circular shapes.

An ellipse drawn with the Height/Width method must be drawn at a 90-degree angle before you can 
reshape it into a wedge or an arc.

There are three ways to draw a circle. You can use the Diameter method or the 3-Point Circle method, or 
you can choose one of the elliptical drawing methods and activate the Proportional Constraint button 

.

{button Related Topics,PI(`',`RT_Drawing_Elliptical_Objects')}



To draw and ellipse using the Diagonal method
To draw a circle using the 3-Point Circle method
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To draw pie wedges using the ribbon
To convert an ellipse into a pie wedge
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To draw an ellipse using the Diagonal method

1 Click the Draw tool  in the Toolbox.

2 On the Ribbon toolbar, click the Ellipse button  and the Diagonal button 

.
3 Point where you want to begin the ellipse's (invisible) rectangular bounding box.
4 Drag diagonally to draw the ellipse.
5 Release the mouse button when you finish.
Tip

Press SHIFT while drawing the ellipse to force a circle.

{button Related Topics,PI(`',`RT_To_draw_an_ellipse_using_the_Diagonal_method')}
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To draw a circle using the 3-Point Circle method

1 Click the Draw tool  in the Toolbox.

2 On the Ribbon toolbar, click the Ellipse button  and the 3-Point Circle button 

.
3 Point where you want to place the first point on the circle. Press and hold the left mouse button.
4 Drag the pointer where you want to place the second point. Release the mouse button.
5 Move the pointer where you want to place the third point. Click the left mouse button to draw the circle.

{button Related Topics,PI(`',`RT_To_draw_an_ellipse_using_the_Diagonal_method')}



Drawing Elliptical Arcs
{button Steps...,PI(`',`HT_Drawing_Elliptical_Objects')}

An elliptical arc is a segment of an ellipse. There are two ways to draw an elliptical arc: the 3-Point Arc and the 
Trace an Ellipse methods.

3-Point Arc Method

The 3-Point Arc method lets you draw an arc by specifying three points on the arc.

Tip

You can draw quarter arcs using the Quarter Arc button 

. With quarter arcs you don't first draw an ellipse, but you are limited to drawing only one quarter of an ellipse. 
(See Drawing Quarter Arcs for more information.)

{button Related Topics,PI(`',`RT_Drawing_Elliptical_Arcs')}
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To draw a 3-point elliptical arc

1 Click the Draw tool  in the Toolbox.

2 On the Ribbon toolbar, click the Ellipse button  and the 3-Point Arc button 

.
3 Drag the arc's diameter and release the mouse button.
4 Move the pointer to create the arc.
5 Click the left mouse button to draw the arc.

{button Related Topics,PI(`',`RT_To_draw_an_ellipse_using_the_Diagonal_method')}



Tracing an Ellipse's Edge
{button Steps...,PI(`',`HT_Drawing_Elliptical_Objects')}

You can use the edge of an existing ellipse to draw an elliptical arc if you have not rotated, skewed, or converted 
the ellipse to curves. The arc traces along the edge of the ellipse and replaces the ellipse.

{button Related Topics,PI(`',`RT_Tracing_an_Ellipse_s_Edge')}
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To draw an elliptical arc by tracing an ellipse

1 Draw the ellipse to use as a template for the arc.
2 Select the ellipse.

3 On the Ribbon toolbar, click the Edit button  and the Point Reshape button 

.
4 Position the pointer outside the ellipse.
5 Drag in a circular motion outside of the ellipse. (Dragging inside the ellipse creates a pie wedge instead of 

and arc.)
6 Release the mouse button when you finish.
Tips

You can also create arcs from pie wedges as long as the wedges have not been skewed, rotated, or 
converted to curves.

You can double click the ellipse in step 3 instead of clicking the buttons.

{button Related Topics,PI(`',`RT_To_draw_an_ellipse_using_the_Diagonal_method')}



Editing an Arc
{button Steps...,PI(`',`HT_Drawing_Elliptical_Objects')}

You can lengthen or shorten an arc by double clicking the arc and dragging in a circular motion outside the 
object.

You can also use the Edit ribbon. Select the arc, click the Edit tool , and click the Point Reshape button 

. Then drag in a circular motion outside the object. (See "Overview of Special Objects" for more information.)

{button Related Topics,PI(`',`RT_Editing_an_Arc')}
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Drawing Pie Wedges
{button Steps...,PI(`',`HT_Drawing_Elliptical_Objects')}

You use an existing ellipse to draw individual or multiple pie wedges. You can draw several pie wedges to create 
a circular pie, or you can create just a portion of the pie.
Each pie wedge is a closed object that you can select and edit individually. For example, you can create a chart 
in which each wedge of the pie is a different color.

{button Related Topics,PI(`',`RT_Drawing_Pie_Wedges')}
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To draw pie wedges using the Ribbon toolbar

1 Draw an ellipse.

2 On the Ribbon toolbar, click the Pie button .
3 Position the pointer near the ellipse and drag in a circular motion to create the first wedge.
4 Release the mouse button when the wedge is the size you want.
5 Repeat steps 3 and 4 to add more adjacent wedges to the pie.
6 Press ESC or click outside the object when you finish.
Tips

You cannot create a pie from an ellipse (or elliptical arc) that has been converted to curves, rotated, or 
skewed.

{button Related Topics,PI(`',`RT_To_draw_an_ellipse_using_the_Diagonal_method')}



To convert an ellipse into a pie wedge

1 Double click the ellipse with the select pointer to select it for reshaping.
2 Drag the pointer in a circular motion inside the ellipse. (Dragging outside the ellipse creates an arc instead of 

a wedge.)
3 Press ESC or double click when you finish.

{button Related Topics,PI(`',`RT_To_draw_an_ellipse_using_the_Diagonal_method')}
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Welcome to Designer 6.0
Congratulations, and thank you for buying Designer!
Micrografx® Designer  6.0 is an Office compatible illustration tool from Micrografx, with a next-generation 
interface that works the way you do. Designer anticipates your next move, using context sensitivity to give you 
the tools you need at the moment you need them.

Designer offers increased power and flexibility, with reduced complexity. And Designer is extremely customizable.
Whether you need a simple circle, a series of rotated overlapping images, custom-warped text, or a complex 
technical illustration, you can do it with Designer. And the results will show in the highest resolution of your 
display, printer, or imaging device.
Designer 6.0 gives you a high level of accuracy and precision in your illustrations. It delivers sophisticated 
object-creation and editing features, impressive text handling, and more. Yet it’s all surprisingly easy to learn and
use.



Designer Features
Designer 6.0 is a 32-bit program created for Windows 95 and Windows NT. It hosts a variety of changes from 
earlier versions.

Takes advantage of Windows 95 improved multitasking performance. Designer’s Task Manager lets you 
monitor tasks in progress. To display the Task Manager, click Show Tasks on the View menu.

Uses Windows 95 common dialog boxes (such as Open File). Designer also has extras such as a preview 
and description. (The Preview and Description features are not currently supported under Windows NT.)

Lets you use long filenames for your Designer documents.

Connect-a-Draw
Designer’s easy method of connecting one object to another as you draw, without snap points. 

ABC Media Manager

a drag-and-drop image manager that makes it easy to view image files and exchange them among your 
Windows documents.

Dynamic Dimensioning

Designer’s powerful dimension lines measure vertically, horizontally, or diagonally.

New and improved filters for importing and exporting vector graphics files to and from AutoCAD (including 
layers) and other programs.

Usability improvements for text on a path.

Ease of Learning

Tool Tips tell you a tool or button’s name, and action hints are displayed in a Hint toolbar.

Lets you create and edit objects with one micron (25,400 dots per inch) precision. 

Twenty-nine precise drawing methods, including direct coordinate-entry.

Bitmap editing, with your selected bitmap image editor.

Multiple documents, multiple views.

Text-manipulation and page-layout features, with flowing text, text within a shape, spell checking, and a 
speedy text editor.

Layers make it easy to work on parts of a drawing without disturbing other parts.

Shortcut Menus

Click the right mouse button to pop up a context-sensitive menu for quick drawing and editing.

OLE 2.0 client and server capabilities have been added, including drag-and-drop.

Offers a Color Separation option (in the Print Document dialog) for Designer's PostScript output. You can 
use color-separation utilities with this output. 
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Working with Files
{button Steps...,PI(`',`HT_Working_with_Files')}

Multiple Documents and Views

Designer lets you have up to nine documents open at one time, each in its own drawing window. The title bar of 
a new window displays "Untitled1" until you save the file with a specific filename. If you have more than one 
unsaved document, they are named Untitled1, Untitled2, and so forth.
You can open multiple windows for the same document to view a different page in each window. You can even 
view the same page in two different windows.
After you minimize a window, you can select the Arrange Icons command in Designer’s Window menu to 
automatically space the minimized document windows evenly on your screen. You can select the Cascade and 
Tile commands to arrange multiple windows on your screen. 
To switch from one document window to the next, press CTRL+F6.
Save Frequently

Make a habit of saving your work often. This helps to ensure that your files are saved in the event of a power 
interruption or a hardware or software problem.
The first time you save a new document file, you can name it and choose where you want to store it. Afterwards, 
each time you choose the Save command, any changes to the file are saved.
Import and Export

You also can import and export image files in several file formats, and you can import and export color palettes.
When you close Designer

If any of the files you are working with have changes, and you have not saved them before closing Designer, the 
Save Changes dialog box opens and requests that you select one of three choices: Yes, No, or Cancel.

Click Yes to save changes to the current drawing before closing Designer. If you have not previously saved 
the drawing, the Save As dialog box opens. Type a name in the text box and press ENTER.

Click No to close Designer without saving changes to your drawing.

Click Cancel to cancel the Exit command and return to Designer.

{button Related Topics,PI(`',`RT_Working_with_Files')}
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Opening Documents with Multiple Pages
{button Steps...,PI(`',`HT_Opening_Documents_with_Multiple_Pages')}

When you open a DRW document with multiple pages, you receive a dialog box asking how you want to open the
document.

If each page in the original document contains a separate drawing, click Split Up Pages. Designer retains 
the contents on multiple pages as they were in the original DRW file.

If a large drawing spans several pages in the original document, click Enlarge Document. The entire 
drawing is loaded as a single-page drawing. The page size is enlarged to include all of the used pages of the original
drawing.

{button Related Topics,PI(`',`RT_Opening_Documents_with_Multiple_Pages')}
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Working with Files



To create a new document

On the File menu, click New. Designer opens a new window containing an untitled document. (Keyboard 
shortcut CTRL+N)

Tip

If the Standard toolbar is displayed, you can click the New button 
.

{button Related Topics,PI(`',`RT_To_create_a_new_drawing')}
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To name a new document

1 On the File menu, click Save or Save As. The Save As dialog box opens.
2 Type a name in the File Name text box and press ENTER.
Tips

The keyboard shortcut for Save is CTRL+S.

If the Standard toolbar is displayed, you can click the Save button 
.

{button Related Topics,PI(`',`RT_To_name_a_new_document')}
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To open a document

1 On the File menu, click Open. The Open dialog box opens. (Keyboard shortcut CTRL+O)
2 Click the drive that contains the document you want to open.
3 Double click the appropriate folder.
5 Click a filename to see a preview of the drawing.
6 Click Open. The drawing appears in the drawing area.
Notes

The Open dialog box does not show a file preview for DRW files. When you open a DRW file, it is 
automatically converted to a DSF file and the extension is changed to DSF.

You also can type the folder name separated with backslashes. For example, type C:\DESIGNER\TUTORIAL 
and press ENTER.

To quickly scroll to a specific filename, you can click anywhwre in the list of filenames and then type the 
first character of the filename. The list jumps to the first file beginning with that character.

Each time you click the Open command on the File menu, the Open dialog box recalls the most recently 
used drive and folder.

{button Related Topics,PI(`',`RT_To_open_a_document')}
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To open a    recently used document

On the File menu, click the filename of the recently used document.
Note

If a document has been deleted or is on a drive that is not currently available, Designer displays a 
message stating that it cannot find the document.

{button Related Topics,PI(`',`RT_Recalling_a_Document')}
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To close a document

On the File menu, click Close (keyboard shortcut CTRL+F4) or Close All.
or

Click the "X" Close button at the right side of the document's title bar.
Note

All open documents are closed if you close Designer.

{button Related Topics,PI(`',`RT_Closing_a_Document')}
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To make a copy of a file

1 On the File menu, click Open. The Open dialog box opens.
2 Click the right mouse button on the name of the file you want to copy.
3 On the shortcut menu, click Copy.
4 Double-click the folder where you want the copy to reside.
5 Click the right mouse button outside of any filenames, and click Paste.

{button Related Topics,PI(`',`RT_To_make_a_copy_of_a_file')}
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To delete a file

1 On the File menu, click Open. The Open dialog box opens.
2 Click the right mouse button on the name of the file you want to delete.
3 On the shortcut menu, click Delete.
4 Click Yes to delete the file or click No to cancel the deletion.
Note

Deleting may either delete the file or move the file to the Recycle Bin, depending on how you have set the 
properties of the Recycle Bin.

{button Related Topics,PI(`',`RT_To_delete_a_file')}
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To rename a file

1 On the File menu, click Open. The Open dialog box opens.
2 Click the right mouse button on the name of the file you want to delete.
3 On the shortcut menu, click Rename.
4 Type the new filename and extension and press ENTER.

{button Related Topics,PI(`',`RT_To_rename_a_file')}
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To find a file

1 On the File menu, click Open. The Open dialog box opens.
2 Click Find. The Find File dialog box opens.
3 Type the name of the file you want to search for.
4 Click the Path option and type a drive and folder.

or

Click the Selected Drives option and click Removable, Fixed, or Remote drives.
5 Click Search. Designer lists the names and locations of matching files.
6 Highlight one or more filenames from the search list.
7 Click Open. Each selected document opens in its own window.
Tips

You can use wild-card characters (for example, *.DSF) to find files of the same type or files with similar 
names.

If Designer lists multiple files found in a search, you can select the desired files from this list and then open
all the files at once, even if the files are in different folders or subfolders.

{button Related Topics,PI(`',`RT_To_find_a_file')}
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To save a document

1 If you have more than one document open, select the window of the document you want to save.
2 On the File menu, click Save. If you are saving a document for the first time, the Save As dialog box opens. If 

you already have saved the file, your changes are saved in the file you named earlier.
3 Type the filename you want. If you do not provide an extension, DSF is used.
4 Choose the drive and folder in which you want to store the file.
5 Choose the file format you want in the file type list box if you want to save the document as a different 

format.
6 Click Save to save the file.
Tips

Pressing a character key when a filename is highlighted in the text box makes the name disappear. To edit 
the filename, press the RIGHT ARROW to remove the highlight. Then press the RIGHT or LEFT ARROW to move the 
cursor. To delete characters to the left of the cursor, press BACKSPACE.

If you enter an existing filename, Designer asks if you want to replace the existing file. Click No to return to
the Save As dialog box. Click Yes to replace the file.

If the current drawing was opened from a file, Designer opens that file's folder. Otherwise, Designer opens 
the last folder in which you saved a file using Save As.

{button Related Topics,PI(`',`RT_To_save_a_document')}
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To save a copy of a document

1 On the File menu, click Save As. The Save As dialog box opens. (Keyboard shortcut CTRL+SHIFT+S)
2 Type a different filename for the document copy.
3 Choose the drive and folder in which you want to store the copy.
4 Click Save. A copy of the document is stored with the new filename.

{button Related Topics,PI(`',`RT_To_save_a_copy_of_a_document')}
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To revert to a saved file

1 On the File menu, click Revert To Saved. Designer asks if you are sure you want to ignore all changes before it
reverts to the previous version.

2 Click Yes to open the most recently saved version of the document, or click No to return to the current 
document.

Note

This command restores the document to the most recently saved version, undoing all changes made since 
you last saved the file.

{button Related Topics,PI(`',`RT_Reverting_to_a_Saved_File')}
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Importing and Exporting Files
{button Steps...,PI(`',`HT_Importing_and_Exporting_Files')}

Designer uses ABC Media Manager to import from and export to standard file-formats for vector graphics, bitmap
graphics, and text. This feature lets you use and share files created or used by other applications.
Filters

The installation CD includes filters (sometimes known as converters or translators) for many different file 
formats. When you import a file, ABC Media Manager uses a filter to convert the file created with another 
application into Designer’s format. When you export, a filter is used to convert the file into another program’s 
format.
When you use the Custom Installation option, the Micrografx Installer lets you install only the filters, fonts, and 
ClipArt that you need. If you need a filter that is not installed, run the Installer again, choose Custom Installation,
and install it.
New filters are developed and added to Designer from time to time. For a current list of supported file formats, 
see Updated import and export filters.
Note

If you do not have the filter for a specific format, that format will be missing in the Import/Export dialog 
boxes. Use the Windows Notepad to examine the file MGXXLATE.LOG in your Windows folder. That file contains a log
of any import/export problems. You may need to reinstall ABC Graphics Suite with a Custom installation, to make 
sure all the filters are installed.

{button Related Topics,PI(`',`RT_Importing_and_Exporting_Files')}
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Importing
{button Steps...,PI(`',`HT_Importing_a_File')}

The Import command (keyboard shortcut CTRL+1) lets you import graphic and text files into Designer. Designer 
can import several file types. 
Multiple pages and layers during import

When you import a file with more than one page (such as DSF, DS4, DRW, or MGX), only the objects on the first 
page are imported. The imported objects are added to the current page and layer in Designer.
When you import a file with more than one layer (such as DS4, DRW, or MGX), all the objects on all the layers are
imported. However, the imported objects are added to the current page and layer in Designer; the imported 
objects are no longer on separate layers.
Note

Designer 6.0 can open DSF, DS4 (Version 4.x), DRW (Designer versions prior to Version 4.0, Windows Draw 
3.0, and Charisma 2.1), GRF, and MGX (Designer 4.x) files. You also can import any of these file types.

The fonts used in an imported document might not be available on your system. For more information, see 
Using an Unavailable Font.

{button Related Topics,PI(`',`RT_Importing_a_File')}
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Exporting
{button Steps...,PI(`',`HT_Exporting_a_File')}

The Export command (keyboard shortcut CTRL+2) lets you export Designer files for use in other programs. 
Designer can export several file types. 
Encapsulated PostScript files can be exported in one of four ways: with no header or preview, with no preview, 
with a TIFF preview, or with a WMF preview. If you plan to export an EPS file and import it into a Macintosh 
application (which is typical when sending files to a service bureau), you should export with no header or 
preview.
Multiple pages and layers during export

When you export a Designer file with more than one page, only the objects on the current page are exported. If 
any objects are selected on the current page, only the selected objects are exported. 
When you export a Designer file with more than one layer to the DSF, DS4, or DRW file type, selected objects 
(even those on multiple layers) are exported to one layer. If no objects are selected, all layers and objects are 
exported, and the multiple layers are retained.
When you export a Designer file to any file type other than DSF, DS4, or DRW, all objects on the current page are
exported to one layer.
Notes

To select objects on multiple layers prior to export, open the Layers dialog box, select Edit All Layers, close 
the dialog box, and then select the desired objects on the desired layers of the current page.

Designer can save to DS4 (Version 4.x) and MGX (Micrografx ClipArt) files. You can also export to DSF if 
needed.

{button Related Topics,PI(`',`RT_Exporting_a_File')}



To export a file
To import a file



Working with Files
Importing and Exporting Files
Importing



To import a file

1 On the Tools menu, click Import. The Import dialog box opens.
2 Click the down arrow in the Files of Type list box. 
3 Choose the type of file you want to import.
4 Change to the drive and folder you want.
5 Highlight the name of the file you want to import.
6 Click Setup if you want to change import settings (if available). 
7 Click Import. The dialog box closes and the imported file appears in the drawing area.
Note

If you skip step 6, Designer uses the settings previously used when importing this file type. The available 
import settings vary depending on the file type you want to import.

Tip

Files in the Hewlett-Packard Graphics Language (HPGL) format are sometimes named with a PLT (plotter) 
extension. Before importing a plotter file, make sure it has a PLT extension so that Designer will list it in the Import 
dialog box.

{button Related Topics,PI(`',`RT_To_import_a_file')}
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To export a file

1 Select the objects you want to export. If no objects are selected, the entire page is exported.
2 On the Tools menu, click Export. The Export dialog box opens.
3 Choose a drive and folder for the exported file’s destination, if necessary.
4 Type a name for the file.
5 Click the down arrow in the Save as Type list box.
6 Choose the type of file you want to export. Designer automatically adds the proper extension to the filename.
7 Click Setup if you want to change export settings (if available). 
8 Click Export. Designer exports the file in the chosen format.
Note: If you skip step 7, Designer uses the settings previously used when exporting this file type. The available 
export settings vary depending on the file type you want to export.

{button Related Topics,PI(`',`RT_To_export_a_file')}
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To close Designer

On the File menu, click Exit. (Keyboard shortcut ALT+F4)
or

On Designer's title bar, click the "X" Close button.

{button Related Topics,PI(`',`RT_Closing_Designer')}
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Style Attributes for All Objects
The Style ribbon gives you a variety of buttons, menus, and dialog boxes to let you change and assign colors, fill 
patterns, and many other style attributes for any object you draw with Designer.
When you click a button in the Style Ribbon toolbar, a menu opens. Most of these menus contain a gallery of 
your most recently used fills, patterns, and styles, giving you quick access to standard or often-used style 
attributes.
You can assign fills and patterns to both lines and the interiors of closed objects. Besides solid colors, you can 
use

Gradient fills (gradual changes from one color to another)

Hatch patterns

Image (bitmap) patterns

Object fills (with repetitions of another object)

In addition, you can

Paste one object inside another to achieve a masking effect

Copy all the style attributes from one object and apply them to another

{button Related Topics,PI(`',`RT_Style_Attributes_for_All_Objects')}
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Style Attributes for Lines Only
For lines, you can change the

Color

Style (a pattern of dots and dashes)

Line weight

Line end markers for straight lines and all open objects (arcs, curves, elliptical arcs, freehand objects, 
parabolas, and jointed lines)

Lines also are used as borders of closed objects. You can change their

Color

Style

Weight
In addition, you can make a line invisible to hide an object's border.

{button Related Topics,PI(`',`RT_Style_Attributes_for_Lines_Only')}
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Selecting a Solid Color Fill
{button Steps...,PI(`',`HT_Selecting_a_Solid_Color_Fill')}

You can choose a color for an object before or after you draw it. Selecting a color affects all selected objects. If 
no objects are selected, selecting a color sets the color for the next object you draw.

{button Related Topics,PI(`',`RT_Selecting_a_Solid_Color_Fill')}
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Dithered Colors
Monitors and printers use a process called dithering to compensate for the inability to display some colors. 
Dithering simulates color by placing dots of different colors next to each other in a pattern. Thus, dithering lets 
you display on a screen, and print on some printers, colors that are actually not available.
If a color is supported on your monitor and graphics adapter, it is displayed. If a color is not supported, it is 
changed to the closest color available on the graphics adapter. The color is changed to the closest color or 
dithered color available when printed or when displayed on another device.

{button Related Topics,PI(`',`RT_Dithered_Colors')}
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To choose an object's color from the Color Palette

1 Select an object.

2 Click the Style tool  in the Toolbox.
3 Use the scroll arrows in the Color Palette to display the color you want, if necessary.
4 Click a color in the palette to change the color of the interior. The selected object changes to the new color. 

(This action has no effect on an open object.)
5 Click a color in the palette with the right mouse button to change the color of the object's line.
Tips

If you are viewing the Color Palette toolbar, you can set an object’s colors without clicking the Style tool.

If an object is not selected, you set a new default color. The next object you draw will have this color.

The default fills and patterns for interior and line are shown on the Status Bar (if displayed) and in Interior 
Fill 

 or Line Fill 

 in the Style Ribbon toolbar (when no object is selected). If an object is selected, these buttons display the 
selected object's fill colors or patterns.

{button Related Topics,PI(`',`RT_To_choose_an_object_s_color_from_the_Color_Palette')}
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To choose an object's color from the Fill-Solid dialog box

1 Select an object.

2 Click the Style tool  in the Toolbox.

3 Click the Interior Fill button  to change the color of an interior. A menu opens.
or

Click the Line Fill button  to change the color of a line. A menu opens.
4 Point to Solid and click Custom. The Fill-Solid dialog box opens.

5 Click a color in the palette at the bottom of the dialog box to choose the object's color.
6 Click Apply to change the object's color. Selected objects (either line or interior) change to the new color.
Tips

If no object is selected, you set a new default color.

To speed your work, the Solid submenu keeps track of the most recently used solid color fills. Click the 
solid fill in the submenu as you would any other command.

{button Related Topics,PI(`',`RT_To_choose_an_object_s_color_from_the_Color_Palette')}



Fill Dialog Box Features
{button Steps...,PI(`',`HT_Selecting_a_Solid_Color_Fill')}

You can access any panel of the Fill dialog box with the click of a button. You can select line or interior colors and 
any type of fill for lines or interiors.
Selection Buttons

The buttons across the top of the Fill-Solid dialog box let you select a line or interior fill, and solid, gradient, 
hatch, image, and object fills.
Resizing the Color Palette

You can resize the Color Palette portion of the Fill dialog box by dragging the bottom edge of the dialog box. Drag
it down to show more colors; drag it up to show fewer colors. If all the colors in the palette cannot be displayed 
at once, a scroll bar appears at the right to give you access to all the colors.
Apply Button and Close Button

As with many of the dialog boxes in Designer, the Fill dialog box stays open to let you apply changes to objects 
without having to open the dialog box repeatedly. You can click Apply each time you want to apply a change to a 
selected object. The dialog box does not close until you click Close.

{button Related Topics,PI(`',`RT_Fill_Dialog_Box_Features')}
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To select an invisible fill or line

1 Select the object you want to have an invisible fill.

2 Click the Style tool .
3 Click the X in the Color palette.

Tips

Click the left mouse button for interior fill, right mouse button for line fill

Alternate method: Select the object, click the Style tool 

, click Interior Fill (or Line Fill 

), and click Invisible.

Alternate method: Select the object, click the Style tool 

, click Interior Fill, click Solid, and click Custom. When the Fill dialog box opens, click the current fill button 
(Solid 

, Gradient 
, Hatch 
, Image 
, or Object 
) to "turn off" the current fill.

Alternate method for lines: Select a line, click Line Style 
 in the Style Ribbon toolbar, and click Invisible.

Alternate method for lines: Click the Lines Style button 
, click Style, and click the Invisible option in the Line-Style dialog box.

{button Related Topics,PI(`',`RT_To_choose_an_object_s_color_from_the_Color_Palette')}



Mixing Your Own Color
{button Steps...,PI(`',`HT_Selecting_a_Solid_Color_Fill')}

If you need a simple method to create a color and you do not need to save the color in a palette for later use, 
you can use the Fill-Solid dialog box to create it. This method works as a temporary color palette to let you select
two to four colors and mix them as a painter would on a palette.
If you plan to reuse the color later or you need to use a color model (HLS, CMYK, or RGB), you may want to use 
the Color Picker dialog box and add the color to the Color Palette.

{button Related Topics,PI(`',`RT_Mixing_Your_Own_Color')}



Selecting a Solid-Color Fill
Dithered Colors
Fill Dialog Box Features



To mix colors using the Fill-Solid dialog box

1 Click the Style tool  in the Toolbox.

2 Click the Interior Fill button  to change the color of an interior. A menu opens.
or

Click the Line Fill button  to change the color of a line. A menu opens.
3 Point to Solid and click Custom. The Fill-Solid dialog box opens. A mixing palette appears with a color swatch 

at each corner. The default color (or current color of the selected object) shows in the rectangle just under 
the mixing palette.

4 Click a color in the Color Palette (at the bottom of the dialog box).
5 Click a corner of the mixing palette.
6 Repeat steps 5 and 6 to choose a color for each corner of the mixing palette. The color transitions change to 

reflect the mix of colors.
7 Click a color square in the mixing palette to choose the desired color. The selected color is highlighted.
8 Click Apply. Selected objects (either line or interior) change to the new color.

{button Related Topics,PI(`',`RT_To_choose_an_object_s_color_from_the_Color_Palette')}



Setting Line Styles
{button Steps...,PI(`',`HT_Setting_Line_Styles')}

You can choose a dotted or dashed line style for selected lines. You also can set a style for lines before you draw 
them.
To speed your work, the Line Style menu keeps track of the most recent line style patterns you have used.

{button Related Topics,PI(`',`RT_Setting_Line_Styles')}
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To choose a line style from the menu

1 Click the Style tool  in the Toolbox.

2 Click the Line Style button  on the Ribbon toolbar. The Line Style menu opens.
3 Click a style in the menu. The selected line or border changes to the new style.
Tips

If no objects are selected, subsequent lines and object borders draw in the new style. You can apply a line 
style to a line of any weight.

You also can choose from other line styles in the Line-Style dialog box.

{button Related Topics,PI(`',`RT_To_choose_a_line_style_from_the_menu')}
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To choose a line style from the Line-Style dialog box

1 Click the Style tool  in the Toolbox.

2 Click the Line Style button  on the Ribbon toolbar. The Line Style menu opens.
3 Click Style. The Line-Style dialog box opens.
4 Click the style you want.
5 Click Apply. The selected line or border changes to the new style.
Tip

If no objects are selected, subsequent lines and object borders draw in the new style. The new style 
appears in the Line Style menu for later use.

{button Related Topics,PI(`',`RT_To_choose_a_line_style_from_the_menu')}



Setting Line Ends
{button Steps...,PI(`',`HT_Setting_Line_Styles')}

You can choose from a variety of line ends to enhance your drawing.
Lines (open objects) can have end markers at one or both ends. The line ends include arrowheads, lines, 
squares, circles, and triangles. You can set the line ends first, so that every line appears with the new end 
marker, or you can change the ends of selected lines.
You can add line ends to any open object. You can set both ends of a line to be the same or different for each 
end. You also can have an end marker on only one end of a line. Each line has a "first end" and a "last end," 
depending on which end is the starting point when the line is drawn.
As you select line ends, the ends you choose are added to the Line Ends menu. The menu shows the most 
recently selected line ends.

{button Related Topics,PI(`',`RT_Setting_Line_Ends')}
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To choose a line end from the menu

1 Click the Style tool  in the Toolbox.

2 Click the Line Ends button  on the Ribbon toolbar. The Line Ends menu opens.
3 Click a line end sample. A selected line changes to the new ends.
Tips

If no line is selected, subsequent lines draw with the new ends.

You also can choose from other line ends in the Line-Ends dialog box. You can even create new line ends 
and paste them into the dialog box.

{button Related Topics,PI(`',`RT_To_choose_a_line_style_from_the_menu')}



To choose ends from the Line-Ends dialog box

1 Click the Style tool  in the Toolbox.

2 Click the Line Ends button . The Line Ends menu opens.
3 Click Ends. The Line-Ends dialog box opens.
4 In the preview window, click the end of the line you want to change. (The end on the left is the first end; the 

end on the right is the last end.)
5 Click the button of the desired line end, using the scroll arrows to locate the one you want.
6 Click Apply. A selected line changes to the new style; if no objects are selected, subsequent lines draw in the 

new style.
Notes

The default options are Same Type and Same Attributes for both ends of the line. You can deselect these 
options to use two different end types or to make the two ends a different size, angle, and so forth.

To reset the line end to none, you can click No Ends in the Line Ends menu or choose the line with no end 
in the dialog box.

To draw a Gantt chart with Designer, set the dimensions of lines to weeks and days (units setting in the 
General panel of the Dimensions dialog box) and use triangles for line ends.

{button Related Topics,PI(`',`RT_To_choose_a_line_style_from_the_menu')}



To add line ends to the Line-Ends dialog box

1 Click the Style tool  in the Toolbox.

2 Click the Line Ends button  on the Ribbon toolbar. The Line Ends menu opens.
3 Click Ends. The Line-Ends dialog box opens.
4 Draw an object to be used as a line end.
5 On the Edit menu, click Copy to copy your line end to the Clipboard.

6 Click the Paste button  in the Line-Ends dialog box. The line end you created is added to the gallery of 
ends.

Tips

You can now choose the line end you created from this dialog box.

If the line end you add is an object with weighted lines, select Weighted and then select Scale with the 
Object in the Line-Weight dialog box so that lines are scaled correctly when the object is reduced.

You also can remove line ends you created and pasted into the Line-Ends dialog box. (You cannot remove 
ends originally included with Designer.)

{button Related Topics,PI(`',`RT_To_choose_a_line_style_from_the_menu')}



To remove line ends from the Line-Ends dialog box

1 Click the Style tool  in the Toolbox.

2 Click the Line Ends button  on the Ribbon toolbar. The Line Ends menu opens.
3 Click Ends. The Line-Ends dialog box opens.
4 Select the line end you want to remove.
5 Click Remove. The line end is removed from the gallery.
{Tips

You cannot remove ends originally included with Designer.

button Related Topics,PopupID(RT_To_choose_a_line_style_from_the_menu)}



Editing Line Ends
{button Steps...,PI(`',`HT_Setting_Line_Styles')}

If you need to adjust the position or appearance of a line end, you can scale, move, rotate, or flip the line end 
relative to its line. You can watch the preview in the Line-Ends dialog box to see the effect your adjustments 
have. Experiment with the controls to reach the result you want.
Scaling a Line End

Change the size of a line end by changing the value of Width % and Height %. The default values are 100%, 
which is the original size. Changing both these values to 50% makes the line end half the original size; changing 
the values to 200% makes the line end twice the original size. To scale the line end proportionally, change Width 
% and Height % the same amount.
Moving a Line End

You can move, or offset, a line end from its line by increasing or decreasing the values in the X Offset % or Y 
Offset %. Zero is the default position.
Increasing the percentage for X Offset moves the line end away from the line. Decreasing the percentage for X 
Offset (using a negative value) moves the end toward the middle of the line.
Increasing the percentage for Y Offset moves the line end up. Decreasing the percentage for Y Offset (using a 
negative value) moves the line end down.
Rotating a Line End

You can rotate a line end relative to the line by changing the value for Angle. The default value (no rotation) is 
zero degrees.

Flipping a Line End

Click Horizontal, Vertical, or both to flip a line end.
Style

If you select Use Line, the current line weight and fill attributes are applied to the line end. If you want to retain 
the original style attributes of an object you are pasting into the line end gallery, deselect this option.

{button Related Topics,PI(`',`RT_Editing_Line_Ends')}
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To edit line ends

1 Select the line with the ends you want to edit.

2 Click the Style tool  in the Toolbox.

3 Click the Line Ends button  on the Ribbon toolbar. The Line Ends menu opens.
4 Click Ends. The Line-Ends dialog box opens.
5 Choose the settings you want to apply to the line ends.

{button Related Topics,PI(`',`RT_To_choose_a_line_style_from_the_menu')}



Using Weighted Lines
{button Steps...,PI(`',`HT_Setting_Line_Styles')}

Weighted lines are lines that are wider than a "hairline." A hairline (the default) is the thinnest line that can be 
displayed or printed. Cap options affect the ends of lines; join options affect the intersection of lines.

You can set the weight, or thickness, of lines and the cap and join options of lines with Line Weight  in the 
Style Ribbon toolbar. If no objects are selected, you set a new default when you change the line weight or cap 
and join options. Subsequent lines display with the selected width, height, and angle. In addition, you can 
change the weighted line options for a selected line.
For simple weighted lines, the width and height are the same, and the pen angle is set to zero degrees. You 
change only the width of the line.
For a different effect, Designer can simulate a calligraphy pen (whose tip is typically taller than it is wide) and 
the way it might be used (at an angle in relation to the page). If you select Calligraphic lines, you can set the 
width, height, and angle of the "pen tip."
The Line Weight menu displays previously used weighted lines so you can choose them directly from the menu.

{button Related Topics,PI(`',`RT_Using_Weighted_Lines')}
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Setting the Line Weight
{button Steps...,PI(`',`HT_Setting_Line_Styles')}

You can choose a line weight directly from the Line Weight menu, or you can change the width of a line in the 
Line-Weight dialog box. Line weights can range from a fraction of a point up to 360 points (5 inches).
You also can customize and edit line weights. You can

Change the thickness of a line.

Change the cap and join options.

Create calligraphic lines.

 Choose whether the line weight changes when an object is scaled.

{button Related Topics,PI(`',`RT_Setting_the_Line_Weight')}
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To choose a line weight from the menu

1 Click the Style tool  in the Toolbox.

2 Click the Line Weight button  on the Ribbon toolbar. The Line Weight menu opens.
3 Click a line weight. A selected line changes to the new weight.
Tips

If no object is selected, subsequent lines draw in the new weight.

{button Related Topics,PI(`',`RT_To_choose_a_line_style_from_the_menu')}



To set the line weight in the Line-Weight dialog box

1 Click the Style tool  in the Toolbox.

2 Click the Line Weight button  on the Ribbon toolbar. The Line Weight menu opens.
3 Click Weight. The Line-Weight dialog box opens.
4 Type a number to change the width to the desired weight (width and height are the same).
5 Click Apply.
Tip

If the Scale with Object option is selected, the line weight increases or decreases when the object is 
resized. If Scale with Object is not selected, the line weight remains the same when the object is resized.

{button Related Topics,PI(`',`RT_To_choose_a_line_style_from_the_menu')}



Setting Join and Cap Options
{button Steps...,PI(`',`HT_Setting_Line_Styles')}

You can choose the shape of the corner intersection and the ends of lines. Designer offers three choices for each.
Select the options you want in the Line-Weight dialog box. A preview line (in the upper right) shows a red line in 
the center to show the effect of different cap options.
Cap Options

Cap options determine the appearance of the ends of lines.

The Round Cap option places the center point of a circle at the end point of the line. (The diameter of the 
circle matches the width and height of the line.)

The Square Cap option places the center point of a square at the end point of the line. (The width and 
height of the square match the width and height of the line.)

The Flat Cap option ends the line at the end point of the line.
Join Options

Join options determine the appearance of the corner intersection of lines in an object.

The Round Join option places the center point of a circle at the vertex of two line ends. (The diameter of 
the circle matches the width and height of the lines.)

The Mitre Join option creates a pointed intersection that is the true intersection of two lines.

The Bevel Join option averages the angles of the two lines, creating a blunt intersection.
Tips

Experiment with the rounded cap option and a line style of short dashes to obtain a dotted (rather than 
dashed) line style.

When you select the Mitre Join option in the Line-Weight dialog box, any lines that meet at angles sharper 
than 11 degrees are drawn with beveled joins. This prevents objects from having extremely pointed joins.

{button Related Topics,PI(`',`RT_Setting_Join_and_Cap_Options')}
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To set join and cap options

1 Click the Style tool  in the Toolbox.

2 Click the Line Weight button  on the Ribbon toolbar. The Line Weight menu opens.
3 Click Weight. The Line-Weight dialog box opens.
4 Click the cap and join options repeatedly until you ones you want are displayed.
5 Click Apply.

{button Related Topics,PI(`',`RT_To_choose_a_line_style_from_the_menu')}



Creating Calligraphic Lines
{button Steps...,PI(`',`HT_Setting_Line_Styles')}

You can draw calligraphic lines with Designer by selecting both Weighted and Calligraphic in the Line-Weight 
dialog box. Then you change the Pen Width, Height, and Angle settings. Calligraphic lines can add a more natural
look to many drawings, especially when used with curved lines.
To make a line calligraphic, you change the value for the width or height in relation to the other. As you 
experiment to find the right settings, the dialog box shows a preview of the lines.

The primary way to set calligraphic lines is to adjust the width and height settings. The lines with the most "flair" 
are produced by choosing very different width and height settings. For example, a very thin but very tall setting will 
produce a calligraphic line even without adjusting the Pen Angle setting.

Adjusting the Pen Angle setting can enhance the effects created with the Width and Height settings. In a 
calligraphic line, the Pen Angle setting forces the pen tip to stay at the chosen angle, much as a calligraphic pen 
is held at particular angles to achieve certain effects.

{button Related Topics,PI(`',`RT_Creating_Calligraphic_Lines')}
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To create calligraphic lines

1 Click the Style tool  in the Toolbox.

2 Click the Line Weight button  on the Ribbon toolbar. The Line Weight menu opens.
3 Click Weight. The Line-Weight dialog box opens.
4 Click Weighted and Calligraphic. Choices for Width, Height, and Pen Angle appear.
4 Type the Width, Height, and Pen Angle you want. The pen tip is shown in the preview area.
5 Click Apply.
Tip

You can drag the red needle in the preview area to set the pen angle.

{button Related Topics,PI(`',`RT_To_choose_a_line_style_from_the_menu')}



Using Fill Options
{button Steps...,PI(`',`HT_Using_Fill_Options')}

Designer lets you control whether object overlaps or cut-outs are filled and whether the interior is filled before or
after the line. For more information on overlaps and cut-outs, see Connecting Objects.
Filling Overlaps

You can choose whether overlaps are filled.

Fill overlaps Skip overlaps

Fill Before or After Line

You can choose whether the fill is drawn before or after the line.
Tips

The Fill Before Line and Fill After Line commands do not apply to hairlines. Objects with only hairlines are 
not affected. You can increase the weight of the lines and then use either of the commands. If you apply either of 
the commands to an object that includes both hairlines and weighted lines, only the weighted lines are affected.

The Fill After Line option works well for shadow effects.



To set fill options



To set fill options

1 Click Fill Options  in the Style Ribbon toolbar.
2 Click Fill Overlaps or Skip Overlaps to set the overlap fill option.
3 Click Fill Before Line and Fill After Line to set the fill draw sequence option.

{button Related Topics,PI(`',`RT_To_set_fill_options')}



Using Fill Options



Adding Gradient Fills to Objects
{button Steps...,PI(`',`HT_Adding_Gradient_Fills_to_Objects')}

A gradient is a fill that makes a gradual transition between colors. Gradients can add more realistic depth to a 
drawing and provide a less mechanical feel to many illustrations. You can create linear, radial, and square 
gradient fills.
Linear gradients are the simplest of the three, with a gradual fade of one color to another in a specified direction 
within an object.
Radial (circular) and square gradients fade from one color in the inner part of the fill to another color in the outer
part of the fill.

Linear Radial Square

A simple gradient fill fades from any one selected color to any other selected color. Designer even lets you use 
gradient fills made up of many colors. For example, you can easily create rainbow effects.
You choose the two or more colors used in a gradient fill in the Fill-Gradient dialog box.
To speed your work, the Gradient submenu keeps track of the most recently used gradient fills. Choose the 
gradient fill in the submenu as you would any other command.

{button Related Topics,PI(`',`RT_Adding_Gradient_Fills_to_Objects')}
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Making Gradient Fills Draw Faster
{button Steps...,PI(`',`HT_Adding_Gradient_Fills_to_Objects')}

Because gradient fills take time to draw on your screen, you can speed them by choosing a different display 
option.
Choosing Smooth produces the highest display quality on your screen but redraws more slowly, while Coarse 
produces the lowest display quality but redraws quickly. When None is selected, only the first color of the 
gradient is displayed. You always see a gradient when you print the document.

{button Related Topics,PI(`',`RT_Making_Gradient_Fills_Draw_Faster')}
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To make gradient fills draw faster

On the View menu, point to Show Gradients. Then click Smooth, Average, Coarse, or None. All gradients in 
all documents draw using the options you choose.

{button Related Topics,PI(`',`RT_To_make_gradient_fills_draw_faster')}
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To add a gradient fill to a selected object

1 Click the Style tool  in the Toolbox.

2 Click the Interior Fill button  or the Line Fill button 

 on the Ribbon toolbar. A menu opens.
3 Point to Gradient and click Custom. The Fill-Gradient dialog box opens.

4 Click the point above the color band at 0%.
5 Click a color in the Color Palette.
6 Click the point above the color band at 100%.
7 Click another color in the Color Palette.
8 Click a gradient in the gallery.
9 Click Apply. The object redraws with the new gradient.
Tips

As a shortcut, double click a gradient instead of choosing the gradient and then clicking Apply.

You can use many colors in a gradient fill, instead of only two, to create multicolor gradients and rainbow 
effects. Click above the color band to create a new color point and then choose a color in the palette. You can 
continue to add additional color points in this way. You can drag each point to the desired location on the color band
(try spacing them evenly) to control how the fill graduates from one color to another. To delete a color point, drag it 
off of the dialog box.

You can quickly change the first and last colors for a gradient fill in a selected object without using the Fill-
Gradient dialog box. Select the object with a gradient fill, click one color in the color palette, press and hold SHIFT, 
and click another color in the palette.

{button Related Topics,PI(`',`RT_To_make_gradient_fills_draw_faster')}



Editing Gradient Fills
{button Steps...,PI(`',`HT_Adding_Gradient_Fills_to_Objects')}

You can change the angle and origin of linear and square gradients and the center point of radial gradients. You 
also can add a new gradient pattern or replace a gradient you previously added with a new one.
When editing linear or square gradients, you adjust the angle of the fill. The y-origin setting adjusts the starting 
and ending points of linear gradients.
When editing radial or square gradients, you adjust the x- and y-axis of the center point with settings from 0 to 
100. A setting of less than 50 moves the center point above and to the left of the center of the object, and a 
setting of more than 50 moves the center point below and to the right of the center of the object. The Angle 
setting is not available for radial gradients.

x = 50%, y = 50% x = 25%, y = 25%

Note

You cannot add a gradient pattern if an identical pattern already exists in the dialog box. You cannot 
replace any of the original gradient patterns included with Designer.

{button Related Topics,PI(`',`RT_Editing_Gradient_Fills')}
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To edit a linear gradient

1 Click the Style tool  in the Toolbox.

2 Click the Interior Fill button  or the Line Fill button 

. A menu opens.
3 Point to Gradient and click Custom. The Fill-Gradient dialog box opens.

4 Click the linear gradient you want to edit.
5 Click Edit. The Gradient-Edit dialog box opens. The Linear option is selected.
6 Type a new angle for the gradient or drag the red needle in the dial control. The gradient changes in the 

preview.
7 Change the y-origin to adjust the starting and ending points of the gradient. The gradient changes in the 

preview.
8 Click Add to append the gradient to the Fill-Gradient dialog box.

or

Click Replace to replace the linear gradient last selected in the Fill-Gradient dialog box.
Note

You cannot replace any of the gradient patterns originally included with Designer.

{button Related Topics,PI(`',`RT_To_make_gradient_fills_draw_faster')}



To edit a radial gradient

1 Click the Style tool  in the Toolbox.

2 Click the Interior Fill button  or the Line Fill button 

. A menu opens.
3 Point to Gradient and click Custom. The Fill-Gradient dialog box opens.

4 Point to the radial gradient you want to edit and click the left mouse button.
5 Click Edit. The Gradient-Edit dialog box opens. The Radial option is selected.
6 Type new numbers for the x- and y-coordinates of the gradient center point. The gradient changes in the 

preview.
7 Click Add to append the gradient to the Fill-Gradient dialog box.

or

Click Replace to replace the radial gradient last selected in the Fill-Gradient dialog box.
Note

You cannot replace any of the gradient patterns originally included with Designer.

{button Related Topics,PI(`',`RT_To_make_gradient_fills_draw_faster')}



To edit a square gradient

1 Click the Style tool  in the Toolbox.

2 Click the Interior Fill button  or the Line Fill button 

. A menu opens.
3 Point to Gradient and click Custom. The Fill-Gradient dialog box opens.

4 Point to the square gradient you want to edit and click the left mouse button.
5 Click Edit. The Gradient-Edit dialog box opens. The Square option is selected.
6 Type new numbers for the x- and y-coordinates of the gradient center point. The gradient changes in the 

preview.
7 Type a new angle for the square gradient, or drag the red needle in the dial control. The gradient changes in 

the preview.
8 Click Add to add the gradient to the Fill-Gradient dialog box.

or

Click Replace to replace the square gradient last selected in the Fill-Gradient dialog box.
Note

You cannot replace any of the gradient patterns originally included with Designer.

{button Related Topics,PI(`',`RT_To_make_gradient_fills_draw_faster')}



Removing a Gradient
{button Steps...,PI(`',`HT_Adding_Gradient_Fills_to_Objects')}

You can remove gradient patterns you have added in Designer. You cannot remove or replace any of the original 
gradient patterns included with Designer.

{button Related Topics,PI(`',`RT_Removing_a_Gradient')}
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To remove a gradient

1 Click the Style tool  in the Toolbox.

2 Click the Interior Fill button  or the Line Fill button 

. A menu opens.
3 Point to Gradient and click Custom. The Fill-Gradient dialog box opens.

4 Click the gradient you want to delete.
5 Click Remove. The gradient is deleted.

{button Related Topics,PI(`',`RT_To_make_gradient_fills_draw_faster')}



Adding Hatch Patterns to Objects
{button Steps...,PI(`',`HT_Adding_Hatch_Patterns_to_Objects')}

You can fill objects with hatch patterns that are composed of vector-based lines.
Objects with hatch patterns have two interior colors: one for the hatch pattern (foreground) and one for the 
background.
Dense patterns show less of the background color, and sparse patterns show more background color. By 
experimenting with different patterns and colors, you can produce interesting effects.
To speed your work, the Hatch submenu keeps track of the most recently used hatch fills. Choose the hatch fill in
the menu as you would any other command.

{button Related Topics,PI(`',`RT_Adding_Hatch_Patterns_to_Objects')}
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Making Hatch Patterns Draw Faster
{button Steps...,PI(`',`HT_Adding_Hatch_Patterns_to_Objects')}

If hatch patterns take too much time to draw on your screen, you can hide them by turning hatch fills off in the 
drawing.

{button Related Topics,PI(`',`RT_Making_Hatch_Patterns_Draw_Faster')}
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To make hatch patterns draw faster

On the View menu, click Show Hatch Fills to toggle whether hatch fills show in your drawing.

{button Related Topics,PI(`',`RT_To_make_hatch_patterns_draw_faster')}
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To choose a hatch pattern

1 Select an object.

2 Click the Style tool .

3 Click the Interior Fill button  or the Line Fill button 

. A menu opens.
4 Point to Hatch and click Custom. The Fill-Hatch dialog box opens.

5 Click a pattern.
6 To change the foreground color, select Foreground, point to a color in the palette, and click the left mouse 

button.
7 To change the background color, select Background, point to a color in the palette, and click the left mouse 

button.
8 Click Apply. The object redraws with the new hatch pattern and colors.
Tips

As a shortcut, double click a hatch pattern instead of choosing the pattern and then clicking Apply.

You can quickly change the foreground and background colors for a hatch fill in a selected object without 
using the Fill-Hatch dialog box. Select an object with a hatch fill, click one color in the palette in the Style Ribbon 
toolbar, and then press and hold SHIFT and click another color in the palette.

The background color is opaque by default. You can make the background color transparent by selecting 
the Background Transparent option in the Fill-Hatch dialog box.

{button Related Topics,PI(`',`RT_To_make_hatch_patterns_draw_faster')}



Changing the Line Weight and Spacing of Hatch Fills
{button Steps...,PI(`',`HT_Adding_Hatch_Patterns_to_Objects')}

You can change both the line weight and spacing of hatch lines.
Weight

The default value for hatch line weight is 100%. Setting this value to 200% makes the lines twice as heavy; 
setting it to 50% makes the lines half as heavy.
Spacing

The default value for the spacing between hatch lines is 100% (no change). Setting this value to 200% doubles 
the space between hatch lines; setting it to 50% cuts the space between hatch lines in half.

{button Related Topics,PI(`',`RT_Changing_the_Line_Weight_and_Spacing_of_Hatch_Fills')}
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To change the line weight and spacing of hatch fills

1 Select an object.

2 Click the Style tool .

3 Click the Interior Fill button  or the Line Fill button 

. A menu opens.
4 Point to Hatch and click Custom. The Fill-Hatch dialog box opens.
5 Enter new values for the line weight and spacing.
6 Click Apply. The object redraws with the new line weight and spacing for the hatch pattern.

{button Related Topics,PI(`',`RT_To_make_hatch_patterns_draw_faster')}



Adding Image Patterns to Objects
{button Steps...,PI(`',`HT_Adding_Image_Patterns_to_Objects')}

You can add image (bitmap) patterns to objects. You can create and save your own patterns with your selected 
bitmap editor, such as Micrografx Picture Publisher.
The Interior Fill and Line Fill menus contain the Image command for image (bitmap) patterns. The Image 
command provides a set of patterns composed of individual pixels (dots).
You choose the pattern for a selected object in the Fill-Image dialog box.
If the image fill pattern is all one color (monochrome), you can change the foreground and background color. To 
set the foreground and background colors for a monochrome image fill in a selected object, select an object with 
an image fill, click one color in the color palette in the Style Ribbon toolbar, and then press and hold SHIFT and 
click another color in the palette. You also can select colors for the foreground and background color swatches in 
the Fill-Image dialog box.
To speed your work, the Image submenu keeps track of the most recently used image fills. Choose the image fill 
in the submenu as you would any other command.

{button Related Topics,PI(`',`RT_Adding_Image_Patterns_to_Objects')}
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To set the image pattern

1 Select an object.

2 Click the Style tool .

3 Click the Interior Fill button  or the Line Fill button 

. A menu opens.
4 Point to Image and click Custom. The Fill-Image dialog box opens.

5 Click a pattern to select it.
6 Click Apply. The object redraws with the new pattern.
Tips

As a shortcut, double click an image pattern instead of choosing the pattern and then clicking Apply.

Plotters and many film recorders do not support bitmap patterns or opaque backgrounds.

{button Related Topics,PI(`',`RT_To_set_the_image_pattern')}
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Making Image Fills Draw Faster
{button Steps...,PI(`',`HT_Adding_Image_Patterns_to_Objects')}

If image fills take too much time to draw on your screen, you can hide them by turning image fills off in the 
drawing. Deselecting image fills has no effect on your drawing when it is printed.

{button Related Topics,PI(`',`RT_Making_Image_Fills_Draw_Faster')}
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To make image fills draw faster

On the View menu, click Show Image Fills to toggle whether image fills show in your drawing.

{button Related Topics,PI(`',`RT_To_set_the_image_pattern')}



Changing the Image Scale
{button Steps...,PI(`',`HT_Adding_Image_Patterns_to_Objects')}

The Fill-Image dialog box includes a scroll box to change the scale of the image.
The default value for Image Scale is 100%. Setting this value to 200% makes the image twice as large; setting it 
to 50% make the image half as large.

{button Related Topics,PI(`',`RT_Changing_the_Image_Scale')}
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To change the image scale

1 Select an object.

2 Click the Style tool .

3 Click the Interior Fill button  or the Line Fill button 

. A menu opens.
4 Point to Image and click Custom. The Fill-Image dialog box opens.

5 Enter a value in the Image Scale area to change the size of the image.
6 Click Apply. The object redraws with the new image size.

{button Related Topics,PI(`',`RT_To_set_the_image_pattern')}



Creating Image Patterns
{button Steps...,PI(`',`HT_Adding_Image_Patterns_to_Objects')}

You can create your own image (bitmap) patterns (such as a texture or part of a photo image) with a bitmap-
editing program, and paste these patterns into the Fill-Image dialog box.
Tip

You can launch your selected bitmap editor from the Bitmap Ribbon toolbar. For more information, see 
Editing a Bitmap Image.

{button Related Topics,PI(`',`RT_Creating_Image_Patterns')}
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To add image patterns

1 Create or import a bitmap pattern in your bitmap-editing program.
2 On the Edit menu, click Copy to copy your pattern to the Clipboard.

3 Start Designer and click the Style tool  in the Toolbox.

4 Click the Interior Fill button  or the Line Fill button 

. A menu opens.
5 Point to Image and click Custom. The Fill-Image dialog box opens.
6 Click Paste. The image pattern you created is added to the gallery of patterns.

{button Related Topics,PI(`',`RT_To_set_the_image_pattern')}



Removing Image Patterns
{button Steps...,PI(`',`HT_Adding_Image_Patterns_to_Objects')}

You can remove image (bitmap) patterns you created and pasted into the Fill-Image dialog box. You cannot 
remove patterns originally included with Designer.

{button Related Topics,PI(`',`RT_Removing_Image_Patterns')}
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To remove image patterns

1 Click the Style tool  in the Toolbox.

2 Click the Interior Fill button  or the Line Fill button 

. A menu opens.
3 Point to Image and click Custom. The Fill-Image dialog box opens.
4 Click the pattern you want to remove to select it.
5 Click Remove. The image pattern is removed from the gallery of patterns.

{button Related Topics,PI(`',`RT_To_set_the_image_pattern')}



Filling an Object with Other Objects
{button Steps...,PI(`',`HT_Filling_an_Object_with_Other_Objects')}

You can fill an object with a pattern made of other objects.
You can fill a closed or connected object with a repeating pattern of other objects. Object fills draw in a grid 
pattern within the shape of the object you choose, extending to the borders of the object.
Designer's Fill - Object dialog box has a gallery of object fills from which to choose. You can use these object fills 
or create your own.
To speed your work, the Object submenu keeps track of the most recently used object fills. Choose the object fill 
in the submenu as you would any other command.
Objects with object fills can have two interior colors: one for the fill pattern (foreground) and one for the 
background. The background color is opaque by default. You can make the background color transparent by 
selecting the Background Transparent option in the Fill-Object dialog box.
Dense patterns show less of the background color, and sparse patterns show more background color. By 
experimenting with different patterns and colors, you can produce interesting effects.

{button Related Topics,PI(`',`RT_Filling_an_Object_with_Other_Objects')}
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Making Object Fills Draw Faster
{button Steps...,PI(`',`HT_Filling_an_Object_with_Other_Objects')}

If object fills take too much time to draw on your screen, you can hide them by turning object fills off in the 
drawing. Deselecting object fills has no effect on your drawing when it is printed.

{button Related Topics,PI(`',`RT_Making_Object_Fills_Draw_Faster')}
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To make object fills draw faster

On the View menu, click Show Object Fills to toggle whether object fills show in your drawing.

{button Related Topics,PI(`',`RT_To_make_object_fills_draw_faster')}
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To fill an object with other objects

1 Select the object you want to fill.

2 Click the Style tool .

3 Click the Interior Fill button  or the Line Fill button 

. A menu opens.
4 Point to Object and click Custom. The Fill-Object dialog box opens.

5 Click the object you want to use for the fill.
6 Click Apply. The selected object is filled with repetitions of the object chosen from the gallery in the dialog 

box.
Tips

Object fill patterns automatically increase or decrease in size when you scale (resize) the larger object that
contains the object fill.

If the object fill pattern is all one color (monochrome), its color is the foreground color. To change the 
foreground color, select Foreground, point to a color in the palette, and click the left mouse button. To change the 
background color, select Background, point to a color in the palette, and click the left mouse button.

You can quickly change the foreground and background colors for a monochrome object fill in a selected 
object without using the Fill-Object dialog box. To change the foreground color, select an object fill and click a color 
in the color palette in the Style Ribbon toolbar. To change the background color, press and hold SHIFT and click 
another color in the palette.

{button Related Topics,PI(`',`RT_To_make_object_fills_draw_faster')}



Adding and Removing Object Fills
{button Steps...,PI(`',`HT_Filling_an_Object_with_Other_Objects')}

If you want to create an object fill and use it later, you can save it in the gallery in the Fill-Object dialog box.

{button Related Topics,PI(`',`RT_Adding_and_Removing_Object_Fills')}
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To add an object to the gallery

1 Draw the object to be added to the gallery and select it.
2 On the Edit menu, click Copy to copy the object to the Clipboard.

3 Click the Style tool .

4 Click the Interior Fill button  or the Line Fill button 

. A menu opens.
5 Point to Object and click Custom. The Fill-Object dialog box opens.

6 Click Paste  to paste the object into the gallery.
Tip

You also can remove objects that you have added to the gallery in the Fill-Object dialog box. (You cannot 
remove any of the original object fills that come with Designer.)

{button Related Topics,PI(`',`RT_To_make_object_fills_draw_faster')}



To remove an object from the gallery

1 Click the Style tool  in the Toolbox.

2 Click the Interior Fill button  or the Line Fill button 

. A menu opens.
3 Point to Object and click Custom. The Fill-Object dialog box opens.
4 Click the object fill you want to delete.
5 Click Remove. The object is deleted from the gallery.

{button Related Topics,PI(`',`RT_To_make_object_fills_draw_faster')}



Copying an Object from the Gallery
{button Steps...,PI(`',`HT_Filling_an_Object_with_Other_Objects')}

If necessary, you can copy an object from the gallery and paste it into Designer for editing. This is useful if you 
create an object fill, paste it into the gallery, and then decide to make further changes to it.

{button Related Topics,PI(`',`RT_Copying_an_Object_from_the_Gallery')}
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To copy an object from the gallery

1 Click the Style tool .

2 Click the Interior Fill button  or the Line Fill button 

. A menu opens.
3 Point to Object and click Custom. The Fill-Object dialog box opens.
4 Click the object fill that you want to copy from the gallery.

5 Click the Copy button . The object is copied and pasted into the current page of your document.

{button Related Topics,PI(`',`RT_To_make_object_fills_draw_faster')}



Editing Object Fills
{button Steps...,PI(`',`HT_Filling_an_Object_with_Other_Objects')}

You can create fascinating effects by creating your own unique object fills. You can change the arrangement, flip 
characteristics, rotation, size, and spacing of an object fill. You can add a new object-fill pattern or replace a 
pattern you previously added with a new one. You can even use multiple objects of different shapes.
Note

You cannot replace any of the original object-fill patterns included with Designer.

{button Related Topics,PI(`',`RT_Editing_Object_Fills')}
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To edit object fills

1 Click the Style tool  in the Toolbox.

2 Click the Interior Fill button  or the Line Fill button 

. A menu opens.
3 Point to Object and click Custom. The Fill-Object dialog box opens.
4 Select the pattern that you want to edit from the gallery.
5 Click Edit. The Edit Object Fill dialog box opens.
6 Make your edits (arrangement, flip, rotate, size, and so forth), clicking Preview to see the effects of your 

changes.
7 Click Add to add the edited object fill to the object fill gallery.
8 Double click the Edit Object Fill dialog box's Control menu to close it. You can apply the newly edited pattern 

to any closed object.
Tip

You can click Replace to replace a selected object fill in the gallery.

{button Related Topics,PI(`',`RT_To_make_object_fills_draw_faster')}



Previewing Object Fills
The preview window lets you see the effects of your editing before you add the new object fill to the gallery. You 
can zoom in or out. You must click Preview each time you want to update the preview window.
The zoom ratio is displayed above the preview window. A ratio of 1:1 is actual size (100%), a ratio of 2:1 is twice 
the actual size (200%), and so forth.

{button Related Topics,PI(`',`RT_Previewing_Object_Fills')}
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Arranging Object Fills
You can Center an object, Tile (repeat) by Row, or Tile (repeat) by Column. You must choose one of the tiling 
options to use many of the other features in the Edit Object Fill dialog box. You must choose a Flip option or 
change the value for Stagger % to see a difference between Tile by Row and Tile by Column.

{button Related Topics,PI(`',`RT_Arranging_Object_Fills')}
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Rotating Object Fills
Selecting the Pattern option rotates the whole object-fill pattern; selecting Object rotates each individual object.
The Angle value sets the angle of rotation. You can either enter a value in degrees directly or drag the red needle
in the dial control.
Note

You can use a bitmap in an object fill, but it cannot be rotated.

{button Related Topics,PI(`',`RT_Rotating_Object_Fills')}
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Scaling and Positioning Object Fills
You can change the size of the object by changing the value of Width % and Height %. The default values are 
100%, which is the original size. Changing both these values to 50% makes the object half the original size; 
changing the values to 200% makes the object twice the original size. To scale the object proportionally, change 
Width % and Height % the same amount.
You can adjust the spacing of tiled objects by changing the values for X Spacing % (height) and Y Spacing % 
(width). Entering a negative value causes objects to overlap; entering a positive value creates space between 
objects. A value of zero makes the bounding boxes of the objects flush with one another.
You can pan the entire object fill pattern within the larger object by adjusting the values for X Shift % (height) 
and Y Shift % (width). These values let you control how the fill pattern looks at the edges of the larger object.
Adjusting the Stagger % lets you stagger the position of every other row or column. For example, to illustrate a 
brick wall, you might set the Stagger % to 50.

{button Related Topics,PI(`',`RT_Scaling_and_Positioning_Object_Fills')}
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Flipping Object Fills
To flip objects, you must select either About X (vertical) or About Y (horizontal). This specifies the coordinate axis
about which the objects are flipped.
To flip objects within an object fill pattern, you can select from the following.
Flip Selection Effect
None No flip
All Flip all the objects in the fill
Every Other Flip every other object
Row or Column Flip every other row or column

{button Related Topics,PI(`',`RT_Flipping_Object_Fills')}
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Changing the Color of Object Fills
Selecting either of the options Modify Fill Color or Modify Line Color changes the color of the object to the current
foreground color in the Fill-Object dialog box. If you want to retain all the original colors of an object you are 
adding to the gallery, deselect both Modify Fill Color and Modify Line Color.

{button Related Topics,PI(`',`RT_Changing_the_Color_of_Object_Fills')}
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Masking Objects
{button Steps...,PI(`',`HT_Masking_Objects')}

You can mask an object to the shape of any other object.
You can paste an object or bitmap into another closed or connected object in Designer. The object you paste is 
masked by the other shape. 



To mask an object



To mask an object

1 Select an object that you want to mask.
2 On the Edit menu, click Copy to copy the object to the Clipboard.
3 Select an object that you want to use as a mask outline.
4 On the Object menu, click Paste Inside. A blue edit border appears around the mask-outline object.
5 Press and hold the left mouse button until an outline of the object to be pasted inside appears.
6 Position the object and release the mouse button. A copy of the first object is pasted inside the second one.

{button Related Topics,PI(`',`RT_To_mask_an_object')}



Masking Objects



Filling Several Objects with a Continuous Fill
You can create a continuous fill across several objects that do not touch. All types of fills can span objects, but 
gradients, object fills, and masked objects are the most interesting.

Not connected Connected

When you connect objects with the Connect Closed command, the objects fill with the current color and pattern. 
If you fill a set of connected objects with a gradient, masked object, or object fill, the fill spans the set of 
connected objects, even if the component objects of the overall connected object do not touch. The example 
above shows connected objects filled with a single diagonal gradient.
(For more information on connecting objects, see Grouping Objects.")

{button Related Topics,PI(`',`RT_Filling_Several_Objects_with_a_Continuous_Fill')}
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Copying and Applying Styles
{button Steps...,PI(`',`HT_Copying_and_Applying_Styles')}

Any of the following style attributes, once applied to an object, can be reapplied to other objects.

Both interior and line fill

Fills (solid, image, gradient, hatch, and object)

Line weights, cap and join options, and calligraphic lines

Line ends and line style
If you spend time applying several style attributes to a single object, you may want to apply all of the same 
styles to other objects all at once. To do this, you can use the Copy Style and Apply Style commands.

{button Related Topics,PI(`',`RT_Copying_and_Applying_Styles')}



To copy style attributes from one object to another



Setting Default Styles



To copy style attributes from one object to another

1 Select an object with the style attributes you want to copy.
2 On the Format menu, click Pick Up Object Style.
3 Select the object to which you want to apply the style attributes.
4 On the Format menu, click Apply Object Style. The style attributes are copied from the first object and 

applied to the second object.
Note

If more than one object is selected and the objects have different style attributes, the Pickup Object Style 
command is not available.

{button Related Topics,PI(`',`RT_To_copy_style_attributes_from_one_object_to_another')}
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Setting Default Styles
{button Steps...,PI(`',`HT_Copying_and_Applying_Styles')}

When you set a new default fill or color, the next object you draw will have these style attributes. Designer gives 
you several ways to set default styles.
One way to set a new default fill or line style is to deselect all objects and then choose any fill pattern or line 
style from the Fill dialog box, Line dialog box, or the Style Ribbon toolbar. The default fills and styles for interior 

and line are shown in the status bar (if displayed) and in the Interior Fill button  and the Line Fill button 

 in the Style Ribbon toolbar (when no object is selected).
Tip

If you want to set new default styles based on an existing object, just select the object and click Set 
Default Style on the Format menu. All of the style attributes of the selected object, including interior fills, line fills, 
and line styles, become the new defaults.

{button Related Topics,PI(`',`RT_Setting_Default_Styles')}
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GETHELP.DOC
This is the Getting Help section of Designer 6.0 Help. Designer’s CNT file also contains references to 
some external, global Getting Help topics, and Windows Help on Help is called as a separate Help 
file.



Getting assistance as you work
If you are new to Micrografx Designer

Open the View menu, click Toolbars, and make sure that the Show Tool Tips option is checked and the Hints 
toolbar is turned on.

Tool Tips, displayed near the mouse pointer when you pause on a tool or button, help you relate the tool's 
image to its name.

The Hint toolbar gives a brief description of the tool, button, or menu item you are pointing to. The Hint 
toolbar also displays "Action Hints" as you draw and edit objects Action Hints guide you step-by-step through 
Designer procedures.

If you are not sure what your options are while editing an object, click the right mouse button. A shortcut 
menu appears, containing commands that are available for the current object.

When you want more detailed information

To see more information about a tool or button, point to it and press the Help key (F1). A popup message 
tells you how to use the tool or button. To close the message, click inside it or press the ESC key.

For quick information about a menu item, press the Help key (F1) while the item is highlighted. A popup 
message gives you assistance.To close the message, click inside it or press the ESC key.

When you are using a dialog box

Click the "?" button on the title bar of the dialog box, and then click the item you want information about. To 
close the message, click inside it or press the ESC key.
When a dialog box is active, pressing F1 displays help about the dialog box item that has the focus. To ensure 
that a specific item has the focus, use the Tab key.
If a dialog box doesn't have the "?" button, look for a Help button, or try pressing F1.
When you are viewing Designer's Help windows

The large Designer 6.0 Help window (you're looking at it) contains two "browse" buttons (  and 

). Click those buttons to page backward or forward through a set of closely related topics. (If you 
prefer using the keyboard, press the < and > keys.)
The Designer Steps window appears on the right-hand side of the screen. It displays numbered steps for a specific 
procedure. This window stays in front of other windows so you can perform each step without Designer's window 
covering up the remaining steps.

Tips

To copy the text from a Help window to the Clipboard, drag across the text, and then press CTRL+C.

To close any active Help window, press the ESC key.



Frequently Asked Questions
General    Bitmaps    ClipArt    Clipboard    Designer 3.1    Designer 4.0    Display    Import/Export    OLE    
PageMaker    Palettes    Printing    Objects    Text

General

How do I set new defaults for my objects?
I can't find the icon. How can I run the program?
Why do I get an error message when I start Designer under Windows NT?
How can I select multiple documents to print?
During reshaping, angle information in the status bar does not appear to be correct.
I'd like to know more about PostScript, EPS, and AI.
I want to know more about reducing points.
Clicking the up arrow in the Transform-Move dialog box moves the object down.
My mouse is unsteady. How can I move an object just a little?
The Layer dialog box appears to change the wrong layer.
When I transfer objects to Picture Publisher, I lose the foreground and background colors.
Printer fonts are not WYSIWYG (what you see is what you get).
Why is the estimated file size for a standalone slideshow so large?
Bitmaps

Bitmaps or bitmap fills do not export properly to the Adobe Illustrator (AI) format.
Exporting a bitmap-filled object results in a solid fill.
Why do transparent bitmaps placed in PageMaker display incorrectly?
Why don't bitmaps retain their original size when importing or exporting?
Why do CGM files exported from Designer import into some other applications at a different size?
Why do color bitmaps sometimes print incorrectly to PostScript?
Bitmaps printed to the HP 550C printer do not print correctly.
Bitmaps printed to the HP DeskJet printer repeat the image or are rotated incorrectly.
Some objects filled with bitmap images are not clipping correctly when printed.
When I transfer objects to Picture Publisher, I lose the foreground and background colors.
Why are bitmaps not the same size in CorelDRAW as they were in Designer?
ClipArt

Why don't thumbnails display in the ClipArt Manager after performing a search?
Why does the Reset Transform command move inserted ClipArt to the page origin?
Clipboard

Sometimes I cannot ungroup objects pasted from the Clipboard.
Designer 3.1

How do I add a point quickly while reshaping?
Importing a Designer 3.1 PAL file results in multiple palettes being created.
Why do text sizes differ in Designer 3.1 and Designer 6.0?
After Connecting objects, both Disconnect and Ungroup are available.



My printed bitmaps look    worse than when I printed them using Designer 3.1.
My text exports to DRW as individual lines.
Why do weighted (non-hairline) lines export to DRW as polygons?
My DRW files containing dashed lines with opaque backgrounds lose their opaque background when opened in 
Designer 6.0
Designer 4.0

Some Designer 4.0 drawings that have container text display differently in Designer 6.0.
Why does the position of text along a curve change from Designer 4.0 to Designer 6.0?
How can I merge a multi-page Designer 3.1 file into Designer 6.0?
Display

Printer fonts are not WYSIWYG (what you see is what you get).
My text displays incorrectly with my printer, an HP4.
Import/Export

What happened to the tab settings in the RTF file I imported?
Why do I get an error when I try to import certain WPG files?
Why do my fonts change when I export to Adobe Illustrator (AI) format? 
I'd like to know more about PostScript, EPS, and AI.
Why does importing an EPS file result in a gray box?
I have an EPS file that I cannot import. What can I do?
I cannot select any objects from a file that I imported. What's wrong?
Bitmaps or bitmap-fills do not export properly to the Adobe Illustrator (AI) format.
Why do weighted (non-hairline) lines export to DRW as polygons?
My text exports to DRW as individual lines.
Exporting a bitmap-filled object results in a solid fill.
When I print to a Level 1 PostScript printer, a piece of one corner of a rectangle is missing.
Polylines export with too many points.
What is the limit on the size of a text file I can import?
Why don't bitmaps retain their original size when importing or exporting?
Why do CGM files exported from Designer import into some other applications at a different size?
Why do color bitmaps sometimes print incorrectly to PostScript?
Why do hairlines exported as HPGL appear to be thicker?
Why are bitmaps not the same size in CorelDRAW as they were in Designer?
Why do some images import at full-page size?
OLE

Some OLE objects do not print to PostScript devices.
I want to link a Designer object into Designer. Can I do this?
PageMaker

Why are objects I've placed in PageMaker 5.0 cut off when printing to PostScript?
Why do transparent bitmaps placed in PageMaker display incorrectly?



Palettes

Importing a Designer 3.1 PAL file results in multiple palettes being created.
How do I delete a palette when the Delete option is not available?
Printing

I'd like to know more about PostScript, EPS, and AI.
How can I select multiple documents to print?
Should blank pages in my document print?
Why are objects I've placed in PageMaker 5.0 cut off when printing to PostScript?
Some OLE objects do not print to PostScript devices.
When I print to a Level 1 PostScript printer, a piece of one corner of a rectangle is missing.
Printing to an AutoGrafix device, there is a white line at the top of the 35 mm slide.
Why do color bitmaps sometimes print incorrectly to PostScript?
Bitmaps printed to the HP 550C printer do not print correctly.
Bitmaps printed to the HP DeskJet printer repeat the image or are rotated incorrectly.
When I print to the HP DeskJet, I get extra copies.
When I print to HPPCL or HPPJ printers, sometimes bits of text appear through opaque objects.
My path text does not print correctly to my printer, an HP LaserJet.
My text displays incorrectly with my printer, an HP4.
Gradient fills print incorrectly on my HP4si printer.
Printer fonts are not WYSIWYG (what you see is what you get).
Why does my color text print as black on my PCL printer?
My printed bitmaps look    worse than when I printed them using Designer 3.1
My Bitstream facelift fonts are not displaying or printing correctly.
Some objects filled with bitmap images are not clipping correctly when printed.
Why do hairlines exported as HPGL appear to be thicker?
How do I get vector clipping in an HPGL file with no option in the export setup to do so?
Objects

How do I set new defaults for my objects?
I want to know more about reducing points.
During reshaping, angle information in the status bar does not appear to be correct.
Why does the Reset Transform command move inserted ClipArt to the page origin?
How is the number of points in the Reduce Points dialog box determined?
Why does rotating a dimension line make the length smaller?
Object fill sizing is inconsistent when applied to freeform text.
After Connecting objects, both Disconnect and Ungroup are available.
When I put text on a path, I lose my small capital letters, superscript, and subscript.
When I transfer objects to Picture Publisher, I lose the foreground and background colors.
When proportionally scaling, objects don't always snap to guides.
Why do hairlines exported as HPGL appear to be thicker?



Why can't I select object-filled objects using the Select dialog box in a file I have saved and reloaded?
Why does converting a metafile to curves sometimes change the size?
Clicking the up arrow in the Transform-Move dialog box moves the object down.
My mouse is unsteady. How can I move an object just a little?
How do I add a point quickly while reshaping?
How can I move the pivot point and make it stay?
How can I reset the pivot point to the default after I move it?
How can I resize a hatch-filled object without affecting the fill?
How can I get text to wrap on all four sides of a rectangle?
How can I space text evenly along a path?
Should aligning objects as group in the Align to Page dialog box automatically group the objects?
Sometimes I cannot ungroup objects pasted from the Clipboard.
My DRW files containing dashed lines with opaque backgrounds lose their opaque background when opened in 
Designer 6.0
Text

What happened to the tab settings in the RTF file I imported?
Why are my tab stops being ignored when I press the Tab key?
Why do my fonts change when I export to Adobe Illustrator (AI) format? 
How can I get text to wrap on all four sides of a rectangle?
How can I space text evenly along a path?
Why do text sizes differ in Designer 3.1 and Designer 6.0?
Some Designer 4.0 drawings that have container text display differently in Designer 6.0.
Why does the position of text along a curve change from Designer 4.0 to Designer 6.0?
Why does slanting underline text cause the underline to go away?
What is the limit on the size of a text file I can import?
When I put text on a path, I lose my small capital letters, superscript, and subscript.
The Split Text command causes non-visible text in the container to be lost.
When I flow text between containers, sometimes the text overwrites itself.
Object fill sizing is inconsistent when applied to freeform text.
When I print to HPPCL or HPPJ printers, sometimes bits of text appear through opaque objects.
My Bitstream facelift fonts are not displaying or printing correctly.
My path text does not print correctly to my printer, an HP LaserJet.
My text displays incorrectly with my printer, an HP4.
My text exports to DRW as individual lines.
Should joining text change the size of the font?
I reshaped my text and the "holes'" disappeared. How do I get them back?
When I fit text to a path, it doesn't always exactly center the text.
Can you change or delete redefined custom units?



How do I set defaults for new objects? For example, what if I want all my 
fill colors to be red and all my lines to be blue.
To set new defaults, first make sure nothing is selected (click away from all objects). Then set the defaults you 
want (fill color, line color, style, and width, and so forth). The new defaults remain in effect until you change 
them. To change an individual object, select it and then set its attributes. Another way is to use the right mouse 

button to click the Line Weight button  or Object Fill button 

 on the status bar. The setting becomes the new default for that button.



Why do weighted (non-hairline) lines export to DRW as polygons?
Exporting objects that have weighted (non-hairline) lines to the "DRW -- Micrografx Drawing (mgx)" filter result in
the lines being converted to polygons. Exporting to the "DRW -- Micrografx Drawing" filter correctly retains the 
weighted lines.



Why does importing an EPS file into Designer 6.0 result in a gray box?
EPS files contain PostScript data, which is not translatable by applications. EPS files may contain an optional TIFF 
or WMF header that can be used to view the content of the EPS file. Designer displays a gray box in place of the 
preview data when importing an EPS file that does not contain a preview image. If the EPS file contains a TIFF or 
WMF preview, then Designer displays that preview when the EPS file is imported. Designer imports and 
translates the Adobe Illustrator format of EPS so you can edit it in Designer. For more information, see the 
description of EPS and PostScript.



Bitmaps or bitmap fills do not export properly to the Adobe Illustrator (AI) 
format.
The "AI -- Adobe Illustrator (mgx)" filter does not support exporting bitmaps or bitmap-filled objects, including 
bitmaps that are used to represent hatched fills. Depending on the option selected in the Setup dialog box, 
bitmaps will be exported in one of three possible solid colors: the foreground color of the bitmap, the background
color of the bitmap, or a blend of the foreground and background colors of the bitmap to create a new color.



Exporting a bitmap-filled object results in a solid fill.
Many formats do not support, or do not support well, clipping of bitmap-filled objects. Designer must clip the 
image and reduce the clipped bitmap to a series of scan lines that represent the bitmap fill in order to reproduce 
the object as it appears in Designer. This process results in exported files that may be large and take a long time 
to process. Designer will substitute a solid fill for clipped bitmap fills in these situations.
An override exists if you want to let Designer generate the clipped bitmap fill as a series of scan lines. On the 
Registry tab of the Options dialog box, add the Value Name ClipImageFill to the Translation key, and give it a 
numeric value of 1 to generate the scan-line fill. This process may take a long time and result in a large output 
file.

{button Related Topics,PI(`',`RT_registry_topics')}



When I print to an AutoGrafix device, there is a white line at the top of the 
35 mm slide.
When printing to 35 mm slides, choose a page size of Use Printable rather than 35 mm in the Page Setup dialog 
box. Also, choose Center on Page in the Print Document dialog box.



When I print to a Level 1 PostScript printer, a piece of one corner of a 
rectangle is missing.
This happens when you create an EPS file in Designer and put the EPS image into certain programs. To fix it, on 
the Registry tab of the Options dialog box, add the Value Name EnablePSAdapt to the Mgxgre key, and give it a 
numeric value of 0. Then set the options of the printer driver to EPS. Print. Print to EPS and use the new file.

{button Related Topics,PI(`',`RT_registry_topics')}



During reshaping, angle information displayed in Designer's status bar 
does not appear to be correct.
Designer reports the current mouse position and the change of angle (relative to the original position). When 
reshaping, the status bar shows you how far you have moved the selected points and in what direction.



Bitmaps printed to the HP 550C printer are extremely dark and 
oversaturated, or do not print correctly.
Update to the latest version of the HP 550C driver.



Bitmaps printed to the HP DeskJet printer repeat the image or are rotated 
incorrectly.
Update to the latest version of the HP DeskJet driver.



I'd like to know more about PostScript, EPS, and AI.
What is PostScript? What is EPS and why do there seem to be so many variations? Why can my application edit 
some EPS files and not others? What's the difference between AI and EPS files? How does Designer work with 
EPS files?
These are just a few of the questions people ask when confronted with distinguishing between PostScript, AI, and
EPS. The following descriptions help to explain the differences and how to decide which format is appropriate for 
which use.
PostScript

PostScript is a high level, device independent programming language that is used to describe the appearance of 
text, graphical shapes, and images on displayed or printed pages. Printing or displaying PostScript involves the 
use of a PostScript interpreter written for a specific output device. The interpreter executes the commands in the
PostScript language and converts them to the low level operations understood by the device.
In Windows, a PostScript print stream can be generated by an application printing to a PostScript device driver. 
Either the application or the device driver may generate its own specialized definition of the output pages using 
PostScript commands. The PostScript commands, along with printer-specific information, make up the print 
stream. A PostScript print stream that is saved to a file is a PostScript file, and typically has a PS file extension. A 
PostScript file is intended for output to a specific device, and as such is not editable or suitable for use as a file 
transfer format.
PostScript File Support in Designer

Set the Target Printer to a PostScript device and print to a file. Designer uses its own internal PostScript 
Adaptation Layer to generate the PostScript, which may be disabled to allow the device driver to generate the 
PostScript.
Designer does not read or import a PostScript print file.
Encapsulated PostScript (EPS)

Encapsulated PostScript (EPS) is a file containing PostScript commands that describe a single page. An EPS file 
does not contain printer-specific information. The typical purpose of an EPS file is to be included, or 
encapsulated, into another PostScript page description. Applications import the EPS data into a document, which 
is then output (the original document plus the included EPS data) to a PostScript device. EPS files are not 
editable after they are imported into a document. Applications may manipulate the whole EPS data, to some 
extent, including modifying the size, position, and rotation of the EPS data, but they cannot modify the EPS data 
directly.
Since the application cannot edit the EPS data, the format of the EPS file allows for the inclusion of a preview 
image that an application may use to display the representation of the EPS data. This preview image is usually 
either a Windows Metafile (WMF) or a TIFF bitmap. Applications that do not support Windows Metafile or TIFF 
images usually display a place holder that assists in the placement and manipulation of the EPS data.
In addition to being used to display the representation of the EPS data, the preview may also be used when a 
document is printed to a device that does not support PostScript. An application that creates a document 
containing EPS data and then prints the document to a PostScript device passes the EPS data to the PostScript 
device for printing. If the application prints the document to a device that does not support PostScript, it must 
print the preview instead. A TIFF or Windows Metafile preview will give a more accurate presentation than a 
place holder, although it is usually inferior to the results generated by the EPS data to a PostScript device.
Some PostScript device drivers let you create an EPS file of a PostScript print job. The PostScript driver supplied 
with Windows 95 has this feature. When the option is selected and an application prints to the driver, you are 
prompted for the file name to be used to create the EPS file.
EPS Support in Designer

Designer supports four types of EPS export. Select the desired type in the Export dialog box.

"EPS - Encapsulated PostScript, No Header or Preview" generates a minimum EPS file.

"EPS - Encapsulated PostScript, No Preview" generates an EPS file with a header but no preview.

"EPS - Encapsulated PostScript, TIFF Preview" generates an EPS file with a TIFF preview.

"EPS - Encapsulated PostScript, WMF Preview" generates an EPS file with a WMF preview.
Designer does not fully support importing EPS files. The preview data is imported, but the EPS data is ignored. 



Importing an EPS file that does not have a preview displays a gray-filled rectangle of the same size as the EPS 
data. Importing an EPS file with a TIFF or WMF header displays only the preview data. Select the "EPS - Adobe 
Illustrator EPS" filter in the Import dialog box to import an EPS file.
Adobe Illustrator

An Adobe Illustrator file (AI) is an EPS file that conforms to the language restrictions defined and published by 
Adobe for use as a file data transfer format. It is the native file format for Adobe Illustrator and has an AI file 
extension. Unlike other PostScript files that require device interpreters, the AI file does not contain custom 
extensions: It is a defined set of operators that can be translated into other page and graphical primitives. 
Applications can read and write the file format just like any other file data transfer format. Like other file formats,
different release versions exist. Applications must ensure that they are compatible with the format version 
specified in the file.
Since it is an EPS file, an AI file also may contain the preview header. Applications that do not choose to support 
the AI file format primitives directly may elect to import the preview instead. Applications that do support the AI 
file format can edit the data that is contained in the file after it is imported.
AI files are sometimes called Adobe Illustrator EPS files, or AI/EPS files, and have an EPS extension. Most clip art 
packages that offer EPS files are AI files with TIFF previews and have the EPS extension. Applications can import 
and edit these EPS files, unlike other EPS files, because they conform to the AI language restrictions and can be 
parsed and translated. EPS files that do not conform to the AI language restrictions are not AI files and cannot be
edited, only incorporated into a document.
AI Support in Designer

Designer supports importing and exporting the AI file format. Imported AI files are translated and the EPS data 
can be edited in Designer. 
When importing files with the AI extension, select the "Adobe Illustrator AI" filter only if you need to edit the 
image. If you don’t need to edit the image, specify the "Adobe Illustrator EPS" filter. This gives you the highest 
compatibility with service bureaus that print PostScript documents.
When importing files with the EPS extension that you know are AI files, select the "Adobe Illustrator EPS" filter.
When exporting to an EPS file that will be printed by a service bureau, use one of the “Encapsulated PostScript” 
filters rather than the “Adobe Illustrator AI” or ”Adobe Illustrator EPS” filter.
Darkening or lightening printed RGB bitmaps

When you print to an EPS file from Designer, you can darken or lighten RGB bitmaps in the document by setting 
a key value in your registry.
To set the value from within Designer, on the Registry tab of the Options dialog box, add the Value Name 
EnableCMYKBlackOpt to the Mgxgre key, and give it a numeric value of 0 or 1.

For lighter RGB bitmaps, set the value to 0.

For darker RGB bitmaps, set the value to 1.

{button Related Topics,PI(`',`RT_registry_topics')}



Why does slanting underline text cause the underline to go away?
Some effects applied to text, such as slanting or warping, are too complicated to be rendered by Windows or 
ATM. Designer converts the text to curves before displaying it, causing the underline to be lost. Since Windows 
can only render TrueType and Type 1 fonts as solid single color, text that has an edge color different from the fill 
color and text that has a complex fill also are converted to curves.



Why is the estimated file size for a standalone slideshow so large?
The value shown is the uncompressed size and should be considered the maximum size required. The actual size
will vary based on the content of the slides.



Why does the Reset Transform command move inserted ClipArt to the 
page origin?
The Reset Transform command removes all transformations applied to an object since its original defined 
location. When inserted, ClipArt is defined to be at the page origin and is translated to the location where you 
place it.



The Split Text command causes non-visible text in the container to be lost.
The Split Text command is intended to make generating individual text labels easy. In order to convert all text 
lines to labels, first resize the text container so that all text is visible.



How is the number of points in the Reduce Points dialog box determined?
In the Reduce Points dialog box, the number of points that may be removed from an object is based on a 
tolerance that varies based on the size of the object. For example, start with two identical objects and reduce the
size of one of those objects. The number of points that can be removed from the reduced object is larger than 
that other object because the distance or tolerance between the points in the reduced object is smaller.



When I flow text between containers, sometimes the text overwrites itself.
The shape is only used as a template to create a text container. The text container and the shape are two 
different objects. To see this, draw two rectangles and select the first one as a container for text. Enter text until 
the text overflows, then press F2 to select everything. Notice that three items are selected; two rectangles and 
one text block. The rectangle is still a separate block so that when you reflow text it is again used as a template 
for the next block, drawing right in front of the first one.



Why does rotating a dimension line make the length smaller?
This is correct behavior for a dimensioning object. When you transform (move, scale, rotate, skew, and so forth) 
a dimensioning object, you are only transforming the points about which the dimensioning object is defined. 
Consequently, when you rotate the horizontal dimension line, you are, in effect, rotation the imaginary line 
measured. As you rotate this line, its horizontal component changes.



Can you change or delete redefined custom units?
Designer has a set of redefined custom unit that it places in every file it creates. These custom units can be 
changed and even deleted from both the file and Designer's profile. New files will, however, always contain the 
original custom units.



Importing a Designer 3.1 PAL file results in multiple palettes being 
created.
A Designer 3.1 palette file (PAL) can contain multiple palette definitions and is imported into separate Designer 
6.0 palettes so you do not lose any of the colors in the original palette.



Object fill sizing is inconsistent when applied to freeform text.
To understand what is occurring it is necessary to look at how object fills work. Before displaying, an object fill is 
transformed using the same transform as the object being filled. This allows the object fill to maintain the same 
size relative to the filled object. For example, suppose you fill a square with the star object fill and it takes only 
five stars to fill the square. If you resize the square, the object fill is also resized so that the same five stars fill 
the square. Filling freeform text with an object fill works exactly the same way. The difference is that the size of 
freeform text can be changed in two ways, one of which applies a transformation and one that does not. Resizing
the text by dragging one of its boundary handles causes a transformation to be applied to the text. In this case, 
the object fill is resized with the text object. Enlarging or reducing the font size using the font size spinner on the 
Text ribbon does not apply a transformation, so in that case the object fill does not change size. You can tell if a 
transformation has been applied to a selected object by looking for a T in a red box in the two-line status bar.



Printer fonts are not WYSIWYG (what you see is what you get).
Since a printer font may not have a close on-screen representation, all printer fonts are mapped to a single font 
for consistent on screen display. The default font used is Arial. 
You can change the default by modifying an entry in your system registry. On the Registry tab of the Options 
dialog box, add the Value Name DefaultFont to the Mgxgre key, and set its value to the name of the font you 
want to use (for example, Times New Roman).
Independent of the font selected for screen display, the text will print correctly if the target printer supports the 
fonts.
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Why do text sizes differ in Designer 3.1 and Designer 6.0?
The "dot" fonts used by earlier versions of Designer (such as Swiss) are no longer supported. TrueType and Type 
1 equivalent fonts have been created for use in Designer 6.0. There are slight differences between Designer 3.1's
rendering of dot fonts and that of Windows and ATM. To compensate for these differences, a table of variations 
was introduced into the MGX.INI file. This table is used to slightly resize fonts when DRW files are read into 
Designer 6.0. All previous Designer file formats were tested and best fit values were created for use in 
converting Designer 3.x fonts to Type 1 and TrueType fonts.



Some Designer 4.0 drawings that have container text display differently in 
Designer 6.0. What has changed?
In Designer 4.0, container text behaved differently from all other types of text when transformed (rotated, 
scaled, and so forth). The container was transformed and the text reflowed in the new container using the 
original point size. While this is a common implementation that is found in many page layout applications, many 
Designer users found this inconsistent and confusing. In Designer 6.0, all text types are transformed the same 
way. If text is flowed or entered into a transformed container, the text is also transformed. Note: If un-
transformed text is desired, convert the container to curves to normalize the container's transformation before 
inserting text.



After Connecting closed two objects, both Disconnect and Ungroup are 
available in the Change menu.
Are the objects grouped as well as connected?
No. In Designer 3.1 the SHIFT+F5 shortcut chose the Break Apart menu command. This single command would 
both ungroup grouped objects and disconnect connected open or closed objects. This was added as a 
convenience for Designer 3.1 users.



When I print to HPPCL or HPPJ printers, sometimes bits of text appear 
through opaque objects. How can I get correct output?
For HPPCL printers select the Print TrueType as graphics option in the options dialog box of the printer driver 
setup dialog box.



I want to link a Designer object into Designer. Can I do this?
No.



How can I merge a multi-page DS4 file into Designer 6.0?
Multi-page DS4 import is not supported. However, you can open both files and cut and paste objects from one 
file to another.



When I print to the HP DeskJet, I get extra copies.
Some printer drivers do not support the ExtDeviceMode command. If a driver does, and you requests 
multiple print copies, then Designer spools one copy and tells the driver to print multiple copies. If the 
driver does not support ExtDeviceMode, then Designer must print multiple copies itself, which takes 
longer.



When I put text on a path, I lose my small capital letters, superscript, and 
subscript.
Small caps, superscript, and subscript do not work with path text. They are changed to normal text.



My printed bitmaps look worse than when I printed them using Designer 
3.1
You can use an entry in your system registry to fix the problem.
On the Registry tab of the Options dialog box, add the Value Name UseGDIForBLTPrinting to the Mgxgre 
key, and give it a numeric value of 1.
This setting causes the GDI to be used to dither printed images. The default value of 0 causes the internal
bitmap code to do the dithering itself. GDI dithering produces the same results as Designer 3.1 bitmap 
printing. This setting only applies to bitmaps printed through GDI and does not affect either screen or 
Postscript output. 
In Designer 4.0, bitmaps imported from Designer 3.1 could look quite bad on screen when running with a 
256-color display. This was because bitmaps imported from DRW files came in as VBMs, one of Designer's
bitmap formats. VBMs display poorly on palette-based 256-color devices. To remedy this problem, 
Designer now converts bitmaps coming from Designer 3.1 to Frames, another internal bitmap type.



My Bitstream facelift fonts are not displaying or printing correctly.
Bitstream Facelift is a font technology, like TrueType or ATM. While that technological difference may be 
irrelevant to some Windows applications, drawing programs such as Designer that manipulate fonts at a 
low level need to explicitly support the technology to work fully. Designer does not.
Facelift can be used in a limited way within Designer, though. On the Registry tab of the Options dialog 
box, add the Value Name DontFilterDeviceFonts to the Mgxgre key, and give it a numeric value of 1.
This setting causes Designer to bypass its usual checking of device fonts (and substitution of a default 
font, usually Arial) and select a font. With the option set to 1, Facelift fonts appear correctly on-screen and
when printing. Any printer device fonts are mapped by Windows to a screen font, often an unattractive-
when-resized bitmap one. It works pretty well if you set the option to 1 and stick to TrueType, ATM, and 
Facelift fonts.
The facelift fonts are still recognized as and treated like device fonts, though, so support for them is far 
from complete. Converting them to curves turns them into Arial. So does any implicit convert-to-curves, 
such as rendering with an edge or fill, some non-proportional resizing, and various other operations.
Another issue to worry about is Facelift's Printer Shell Drivers. To have the Facelift fonts available for a 
given printer, you set it up so that your normal printer drivers are replaced by SHELLPRT, Facelift's shell. 
The shell then passes printer commands to the actual driver. One side effect of this is that it defeats 
Designer's normal detection of whether a printer is Postscript. Therefore, Designer will not use its 
PostScript adaptation layer.
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Some objects filled with bitmap images are not clipping correctly when 
printed.
This occurs when printing to the IBM/Lexmark WinWriter 600 using the Microsoft Windows Printing 
System. When an object containing an image is printed, the image prints beyond the object's borders. 
The Printer's driver appears to be reporting its capabilities incorrectly. Contact Lexmark for a fixed driver.



When I transfer objects from Designer to Picture Publisher using Copy and 
Paste, I lose the foreground and background colors.
The colors are not applied to the bitmap itself: They are saved as foreground and background attributes. 
The transition into Picture Publisher does take these attributes into account to some extent. If the 
foreground color is black, then the monochrome bitmap comes into Picture Publisher as black on white. If 
the foreground color is not black, then the monochrome bitmap comes into Picture Publisher inverted 
(white on black).



My path text does not print correctly to my printer, an HP LaserJet 4Si/4Si 
MX Driver.
The symptom is that some of the characters of a text-along-a-curve string are either too high or too low. 
Printing to Postscript, or using the "Print True Type as Graphics" driver option fixes it.



I want to know more about reducing points.
The algorithm works by specifying a tolerance with which to approximate the polyshape. When parts of 
the curve slip under that tolerance, then there will be fewer points in general, but sometimes lessening 
the tolerance actually adds a few points. The overall behavior is a reduction in points as the tolerance 
increases, but it is not a perfectly predictable or smooth process.



My text exports to DRW as individual lines.
A text block (container) exported to DRW -- or any other vector format -- exports as individual text lines, 
not as an entire text block.



Gradient fills print incorrectly on my HP4si printer.

Gradient fills can print incorrectly on the HP4si when you use the HP4si    PCL driver and a high resolution.

To solve the problem

Use the HP4si    PostScript driver          
or
Switch to the HP3si    PCL driver 



My text displays incorrectly with my printer, an HP4.
With the HP4 PCL driver set to 600 dpi, checking and unchecking the "Print TrueType as Graphics" option 
in the driver causes Designer to display text slightly misplaced. This effect is base on the text metrics 
returned from the printer driver and does not affect printing, only display.
Selecting the "Print TrueType as Graphics" option ensures that text displays and prints the same.
Note: The "Print TrueType as Graphics" option is in the printer driver's Options dialog box and cannot be 
selected unless the "Graphics Mode" is set to "Raster."



When proportionally scaling, wide objects don't snap to horizontal guides 
and tall objects don't snap to vertical guides.
Proportional resize of tall objects only snaps to horizontal guides (the horizontal component of the 
object's size box is calculated based on the vertical size). Likewise, proportional resize of wide objects 
only snaps to vertical guides (the vertical component is calculated based on the horizontal size).



Polylines export with too many points.
You can change this behavior with an entry in your system registry.
The entry sets an abstract tolerance factor that removes excess points from a polyline based on the 
distance and colinearity between points. The default is 4. The larger the number, the more points are 
removed and the fewer points remain in the polyline.
On the Registry tab of the Options dialog box, add the Value Name ExportPointReductionFactor to the 
Translation key, and give it a numeric value between 1 and 10.
Depending on the capabilities of the file format and/or filter, certain objects must be represented as 
polylines instead of Bézier curves. More points must be maintained for visual fidelity.
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Why are the Designer objects that I've placed into PageMaker 5.0 getting 
cut off when printing to a PostScript device?
This problem only happens when you are using a full-page graphic. This is a known PageMaker 5.0 bug and occurs with any 
vector graphic imported into PageMaker, not just Designer's. The workaround suggested by Aldus Technical Support is:

1 Install a driver for a printer that is capable of printing at a resolution higher than 1500 dpi, such as the 
Linotronic 330 and connect it to the port to which your printer is connected.

2 In the PageMaker Page Setup dialog box (File/Page Setup), choose this printer as the target printer and select 
a resolution higher than 1500 dpi.

3 Print the page.
Limitations: This workaround limits the ability to choose different paper trays and other printer-specific options.
Another workaround is to use a PCL driver instead of PostScript if you are printing to an HP printer.



Why do transparent bitmaps placed into PageMaker from Designer display 
incorrectly in Normal Graphics mode?
In Normal Mode, PageMaker displays a metafile. Windows metafiles do not support transparent bitmaps. The workaround is to 
select High Graphics Mode in PageMaker preferences. 



Why do hairlines exported as HPGL appear to be thicker?
This is because the default pen nib width for HPGL plotters is used for the hairline width. This is correct behavior.



What is the limit on the size of a text file I can import?
Importing text in a text block is limited to files that have less than 10,000 characters. Text is truncated after that.



Why don't thumbnails display in the ClipArt Manager after performing a 
search?
Because the Search Results subject is created dynamically, thumbnails are not able to be displayed.



How do I get vector clipping in an HPGL file when there is no option in the 
export setup to do so?
Load an HPGL driver and print to a file.



Why can't I select object-filled objects using the Select dialog box in a file I
have saved and reloaded?
The Select by Interior Fill in the Select dialog box is valid for object-filled objects in the current Designer session only. After 
the file is reloaded, the object fills have moved in memory and are not selectable by the Interior Fill option.



Why does converting a metafile to curves sometimes change the size?
When Designer interprets a metafile and converts it to Designer objects, it uses the bounds stored in the metafile to determine 
the size of the objects. If the application that created the metafile incorrectly stored the bounds, the objects may change in size 
when they are converted to Designer objects (converted to curves).



Clicking the up arrow in the vertical movement field of the Transform-Move
dialog box moves the object down.
Why doesn't it go up?

An increasing value in the spinner matches increasing numbers down the ruler. The spinners do not transform the object up or 
down the page; they increase or decrease the number.



How can I select multiple documents to print?
In the Print Multiple Files dialog box, hold down the CTRL key as you click each document.

Note

Due to a current program limitation, files printed in this manner do not print their master page.



Why don't GIF, PCX, and TGA bitmaps retain their original size when 
importing or exporting?
The GIF, PCX, and TGA filters do not understand the concept of the DPI setting. To them a bit is just a little square with no 
specific size. That means that the bitmap will appear larger or smaller when displayed on a lower resolution device or a higher 
resolution device. Some programs, such as Picture Publisher, assume that these files were created at 75 dpi. When importing 
one of these files, Designer assumes that it was created at the current screen resolution and will resize the bitmap according to 
that assumption. For example, if you are running SuperVGA mode (800 x 600), Designer resizes the bitmap as though there 
were 96 pixels per inch.

When exporting to one of these formats, set the desired resolution, using the Setup dialog box. If another application reads GIF, 
PCX, and TGA files created by Designer and assumes that they were created at 75 dpi, then the bitmap may appear larger than 
it does in Designer.



Why are JPG bitmaps not the same size in CorelDRAW as they were in 
Designer?
CorelDRAW ignores the dpi field in the file when importing JPG.



Why do CGM files exported from Designer import into some other 
applications at a different size?
Designer exports metric, that is, with a scale factor. Some applications use an abstract scale.



Should blank pages in my document print?
No. Pages that do not contain objects should not print. Designer does not currently have any word processing features such as 
page numbers, headers, footers, and so forth, so you can just insert a blank piece of paper, if needed. Designer does print blank 
tiles that result from a tiling operation.

Note

When printing tiled output (Designer's page is larger than the printer's page), blank pages do print. That 
way you can paste all the pages together to create a single large document.



My mouse is unsteady. How can I move an object just a little?
There are some keyboard sequences you may find handy.

The SPACEBAR acts like the left mouse button. You can tap to click, hold to press, or tap twice quickly to 
double click.

The ARROW KEYS move the cursor one dot at a time. Zoom in and out to have more or less precision.

The 2 key at the top of the keyboard opens the shortcut menu.
All the constraint keys (such as CTRL and SHIFT) can be used with these keys just as if you were using a mouse.



How do I add a point quickly while reshaping? Shift+hold does not work as 
it did in Designer 3.1.
Shift+click adds a point during point or curve reshaping.



How can I move the pivot point and make it stay?
Use Shift+drag to move the pivot point and make it stay.



How can I reset the pivot point to the default after I move it?
In the Options-Rulers/Snap dialog box, select Center Snap Points. Select the object. Turn on snap points (CTRL+F7). Hold 
SHIFT and drag the pivot point to the center.



How can I resize a hatch-filled object without affecting the fill?
Choose the Convert to Curves command after resizing the object. This can be done as many times as needed.



Should joining text change the size of the font?
When text is joined, all text objects joined will inherit the transformation, if any, of the first text object.



Why does text along a curve change when I save a Designer 4.0 file in 
Designer 6.0 and then open the file in Designer 4.0?
There were several problems with Designer 4.0's placement of text along a curve. In fact, saving and reopening a file in Designer
4.0 would sometimes cause the text to shift position. Attempts have been made to recreate the Designer 4.0 anomalies when 
Designer 6.0 saves Designer 4.0 compatible files. However, priority has been given to the display of Designer 4.0 files in 
Designer 6.0.



How can I get text to wrap on all four sides of a rectangle?
The basic implementation of text along a curve is to wrap text along each side of a polygon and to continue in a straight line after
the polygon sides are exhausted. Text unwrapping from a rectangle is a side effect of that. If you move the alignment point to the 
top line of the rectangle (only a slight movement is required), the text should wrap correctly.



How can I space text evenly along a path?
Designer 6.0 does not perform this operation. Text is a single object. In order to space it evenly, it is necessary to adjust the 
character and/or word spacing, or possibly the character widths.

Note

You can convert the text to curves and then use the Align To Path dialog box to space the characters evenly along a path. 
However, after converting the text to curves, you will no longer be able to edit the text (correct typographical errors, change fonts, 
and so forth).



Should aligning objects as group in the Align to Page dialog box 
automatically group the objects?
No. The purpose of the Align Objects as Group option is not to group the objects, but to treat them like a group during the 
alignment.



I reshaped my text and the "holes" disappeared. How do I get them back?
When a letter such as an A is reshaped, it is converted to curves and becomes two shapes. You can regain the original "holes" 
by Connecting Closed (F11) the two new shapes.



Sometimes I cannot ungroup objects pasted from the Clipboard. Why is 
this?
Check the two-line status bar to see what kind of object was pasted.

If the object is an OLE object, Designer cannot edit the object. Use Paste Special and choose Picture to paste an object 
Designer can edit.

The object may be a picture (Windows metafile). Metafiles pasted from the Clipboard must be decomposed by 
using the Convert to Curves command before you can edit the objects. Then they can be ungrouped and 
edited.



The Layer dialog box appears to change the wrong layer.
Note that Designer automatically names layers as they are added. Create a new drawing and add a few layers. Now go to the 
layers dialog and start moving the layers (using the up and down arrow keys). Notice that unnamed layers are renamed to reflect
their new position when they are moved.



How do I delete a palette when the Delete option is not available?
Designer does not allow you to delete the current or active palette. Select another palette to make it active. Then you can delete 
the nonactive palette.



When I fit text to a path, it doesn't always exactly center the text.
The Change/Align/Text to Path command enters an interactive text placement mode. The text is initially placed on the curve 
centered about the point on the curve that is nearest the top middle selection handle. To automatically place the text, choose one
of the predefined positions in the Text ribbon's Path Fit button.



Some OLE objects do not print to PostScript devices.
Designer 6.0 has certain restrictions processing files that contain embedded or linked OLE objects that were created in Designer 
3.1, Windows Draw, and Charisma 2.1. Due to limitations in the implementation of these OLE objects, Designer 6.0 cannot print 
these objects to a PostScript device or export them to another file format. Designer 6.0 can print these objects to a PCL device. 
There are two workarounds for preserving the appearance of the OLE data and enabling Designer 6.0 to print to PostScript or 
export the data.

Copy the OLE object to the Clipboard from Designer 6.0. Select Paste Special and paste in as a DIB or 
bitmap.

or

Double click the OLE object from Designer 6.0 to launch the original application. From that application, 
copy all the data to the Clipboard. Close the original application. Select Paste Special in Designer 6.0 and paste the 
data as a picture, DIB, or bitmap.



My DRW files containing dashed lines with opaque backgrounds lose their 
opaque background when opened in Designer 6.0
Designer 6.0 does not support opaque backgrounds for styled lines. Opening or importing a DRW file that contains styled lines 
with opaque backgrounds results in the loss of the background color. The styled lines are read correctly.



Why do color bitmaps sometimes print incorrectly to PostScript?
There are two things to do if your color bitmaps don't print correctly to PostScript.
1 Use the PSCRIPT driver instead of the Adobe PostScript driver.
2 On the Registry tab of the Options dialog box, add the Value Name UseAlternateBlt to the Mgxgre key, and 

give it a numeric value of 1.

{button Related Topics,PI(`',`RT_registry_topics')}



Why do weighted (non-hairline) lines export to DRW as polygons?
Exporting objects that have weighted (non-hairline) lines to the "DRW -- Micrografx Drawing (mgx)" filter result in
the lines being converted to polygons. Exporting to the "DRW -- Micrografx Drawing" filter correctly retains the 
weighted lines.



Bitmaps or bitmap fills do not export properly to the Adobe Illustrator (AI) 
format.
The "AI -- Adobe Illustrator (mgx)" filter does not support exporting bitmaps or bitmap-filled objects, including 
bitmaps that are used to represent hatched fills. Depending on the option selected in the Setup dialog box, 
bitmaps will be exported in one of three possible solid colors: the foreground color of the bitmap, the background
color of the bitmap, or a blend of the foreground and background colors of the bitmap to create a new color.



My text exports to DRW as individual lines.

A text block (container) exported to DRW or any other vector format

exports as individual text lines, not as an entire text block.



Why do some images import at full-page size?
Any import that reports an abstract scale is scaled to fit the page. Images with a metric scale import at actual 
size.



I have an EPS file that I cannot import. What can I do?
The file might not be a "pure" EPS file. That is, it might contain binary characters instead of all text (ASCII) 
characters.
Try renaming the file so that its file extension is PS instead of EPS, and then import it using the PostScript filter.



I cannot select any objects from a file I imported. What's wrong?
If the objects show on the screen, but you cannot select them, the objects might be on a different layer than the 
current layer. For example, if all the objects were in Layer 2 when the file was saved, but Layer 1 is the current 
layer, you probably cannot select the objects.
To select objects that are not in the current layer
1 Click the current-layer button at the bottom of the document window, and click Layers on the menu that pops

up.
2 In the Layers dialog box, click Edit All Layers. You should now be able to select the imported objects.



Why does my color text print as black on my PCL printer?
All colors of text print as black text on all PCL devices. Many Windows GDI printer drivers can only print color text
in full intensity colors: white, black, red, green, blue, cyan, magenta, and yellow. To print color text in grayscale 
or to print text in a color other than these eight colors, you must first convert the text to curves.
For printing from within Designer, you can create an entry in your system registry that tells Designer to convert 
all color text to curves during printing. This feature does not alter your document--only the output to the printer.
On the Registry tab of the Options dialog box, add the Value Name PrintColorTextAsCurves to the Mgxgre 
key, and give it a numeric value of 1. When you print from Designer, your color text will be converted to 
curves automatically. To disable the automatic conversion, change the value to 0.
If you want to paste the drawing into another program and print from that program, you must first convert the 
text to curves manually.
Note

This fix works only with TrueType and Adobe Type 1 fonts; it does not work with printer fonts.

{button Related Topics,PI(`',`RT_registry_topics')}



Why do I get an error message when I start Designer under Windows NT?
If you install Designer on a network for use with Windows 95 workstations and then run the network copy on 
Windows NT workstations, NT users may see an Entry Point not Found error message. The error occurs during 
Designer startup.
If only NT workstations need to use Designer from the network, you can eliminate the error message by deleting 
the two files ATM32.DLL and ATM16.DLL. These files reside in the same directory as the Designer .EXE file.
If a combination of Windows 95 and NT users run the network copy, the NT users must ignore the error message.



Why do my fonts change when I export to Adobe Illustrator (AI) format?
The export filter for AI files converts font names in your text objects according to a predefined set of font names. 
If you use a font that is not in the predefined set, the font name is converted.



Why are my tab stops being ignored when I press the Tab key?
When a text block contains line wraps and only has a few tabstops set, it is possible to have tabstops that have a
zero width.
To correct this problem
1 Select the block of text.
2 Note the width of the selected block (shown as W on the status bar).
3 On the Format menu, click Tabstops.
4 Add a tab stop that is at least as wide as the text block.
5 Click Apply.



Why do I get an error when I try to import certain WPG files?
Some WPG files cause the import filter to fail with the message "Unable to read import file." Try using the file in a
different program to see if it has become corrupted.



What happened to the tab settings in the RTF file I imported?
The RTF import filter in Designer 6.0 does not import all tab settings in an RTF file.
Make sure the container for the imported text is wide enough for the tabbed material. If the container is wide 
enough but the tab settings are missing or incorrect, highlight the text with the missing tab settings and use the 
Tab Stops panel of the Text Attributes dialog box to add the tab stops you need.



How do I play an OLE sound object during a slideshow?
Single click is used to execute OLE objects during a slideshow.



Registry settings



Selecting Objects
{button Steps...,PI(`',`HT_Selecting_an_Object')}

Designer offers you many ways to edit, transform, and reshape objects. You can select, copy, paste, resize, 
group, connect, and align objects, as well as link and embed Windows OLE objects.
When you want to apply any action to an object, you first must select it. Eight small blue boxes called handles 
appear around an object when it is selected (if the object is a line, only two handles appear; one at each end). If 
several objects are selected at once, outer handles appear surrounding all the selected objects.

Designer gives you four ways to select objects:

Click to select

Select all

Block select

Select by property.
Tip

Watch the handles! They can help you determine if you've selected the correct object when there are 
many objects in one area. You also can use the status toolbar to help determine if you've selected the correct 
object. The status toolbar shows the shape selected, such as Rectangle, Line, Ellipse, Polygon, and so on.

{button Related Topics,PI(`',`RT_Selecting_an_Object')}



To select an object by clicking it
To select objects by attribute
To select objects by property value



Clicking to Select Objects
Selecting Overlapping Objects
Deselecting Objects
Other Clicking Actions
Implied Selection
Block Selecting Objects
Selecting All Objects
Selecting by Name or Physical Characteristic
Copying and Pasting Objects
Resizing Manually
Grouping Objects
Connecting Objects
Linking OLE Objects



Clicking to Select Objects
{button Steps...,PI(`',`HT_Selecting_an_Object')}

When you want to click to select objects, you must be in select mode. You are in select mode when the pointer 
becomes a select pointer. There are two ways to enter select mode.

Click the Edit tool 

, and then click the Select button 
 in the ribbon.

or

Double click the left mouse button away from all objects. When you finish selecting, you can double click 
again to return to the previous mode.

The Select pointer A drawing pointer

{button Related Topics,PI(`',`RT_Clicking_to_Select_Objects')}



Selecting Overlapping Objects
Deselecting Objects
Other Clicking Actions
Implied Selection
Block Selecting Objects
Selecting All Objects
Selecting by Name or Physical Characteristic
Selecting an Object



To select an object by clicking it

To select an object, point to it with the tip of the select pointer and click the left mouse button.
Tips

You must point to an element of the object such as a line or color. For example, to select an unfilled circle, 
you point and click the edge of the circle, not the hollow interior. If the interior is filled, you can click anywhere in 
the interior to select the object. 

If you are in a drawing mode, you can point to the object with a drawing pointer and double click to select 
it. The blue handles appear to indicate that the object is selected.

Single clicking an object in drawing mode results in implied selection of the object, indicated by a hollow 
selection handle.

To select additional objects, press and hold CTRL and click the other objects that you want to include.

Be careful not to move the pointer while clicking or you'll move the object.

{button Related Topics,PI(`',`RT_To_select_objects_by_attribute')}



Selecting Overlapping Objects
{button Steps...,PI(`',`HT_Selecting_an_Object')}

You can select overlapping objects by pressing ALT while clicking. Each click selects an object deeper in the 
stack, starting with the object in front. (See Input Options for information on changing the left mouse button's 
function.)
Tip

Using ALT forces Designer to avoid the rotate/skew mode when you click an already-selected object. It also 
lets you click anywhere inside an unfilled object to select it.

{button Related Topics,PI(`',`RT_Selecting_Overlapping_Objects')}



Clicking to Select Objects
Deselecting Objects
Other Clicking Actions
Implied Selection
Block Selecting Objects
Selecting All Objects
Selecting by Name or Physical Characteristic
Selecting an Object



Deselecting Objects
{button Steps...,PI(`',`HT_Selecting_an_Object')}

Click the left mouse button anywhere away from all objects to deselect all selected objects. If you want to 
deselect some objects, but not others, point to the object you want to deselect, press and hold SHIFT, and click 
the left mouse button. Point to another object to deselect and click again. Release SHIFT when you finish.

{button Related Topics,PI(`',`RT_Deselecting_Objects')}



Clicking to Select Objects
Selecting Overlapping Objects
Other Clicking Actions
Implied Selection
Block Selecting Objects
Selecting All Objects
Selecting by Name or Physical Characteristic
Selecting an Object



Other Clicking Actions
{button Steps...,PI(`',`HT_Selecting_an_Object')}

Click an already-selected object with the select pointer to place it in rotate/skew mode (see Rotating Manually 
and Skewing Manually for more information). Rotate/skew selection is indicated by the appearance of special 
rotate and skew handles.

Double click an object with the select pointer to place it in reshape mode (see Introduction to Reshaping for more 
information). Different types of objects have different reshaping indicators.

Tip

To be certain that you have the correct selection mode, check the double-line status toolbar. If the object is
selected for Rotate/Skew, the double line status toolbar shows Rotate and Skew Mode. If the object is selected for 
reshaping, the status toolbar shows the reshape mode. To turn on the status toolbar, click Status Bar on the View 
menu, and click Double.

{button Related Topics,PI(`',`RT_Other_Clicking_Actions')}



Clicking to Select Objects
Selecting Overlapping Objects
Deselecting Objects
Implied Selection
Block Selecting Objects
Selecting All Objects
Selecting by Name or Physical Characteristic
Selecting an Object



Implied Selection
{button Steps...,PI(`',`HT_Selecting_an_Object')}

You can change an object's interior fill, line style, or other style attribute immediately after drawing it without 
explicitly selecting it. Remembering the last drawn object is called implied selection.
Implicitly selected closed objects have one hollow handle. Implicitly selected open objects have a hollow handle 
at each endpoint.

Tips

Single clicking on an object when you're in drawing mode also implicitly selects the object.

Implicitly selected objects cannot be resized or rotated without first selecting them. Click away from the 
object to deselect it. Click the Edit tool 

 or double click the object to explicitly select it.

{button Related Topics,PI(`',`RT_Implied_Selection')}



Clicking to Select Objects
Selecting Overlapping Objects
Deselecting Objects
Other Clicking Actions
Block Selecting Objects
Selecting All Objects
Selecting by Name or Physical Characteristic
Selecting an Object



Block-Selecting Objects
{button Steps...,PI(`',`HT_Selecting_an_Object')}

You can select objects by using the select pointer to drag a rectangular block around the objects you want to 
select. To block select, you must be in edit mode (see Clicking to Select Objects).

Tips

The entire object must be enclosed in the rectangular block before that object is selected.

You can cancel a block selection by pressing ESC before relaeasing the mouse button.

Check the Status Bar to determine how many objects you have block selected. If you have selected 10 
objects, for example, the status toolbar shows Objects (10).

{button Related Topics,PI(`',`RT_Block_Selecting_Objects')}



Clicking to Select Objects
Selecting Overlapping Objects
Deselecting Objects
Other Clicking Actions
Implied Selection
Selecting All Objects
Selecting by Name or Physical Characteristic
Selecting an Object



Selecting All Objects
{button Steps...,PI(`',`HT_Selecting_an_Object')}

Use any of these methods to select all the objects on the page.

On the Edit menu, Click Select All

Click the Select All button 
 in the Edit ribbon.

Press the keyboard shortcut CTRL+A or F2
To select all objects except those currently selected, press CTRL+SHIFT+A or SHIFT+F2.

{button Related Topics,PI(`',`RT_Selecting_All_Objects')}



Clicking to Select Objects
Selecting Overlapping Objects
Deselecting Objects
Other Clicking Actions
Implied Selection
Block Selecting Objects
Selecting by Name or Physical Characteristic
Selecting an Object



Selecting by Name or Physical Characteristic
{button Steps...,PI(`',`HT_Selecting_an_Object')}

The Select command on the Edit menu (keyboard shortcut CTRL+SHIFT+F2) opens the Select dialog box. This 
dialog box lets you select objects based on their attributes and properties.
For example, you can use this command to select all objects with red interiors and blue edges. If you've named 
the objects in your drawing, you also can search for objects by name.

{button Related Topics,PI(`',`RT_Selecting_by_Name_or_Physical_Characteristic')}



Clicking to Select Objects
Selecting Objects by Physical Attributes
Selecting Objects by Property Value
Selecting Matching Objects
Selecting an Object



Selecting Objects by Physical Attributes
{button Steps...,PI(`',`HT_Selecting_an_Object')}

You can search for and select objects based on their physical attributes. The Attributes area shows a list of 
possible physical characteristics, such as line style, fill style, and font. Select an object and highlight the 
attributes for which you want to search (use the CTRL key to highlight multiple attributes). Designer selects other
objects on the page with matching attributes.
For example, to search for objects with a yellow interior and 2-point line weight, select an object matching those 
specifications and select Interior Fill Style and Line Weight. All objects on the page with a yellow interior and a 2-
point weight are selected.

{button Related Topics,PI(`',`RT_Selecting_Objects_by_Physical_Attributes')}



Clicking to Select Objects
Selecting by Name or Physical Characteristic
Selecting Objects by Property Value
Selecting Matching Objects
Selecting an Object



Selecting Objects by Property Value
{button Steps...,PI(`',`HT_Selecting_an_Object')}

You can type a value into the Property Value text box and select objects with that value. The value is associated 
with the property chosen in the Property drop-down list box. You can either select other objects with the same 
value or use wildcard characters to designate the portions of names to search for.
For example, if the value for the property "Name" is "bolt1," but you want to select all types of bolts, you can 
type "bolt*" to select bolt1, bolt2, and so on.
Wildcard characters let you search for partial matches. Use "?" for single characters; use "*" for multiple 
characters.

{button Related Topics,PI(`',`RT_Selecting_Objects_by_Property_Value')}



Clicking to Select Objects
Selecting by Name or Physical Characteristic
Selecting Objects by Physical Attributes
Selecting Matching Objects
Selecting an Object



Selecting Matching Objects
{button Steps...,PI(`',`HT_Selecting_an_Object')}

After you enter the characteristics of the objects you want to select, you can click Select to select all matching 
objects on the current layer and page.
If you want to select additional sets of objects without deselecting the current objects, click Append, select 
another set of objects, click Append again, and so on.
You can select matching objects one at a time by using the Next Matching Object option. Click Select to deselect 
the first object and select the next one.

{button Related Topics,PI(`',`RT_Selecting_Matching_Objects')}



Clicking to Select Objects
Selecting by Name or Physical Characteristic
Selecting Objects by Physical Attributes
Selecting Objects by Property Value
Selecting an Object



To select objects by attribute

1 Select the object you want to base your search on.
2 On the Edit menu, click Select. The Select dialog box opens.
3 Highlight the attributes for which to search. For example, if the selected object has a red interior and you 

choose Interior Fill Style, all objects with red interiors will be selected.
4 Click Select to select the matching objects.

{button Related Topics,PI(`',`RT_To_select_objects_by_attribute')}



Clicking to Select Objects
Selecting Overlapping Objects
Deselecting Objects
Other Clicking Actions
Implied Selection
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Selecting All Objects
Selecting by Name or Physical Characteristic
Selecting Objects by Physical Attributes
Selecting Objects by Property Value
Selecting Matching Objects
Selecting an Object



To select objects by property value

1 On the Edit menu, click Select. The Select dialog box opens.
2 Choose a property you want to search for in the Property list box.
3 Type the value of the property. You can enter wildcard characters to search for partial matches.
4 Click Select to select the matching objects.

{button Related Topics,PI(`',`RT_To_select_objects_by_attribute')}



Using the Mouse
{button Steps...,PI(`',`HT_Using_the_Mouse')}

To move an object with the mouse, select the object you want to move and drag it to the new position.

{button Related Topics,PI(`',`RT_Using_the_Mouse')}



To move an object with the mouse
To move an object with the arrow keys
To move an object while drawing
To move an object numerically



Constraining an Object’s Movement
Moving Using the Keyboard
Moving an Object While Drawing It
Moving Numerically
Showing Manual Movements in the Transform Dialog Box



To move an object with the mouse

1 Select one or more objects you want to move.
2 Position the pointer anywhere inside the object or group of objects (do not place the pointer on a handle).
3 Drag the object to the new position.
4 Release the mouse button.
Tips

Hold the mouse still for one second when moving an object to display a wireframe outline of the object to 
help you position it.

You can cancel a move by pressing ESC before releasing the left mouse button. The object returns to its 
original position.

Use the coordinates displayed in the Status Bar to position objects precisely.

{button Related Topics,PI(`',`RT_To_move_an_object_with_the_mouse')}
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Constraining an Object’s Movement
Moving Using the Keyboard
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Moving Numerically
Showing Manual Movements in the Transform Dialog Box



Constraining an Object's Movement
{button Steps...,PI(`',`HT_Using_the_Mouse')}

Press and hold SHIFT while moving an object to snap to a path of movement that is in 15-degree increments 
from the original position. You can use this technique to constrain the object's movement to a perfectly vertical 
path (0 degrees or 180 degrees) or a perfectly horizontal path (90 degrees or 270 degrees). Using SHIFT in this 
way overrides the Snap to Rulers command in the Snap submenu on the Tools menu, if necessary, to constrain to
the 15-degree angle.

{button Related Topics,PI(`',`RT_Constraining_an_Object_s_Movement')}
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Moving Using the Keyboard
{button Steps...,PI(`',`HT_Using_the_Mouse')}

You can move an object more precisely with the arrow keys. Use this method when you want to move an object 
in small increments.
Tip

To move in small increments, choose Snap on the Tools menu and then turn off Snap to Rulers.

{button Related Topics,PI(`',`RT_Moving_Using_the_Keyboard')}
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To move an object with the arrow keys

1 Select one or more objects you want to move.
2 Point anywhere inside the object or group of objects (do not point to a handle).
3 Press and hold the SPACEBAR.
4 Press an ARROW KEY to move the object.
5 Release the SPACEBAR when you finish.

{button Related Topics,PI(`',`RT_To_move_an_object_with_the_mouse')}



Moving an Object While Drawing It
{button Steps...,PI(`',`HT_Using_the_Mouse')}

You can use the right mouse button to move an object before you finish drawing it.

{button Related Topics,PI(`',`RT_Moving_an_Object_While_Drawing_It')}
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To move an object while drawing

1 Start drawing.
2 Press and hold the right mouse button without releasing the left mouse button.
3 Move the outline of the unfinished drawing to its new position.
4 Release the right mouse button and continue drawing.

{button Related Topics,PI(`',`RT_To_move_an_object_with_the_mouse')}



Moving Numerically
{button Steps...,PI(`',`HT_Using_the_Mouse')}

You can use the Move panel of the Transform dialog box to precisely move an object to a specific place or a 
certain distance from its current position. Click Transform on the Change menu, and click Move to display the 
Move panel.
You numerically move an object by selecting an object and entering either the distance to move it, or the 
position to which you want to move it. Designer displays a preview of the movement as a rectangular outline.
To move an object a certain distance, select Move from Current Position and enter the distance in the Horizontal 
and Vertical boxes. Enter positive numbers to move the object toward increasing ruler numbers; enter negative 
numbers to move toward decreasing ruler numbers.
With Move from Current Position selected, the Transform dialog box moves an object from its present position. 
For example, if you move a circle two inches and then type 2 to move it another two inches, the circle is moved 
an additional two inches.
To move an object to a ruler coordinate, select Move Along Ruler and type the horizontal and vertical ruler 
coordinates in the Horizontal and Vertical boxes, respectively. The object's origin (chosen in the origin list box) is 
placed at the coordinate.
Note

Before you can transform an object imported as a WMF file, you must convert the object to curves.

{button Related Topics,PI(`',`RT_Moving_Numerically')}
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Showing Manual Movements in the Transform Dialog Box
{button Steps...,PI(`',`HT_Using_the_Mouse')}

If you display the Transform dialog box by clicking Transform and then Repeat Last on the Change menu, the 
measurements of the last transformation appear in the Transform dialog box. For example, if you manually move
an object two inches left and then display the dialog box, -2 appears in the Horizontal box.
A movement does not appear if you move an object while the Transform dialog box is open.
Changing the Units

You can change the units used to move an object. To change the units, click the Units button  and choose 
the new unit. (See Using Units of Measure to learn how to create custom units.)
Changing the units only affects units used by the Transform dialog box; it does not affect the ruler or units used 
elsewhere.
Making Copies

You can create an array of duplicate objects that are equally spaced. Enter the number of copies you want to 
make. Click Apply to create the copies. Designer shows the first and last preview copy in red and other copies in 
blue. Only the first five and last five copies are previewed. (See also "Duplicating Objects.")

In the illustration above, the object at right was moved 0.5 inches down and copied twice. To produce this action,
the entries in the Move panel of the Transform dialog box were "Vertical 0.5, Move from Current Position, Copies 
2."
Tip

You can also make a series of copies by dragging an object, Clicking Transform and Repeat Last on the 
Change menu, typing the number of additional copies to make in the Copies box, and clicking Apply.

{button Related Topics,PI(`',`RT_Showing_Manual_Movements_in_the_Transform_Dialog_Box')}
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To move an object numerically

1 Select the object to move.
2 On the Change menu, click Transform.
3 Click Move. The Move panel of the Transform dialog box opens.
4 Select Move from Current Position or Move Along Ruler.
5 Select the object origin in the Origin list box, if you are moving along the ruler.
6 Type numbers in the Horizontal and Vertical boxes. A red outline of the object movement appears.
7 Type the number of copies you want to make, if any. Designer shows the first and last preview copy in red 

and other copies in blue. Only the first five and last five copies are previewed.
8 Click Apply to move the object.

{button Related Topics,PI(`',`RT_To_move_an_object_with_the_mouse')}



Resizing Manually
{button Steps...,PI(`',`HT_Resizing_Manually')}

You can change the size and shape of an object by selecting it and dragging one of its handles.
There are two types of handles: corner and side. 

Corner handles (at the four corners of the bounding box) enlarge or shrink an object while maintaining its 
original proportions. 

or

Side handles (at the center of each side of the bounding box) stretch an object and change its proportions.

{button Related Topics,PI(`',`RT_Resizing_Manually')}
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To resize an object manually

1 Select the object to resize.
2 Move the pointer to one of the eight handles on the object.
3 Drag the handle to resize the object.
4 Release the mouse button when you finish.
Tips

To return the object to its original position, press ESC before releasing the mouse button in step 4.

To make the object’s height and width equal, press and hold SHIFT while dragging a corner handle.

To change the height-to-width ratio of the object, press and hold CTRL while dragging a corner handle.

{button Related Topics,PI(`',`RT_To_resize_an_object_manually')}
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Resizing Numerically
{button Steps...,PI(`',`HT_Resizing_Manually')}

You can use the Scale panel in the Transform dialog box to precisely resize an object. Click Transform on the 
Change menu, and click Scale to display the Scale panel of the Transform dialog box.
Resizing an object

You numerically resize an object by selecting an object and entering a percentage of the current size. The current
size is 100%. A number below 100% decreases, and a number above 100% increases the size. Designer displays 
a preview of the resized object as a rectangular outline.
The horizontal number affects the side-to-side size; the vertical number affects the top-to-bottom size. The 
horizontal and vertical sizes are the same unless you deselect the Proportional Scale option.
The Scale panel of the Transform dialog box lets you resize an object based on its current size. For example, if 
you enlarge a circle to 200% and then type 200 to enlarge it to another 200%, the circle is enlarged an additional
amount.

Note

Before you can transform an object imported as a WMF file, you must convert the object to curves.

{button Related Topics,PI(`',`RT_Resizing_Numerically')}
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To resize an object numerically

1 Select the object to scale.
2 On the Change menu, click Transform.
3 Click Scale to display the Scale panel.
4 Select the origin of the resize in the Origin list box, if you want.
5 Type numbers in the Horizontal and Vertical boxes. A red outline of the resized object appears.
6 Type the number of copies you want to make, if any.
7 Click Apply to accept the change.

{button Related Topics,PI(`',`RT_To_resize_an_object_manually')}



Showing Manual Scaling in the Transform Dialog Box
{button Steps...,PI(`',`HT_Resizing_Manually')}

If you display the Transform dialog box by clicking Transform and then Repeat Last on the Change menu, the 
measurements of the last transformation appear in the Transform dialog box. For example, if you manually resize
an object to 50% of its original size and use Repeat Last to open the Transform dialog box, 50 appears in the 
Scale panel.
A resize does not appear if you resize an object while the Transform dialog box is open.

{button Related Topics,PI(`',`RT_Showing_Manual_Scaling_in_the_Transform_Dialog_Box')}
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Making an Array of Copies
{button Steps...,PI(`',`HT_Resizing_Manually')}

You can create an array of equally resized copies. Type the number of copies you want to make. The original 
object is not affected. Designer shows the first and last preview copy in red and other copies in blue. Only the 
first five and last five copies are previewed.

{button Related Topics,PI(`',`RT_Making_an_Array_of_Copies')}
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Rotating Manually
{button Steps...,PI(`',`HT_Rotating_Manually')}

The manual method lets you use the pointer to rotate an object. You manually rotate by dragging a corner 
handle in a circular motion around a pivot point.

{button Related Topics,PI(`',`RT_Rotating_Manually')}
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To rotate an object manually

1 Select the object you want to rotate, and then click it again (that is, click the currently selected object).
2 Drag the pivot point to a new location, even outside the object, if you wish.
3 Move the pointer to a corner handle.
4 Drag in a circular motion around the object.
5 Release the mouse button when you finish.
Tips

The action in step 1 is similar to a double click but much slower. A rapid double click places you in edit 
mode. Click, pause, click places you in rotate/skew mode.

As an alternative to step 1, select the object, click the Edit tool 

, and click the Rotate/Skew button 
 in the ribbon.

You can cancel a rotation by pressing ESC before releasing the left mouse button. The object returns to its 
original position.

Press and hold SHIFT while dragging a corner handle to constrain the rotation of an object to 45-degree 
increments. Press and hold CTRL while dragging a corner handle to rotate a copy of an object.

{button Related Topics,PI(`',`RT_To_rotate_an_object_manually')}
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Changing the Pivot Point
{button Steps...,PI(`',`HT_Rotating_Manually')}

The pivot point defaults to the center of the object, but you can drag it anywhere inside or outside the object. 
The pivot point defaults to the center the next time you select the object unless you permanently reposition it.

You can permanently reposition an object's pivot point by pressing SHIFT while dragging it to a new position.
To return the permanent pivot point to the center of the object, use a center snap point and then press SHIFT and
drag the pivot point back to the center.
Note

Before you can transform an object imported as a WMF file, you must convert the object to curves.

{button Related Topics,PI(`',`RT_Changing_the_Pivot_Point')}
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Preset Rotation Key
{button Steps...,PI(`',`HT_Rotating_Manually')}

You can rotate an object a preset amount by selecting the object and pressing F8. Each time you press F8, the 
object is rotated the preset amount. The initial setting for the F8 key is 45 degrees.

{button Related Topics,PI(`',`RT_Preset_Rotation_Key')}
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To change the rotation key setting

1 On the Tools menu, click Options. The Options dialog box opens.
2 Click Rotation. The Rotation tab opens.
3 Type a value in the F8 Rotation Increment box.

or

Click the arrows beside the F8 Rotation Increment box.
or

Drag the red needle in the F8 Rotation Increment dial control.

{button Related Topics,PI(`',`RT_To_rotate_an_object_manually')}



Constraining Manual Rotation
{button Steps...,PI(`',`HT_Rotating_Manually')}

You can constrain rotations to fixed increments by setting a Manual Rotation Increment value in the Rotation tab 
of the Options dialog box. For example, if the Manual Rotation Increment is set to 12 degrees, then an object 
rotates in 12-degree increments when you drag its corner handles.

{button Related Topics,PI(`',`RT_Constraining_Manual_Rotation')}
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To change the Manual Rotation Increment

1 On the Tool menu, click Options.
2 Click Rotation to go to the Rotate tab.
3 Enter the rotation amount in the Manual Rotation Increment box (or drag the red needle in the dial control).

{button Related Topics,PI(`',`RT_To_rotate_an_object_manually')}



Rotating Numerically
{button Steps...,PI(`',`HT_Rotating_Manually')}

You can use the Rotate panel of the Transform dialog box to precisely rotate an object by specifying the degree of
rotation. Click Transform on the Change menu, and click Rotate to display the Rotate panel.
Rotating an object

You numerically rotate an object by selecting an object and a rotation angle. There are two ways to specify the 
rotation angle: use the Angle box to specify the angle numerically, or drag the dial to adjust the angle 
graphically. Designer displays a preview of the rotation as a red box.
The Rotate panel lets you rotate an object based on its current position. For example, if you rotate a square 45 
degrees and then type 45 to rotate it another 45 degrees, the object is rotated an additional 45 degrees.
Note

Before you can transform an object imported as a WMF file, you must convert the object to curves.
Showing Manual Rotations in the Transform Dialog Box

If you display the Transform dialog box by clicking Transform and then Repeat Last on the Change menu, the 
measurements of the last transformation appear in the Transform dialog box. For example, if you manually rotate
an object 25 degrees and then use Repeat Last to open the dialog box, 25 appears in the Angle box.
A rotation does not appear if you rotate an object while the Transform dialog box is open.
Changing the Units

You can change the units to rotate an object in either degrees or radians. To change the units, click the Units 

button  and choose the new unit.
Changing the units only affects units used by the Transform dialog box; it does not affect units used elsewhere.
Changing the Pivot Point

You change the pivot point of the rotation in the Origin list box. The default origin is the movable pivot point. For 
example, if you select the bottom left handle and rotate the object, the object rotates around the bottom left 
handle.

{button Related Topics,PI(`',`RT_Rotating_Numerically')}
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To rotate an object numerically

1 Select the object to rotate.
2 On the Change menu, click Transform. A submenu opens.
3 Click Rotate to display the Rotate panel.
4 Type a number in the Angle box, or drag the dial to specify a rotation angle.
5 Select a new pivot point in the Origin list box, if you wish.
6 Click Apply to rotate the object.

{button Related Topics,PI(`',`RT_To_rotate_an_object_manually')}



Skewing Manually
{button Steps...,PI(`',`HT_Skewing_Manually')}

The manual method lets you use the pointer to skew (slant) an object. You manually skew by dragging a side 
handle.

Note

Bitmaps cannot be skewed.

{button Related Topics,PI(`',`RT_Skewing_Manually')}
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To skew an object manually

1 Click an already-selected object with the select pointer.
or

Select the object, click the Edit tool , and click the Rotate/Skew button 

 in the ribbon.
2 Point to a side handle of the object.
3 Drag the handle to skew the object.
4 Release the mouse button when you finish.
Tips

You can cancel a skew by pressing ESC before releasing the left mouse button. The object returns to its 
original position.

Press and hold SHIFT while dragging a side handle to constrain the skewing of an object to 45-degree 
increments. Press and hold CTRL while dragging a side handle to skew a copy of an object.

{button Related Topics,PI(`',`RT_To_skew_an_object_manually')}
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Skewing Numerically
{button Steps...,PI(`',`HT_Skewing_Manually')}

You can use the Skew panel of the Transform dialog box to precisely skew an object by specifying the degree of 
skew. Click Transform on the Change menu, and click Skew to display the Skew panel.
The Skew panel lets you skew an object based on its current shape. For example, if you skew a square 45 
degrees and then type 45 to skew it another 45 degrees, the object is skewed on additional 45 degrees.
Note

Before you can transform an object imported as a WMF file, you must convert the object to curves.

{button Related Topics,PI(`',`RT_Skewing_Numerically')}
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To specify a degree of slant

1 Select the object you want to skew.
2 On the Change menu, click Transform. A submenu opens.
3 Click Skew to display the Skew panel.

4 Type an angle from -89 to 89 in the Horizontal Angle box, or drag the dial to specify an angle.

5 Type an angle from -89 to 89 in the Vertical Angle box, or drag the dial to specify an angle.

6 Select a different pivot point for the slant in the Origin list box, if you want.
7 Click Apply to skew the object.

{button Related Topics,PI(`',`RT_To_skew_an_object_manually')}



Making Copies while Rotating or Skewing
{button Steps...,PI(`',`HT_Skewing_Manually')}

You can create an array of rotated or skewed objects between the original object and its final position. Designer 
shows the first and last preview copy in red and other copies in blue. Only the first five and last five copies are 
previewed.

{button Related Topics,PI(`',`RT_Making_Copies_while_Rotating_or_Skewing')}
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To make intermediate copies of rotated or skewed objects

1 Select the object to rotate or skew.
2 On the Change menu, click Transform. A submenu opens.
3 Click Rotate or Skew and type the specifications you want.
4 Type the number of copies you want to create.
5 Click Apply to draw the copies.

{button Related Topics,PI(`',`RT_To_skew_an_object_manually')}



Duplicating Objects
{button Steps...,PI(`',`HT_Duplicating_Objects')}

There are three ways to duplicate an object.

Use the Duplicate button 
.

or

Press CTRL and drag a copy.
or

Use the Copies option in the Transform dialog box.

{button Related Topics,PI(`',`RT_Duplicating_Objects')}



To drag    a copy
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Using the Duplicate Button
{button Steps...,PI(`',`HT_Duplicating_Objects')}

Click the Duplicate button  in the Edit ribbon to activate the duplicate mode. In this mode, you create a 
duplicate with every scale, movement, flip, or rotation.

{button Related Topics,PI(`',`RT_Using_the_Duplicate_Button')}
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To drag a copy

1 Select the object you want to copy.
2 Press and hold CTRL.
3 Drag the duplicate object to a new position.
4 Release the mouse button and then release CTRL.
Note

If the Duplicate button 

 is on, don’t press CTRL while dragging. CTRL temporarily turns off duplication if it is on.
Tip

To rotate or skew a copy of an object, press and hold CTRL while rotating or skewing.

{button Related Topics,PI(`',`RT_Dragging_a_Copy')}
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Making Copies with the Transform Dialog Box
The Copies option is available at the bottom of the Transform dialog box (on the Change menu, click Transform 
and click any command on the submenu). This option lets you duplicate the transformation you just performed 
as many times as space allows.
You can make as many copies as will fit in the drawing area.

{button Related Topics,PI(`',`RT_Making_Copies_with_the_Transform_Dialog_Box')}
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Changing the Order of Objects
{button Steps...,PI(`',`HT_Changing_the_Order_of_Objects')}

You can reorder the stacking arrangement of objects with the Order command on the Change menu.
You can only change the order of objects on the current layer. If you are using multiple layers, objects on upper 
layers always appear in front of objects on lower layers. (See Benefits of Layers for more information.)
Bring Forward Moves the currently selected object one level toward the front. 

(keyboard shortcut SHIFT+F10)
Send Backward Moves the currently selected object one level toward the back. 

(keyboard shortcut SHIFT+F9)
Bring to Front Moves the currently selected object in front of all others on the current layer. 

(keyboard shortcut F10)
Send to Back Moves the currently selected object behind all others on the current layer. 

(keyboard shortcut F9)
Reverse Reverses the stacking order of the selected objects. For example, the order 1, 2, 3, 4 becomes 4,

3, 2, 1. 
(keyboard shortcut CTRL+SHIFT+F9)



To change the order of objects



To change the order of objects

1 Select one or more objects.
2 On the Change menu, click Order and click a command on the Order submenu.
Tip

You can click the right mouse button to open the shortcut menu, and click an ordering command.

{button Related Topics,PI(`',`RT_To_change_the_order_of_objects')}
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Grouping Objects
{button Steps...,PI(`',`HT_Grouping_Objects')}

When you create a drawing with many objects, it is useful to group objects together to help organize your 
drawing. Grouping makes it easier to select objects, and makes it possible to manipulate several objects at once.
Group objects when you want to create a collection of individual objects. Grouping does not change an object's 
appearance.
Changing a style of an object group changes all objects in the group to the new style. For example, if you select 
a group of objects and change the interior fill color to red, all objects in the group become red.

{button Related Topics,PI(`',`RT_Grouping_Objects')}
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To group objects

1 Select the objects you want in the group (they don't have to be adjacent)
2 On the Change menu, click Combine, and click Group.
Tip

There are two other ways to group selected objects.
Click the right mouse button to open the shortcut menu and click Group.

or

Press F5 (keyboard shortcut).

{button Related Topics,PI(`',`RT_To_group_objects')}
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Ungrouping Objects
{button Steps...,PI(`',`HT_Selecting_an_Object')}

You can ungroup objects to return them to their original, ungrouped state.

{button Related Topics,PI(`',`RT_Ungrouping_Objects')}
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To ungroup objects

1 Select the group to break apart
2 On the Change menu, click Combine, and click Ungroup.
Tips

If you have groups within groups, you need to use the Ungroup command more than once to break up all 
the groups.

There are two other ways to ungroup a selected group.
Click the right mouse button to open the shortcut menu and click Ungroup.

or

Press SHIFT+F5 (keyboard shortcut).

{button Related Topics,PI(`',`RT_To_group_objects')}



Working with Grouped Objects
{button Steps...,PI(`',`HT_Selecting_an_Object')}

In many ways, grouped objects are similar to individual objects. For example, changing line and fill styles affects 
the whole group, and moving a group is like moving one object. You can also skew and rotate groups.
Editing a Grouped Object

If you want to reshape or change the color of one object in a group, you can first break apart the group or you 
can select only the object within the group that you want to edit.

    

Adding a New Object to a Group

You can add an object to a group of objects. Double click the group to which you want to add an object, and draw
or paste another object. It is automatically included inside the editing border and becomes part of the group. 
Double click outside the edit border when you finish adding objects.
Removing an Object from a Group

You can separate an object from its group without breaking apart the group. Double click the object in the group. 
An edit border appears around the group. Select the object you want to remove. Click Cut on the Edit menu. 
Double click outside the group and paste the object where you want it. You can also press DEL to delete the 
object.

{button Related Topics,PI(`',`RT_Working_with_Grouped_Objects')}
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To edit an object without ungrouping it

1 Using the select pointer, double click the object group that contains the object you want to edit. An edit 
border appears around the group.

2 Select the object to edit. Handles appear around the selected object. Edit or move it as you would any object.
3 Double click anywhere outside the group when you finish.
Tips

To select additional objects within the group, press and hold CTRL and click the other objects that you want
to select.

You also can edit objects that belong to groups within other groups. Point to the object or group you want 
to edit and continue double clicking until the group you want to edit displays the edit border. When you finish, 
double click outside the groups until the edit border disappears.

{button Related Topics,PI(`',`RT_To_group_objects')}



Connecting Objects
{button Steps...,PI(`',`HT_Connecting_Objects')}

The Connect commands let you join objects, making it easy to create complex shapes.
Note

You cannot connect text, grouped objects, or bitmaps.

{button Related Topics,PI(`',`RT_Connecting_Objects')}
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Connect Open
{button Steps...,PI(`',`HT_Connecting_Objects')}

You can use the Connect Open command to combine two or more objects with open endpoints. The Connect 
Open command joins selected objects by drawing a line between the open endpoints, leaving the last side open.

{button Related Topics,PI(`',`RT_Connect_Open')}
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To connect open

1 Select the objects you want to connect
2 On the Change menu, click Combine, and click Connect Open
 or

Press CTRL+F11.

{button Related Topics,PI(`',`RT_To_connect_open')}
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Connect Closed
{button Steps...,PI(`',`HT_Connecting_Objects')}

You can use the Connect Closed command to close open shapes or to connect and fill closed shapes. You can use
Connect Closed with one or more objects.
On selected objects with open endpoints, the Connect Closed command draws a line between all endpoints, 
creating a completely closed shape.

Before connecting After connecting

On selected objects with no endpoints (already closed shapes), the Connect Closed command connects the 
objects and the resulting object is filled with the fill color of the first drawn object (the one in back). Note that in 
this case no lines are drawn.

If you use Connect Closed on overlapping objects that are closed, the front object cuts or "punches" a hole in the 
underlying object.

Before connecting Connected objects

If the front object extends off the edge of the back object, the extending portion is filled. Select Fill Overlaps in 
the Style ribbon to fill the overlapping portion also (that is, the hole in the back object is filled).

 



 

{button Related Topics,PI(`',`RT_Connect_Closed')}
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To connect closed

1 Select the objects you want to connect.
2 On the Change menu, click Combine, and click Connect Closed.

or

Press F11 (keyboard shortcut).

{button Related Topics,PI(`',`RT_To_connect_open')}



Disconnecting Objects
{button Steps...,PI(`',`HT_Connecting_Objects')}

After applying Connect Open, you can use Disconnect to restore an object to its original, disconnected objects. 
However, after applying Connect Closed to an open connected object, you can no longer restore the original 
objects.

{button Related Topics,PI(`',`RT_Disconnecting_Objects')}
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To disconnect connected objects

1 Select the connected object you want to disconnect.
2 On the Change menu, click Combine, and click Disconnect.

or

Press SHIFT+F11.

{button Related Topics,PI(`',`RT_To_connect_open')}



Aligning to the Page
{button Steps...,PI(`',`HT_Aligning_to_the_Page')}

You can align one or more objects to several positions on the page. For example, you can align an object to the 
exact center of the page.
Tips

Select Align Objects as Group to align the selected objects to the page as a group. Align Objects as Group 
treats the selected objects as a group only for the Align to Page command. It does not actually group the objects or 
affect the operation of other commands.

The keyboard shortcut to open the Align Objects dialog box is ALT+1.

{button Related Topics,PI(`',`RT_Aligning_to_the_Page')}
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To align objects to the page

1 Select the objects you want to align.
2 On the Change menu, click Align.
3 Click To Page to display the Align To Page panel.
4 Click a vertical and horizontal alignment button. The preview box shows an example of the alignment.
5 Click Apply to align the objects.
Tip

There are keyboard shortcuts for the alignment options.
Align to page center CTRL+SHIFT+5
Align to page middle CTRL+SHIFT+6
Align to rulers ALT+2
Align to page left CTRL+SHIFT+3
Align to page top CTRL+SHIFT+4
Align to page right CTRL+SHIFT+7
Align to page bottom CTRL+SHIFT+8
Justify to page horizontally CTRL+SHIFT+9

Justify to page vertically CTRL+SHIFT+0 (zero)

{button Related Topics,PI(`',`RT_To_align_objects_to_the_page')}
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Aligning to Other Objects
{button Steps...,PI(`',`HT_Aligning_to_the_Page')}

You can align objects to each other. For example, if you select three objects and align them to the center, they 
are stacked in the center of the bounding box.
Designer uses the bounding box that surrounds all selected objects as the basis for alignment. For example, if 
you select three objects and align them at top left, they align to the top left corner of the surrounding bounding 
box.

{button Related Topics,PI(`',`RT_Aligning_to_Other_Objects')}
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To align objects to each other

1 Select the objects you want to align.
2 On the Change menu, click Align.
3 Click To Object to open the Align Objects panel.
4 Click a vertical and horizontal alignment button. The preview box in the panel shows an example of the 

alignment.
5 Click Apply to align the objects.
Tips

There are keyboard shortcuts for the alignment options.
Align to left ALT+3
Align to center ALT+5
Align to right ALT+7
Justify Horizontally ALT+9
Align to top ALT+4
Align to middle ALT+6
Align to bottom ALT+8
Justify Vertically ALT+0 (ZERO)

{button Related Topics,PI(`',`RT_To_align_objects_to_the_page')}



Aligning to a Path
{button Steps...,PI(`',`HT_Aligning_to_the_Page')}

You can align objects along the path of another object. For example, you can draw a curve and align a series of 
stars along it. Grouped and text objects cannot be used as a path (but you can align them to a path).
It is easy to get the alignment that you want because Designer previews on your page the effect of alignment 
settings as you choose them. When the alignment preview shows the arrangement that you want, you can apply 
the alignment.

The Align To Path panel of the Align dialog box is used to align objects to a path.
Notes

The Align To Path panel is used only to align objects (or text that has been converted into curves) to a path.
For details on aligning text to a path, see Fitting Text to a Path.

Designer removes warps, rotations, and skews of objects that are aligned to a path. Convert the objects to 
curves (keyboard shortcut CTRL+R) before aligning them if you want to keep their previous transformations.

{button Related Topics,PI(`',`RT_Aligning_to_a_Path')}
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Selecting the Path Object
{button Steps...,PI(`',`HT_Aligning_to_the_Page')}

The Select Path for Alignment buttons select the object to use as a path for the other objects. The initial path 
selection is the object that provides the longest path. Each time you click a Select Path for Alignment button, the 
path object changes.

The Previous button  cycles through objects in the opposite order in which they were drawn.

The Next button  cycles through objects in the order in which they were drawn.

{button Related Topics,PI(`',`RT_Selecting_the_Path_Object')}
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Changing the Alignment Justification
{button Steps...,PI(`',`HT_Aligning_to_the_Page')}

The Justification buttons set the position of the aligned objects in relation to the alignment point.

The Left button  positions objects so the left edge of the left-most object aligns to the alignment point.

The Center button  centers objects around the alignment point.
The Right button  positions objects so the right edge of the right-most object aligns to the alignment point.

The Justify button  spaces objects evenly on the path.

{button Related Topics,PI(`',`RT_Changing_the_Alignment_Justification')}



Aligning to the Page
Aligning to Other Objects
Aligning to a Path
Selecting the Path Object
Changing the Alignment Pitch
Changing the Alignment Direction
Changing the Alignment Offset
Changing the Alignment Point



Changing the Alignment Pitch
{button Steps...,PI(`',`HT_Aligning_to_the_Page')}

The Pitch buttons set the orientation, or pitch, of the aligned objects in relation to the path. Click the current 
Pitch button to display the other pitch options.

The Rotate to Path button  aligns the objects along a path by rotating, but not changing the shapes.

The Follow Path button  places objects along a path without skewing or rotating the shapes.

{button Related Topics,PI(`',`RT_Changing_the_Alignment_Pitch')}
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Changing the Alignment Direction
{button Steps...,PI(`',`HT_Aligning_to_the_Page')}

The Direction buttons set the direction in which objects align along the path.

The Backward button  aligns objects in the opposite direction in which the path was drawn (the alignment 
direction is endpoint to origin).

The Forward Direction button  aligns objects in the direction in which the path was drawn (the alignment 
direction is origin to endpoint).

{button Related Topics,PI(`',`RT_Changing_the_Alignment_Direction')}
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Changing the Alignment Offset
{button Steps...,PI(`',`HT_Aligning_to_the_Page')}

The Offset % box controls where objects vertically rest on a path. An offset of 100 aligns the bottom of the 
objects to the path, an offset of 0 aligns the middle of the objects to the path, and an offset of -100 aligns the 
top of the objects to the path.
An offset greater than 100 (to the limit of 200) aligns the bottom of the objects above the path. An offset less 
than -100 (to the limit of -200) aligns the top of the objects below the path.

{button Related Topics,PI(`',`RT_Changing_the_Alignment_Offset')}
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Changing the Alignment Point
{button Steps...,PI(`',`HT_Aligning_to_the_Page')}

The Alignment Point buttons set the location on the path of the point used to align the objects. The alignment 
point can be set to the fixed locations of left, center, and right for open paths or top, left, right, and bottom for 
closed paths.

{button Related Topics,PI(`',`RT_Changing_the_Alignment_Point')}
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To set the alignment point to a custom location

1 Click To Path to display the Align To Path tab.
2 If the Align To Path tab obscures the objects you want to align, drag it out of the way.

3 Click the Choose Position button .
4 Drag the red Alignment Point to the location that you want

{button Related Topics,PI(`',`RT_To_align_objects_to_the_page')}



To align objects to a path

1 Select the objects you want to align, including the object you want to use as a path.
2 On the Change menu, click Align. A submenu opens.
3 Click To Path to display the Align To Path tab.
4 If the Align To Path tab obscures the objects you want to align, drag it out of the way.

5 Choose the object to use as the path by clicking the Previous button  or the Next button 

 in the Align To Path tab until the preview rectangles are shown along the desired path.
6 Choose the Alignment Point that you want.
7 Change the justification, pitch, and direction settings, if you wish.
8 Click Apply to align the objects.
Tip

Click Undo to return objects to their unaligned positions.

{button Related Topics,PI(`',`RT_To_align_objects_to_the_page')}



Copying and Pasting Objects
{button Steps...,PI(`',`HT_Copying_and_Pasting_Objects')}

You can copy objects from a drawing to the Windows Clipboard and paste the object into another Designer 
drawing or another Windows program.
Copying and pasting to the Clipboard is an easy way to move objects from one Designer drawing to another. You 
can also move drawings and text from Designer to many other Windows programs, or from a Windows program 
to Designer.
Using the Clipboard is similar to importing or exporting drawings except it is temporary (the Clipboard is emptied
when you close Windows), and the receiving program might convert the object into a format it recognizes. For 
example, if you copy from a program that doesn’t use Designer’s DSF file format, Designer converts the object to
a format it recognizes before pasting.

{button Related Topics,PI(`',`RT_Copying_and_Pasting_Objects')}
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Copying and Cutting Objects
{button Steps...,PI(`',`HT_Copying_and_Pasting_Objects')}

The Copy and Cut commands both move selected objects to the Clipboard. The Copy command places a copy of 
the selected object on the Clipboard. The Cut command removes the original object from the drawing and places
it on the Clipboard.

{button Related Topics,PI(`',`RT_Copying_and_Cutting_Objects')}
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To copy or cut an object to the Clipboard

1 Select the object you want to copy or cut.
2 On the Edit menu, click either Copy or Cut.
Tip

Use either CTRL+C or CTRL+INS as a keyboard shortcut for the Copy command. Use either CTRL+X or 
SHIFT+DEL as a shortcut for the Cut command.

{button Related Topics,PI(`',`RT_To_copy_or_cut_an_object_to_the_Clipboard')}
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Pasting Objects
{button Steps...,PI(`',`HT_Copying_and_Pasting_Objects')}

The Paste command retrieves objects from the Clipboard and places them in your drawing. Before you can paste,
you must copy or cut an object to the Clipboard. You can repeatedly paste the same object from the Clipboard 
until you cut or copy a new object to the Clipboard.
Tip

Use either CTRL+V or SHIFT+INS as a keyboard shortcut for the Paste command.

{button Related Topics,PI(`',`RT_Pasting_Objects')}
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OLE (Object Linking and Embedding)
{button Steps...,PI(`',`HT_Copying_and_Pasting_Objects')}

When you paste an object, you can establish a connection, or link, between the pasted object and its source. 
This connection is usually called "OLE," for Object Linking and Embedding.

{button Related Topics,PI(`',`RT_OLE_Object_Linking_and_Embedding')}
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Embedding OLE Objects
{button Steps...,PI(`',`HT_Copying_and_Pasting_Objects')}

Whenever possible, Designer embeds an object while pasting it. Double clicking an embedded object 
automatically opens the program in which the object was created so you can edit it. You can also select the 
object, click the right mouse button, and click Edit on the shortcut menu to edit the embedded object.
For example, you can create an image in Micrografx Picture Publisher, copy it to the Clipboard, and paste 
(embed) it into Designer. Double click the image to open Picture Publisher and display the image. You now can 
edit the image in Picture Publisher. When you close Picture Publisher, you are asked if you want to update the 
image.
Not all programs permit embedding (or linking). Some programs are both client (receiver of the object) and 
server (originator of the object); others are just servers. Servers let you copy objects from them to embed into 
other programs, but they do not let you embed objects from other programs. (See the program’s documentation 
for more information.)
Designer automatically embeds the object if the originating (server) program supports OLE. To find out if the 
object is an OLE object, select it and look at the status bar to see if OLE Object is displayed.
Tips

If you paste (embed) from a non-drawing program such as Microsoft Word, the object is sometimes pasted 
as a picture (usually an icon). If you want to paste editable text, you must paste it without embedding (or linking) it.
On the Edit menu, click Paste Special, select Text, and then click Paste.

Although you must have the embedded object’s original (server) application on your system, you don’t 
have to have the original file. This makes embedding useful for portable computers where disk space is at a 
premium.

{button Related Topics,PI(`',`RT_Embedding_OLE_Objects')}



Copying and Pasting Objects
Copying and Cutting Objects
Pasting Objects
OLE (Object Linking and Embedding)
Inserting an Object from Another Program
Linking OLE Objects
Managing OLE Links
Viewing an OLE Link
Updating an OLE Object
Breaking an OLE Link
Changing the Location of a Linked File
Activating Linked Objects
Pasting and Embedding an Object
Pasting and Linking an Object



To paste or embed an object from the Clipboard

On the Edit menu, click Paste. The object is pasted in the center of the page.



To edit an embedded object in its original program

1 Double click the object to edit. The program in which the object was created opens and displays the object.
2 Edit the object.
3 On the File menu, click Update to see the changes in Designer.
4 Close the server program when you finish editing.
5 Click Yes to apply the changes to the object in Designer; click No to disregard any changes.



Inserting an Object from Another Program
{button Steps...,PI(`',`HT_Copying_and_Pasting_Objects')}

You can use Paste to embed objects from OLE-compatible programs, or you can use Insert Object. Insert Object 
lets you open an OLE-compatible program, create an object in the program, then close the program and 
automatically insert the object into Designer.

{button Related Topics,PI(`',`RT_Inserting_an_Object_from_Another_Program')}
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To embed an object from another program (without using Paste)

1 On the Edit menu, click Insert Object. The Insert Object dialog box opens.
2 Select the type of object that you want to create. Click OK. The program opens.
3 Create the object.
4 On the program’s File menu, click Update to update the Designer drawing as you draw (if you want).
5 On the program’s File menu, click Exit when you finish.
6 Click Yes to embed and display the object in Designer; click No to close the program without embedding.
Tip

Only OLE-compatible-program objects are listed in the Insert Object dialog box.



Linking OLE Objects
{button Steps...,PI(`',`HT_Copying_and_Pasting_Objects')}

Linking lets you maintain an invisible connection between an OLE object and its original (source) file. Linking is 
used with pasting and is sometimes called paste linking. When you paste link an object into Designer, you can 
make changes to the object’s original file. If you update the original file, the Designer document also updates.
For example, you can copy a Picture Publisher bitmap file, and then paste link it into Designer. If you make 
changes to the image in Picture Publisher, Designer also changes to reflect the change.
Designer must have access to the object’s original file before you can edit it. For example, if the file LINK.TIF is 
located on drive A, be sure the diskette containing LINK.TIF is inserted in the drive before you attempt to edit the
linked object.
Tip

Linking is a way for more than one user to connect to the same file. For example, linking can be helpful on 
a network where several users are working with the same file. Users are linked to a master file so that whenever 
one user makes a change, the master and all linked files show the change.

{button Related Topics,PI(`',`RT_Linking_OLE_Objects')}
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To link an object

1 Create the object in its original program and save it as a file.
2 Copy the object you want to link to the Clipboard. 
3 Close the original program if you want.
4 Open Designer, if necessary.
5 On Designer’s Edit menu, click Paste Special. The Paste Special dialog box opens.
6 Click Paste Link. The object is pasted in the center of the page.
Tip

You must save the linked object as a file.



To edit a linked object

1 Double click the object to edit. The program in which the object was created (the server) opens and displays 
the object.

2 Edit the object.
3 On the File menu, click Save to update the changes in Designer.
4 Close the server program when you finish editing.
5 Click Yes to save the linked file and update the object in Designer; click No to disregard changes made since 

you last saved the linked file.
Tip

Another way to edit a linked object is to click Links on the Edit menu, select the Link to edit in the Links 
dialog box, and click Edit.



Managing OLE Links
{button Steps...,PI(`',`HT_Copying_and_Pasting_Objects')}

You can use the Links dialog box to manage OLE links that you have created. To open the Links dialog box, click 
Links on the Edit menu.

{button Related Topics,PI(`',`RT_Managing_OLE_Links')}
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Viewing an OLE Link
{button Steps...,PI(`',`HT_Copying_and_Pasting_Objects')}

Links are displayed in the Links dialog box. A description of each link includes the name of the source 
application, the type of linked object (for example, picture or text), the filename, and whether the object updates
automatically or manually.

{button Related Topics,PI(`',`RT_Viewing_an_OLE_Link')}
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Updating an OLE Object
{button Steps...,PI(`',`HT_Copying_and_Pasting_Objects')}

You can update objects automatically or manually by selecting Automatic or Manual in the Links dialog box. 
Automatic updates a linked object whenever you change it. Manual only updates the object when you click 
Update Now in the Links dialog box and when you click Yes whenever you are prompted to update links.
Tip

Some OLE programs don’t automatically update. In those cases, you must choose Save to update.

{button Related Topics,PI(`',`RT_Updating_an_OLE_Object')}
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Breaking an OLE Link
{button Steps...,PI(`',`HT_Copying_and_Pasting_Objects')}

The Cancel Link command breaks the link between an object and its source program (server).

{button Related Topics,PI(`',`RT_Breaking_an_OLE_Link')}
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To break the link between an object and its server

1 Select the linked object in Designer.
2 On the Edit menu, Links.
3 Click Cancel Link.
4 You are asked if you want to sever the link permanently. Click Yes to break the link; click No to cancel and 

leave the link unbroken.



Changing the Location of a Linked File
{button Steps...,PI(`',`HT_Copying_and_Pasting_Objects')}

When you establish a link, Designer "remembers" the location and name of the source file. If you move or 
rename the file, you must tell Designer the new location and filename in order to reestablish the link.

{button Related Topics,PI(`',`RT_Changing_the_Location_of_a_Linked_File')}



Copying and Pasting Objects
Copying and Cutting Objects
Pasting Objects
OLE (Object Linking and Embedding)
Embedding OLE Objects
Inserting an Object from Another Program
Linking OLE Objects
Managing OLE Links
Viewing an OLE Link
Updating an OLE Object
Breaking an OLE Link
Activating Linked Objects



To change an OLE link

1 Select the object in Designer.
2 On the Edit menu, click Links. The Links dialog box opens.
3 Click Change Link. The Change link dialog box opens.
4 Change to the directory where the source file is located and select the new filename, if necessary.
5 Click OK. The link is reestablished.



Activating Linked Objects
{button Steps...,PI(`',`HT_Copying_and_Pasting_Objects')}

You might want to play or activate certain types of objects instead of editing them. For example, you can play 
sound, music, or animation objects that you have linked in your drawing.
If you select a linked video clip, for example, the shortcut menu for the object displays the item Linked Video Clip
Object. The menu subitems include a Play option. Non-action objects, such as pictures, can only be edited.

{button Related Topics,PI(`',`RT_Activating_Linked_Objects')}
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Changing the Pasted Data Type
{button Steps...,PI(`',`HT_Changing_the_Pasted_Data_Type')}

You can paste an object in a more generic form by changing the pasted data type. By default, Designer pastes 
objects in their original format (if possible). You can highlight a different data type to paste the object as a 
different format.
Tip

You must choose the highlighted data type if you want to paste link the object.

{button Related Topics,PI(`',`RT_Changing_the_Pasted_Data_Type')}
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Pasting and Embedding an Object
{button Steps...,PI(`',`HT_Changing_the_Pasted_Data_Type')}

Use the Paste button  to paste and embed the object into your drawing. If the source program is OLE-
compatible, the object is automatically embedded when it is pasted. The format of the original object is 
highlighted.

{button Related Topics,PI(`',`RT_Pasting_and_Embedding_an_Object')}
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Pasting and Linking an Object
{button Steps...,PI(`',`HT_Changing_the_Pasted_Data_Type')}

Use Paste Link on the Edit menu to simultaneously paste and link the object. This menu item is gray if the object 
comes from a program that cannot link to Designer or if the file you want to link is not saved.

{button Related Topics,PI(`',`RT_Pasting_and_Linking_an_Object')}
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Pasting Inside
The Paste Inside command (on the Object menu) lets you mask an object. (See "Masking Objects" for more 
information.)

{button Related Topics,PI(`',`RT_Pasting_Inside')}
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Replacing Objects
{button Steps...,PI(`',`HT_Changing_the_Pasted_Data_Type')}

Use the Replace dialog box (click Replace on the Object menu) to control how selected objects are replaced by 
those from the Clipboard.

{button Related Topics,PI(`',`RT_Replacing_Objects')}
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Scaling to Fit
{button Steps...,PI(`',`HT_Changing_the_Pasted_Data_Type')}

You can use the Scale to Fit option to force a Clipboard object to scale up or down to completely fill the bounding 
area of the original object.

{button Related Topics,PI(`',`RT_Scaling_to_Fit')}
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Aligning to the Border
{button Steps...,PI(`',`HT_Changing_the_Pasted_Data_Type')}

You can position a replacement object inside the bounding box of the original as you paste it with the Align to 
Border option. This option does not change the object’s proportions.
Use the list box to select a handle on the original object to which Designer can align the Clipboard replacement.

{button Related Topics,PI(`',`RT_Aligning_to_the_Border')}
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Replacing with Multiple Objects
{button Steps...,PI(`',`HT_Changing_the_Pasted_Data_Type')}

If you select several objects to replace, Designer distributes Clipboard objects to replace selected objects. The 
first object    in the Clipboard(from back to front if no reordering has taken place) replaces the first original object,
the second Clipboard object replaces the second original object, and so on.
Select the Group Clipboard Objects option to replace each selected object with the entire contents of the 
Clipboard.
If you have several objects selected but only one in the Clipboard, each selected object is replaced with the 
Clipboard object.

{button Related Topics,PI(`',`RT_Replacing_with_Multiple_Objects')}
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To replace an object

1 Cut or copy one or more objects to the Clipboard.
2 Select the object or group of objects to replace.
3 On the Object menu, click Replace. The Replace dialog box opens.
4 Change the replacement options, if you wish.
5 Click Apply. The object in the drawing area is replaced with the contents of the Clipboard.

{button Related Topics,PI(`',`RT_To_replace_an_object')}
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To use special pasting options

1 On the Edit menu, click Paste Special. A dialog box opens that lets you choose how you want to paste an 
object from the Clipboard.

2 Choose the option you want to use.

{button Related Topics,PI(`',`RT_To_use_special_pasting_options')}
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Flipping Objects
{button Steps...,PI(`',`HT_Flipping_Objects')}

Designer lets you flip an object across an imaginary axis so the new object is a mirror image of the original. You 
can flip an object manually, or numerically with the Transform dialog box.
Flipping Manually

To flip an object manually, drag a handle across the object’s opposite side. The action is similar to turning the 
page of a book.

Flipping Numerically

You can use the Flip panel of the Transform dialog box to flip an object at a specific angular value.
When you flip an object numerically, you specify an imaginary line that passes through or beside an object at 
any angle. The object behaves as though it is hinged to the line, and flips over it.
Changing the Flip Units

You can change the units used to flip an object. Changing the units affects only the units used by the Transform 
dialog box; it does not affect the units used elsewhere.
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To flip an object manually

Drag a handle across the object’s opposite side.
Tip

The action is similar to turning the page of a book.

{button Related Topics,PI(`',`RT_To_use_special_pasting_options')}
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To flip an object horizontally or vertically

1 Select the object you want to flip.
2 On the Change menu, click Transform, and then click Flip to display the Flip panel.
3 Choose Flip Horizontal to flip the object horizontally (like a page in a book), or choose Flip Vertical.
Tip

As a shortcut, select the object and then press F7 to flip horizontally. Press SHIFT+F7 to flip vertically.

{button Related Topics,PI(`',`RT_To_flip_an_object_horizontally_or_vertically')}
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To flip an object at a specified angle

1 Select the object you want to flip.
2 On the Change menu, click Transform.
3 Choose Flip to display the Flip panel.
4 In the Origin list box, select a point on the object. This is the point that the flip axis passes through.
5 Type an angle from 0 to 179 in the Angle box or drag the red needle to specify a flip angle.
Tip

You can place the imaginary axis at which flipping occurs at any of the ten object origin points. For 
example, select the center origin to flip an object around a central axis, or select the right middle origin to flip the 
object around its right side.

{button Related Topics,PI(`',`RT_To_flip_an_object_numerically')}
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To make copies of an object while flipping it

1 Select the object you want to flip.
2 On the Change menu, click Transform.
3 Choose Flip to display the Flip panel.
4 Type the number of copies in the Copies box. Designer repeats the flipping, placing copies on top of one 

another.

{button Related Topics,PI(`',`RT_To_copy_an_object_while_flipping_it')}
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To change the flip units

1 Select the object you want to flip.
2 On the Change menu, click Transform.
3 Choose Flip to display the Flip panel.
4 Click the Units button.
5 Click the new unit.

{button Related Topics,PI(`',`RT_To_change_the_flip_units')}
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Applying Multiple Changes to an Object
{button Steps...,PI(`',`HT_Applying_Multiple_Changes_to_an_Object')}

You can use the Transform dialog box to make a series of changes to an object by recording each individual 
change, then applying them all at the same time.
For example, you can move an object 2 inches right, 1 inch down, and then make it twice as large. You also can 
apply these transformations to other objects, if you want.

{button Related Topics,PI(`',`RT_Applying_Multiple_Changes_to_an_Object')}
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Updating a Remembered Transform



To apply multiple changes to an object

1 On the Change menu, click Transform.
2 Click one of the submenu commands to display the Transform dialog box.

3 Click the Details button  to show the Multiple Transforms area.

4 Click a transform button (Rotate , for example) and select the transformation amounts, origin, and 
the number of copies.
5 Click Add in the Multiple Transforms area. The transform type and amount appears.
6 Repeat steps 5 and 6 to add more transformations to the list.

7 Select an object and click Apply to apply the multiple transforms.

{button Related Topics,PI(`',`RT_To_apply_multiple_changes_to_an_object')}
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Updating a Remembered Transform
{button Steps...,PI(`',`HT_Flipping_Objects')}

Remembered transforms remain in the multiple transforms box until you close Designer or transform an object 
and reopen the Transform dialog box.
You can update a remembered transform based on its current settings.

{button Related Topics,PI(`',`RT_Updating_a_Remembered_Transform')}
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To update a remembered transform

1 On the Change menu, click Transform.
2 Click one of the submenu commands to display the Transform dialog box.

3 Click the Details button  to show the Multiple Transforms area.
4 Highlight the remembered transform you want to change
5 Make the changes in the top portion of the dialog box, and click Modify. The new measurements appear.

{button Related Topics,PI(`',`RT_To_apply_multiple_changes_to_an_object')}



To delete remembered transformations

Click Empty to delete all remembered transforms
or
Click Delete to delete the last transform on the list.



Setting Options
Designer lets you customize your working environment by setting your options for many aspects of Designer. 
Your options can be saved in a profile or start-up file so that they apply every time you run Designer, or you can 
restrict options to your current work session by not saving them. If you want to maintain different sets of options,
you can define two or more profile files. Certain options, such as ruler units, are saved with the document so that
you do not have to reset them each time you open the document.
You can set options with the View menu and with the Options command on the Tools menu. The Options 
command lets you set many different categories of options. The categories include general options, ruler and 
snap options, rotation options, input (primarily mouse) options, settings for the system registry, and changing 
your profile (a collection of your personal settings).

{button Related Topics,PI(`',`RT_Setting_Options2')}
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View Options
You set display options on the View menu. View options affect all open documents, not just the active window.
Workspace (on the View menu)

From the Workspace submenu, you can either select or deselect to show or hide the following from the display.

Grid

Guides

Crosshairs (keyboard shortcut CTRL+H)

Printer Page Tiles (non-printing guidelines that indicate that the page is larger than the target printer's 
paper size)

Rulers

Ruler position (the colored marks in the rulers that indicate the position of the mouse pointer)
Status Bar

The status bar provides current information about your drawing and quick access to various commands such as 
line weight, object fill, and coordinates.
Choose Status Bar on the View menu and choose Single to display the single-line status bar. Choose Double from
the Status Bar submenu to display the double-line status bar.
Note

The Status Bar options on the View menu are available only when the Status toolbar is visible.
Preview (on the View menu)

Designer lets you select more than one way to view various fills and patterns. Changing display options does not 
affect the contents of your drawing or the way it is printed. If you are working on a large, complex drawing, you 
might choose a draft or wireframe preview to speed redraw and simplify your work.
The Preview command on the View menu affects all fills and patterns (solid, gradient, image, object fill, and 
hatch fill). You can use the three options (Proof, Draft, or Wireframe) in the Preview submenu to control the 
display for all of these types of fills at once. If you set Preview to Proof, you can use the individual commands for 
gradient, image, object fill, and hatch fills to control their display individually.
Generally, the Preview command overrides your selections with the individual commands. For example, if you 
select Draft in the Preview submenu, gradients are automatically set to none, and other commands are grayed.
Command Display

Preview Proof Full Preview—all colors and fills are displayed; you can limit gradient, image, 
object, and hatch fills with individual commands

Preview Draft Solid fills are normal; gradients, hatch fills, and object fills are solid (first color 
only). Image fills and masked objects are solid; bitmap images are a rectangle with
an X. All lines are displayed as hairlines.

Preview Wireframe No fills or line ends are displayed; all lines are displayed as hairlines.
Show Gradients Smooth Best gradient display, with all colors and smooth gradations from one color to the 

next
Show Gradients Average All colors are shown, but gradations are not as smooth
Show Gradients Coarse Fewer colors, with banding
Show Gradients None Only the first color is displayed
Show Images (selected) All colors and gray scales in the bitmap are displayed
Show Images (deselected) Rectangle with an X on it to show position only
Show Object Fills (selected) Object fills displayed
Show Object Fills (deselected)Only the foreground color is displayed
Show Hatch Fills (selected) Hatch fills displayed
Show Hatch Fills (deselected) Only the foreground color is displayed



Show Image Fills (selected) Image fills displayed
Show Image Fills (deselected) Only the foreground color is displayed

{button Related Topics,PI(`',`RT_Display_Options')}
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General Options
The General Tab of the Options dialog box lets you set a variety of high-level options.
Auto Scroll

When selected, Auto Scroll causes the window to automatically scroll when you drag an object beyond the 
window borders. This is especially useful when you have zoomed in for close work.
Make Backups

Use the Make Backups option to retain a copy of the previous version of all document files. Designer appends the
extension BAK to the filename. When the Make Backups option is selected, you have two copies of the document
on disk—the current version and the previously saved version. The backup version is overwritten each time you 
save the document.
Suppress New On Startup

If you do not want Designer to create a new file when you open it, select this option. Selecting this option makes 
Designer start faster, which can save you time when you plan to open an existing document rather than create a
new one.
Handle Size

The Handle Size option lets you select small, medium, or large handles to suit your option.
Undo Event Limit

By default, the Undo and Redo commands on the Edit menu reverse (Undo) or reverse the reversal (Redo) of the 
most recent five actions. The Options dialog box lets you specify that Designer remember from 0 to 100 undo 
and redo steps since the last save. Setting a higher number of steps gives you the freedom to try multiple 
changes and the capability to undo those changes if desired, but takes up memory.
Most Recently Used Files

You can specify how many recently used files you want Designer to remember. The default value is 4.

{button Related Topics,PI(`',`RT_General_Options2')}
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Rulers/Snap Options
In the Rulers/Snap tab of the Options dialog box, the Horizontal and Vertical Ruler areas provide options affecting
the two rulers. The rulers are independent, so you can have different options for each. The ruler settings are 
saved with the document.
For each ruler, you can choose a unit of measure, the number of snap divisions for each ruler unit, and how the 
ruler is labeled.
Ruler Unit

You can change the measurement units setting for a ruler by clicking its Units button  and choosing the 
desired units.
Snaps per Unit

The Snaps per Unit setting sets the number of divisions per unit, which affects the number of grid dots that 
appear when the grid is displayed and also affects how objects snap to the rulers if Snap to Rulers is selected. 
The grid appears as a pattern of dotted lines that corresponds to divisions in your ruler settings. You can use the 
grid as a guide for aligning objects or measuring distances.
Tip

To prevent the drawing area from becoming too cluttered, Designer limits the number of grid dots and ruler
divisions that appear.

Label Frequency

This value specifies how frequently a number appears to label the ruler's units. This option prevents 
overcrowding the ruler when it is set to small units. For example, when a ruler is set to inches, you might use a 
value of 1, but when a ruler is set to millimeters, you might prefer a value of 10.
Displayed Precision of Ruler Units

The Displayed Precision of Ruler Units value sets the decimal precision of the coordinates displayed in the status 
bar. The H list box sets the precision for the Horizontal and X coordinates. The V list box sets the precision for the
Vertical and Y coordinates.
Snap Points

Snap options lets you select or deselect where Designer places snap points on an object when you click the Add 

Snap Points button  in the Edit ribbon. The options include

Bounds

End Points

Center

Mid Point

Pivot

Control Points

Vertices
Tip

On the Tools menu, you can select or deselect Snap to Rulers and Snap to Guides to turn these features on 
or off. for information on using these features, see Snapping to the Ruler and Snapping to Guides.

Dragging Snap

Select the Dragging Snap option to cause an object's bounding box, rather than the mouse pointer, to snap to 
the rulers or guides when you are moving (dragging) the object. When Dragging Snap is selected, the mouse 
pointer will continue to snap to rulers or guides when drawing an object (if Snap to Ruler or Snap to Guides are 
currently selected on the Tools menu). 



Dragging Snap has no effect on object movement if Snap to Ruler and Snap to Guides are not selected on the 
Tools menu.

{button Related Topics,PI(`',`RT_Rulers_Snap_Options')}
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Rotation Options
The Rotation tab lets you set the rotation angle increment for the F8 key and constrain rotations to angle 
increments for manual rotation. To change the rotation units setting (degrees or radians), click the Units button

 and choose the new unit.
F8 Rotation Increment

You can change the F8 rotation increment by clicking the arrows beside the F8 Rotation Increment box, entering 
a new value, or dragging the red needle in the dial control. 
For details on using the F8 key, see Preset Rotation Key and Manual Rotation Constraint.
Manual Rotation Increment

Setting Manual Rotation Increment to a non-zero value constrains manual rotation to increments of the specified 
value. For example, if you set the rotation angle to 12 degrees, an object rotates in increments of 12 degrees 
when you drag its corner rotation handles. To change the Manual Rotation Increment, enter a new value or drag 
the red needle in the dial control.

{button Related Topics,PI(`',`RT_Rotation_Options')}
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Input Options
The Input tab lets you set options for your mouse buttons and select Designer 3.1 keyboard shortcuts.
Left Button Click

By default, if you point to an object in your document and double click the left mouse button, you enter a 
reshape mode. (If you double click a bitmap or an embedded OLE object, another program capable of editing the
object is launched instead). If you press and hold the ALT key and then point and click the left mouse button, you
can select overlapping objects in succession as in previous versions of Designer.
Function Default setting
Pick or Edit Objects Double click
Pick Among Overlapping Objects ALT+click
If you prefer, you can change the settings in the Input tab to reverse the use of the ALT key with these two 
functions.
Function Alternate setting
Pick or Edit Objects ALT+double click
Pick Among Overlapping Objects Click
Mouse and Ctrl/Shift Combinations

By default, holding down CTRL as you drag an object leaves a copy of the dragged object. Holding down SHIFT 
constrains the dragging to specific angles.
If you are accustomed to Designer 4.x, you may prefer holding SHIFT for copying and holding CTRL for 
constrained dragging. Click Designer 4.x Compatible Operation.
Right Button Click

The default function of a single click of the right mouse button displays the shortcut menu, which displays 
commands that give you quick access to functions that may not be displayed in the current ribbon.
The default setting for ALT+click right mouse button is an assigned command or tool similar to previous versions 
of Designer. 
Function Default setting
Display shortcut menu Click right mouse button
Assigned command ALT+click right mouse button
If you prefer, you can change the settings in the Input tab to reverse the actions used to access these two 
functions.
Function Alternate setting
Display shortcut menu ALT+click right mouse button
Assigned command Click right mouse button
You can choose a command to assign to a mouse button from the list box. Click the down arrow to view the 
available commands.
Designer 3.1 Keyboard shortcuts

If you have used earlier versions of Designer and you would like to continue to use the same keyboard shortcuts,
choose this option in the Input tab of the Options dialog box.

{button Related Topics,PI(`',`RT_Input_Options')}
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Registry settings
{button Steps...,PI(`',`HT_Registry_settings')}

Windows 95 programs save status and other information in a file called the system registry. Changes in the 
registry are detected by the Windows operating system and programs that monitor the registry.
Normally, you do not have to change registry entries directly. For example:

When you first install Designer, settings are automatically stored in the registry.

When you change a setting in the Windows Control Panel, the setting is automatically stored in the registry.
The registry entries for Designer customize Designer to meet your system's hardware and operating 
environment needs. Several entries are created by the Micrografx Installer when you install Designer. When 
necessary, you can use the Registry tab of the Options dialog box to edit those entries and to create new entries 
as needed.
Note

You should not modify Designer registry entries unless you are instructed to do so by Micrografx.

{button Related Topics,PI(`',`RT_Registry_settings')}
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To change the value of a registry key

1 On the Tools menu, click Options.
2 Click the Registry tab.
3 Choose the key name from the Key list box.
4 In the Value Name list, click the name whose value you want to change.
5 Highlight the old value and type the new value over it.

6 Click the Accept Entry button .
Note

You should not modify Designer registry entries unless you are instructed to do so by Micrografx.

{button Related Topics,PI(`',`RT_To_change_the_value_of_a_registry_key')}
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To add a new value to a registry key

1 On the Tools menu, click Options.
2 Click the Registry tab.
3 Choose the key name from the Key list box.
4 Click the New Value button.
5 Type the name of the new value and, if the value is numeric, click Numeric Value Type.
6 In the Value box, type the new value.
Note

You should not modify Designer registry entries unless you are instructed to do so by Micrografx.

{button Related Topics,PI(`',`RT_To_add_a_new_value_to_a_registry_key')}
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To delete a value from a registry key

1 On the Tools menu, click Options.
2 Click the Registry tab.
3 Choose the key name from the Key list box.
4 Choose a name from the Value Name list box.
5 Click the Delete Value button, and then confirm that you want to delete the entry.
Note

You should not modify Designer registry entries unless you are instructed to do so by Micrografx.

{button Related Topics,PI(`',`RT_To_delete_a_value_from_a_registry_key')}
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Profile Options
{button Steps...,PI(`',`HT_Profile_Options')}

You also can manage "option profiles" (which are PRO file types that contain all of your personal options). When 
you change settings, they are saved automatically to the file name.PRO (where name is your name), which is the
standard file that stores your settings. Designer also lets you save your options to other profiles. Unlike with INI 
files, when you change to a different profile, the changes take effect immediately.
Profiles are a collection of all of your options. You may want to use a different profile for different kinds of work 
(such as graphic design or technical illustration). You may want to change options for one particular session or 
project, and then return to your normal options. If more than one person is running Designer from a file server or
sharing a computer, each person can save and use his or her own options.
In addition, you can share option files with others. Systems administrators may want to use the same option file 
for multiple computers to ensure consistency.
You can use the Profile tab of the Options dialog box to choose a different profile, elect to save that choice when 

you close Designer, enter or edit a description of a profile. You can also click the File Options button  to 
create a new profile, copy a profile, delete a profile, rename a profile, and update a profile.
Working with Profiles

You can also click the File Options button  to create a new profile, copy a profile, delete a profile, rename a 
profile, or update a profile.

{button Related Topics,PI(`',`RT_Profile_Options')}
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To change profiles

1 On the Tools menu, click Options.
2 Click the Profile tab.
3 Choose a different PRO file from the Profile Document list box.
4 Select Save on Exit if you want Designer to use the new profile the next time Designer is opened.

or

Deselect Save on Exit if you want Designer to use the previous profile the next time Designer is opened.
Tip

Designer now uses the options in the profile to which you changed, and any changes to your options are 
stored there.

{button Related Topics,PI(`',`RT_To_change_profiles')}
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To create a new profile

1 On the Tools menu, click Options.
2 Click the Profile tab.

3 Click the File Options button  and choose New. The New Profile Document dialog box opens.
4 Type a DOS filename for the new profile and press ENTER. The New Profile Document dialog box closes, and 

the new filename appears as the current Profile Document.

{button Related Topics,PI(`',`RT_To_change_profiles')}



To copy a profile

1 On the Tools menu, click Options.
2 Click the Profile tab.

3 Click the File Options button  and choose Copy. The Copy Profile Document dialog box opens.
4 Type a new filename and press ENTER. The Copy Profile Document dialog box closes. The new filename is 

listed as an option in the Profile Document list box.

{button Related Topics,PI(`',`RT_To_change_profiles')}



To delete a profile

1 On the Tools menu, click Options.
2 Click the Profile tab.
3 Choose a file in the Profile Document list box that you want to delete.

4 Click the File Options button  and choose Delete. You are asked to confirm that you want to delete the 
profile.

5 Click Yes to confirm the deletion.

{button Related Topics,PI(`',`RT_To_change_profiles')}



To rename a profile

1 On the Tools menu, click Options.
2 Click the Profile tab.

3 Click the File Options button  and choose Rename. The Rename Profile Document dialog box opens.
4 Type a new filename and press ENTER. The Rename Profile Document dialog box closes, and the renamed 

profile appears as the current Profile Document.
Tip

If you want to update the profile manually, you can deselect the Save on Exit option and use the Update 
command.

{button Related Topics,PI(`',`RT_To_change_profiles')}



To update a profile

1 On the Tools menu, click Options.
2 Click the Profile tab.

3 Click the File Options button  and choose Update. The current profile is updated with any options that 
have changed since the last time the profile was saved or updated.

{button Related Topics,PI(`',`RT_To_change_profiles')}



Changing the Ruler Origin
{button Steps...,PI(`',`HT_Changing_the_Ruler_Origin')}

The ruler origin is the point, on or off the page, where the two rulers intersect at zero. The default position for the
ruler origin is at the upper left corner of the page. You can drag and drop to change the placement of the ruler 
origin.

{button Related Topics,PI(`',`RT_Changing_the_Ruler_Origin')}
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To change the placement of the ruler origin

1 Make sure that rulers are displayed. On the View menu, click Workspace, and then click Show Rulers, if 
necessary.

2 Point to the button at the intersection of the two rulers and press and hold the left mouse button.
3 Drag the mouse pointer to the desired position.
4 Release the mouse button. The zero point on each ruler changes to reflect the new placement.
Tips

If you have selected Snap to Rulers on the Tools menu, the new ruler origin also snaps to the rulers. This 
ensures that your grid remains the same. If you have deselected Snap to Rulers, the new ruler origin is placed at 
the exact point where you place it.

You can quickly reset the ruler origin to its default position at the corner of the page by double clicking the 
button at the intersection of the two rulers.

{button Related Topics,PI(`',`RT_To_change_the_placement_of_the_ruler_origin')}
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Using Guides
{button Steps...,PI(`',`HT_Changing_the_Ruler_Origin')}

A guide is a horizontal or vertical line you can use for alignment or visual reference. Guides can help organize 
the layout of your drawing by guiding the placement of your objects. You can use guides as visual cues for where
to place objects, or you can snap objects to guides for more exact placement. Guides appear on screen but do 
not print.

{button Related Topics,PI(`',`RT_Using_Guides')}
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To add a guide

1 Move the selection pointer to the top or side ruler (for a horizontal or vertical guideline, respectively).
2 Press and hold the left mouse button, and drag a guide to the desired position in the drawing area.
3 Release the left mouse button.
Tips

You can add as many guides as you need. You also can move guides by dragging them to new locations on 
the screen with the selection pointer.

To remove a guide, just drag and drop it onto the ruler with the selection pointer.

{button Related Topics,PI(`',`RT_To_change_the_placement_of_the_ruler_origin')}



Setting Up a Page
{button Steps...,PI(`',`HT_Setting_Up_a_Page')}

Use the Page Setup command on the File menu to change the size and orientation of the current page in the 
active window.
Page Setup displays a tabbed dialog box that lets you change the size, margins, and orientation of the active 
window's on-screen page. You can change page settings before, during, or after creating a drawing.
Tip

If you change the page setup, and you plan to print your work, you should change the printer setup to 
match.

New page settings are applied immediately to the current page in the active window.
Individual pages in your document can have different sizes, orientations, and page fills, if desired. To apply the 
same size, orientation, and page fill to all pages in the document, select Apply to All Pages. This option, like Use 
Master Page, forces all pages to be uniform.
The Paper Size tab

Use the list box on the Paper Size tab to choose the size of the current page. You can choose from standard page 
sizes or create your own by adjusting the Width and Height measurements. If you enter dimensions for Width 
and Height that do not match one of the standard page sizes, the Page Size selection changes to Custom Size.
35 mm Use this selection in the Page Size list box when preparing slides rather than paper 

documents. The page size is set to the proper proportions for slides.
Screen Size Use this selection in the Page Size list box when preparing on-screen presentations 

(slideshows) using the Page Manager tool . Choosing this option sets the page size 
to match the size, proportions, and resolution of your computer monitor.

Use Master Page If you choose the Use Master Page option, the page matches the size, orientation, and 
page fill (if any) of the master page. To edit the master page, click the Page button (at the bottom left of the active 
window) and choose Master Page. For more information, see Using the Master Page.
Use Printable Area Choose the Use Printable Area option to force the on-screen page to reflect your 

printer's page size and margins. For example, if your printer uses an 8.5" x 11" page 
with 1/2 inch margins, the on-screen page matches it.

Units The Units button  shows the current page size measurement units. To change the 
units setting, click the Units button 

 and choose the desired units.
Width and Height The Width and Height boxes show the measurements for the current page size. You can 
create a custom page size by changing these settings. Click the arrows to change its setting.
Page Orientation The Page Orientation options determine the page layout. Select Portrait to layout the 

page so that the vertical dimension is longer than the horizontal dimension. Select 
Landscape to layout the page so that the horizontal dimension is longer than the 
vertical dimension.

Apply to All Pages Select this option if you want to apply the settings to all pages in your document rather 
than only to the current page.

The Margins tab

The Top, Bottom, Left, and Right boxes let you set the page margins (border widths). You can use margins as 
boundary guides for creating drawings. Type the margins you want, or use the scroll arrows to change the 

widths. The measurement unit used for margins is the unit displayed on the Units button  (for example, 
inches or centimeters).

Most printers do not print to the edge of the paper. Margins include this non-printing area. For example, if your 
margin is 1/2 inch and the non-printing area is 1/4 inch, the margin is 1/2 inch from the edge.
Preview area The preview area shows the number of columns and rows of tiles used when the current

page size is printed to the target printer. If the page size is set to use Printable Area 
and the Page Orientation matches the orientation of the target printer, no tiling is used,
and the number for columns and rows are both set 



to 1.
If you enter new values for columns and rows, the page size changes to match. If you 
want to display tile lines on your screen as you work, click Workspace on the View 
menu, and then click Show Printer Page Tiles on the Workspace submenu.

Show Page Crop Marks Select Show Page Crop Marks to display and print crop marks on the page. 
Crop marks are used by print shops to determine alignment and trim margins.
For example, suppose you set your page size to a custom size of 7 inches x 9 inches, 
set all four margins to zero, and you print to a printer with 8.5 x 11 inch paper. Your 
custom page is centered on the printer's paper. When you select Show Page Crop 
Marks, four sets of crop marks print at the corners of your custom page area.

Page Fill Page Fill lets you choose a background for the entire page, such as a gradient fill for a 
slide or a solid color to simulate printing on colored paper.
You can select or deselect Page Fill for individual pages in your document. When you 
click the Page Fill button , the Fill dialog box opens. You can apply any kind of fill
or pattern to the overall page as a background for your drawings. For more information 
on fills, see Style Attributes for All Objects.

{button Related Topics,PI(`',`RT_Setting_Up_a_Page')}
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Setting Up Multiple Pages
{button Steps...,PI(`',`HT_Setting_Up_a_Page')}

You can use the Page Manager tool  to select any number of pages in your document and set them up with 
the same size, orientation, margins, page fill, and so forth.

{button Related Topics,PI(`',`RT_Setting_Up_Multiple_Pages')}
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To set up multiple pages

1 Open a document with multiple pages.

2 Click the Page Manager tool  in the toolbox. Thumbnail images are displayed for each page in the 
document.

3 Press and hold CTRL and select each page you want to setup.

4 Click the Page Setup button  in the ribbon. The Page Setup dialog box opens.
5 Choose the page size, orientation, margins, and so forth.

{button Related Topics,PI(`',`RT_To_display_a_preview_of_the_page_and_margins')}



Using the Master Page
{button Steps...,PI(`',`HT_Setting_Up_a_Page')}

Every Designer document has a master page. You can use the master page to make all the pages in your 
document consistent in size, orientation, margins, and page fill. The size of the master page defaults to match 
the printable area of your target printer.
If you want certain graphic or text objects, such as a title or border, to appear on every page, you can place 
these objects on the master page. These repeated objects are called master items.

{button Related Topics,PI(`',`RT_Using_the_Master_Page')}
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To set up and use the master page

1 Create a new document.
2 Click the Page button at the bottom left of the window and choose Master Page. The master page displays.
3 On the File menu, click Page Setup. The Page Setup dialog box opens.
4 Choose page size and orientation to match your target printer, and adjust the margins if necessary.

5 If you want a background color or fill, choose the Page Fill option, click the Page Fill button , and choose a
fill style in the Fill dialog box.

6 Click OK to close the Page Setup dialog box.
7 Place any items on the master page that you want to appear on all your pages.
8 Use the Master Page as the Page Size for all other pages in your document.
Tips

You can create and edit objects on the master page as with other pages by clicking the Page button, 
choosing Master Page, and making your changes. However, you cannot select or change master items unless the 
master page is the current page; this protects the master items from accidental changes.

If you have a page in the document that you want to be different from the rest, you can display that page, 
choose the Page Setup command, and change the Page Size in the Page Setup dialog box to something other than 
Use Master Page. You can then make any changes you want to orientation, margins, and so forth. Master items do 
not appear on pages that are not set up to use the master page.

{button Related Topics,PI(`',`RT_To_display_a_preview_of_the_page_and_margins')}



Using Multiple Pages
{button Steps...,PI(`',`HT_Using_Multiple_Pages')}

Designer lets you use as many pages as you need for your documents.
Individual pages in a document can be of different sizes and orientations (portrait, landscape). Each page can be 
set up differently if needed.
If you want to remove an object from a page temporarily, you can drag it off of the page onto the working area. 
The object remains there until you need it again. However, if you select another page, it is not visible.

{button Related Topics,PI(`',`RT_Using_Multiple_Pages')}
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To view a different page in the document

1 Click the Page button at the bottom left of the active window. The Page menu opens, listing the names of all 
the pages in the document.

2 Choose the name of the page you want to display.
or

Type the number of the page you want to display.
Tip

You can easily move from page to page with the keyboard shortcuts CTRL+PAGE UP, CTRL+PAGE DOWN, 
CTRL+HOME, and CTRL+END. Press CTRL+PAGE UP to move to the next (higher-numbered) page. Press CTRL+PAGE 
DOWN to move to the previous (lower-numbered) page. Press CTRL+HOME to move to the first page. Press 
CTRL+END to move to the last page.

{button Related Topics,PI(`',`RT_To_view_a_different_page_in_the_document')}
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Selecting Pages
{button Steps...,PI(`',`HT_Using_Multiple_Pages')}

In Page Manager view, you can simply click the desired page to select it.

{button Related Topics,PI(`',`RT_Selecting_Pages')}



Using Multiple Pages
Sorting Pages
Renaming a Page
Adding a Page
Deleting a Page



To select multiple pages

1 Open a document with multiple pages.

2 Click the Page Manager tool . The drawing area changes to Page Manager view.
3 Click the first page you want to select.
4 Press and hold SHIFT and click the last page you want to select. Designer selects every page between the 

two pages you selected.

{button Related Topics,PI(`',`RT_To_view_a_different_page_in_the_document')}



To select multiple pages that are not next to each other

1 Open a document with multiple pages.

2 Click the Page Manager tool . The drawing area changes to Page Manager view.
3 Click the first page you want to select.
4 Press and hold CTRL and click the other pages you want to select. Only the pages you click are selected.

{button Related Topics,PI(`',`RT_To_view_a_different_page_in_the_document')}



Sorting Pages
{button Steps...,PI(`',`HT_Using_Multiple_Pages')}

You can easily sort pages in a document into a different order.

{button Related Topics,PI(`',`RT_Sorting_Pages')}
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To sort pages in a document

1 Open a document with multiple pages.

2 Click the Page Manager tool . The drawing area changes to Page Manager view.
3 Select a page and drag it to the beginning, end, or middle of the sequence. 
Tips

A vertical cursor bar displays as you drag the page to a different point in the sequence, indicating its 
position. As you sort pages, they are automatically renumbered.

If your document has more pages than fit on the screen, use the scroll bar to display the other pages.

To insert a page between two other pages, you can add a new page at the end of the document (in the 
normal single-page view) and then drag the new page into the correct sequence (in Page Manager view).

{button Related Topics,PI(`',`RT_To_view_a_different_page_in_the_document')}



Renaming a Page
{button Steps...,PI(`',`HT_Using_Multiple_Pages')}

By default, Designer names the pages Page 1, Page 2, and so forth. You can change the default page names to 
give each page in your drawing a unique name.

{button Related Topics,PI(`',`RT_Renaming_a_Page')}
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To rename a page

1 Click the Page button at the bottom left of the active window. The Page menu opens.
2 Click the Pages button on the menu. The Pages dialog box opens.
3 Under Current Page, highlight the name of the page you want to rename if necessary.
4 Point to the Page name text box and click the left mouse button.
5 Type a new page name and press ENTER.

{button Related Topics,PI(`',`RT_To_view_a_different_page_in_the_document')}



Adding a Page
{button Steps...,PI(`',`HT_Using_Multiple_Pages')}

Designer lets you add a new page at the end of your document.

{button Related Topics,PI(`',`RT_Adding_a_Page')}
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To add a page

1 Click the Page button at the bottom left of the active window. The Page menu opens.
2 Click Add Page on the menu to add one additional page to the end of the document. The new page is 

displayed in the active window, and its name is added to the Page menu.
Tip

You can also click the Add button in the Pages dialog box as another way to add a new page to the end of 
the document.

{button Related Topics,PI(`',`RT_To_view_a_different_page_in_the_document')}



Deleting a Page
{button Steps...,PI(`',`HT_Using_Multiple_Pages')}

You can delete any page in your document except the current page or the master page. When you delete a page 
from your document, the entire contents of the page are deleted as well. 

{button Related Topics,PI(`',`RT_Deleting_a_Page')}
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To delete a page

1 Click the Page button at the bottom left of the active window. The Page menu opens.
2 Click the Pages button on the menu. The Pages dialog box opens.
3 Highlight a page name. 
4 Click Delete to delete the specified page and its contents.
Tip

Double click a page in the Pages dialog box to make it the current page.

{button Related Topics,PI(`',`RT_To_view_a_different_page_in_the_document')}



Benefits of Layers
{button Steps...,PI(`',`HT_Benefits_of_Layers')}

Designer lets you create layers for each page of your document. This allows you to place some objects on one 
layer, others on another layer, and so on, just as you might with several overhead transparencies. Layers help 
you:

Manage complex drawings with many overlapping objects

Categorize objects that logically belong together by layer

View certain objects in your drawing while hiding others

Easily select and edit objects

Protect objects from accidental changes

Trace from a template on another layer

Print certain objects only
Each page in a Designer drawing has one layer by default. Layers remain perfectly aligned with one another. 

Designer automatically numbers layers for you. The total number of layers you can use is virtually unlimited
32,767.
Designer lets you do the following with layers.

Name the layers

Add and remove layers

Change the order of layers

Lock layers (so that objects cannot be changed)

Display or hide selected layers

Specify layers as printable or non-printable

Use one color (for easy identification) or multiple colors on a layer

Move objects from one layer to another

Edit all the layers or edit one layer at a time
Tip

Designer does not store a layer that has no objects on it unless you have named the layer.

{button Related Topics,PI(`',`RT_Benefits_of_Layers')}
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Basic Layer Tasks
{button Steps...,PI(`',`HT_Benefits_of_Layers')}

You can click the Layer button at the bottom of the active window to open the Layer menu, which lists the 
numbers and names of all the layers on the current page, with the current layer highlighted. From this menu you 
can

Change to a different layer

Add a layer

Open the Layers dialog box for other operations

{button Related Topics,PI(`',`RT_Basic_Layer_Tasks')}
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To change to a different layer

1 Click the Layer button at the bottom of the active window. The Layer menu opens, listing the names of all the
layers on the current page.

2 Choose the name of the layer you want to work with.
Tip

You can easily move from layer to layer with the keyboard shortcuts SHIFT+PAGE UP and SHIFT+PAGE 
DOWN. Press SHIFT+PAGE UP to move to a higher-numbered layer. Press SHIFT+PAGE DOWN to move to a lower-
numbered layer.

{button Related Topics,PI(`',`RT_To_change_to_a_different_layer')}
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To add a layer

1 Click the Layer button at the bottom of the active window. The Layer menu opens.

2 Click the Add Layer button . The new layer becomes the active layer, and its name is added to the Layer 
menu.

{button Related Topics,PI(`',`RT_To_change_to_a_different_layer')}



Managing Layers
{button Steps...,PI(`',`HT_Benefits_of_Layers')}

You can manage layers in other ways with the Layers dialog box. You can do any of the operations on a single 
layer, and you can work with multiple layers when removing, locking, unlocking, showing, and hiding layers. 

{button Related Topics,PI(`',`RT_Managing_Layers')}
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To select multiple layers

1 Create or open a document with multiple layers.
2 Click the Layer button at the bottom of the active window. The Layer menu opens.
3 Click the Layers button on the menu. The Layers dialog box opens.
4 Choose the first layer you want to select.
5 Press and hold SHIFT and choose the last layer you want to select. Every layer between the two layers is 

selected.

{button Related Topics,PI(`',`RT_To_change_to_a_different_layer')}



To select multiple layers that are not next to each other

1 Create or open a document with multiple layers.
2 Click the Layer button at the bottom of the active window. The Layer menu opens.
3 Click the Layers button on the menu. The Layers dialog box opens.
4 Choose the first layer you want to select.
5 Press and hold CTRL and choose the other layers you want to select. Only the layers you choose are selected.
Tip

By default, Designer names the layers Layer 1, Layer 2, and so forth. You can change these names to give 
each layer in your drawing a unique name.

{button Related Topics,PI(`',`RT_To_change_to_a_different_layer')}



To rename a layer

1 Click the Layer button at the bottom of the active window. The Layer menu opens.
2 Click the Layers button on the menu. The Layers dialog box opens.
3 Highlight the name of the layer you want to rename.
4 Point to the Layer Name text box and click the left mouse button.
5 Type a new name and press ENTER. The new name appears in the list of names.

{button Related Topics,PI(`',`RT_To_change_to_a_different_layer')}



To add and remove layers

1 Click the Layer button at the bottom of the active window. The Layer menu opens.
2 Click the Layers button on the menu. The Layers dialog box opens.

3 To add a layer, click the Add Layer button .
or

To remove a layer, choose the layer you want to remove and click Delete Layer .
Tips

When you remove a layer, all objects on that layer are deleted. You cannot remove the current layer.

Double click a layer in the Layers dialog box to make it the current layer.

{button Related Topics,PI(`',`RT_To_change_to_a_different_layer')}



To change the order of layers

1 Click the Layer button at the bottom of the active window. The Layer menu opens.
2 Click the Layers button on the menu. The Layers dialog box opens.

3 To move a layer up the list, choose the layer you want to move and click the Move Up button .
or

To move a layer down the list, choose the layer you want to move and click the Move Down button .

{button Related Topics,PI(`',`RT_To_change_to_a_different_layer')}



To move an object from one layer to another

1 Select the object you want to move to another layer.
2 Click the Layer button at the bottom of the active window. The Layer menu opens.
3 Click the Layers button on the menu. The Layers dialog box opens.
4 Click Move Objects.
5 Double click the name of the layer to which you want to move. The selected object moves to the chosen (now

current) layer.

{button Related Topics,PI(`',`RT_To_change_to_a_different_layer')}



To edit all layers

1 Click the Layer button at the bottom of the active window. The Layer menu opens.
2 Click the Layers button on the menu. The Layers dialog box opens.
3 Click Edit All Layers. You can now select and edit all objects on all layers. Deselect this option to return to 

single-layer selection and editing.
Tip

You cannot move an object on a lower layer in front of an object on a higher layer. You can, however, 
change the order of layers so that the entire layer and its contents move in front of another layer. 

{button Related Topics,PI(`',`RT_To_change_to_a_different_layer')}



Locking and Unlocking Layers
{button Steps...,PI(`',`HT_Benefits_of_Layers')}

When a layer is locked, it can either be displayed or hidden, but it cannot be edited or deleted. You cannot lock 
the current layer.

{button Related Topics,PI(`',`RT_Locking_and_Unlocking_Layers')}
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To lock or unlock layers

1 Click the Layer button at the bottom of the active window. The Layer menu opens.
2 Click the Layers button on the menu. The Layers dialog box opens.

3 To lock a layer, choose the layer you want to lock and click the Lock Layer button .
or

To unlock a layer, choose the layer you want to unlock and click the Unlock Layer button .

{button Related Topics,PI(`',`RT_To_change_to_a_different_layer')}



Showing and Hiding Layers
{button Steps...,PI(`',`HT_Benefits_of_Layers')}

You cannot hide the current layer. If you make a hidden layer the current layer, it is no longer hidden.
Hidden layers are not printed, so you can hide layers not only in your display but also in your printout. If you 
want to print all of the layers in the drawing, be sure to show all the layers before you print.

{button Related Topics,PI(`',`RT_Showing_and_Hiding_Layers')}
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To show or hide layers

1 Click the Layer button at the bottom of the active window. The Layer menu opens.
2 Click the Layers button on the menu. The Layers dialog box opens.

3 To show a layer, choose the layer you want to show and click the Show button .
or

To hide a layer, choose the layer you want to hide and click the Hide button .

{button Related Topics,PI(`',`RT_To_change_to_a_different_layer')}



Printable Layers
{button Steps...,PI(`',`HT_Benefits_of_Layers')}

You can make layers printable or non-printable. By default, all layers are printable.
Tip

Hidden layers cannot be set to printable.

{button Related Topics,PI(`',`RT_Printable_Layers')}
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To make a layer printable or non-printable

1 Click the Layer button at the bottom of the active window. The Layer menu opens.
2 Click the Layers button on the menu. The Layers dialog box opens.

3 To make a layer printable, choose the layer you want to print and click the Printable Layer button .
or

To make a layer non-printable, choose the layer you do not want to print and click the Non-Printable Layer 
button .

{button Related Topics,PI(`',`RT_To_change_to_a_different_layer')}



Using Multicolor or Single-Color Layers
{button Steps...,PI(`',`HT_Benefits_of_Layers')}

You can make every object on a particular layer the same color. Using single-color layers can help you visually 
keep track of which objects are on which layer. Designer lets you mix single-color layers and multiple-color layers
in the same drawing.
By default, a layer is multicolor. If you limit a particular layer to a single color, all existing objects and all 
subsequent objects are filled with the single color. You can use the current default layer color or click the Layer 
Color button to choose a different color.

{button Related Topics,PI(`',`RT_Using_Multicolor_or_Single_Color_Layers')}
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To change a layer to a single-color layer

1 Click the Layer button at the bottom of the active window. The Layer menu opens.
2 Click the Layers button on the menu. The Layers dialog box opens.
3 Choose the layer that you want to make a single color.
4 Click the Layer Color button. A color palette opens.
5 Choose a color from the color palette.

6 Click the Single-color button . An indicator appears to mark the chosen layer as all one color.
Tips

If you skip steps 4 and 5 above, the default layer color is applied.

To change a layer back to a multicolor layer, open the Layers dialog box, choose the layer, and click the 
Multicolor button 

. The objects on the layer change back to their previous colors.

{button Related Topics,PI(`',`RT_To_change_to_a_different_layer')}



Hiding and Locking Individual Objects
{button Steps...,PI(`',`HT_Benefits_of_Layers')}

In addition to letting you hide or lock all objects on a specified layer, Designer also lets you hide or lock 
individual objects.
Temporarily hiding objects may speed screen redraw time, especially if the objects include gradient fills or 
bitmaps. Locking objects may be desirable if you want to ensure that you do not accidentally move or resize 
them.

{button Related Topics,PI(`',`RT_Hiding_and_Locking_Individual_Objects')}
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To hide or lock individual objects

1 Select one or more objects to hide or lock.
2 On the Object menu, click Hide or Lock.

{button Related Topics,PI(`',`RT_To_change_to_a_different_layer')}



To show or unlock all objects

On the Object menu, click Show All or Unlock All.

{button Related Topics,PI(`',`RT_To_change_to_a_different_layer')}



Properties and Values
{button Steps...,PI(`',`HT_Properties_and_Values')}

You can assign names to objects and groups of objects in your drawing. This lets you create a list of objects, 
select objects by name, and create your own library of clip art. You can assign names, costs, and other properties
to complex engineering drawings.
Properties are like categories of information about the objects in your drawings. "Name," known as "Symbol ID" 
in previous versions of Designer, is a predefined property. When you assign a name to an object, you create a 
value for the property "Name."
You can define your own properties and assign values to them. For example, you could use properties and values
for a part in an engineering drawing as follows.
Property Value
Part Number TL7770-5
Name Voltage Regulator
Cost $1.75
Primary Source United Semiconductors
Second Source Hi-Tech Distributors

{button Related Topics,PI(`',`RT_Properties_and_Values')}
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Getting Object Information
{button Steps...,PI(`',`HT_Properties_and_Values')}

You can name or rename objects and assign other values to other properties for specific objects. You can also 
create new properties.
Designer gives you two ways to access object properties and their values. The quick way is with the Object 
Properties button [bmc object properties.bmp} and text box in the Edit ribbon. The other way is through the 
Properties dialog box.

{button Related Topics,PI(`',`RT_Getting_Object_Information')}
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Naming (or Renaming) an Object
{button Steps...,PI(`',`HT_Properties_and_Values')}

If an object has a name, you can select the object, click the Edit tool , and the object's name appears in the 
Object Properties text box in the Edit ribbon.

{button Related Topics,PI(`',`RT_Naming_or_Renaming_an_Object')}
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To name an object using the Edit ribbon

1 Click the Edit tool .
2 Select an object.
3 Point to the Object Properties text box and click the left mouse button. A cursor appears.
4 Type a new name.
If the object already has a name, it appears in the text box in the Edit ribbon. If you want to change the name, 
highlight it and type over it.

{button Related Topics,PI(`',`RT_To_name_an_object_using_the_Edit_ribbon')}
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To name an object using the Properties dialog box

1 Select an object.
2 On the Object menu, click Properties. The Properties dialog box opens.
3 Choose Name in the Properties list (if not already selected).
4 Type a name in the Value field and press ENTER.
5 Click Close. The name appears in the Object Properties text box in the Edit ribbon when the object is 

selected.
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To create a new property

1 Select an object.
2 On the Object menu, click Properties. The Properties dialog box opens.
3 Click New. The New Property dialog box opens.
4 Type a new property (for example, Part Number) and press ENTER.
5 With the new property selected, type a value in the Value field (for example, 12345-01).
Tip

You can delete the values of any properties you have created by choosing the property and value and 
clicking Delete in the Properties dialog box. Any properties you have added remain until you close Designer so that 
you can assign them to other objects. If there are properties with no values when you close Designer, the properties
are not saved.

{button Related Topics,PI(`',`RT_Naming_or_Renaming_an_Object')}



Assigning Values to Other Properties
{button Steps...,PI(`',`HT_Properties_and_Values')}

If other properties (besides Name) have been created for a document, you can select an object, choose one of its
properties, and then assign a new value to that property or find out what value has already been assigned.
After you have used the Properties dialog box to create the properties you want to use, you can access them 
quickly through the Edit ribbon or through the Properties dialog box. 
Properties that have already been created are displayed on the Object Properties menu in the Edit ribbon.
Tip

If you typically use many of the same properties you have used before, you need not enter them again 
when you create a new document. Just open a document that includes the desired properties. You can then access 
the same properties from any other open document.
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Listing Objects
{button Steps...,PI(`',`HT_Properties_and_Values')}

You can create a list of objects in your drawing. This lets you create a named parts list of all the pieces of your 
drawing, plus a list of other defined properties. ClipArt files are a good example of files with named objects.
The List command is on the Object menu. The List command opens the List Objects dialog box, which 
alphabetically lists the names (the values assigned to the property "name") for the objects selected in the 
current drawing, and shows the number of times each object appears (quantity).
If no objects are selected, the list contains the names for all the objects in the drawing. Objects without names 
are listed as "other."
If you click the down arrow in the Property list box, you can choose any other property (in addition to "Name") 
that is defined. The value and quantity for that property for selected objects appears under Value and Quantity 
(Qty). Unless you select an object, Designer lists all objects with the selected property.
Titles

You can change the column titles and the column separator character used when the list is copied or printed. 
Click Titles, and the Titles dialog box opens. You can then enter a Main Title and enter column titles for Value 
Column and Quantity Column.
If you want to print leader characters, such as periods, between the two columns, you can enter one or more 
characters in the Column Separator field of the Titles dialog box.
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Copying and Printing Object Lists
{button Steps...,PI(`',`HT_Properties_and_Values')}

Click the Copy button  to copy the object list to the Clipboard. The list remains in the Clipboard after you 
close the List Objects dialog box. You can paste the data into the drawing area or into any Windows-compatible 
program.
Click Print to print the parts list.
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Saving an Object List
{button Steps...,PI(`',`HT_Properties_and_Values')}

You can save an object list as a file to use with another program. Save the list as a TXT file, the default, to use in 
a word processor. Save the list as a DIF or SLK file to use in compatible programs such as a spreadsheet or 
database program.
Click Save As to save the parts list as a text (TXT), DIF, or SYLK (SLK) file.
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Using Units of Measure
{button Steps...,PI(`',`HT_Using_Units_of_Measure')}

The units of measure in Designer are extremely flexible and can be set separately for every function that uses a 
measurement unit. For example, you can specify different measurement units for rulers, page size, coordinates, 
line weight, and dimension lines. The current units setting for a particular function appears on the Units button

 in the dialog box (or ribbon) for that function. For example, if the measurement unit for page size is inches, 
the Units button 

 in the Page Setup dialog box reads "in."
When specifying the measurement units, you can choose from a set of standard units, another set of predefined 
units, or create your own custom units. You can also set a scale to relate one unit of measure to another.
The units settings that you use with a drawing are saved with the drawing so that you do not have to reset them 
each time you open the file.
Standard Units

Units can be linear (to measure length) or radial (to measure angles). Linear units are used to measure spatial 
distances. Radial units are used to measure angular orientation or direction.
The standard linear units are inches, centimeters, millimeters, points, picas, picas and points, and ciceros. The 
standard radial units are degrees and radians.
Other predefined units include feet, feet and inches, kilometers, meters, miles, weeks and days, yards, and yards
and feet.
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Changing a Units Setting
{button Steps...,PI(`',`HT_Using_Units_of_Measure')}

The currently selected units setting for a particular function appears on the appropriate Units button  for 
that function. The following steps apply specifically to changing the units setting of the Page Setup dialog box, 
but the procedure is virtually identical for other dialog boxes.

{button Related Topics,PI(`',`RT_Changing_a_Units_Setting')}



Using Units of Measure
Defining Scale Units
Defining Unscaled Units
Updating Unit Settings
Deleting a Defined Unit



To change the units setting for the page size

1 On the File menu, click Page Setup. The Page Setup dialog box opens.
2 Click the Paper Size tab.

3 Click the Units button  (marked with an abbreviation for a standard unit, such as "in" or "cm"). A menu 
opens.

4 Choose the desired units setting from the menu.
or

Choose More Units, choose a setting in the Available Units dialog box, and click OK.

5 The menu closes and the Units button  in the Page Setup dialog box changes to reflect the new setting.
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Defining Scale Units
{button Steps...,PI(`',`HT_Using_Units_of_Measure')}

If you do scale drawings, you can use the Custom Units dialog box to define a scale unit, which is a ratio of one 
unit of measure to another. For example, you could define a scale of 10 feet per inch and draw a landscape at 
that scale, or define a scale of 2 weeks per centimeter and draw a timeline chart at that scale.
To show scaled distances in a drawing, use dimension lines with the dimension units set to the scale units. If you 
also want to see the scale used by the rulers, set the units for the rulers to the scale units. In the following 
example, the dimension units are set to 5 meters per centimeter.

You define new units using the Custom Units dialog box. You can open the Custom Units dialog box by clicking 

Custom Units on the Tools menu, or by clicking any Units button  and clicking Custom Units.
After defining a new scale unit, you can add it to your current profile, or just save it to the current drawing. If you
add it to your profile, the scale units are available in other drawings you make. New units that have been saved 
to a profile are designated by a plus sign in front of the unit's name in the Defined Units list box.
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To define a scale unit of 5 meters per centimeter

1 On the Tools menu, click Custom Units. The Custom Units dialog box opens.
2 Click in the Custom Unit Name field and type the name METERS (SCALE 5). Adding (scale 5) to the name 

makes it easy to identify the scale in the units list.
3 Press TAB and type M for the Primary Unit Label.
4 Press TAB and type 5 for the Primary Unit Scale value.
5 Click the down arrow in the list box for the Primary base unit and choose centimeters.
6 If you want to save the scale unit to just the current drawing, click Save to Drawing. If you want to save the 

scale unit to the current profile, click Save to Profile. Your scale unit (with abbreviated label) appears in the 
list of Defined Units.

Tip

The unit you entered above only defines a primary unit. If needed, you also can specify a secondary unit. 
Yards and feet, feet and inches, and weeks and days are all examples of definitions with primary and secondary 
units.
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To apply scale units to a dimension line

1 Click the Dimension tool .
2 Select the dimension line.

3 Click the Units button  in the ribbon. A menu opens.
4 Choose More Units. The Available Units dialog box opens.
5 Highlight the scale units you want to use.
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Defining Unscaled Units
{button Steps...,PI(`',`HT_Using_Units_of_Measure')}

Besides defining scaled units, the Custom Units dialog box lets you define new unscaled units of measure. The 
procedure for defining unscaled units is identical to that for defining scaled units (explained in the previous 
section) except that you do not specify a scaled ratio when you define the unit. Instead, you specify an accurate 
conversion ratio for the unit, such as 1000 meters per kilometer.
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Updating Unit Settings
{button Steps...,PI(`',`HT_Using_Units_of_Measure')}

Designer gives you exceptional flexibility in defining scale units without causing unwanted changes. Note that 
changing a unit's values in the Custom Units dialog box does not automatically change the overall units 
definition for the rulers in the current drawing. To change the ruler unit settings, choose the setting again in the 
Rulers/Snap tab of the Options dialog box.
In addition, changing a unit's values in the Custom Units dialog box does not automatically change the overall 
units definition for any other drawings using that unit. This is because the various units set for different functions
are saved with each Designer drawing. 
For example, suppose that the rulers are set to a custom scale unit called Meters (Scaled), which defines a scale 
of 5 meters per centimeter. You open the Tools Menu, click Custom Units, and edit this scale unit by changing its 
scale to 10 meters per centimeter. The ruler unit settings do not change unless you open the Tools Menu, click 
Options and Rulers/Snap, and deliberately change the Ruler Unit to Meters (Scaled) again.
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Deleting a Defined Unit
{button Steps...,PI(`',`HT_Using_Units_of_Measure')}

You can delete a defined unit from the list of available units by selecting it in the Defined Units list box and 
clicking Delete. The defined unit is not deleted from other drawings using that unit. The deleted unit remains in 
use where you have applied it already, but you can not choose that unit for future uses.    
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Displaying Coordinates
{button Steps...,PI(`',`HT_Displaying_Coordinates')}

Designer uses coordinates for precise drawing and positioning. You can display coordinates to reference the 
current mouse position, the origin and size of a selected object, the origin and endpoint of a selected object, or 
the orientation and rate of expansion during transformations. Coordinates can also be used to draw, move, or 
resize an object.
Coordinates are displayed in the status bar. When no object is selected, the status bar shows the coordinates of 
the mouse pointer. When an object is selected, the status bar shows the coordinates of the selected object. 
During a transformation such as manually resizing an object, the status bar shows the coordinates of the 
transformation.
You can set the type of coordinates displayed for a selected object with the Coordinates menu. To set the 
coordinates type, click the Coordinates button  in the status bar and choose one of the following.
Choose To display
Width/Height The object's origin, width, and height.
Length/Angle The object's origin, length, and angle.
Range The object's origin and end point.
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Choosing a Coordinate System
{button Steps...,PI(`',`HT_Displaying_Coordinates')}

Designer can use Cartesian (rectangular) or polar (radial) coordinates. In the polar coordinate system, you can 
express angles in degrees or radians.
Cartesian Coordinates

Cartesian coordinates use the familiar vertical and horizontal axes. The vertical axis is called Y and the horizontal
axis is called X.

The X and Y axes correspond closely to the rulers in the Designer window. The ruler origin is the intersection of the 
two axes, where X=0, Y=0. If the origin is set at the top left of a page, the values for X go from left to right, and the 
values for Y go from top to bottom, just like the rulers.

If you drag the ruler origin to the center of the page, the axes and rulers are repositioned with respect to the 
page.
Polar Coordinates

Polar coordinates use a different method to reference each point on the page. Instead of having two straight 
axes, polar coordinates measure the distance from the center and the angle from the axis.

The distance from the center is called R (for radius). R is measured in inches, centimeters, or some other linear unit 
of measure. Angles are called A and are measured in degrees or radians.

To find a point where R equals 3 and A equals 45 degrees, find 3 at zero degrees and then move along that circle
until you reach 45 degrees.
Angles can be measured in either degrees or radians. Degrees and radians are both radial, rather than linear, 
units of measure. One radian is equal to approximately 57.3 degrees.
The zero degree point of the polar coordinate system corresponds to Designer's horizontal ruler. The ruler origin 
is the center of the polar coordinate model. If the origin is set at the top left of a page, the relationship of the 
system to the page is as shown in the following diagram.
If you drag the ruler origin to the center of the page, the rulers and system are repositioned with respect to the 
page.
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To choose a coordinate system

1 On the Object menu, click Coordinates.
or

Click the Coordinates button  in the status bar.
2 Choose Cartesian, Polar (Radians), or Polar (Degrees). The ribbon reflects the new coordinate system.
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Drawing with Coordinates
{button Steps...,PI(`',`HT_Displaying_Coordinates')}

Coordinates give you a more precise method of drawing than using the mouse. Instead of pointing, clicking, and 
dragging the mouse, you can enter numbers for coordinates for an object's origin (starting point) and its ending 
point, or for an object's width and height.
The Coordinates dialog box gives you several methods for specifying the size and position of an object, as well as
some actions that let you point and click with the keyboard, without using a mouse or other pointing device.
Click the How To button to see an example that shows how to draw a rectangle by entering coordinates. It is 
assumed that the rulers are set to centimeters. The upper left corner of the rectangle is positioned at the point 
(4,6). The rectangle is 10 centimeters wide and 3 centimeters high.
The drawing methods and mouse actions included in the Coordinates dialog box are as follows.
Method Description

Width/Height Lets you simulate clicking a mouse at a specific point, dragging, and then releasing the mouse 
button at a specific distance (width and height) from the first point.

Length/Angle Lets you simulate clicking a mouse at a specific point, dragging, and then releasing the mouse 
button at a specific distance and angle from the first point.

Range Lets you simulate clicking a mouse at a specific point, dragging, and then releasing the mouse 
button at a second specific point.

Current Position Lets you specify a position for the mouse pointer.
Click Applies the equivalent of a mouse click at the current position of the mouse pointer.
Double Click Applies the equivalent of a double mouse click at the current position of the mouse pointer.
Ruler Origin Lets you specify the exact point for the placement of the ruler origin relative to the current 

origin.
X Guide Lets you specify the position on the horizontal ruler (X-axis) to place a vertical guideline.
Y Guide Lets you specify the position on the vertical ruler (Y-axis) to place a horizontal guideline.
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To draw a rectangle with coordinates

1 Click the Draw tool .

2 Click the Rectangle button .
3 On the Object menu, click Coordinates.

or

Click the Coordinates button  in the status bar and choose Coordinates.
4 The Coordinates dialog box opens.

5 Click the Coordinates button  in the dialog box and choose Cartesian from the menu.
6 Click the down arrow in the Method list box and choose Width/Height, if necessary.

7 Click the Units button  and choose centimeters, if it is not already selected.
8 Press TAB until the cursor is at the X scroll box. Type 4 and press TAB.
9 In the Y scroll box, type 6 and press TAB. You have now specified the X and Y coordinates for the starting 

point of the rectangle.
10 In the W scroll box, type 10 and press TAB. The width of the rectangle is 10 centimeters.
11 In the H scroll box, type 3.
12 Press ENTER or click Apply. Designer draws the rectangle on the page with the exact starting point and 

dimensions that you entered.
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Adding, Removing, and Connecting Printers
Windows uses a software program called a printer driver that communicates with your printer or other output 
device. Printer drivers are provided with Windows.
The Windows Control Panel lets you add, remove, and set up printer drivers. You can add multiple printer drivers 
if you use more than one type of printer.
If you want to use a printer that is not connected to your computer, you can force the driver to send its output 
directly to a file on disk by specifying FILE as the printer port. You then can take the disk to a computer that is 
connected to the desired printer and copy (using the COPY command in DOS) the output file to the printer.
See your Windows documentation for instructions on adding or removing a printer and connecting a printer to a 
port.



Selecting and Setting Up Your Printer
{button Steps...,PI(`',`HT_Selecting_and_Setting_Up_Your_Printer')}

After you add a printer, you can select and set up the target (default) printer with the Windows Control Panel, or 
you can select a printer and change the setup as needed in Designer. Setup choices vary from one printer to 
another, but common options include changing the orientation (portrait or landscape), paper size, and paper 
source.
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To select a target printer

1 On the File menu, click Print. The Print submenu opens.
2 Click Target Printer. The Target Printer dialog box opens.
3 Select the printer you want to use.
Tip

If your printer is not listed in the Target Printer dialog box, open the Windows Control Panel and add it.
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To set up a target printer

1 On the File menu, click Print. The Print submenu opens.
2 Click Target Printer. The Target Printer dialog box opens.
3 Select the printer you want to use.
4 Click Setup. The dialog box for the selected printer driver opens.
5 Select the options you want. Make sure the orientation (portrait or landscape) matches the on-screen 

orientation.
Tip

If your printer is not listed in the Target Printer dialog box, open the Windows Control Panel and add it.
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Using a Pen Plotter
If you are using a pen plotter instead of a printer, you should be aware of a few differences.

Bitmaps and bitmap fill patterns do not plot.

To avoid plotter pen damage (due to staining), you may want to use the Vector Clipping option in the Print 
Document dialog box.

You should create a special color palette that matches the colors of the pens used by your plotter.



Printing with Layers
If you have multiple layers in your drawing, you can choose to make selected layers visible or invisible. You can 
also choose to make selected layers printable (able to be printed) or non-printable. 
Only visible layers will print. To omit certain layers from a printout, you can either make them non-printable or 
make them invisible.
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Fonts and Printing
Using scalable, or outline, fonts is the best way to avoid differences between displayed and printed text.
Scalable Fonts

Scalable fonts are fonts that can be sized or rotated as needed. TrueType fonts are an example of scalable fonts. 
They give you WYSIWYG (what you see is what you get) printed output. Windows handles the tasks of displaying,
scaling, and printing TrueType fonts so that separate screen fonts are not necessary.
Adobe Type Manager, if you have it installed, handles the display, scaling, and printing of Type 1 fonts and also 
ensures that these fonts are treated as scalable fonts and are not limited to PostScript printers.
If, however, you use non-scalable, device-dependent printer fonts (such as cartridge fonts with an HP LaserJet 
printer), you should read and understand the next section, "Device-Dependent Fonts."
Device-Dependent Fonts

Device-dependent printer fonts, including cartridge fonts and soft fonts, are limited to the set of typefaces, point 
sizes, and styles supported by your printer. If you create a document with one printer specified, use its printer 
fonts, and then change to a different target printer, the fonts displayed in the document change. This may not be
evident from the on-screen appearance.
For example, suppose you specify a PostScript printer and have 12-point Bookman text with 20-point Avant 
Garde headlines in your document. If you change to a printer that does not support these fonts, Designer 
chooses the closest available fonts, which will not display or print as you expect. You can either change back to a
PostScript printer or change the fonts in the document to fonts supported by the new printer.
Designer also substitutes the closest available font when you use a device-dependent font and then rotate the 
text.
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Printable and Non-Printable Areas
Most printers do not print to the edge of the paper. Margins include this nonprinting area. For example, if your 
margin is 1/2 inch and the nonprinting area is 1/4 inch, the margin is 1/2 inch from the edge.
If part of your drawing extends into the nonprinting area, the portion in the nonprinting area is not printed.



Tiling
If the current page size is larger than the paper size of your printer or plotter, the entire drawing page is printed 
with as many printer pages as needed. This process is called tiling.
When the page size is larger than the printer’s paper size, the printer pages can be assembled like individual 
pieces of tile to compose the entire drawing.
Tiling lets you print proofs of a large drawing, such as a B size (11" x 17"), on a printer that uses a smaller paper 
size, such as A size (8.5" x 11"). Tiling also lets you print banners that are made up of multiple pages.
Designer automatically tiles to two printer pages when you print an 11" x 17" drawing page to a printer with 8.5"
x 11" paper.
Page tiles are numbered top to bottom beginning at the top left of the drawing page.
You can print selected page tiles by entering page and tile numbers in the Page Range box in the Print Document
dialog box.
You can show or hide tile lines on the current page by selecting or deselecting Show Printer Page Tiles in the 
Workspace submenu of the Display menu. You can also display a preview of tile lines if you click Details in the 
Page Setup dialog box.
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Basic Printing Methods
{button Steps...,PI(`',`HT_Basic_Printing_Methods')}

You can use Document and the Print Document dialog box to choose printing options. The Print Document dialog 
box lets you print the document in the active window. You can specify the current page, all pages, or selected 
pages from the document; the number of copies to be printed; whether to collate the copies; whether to include 
page labels; and whether to use vector clipping (for use with a pen plotter).
You also can print multiple documents.
To use crop marks, select the Show Page Crop Marks option in the Page Setup dialog box. 
You can use Current Page to print only the currently displayed page, no matter how many pages are in your 
document.
You can use Selection to print only the selected objects on the current page. Selected objects do not change in 
size or position in the printout.
You can use View to print an area that you define (by dragging a rectangle). The area is scaled to fit the printable
area of the printer page.
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Printing Page Ranges
Collating Printed Pages
Printing Mirror Images
Vector Clipping
Fitting a document to the Page
Centering a Printout on the Page
Printing Multiple Documents



To print the current page

1 On the File menu, click Print. The Print submenu opens.
2 Click Current Page. All objects on the current page are printed.
Tip

The keyboard shortcut sequence for Current Page is CTRL+P.
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To print a selection

1 Select the objects on the current page you want to print.
2 On the File menu, click Print. The Print submenu opens.
3 Click Selection. All selected objects are printed.
Tip

The keyboard shortcut sequence for Selection is CTRL+SHIFT+P.
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To print a defined area

1 On the File menu, click Print. The Print submenu opens.
2 Click View. The print view pointer appears.
3 Position the print view pointer at one corner of the area you want to print, and press and hold the left mouse 

button.
4 Drag a bounding box around the area you want to print. Release the mouse button. The selected area is 

printed.
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To print the active document

1 In the File menu, click Print. The Print submenu opens.
2 Click Document. The Print Document dialog box opens.
3 Type the number of copies you want to print.
4 Choose the options you want.
5 If you wish, click Target Printer, choose the printer you want to use, and click OK.
6 If you wish, click Setup, make any changes to printer settings, and click OK.
7 Click Print. The document is printed.

{button Related Topics,PI(`',`RT_To_print_the_current_page')}



Printing Page Ranges
If desired, you can print only the pages or page tiles you need. For example, if you have a ten-page document, 
you can type 1,3-5,10 to print pages 1, 3, 4, 5, and 10.
In the Print Document dialog box, enter a page number separated by a comma to print a page; enter a range 
with the first and last pages separated by a hyphen to print a sequence of pages. To specify a page tile, enter a 
page number, a colon, and a tile number.
Type To print
1,2,6-9 Pages 1, 2, 6, 7, 8, 9
6- Pages 6, 7, 8, to the end of the document
1:2 Page 1, tile 2
1:4, 2:6 Page 1, tile 4 and page 2, tile 6
3:8-4:5 Page 3, tile 8 through page 4, tile 5
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Collating Printed Pages
The Collate option in the Print Document dialog box prints a complete copy of a document before printing the 
next copy. Collate is only available when you print more than one copy of a multiple-page document. Collating 
can slow the print speed on some printers.
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Printing Mirror Images
The Mirror option flips a drawing so that it prints reversed—as though you were viewing it in a mirror. Use this 
option to print T-shirt transfers or other drawings that must be given to a print shop reversed.
The Mirror option is available in the Print Document dialog box only with certain printer drivers. This option is 
gray if the printer driver does not support mirroring.
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Vector Clipping
Vector clipping improves the output of drawings on pen plotters by causing the top object of overlapping 
drawings to completely cover the back object (this is done automatically with non-plotting printers).
Vector clipping also prevents the damage to plotter pens that can occur when different colors are drawn over 
each other. For example, a yellow line drawn over a black line can permanently stain the yellow pen.
The Vector Clipping option in the Print Document dialog box is available only when you are using a plotter. This 
option increases the time it takes to plot your drawing.

{button Related Topics,PI(`',`RT_To_print_the_current_page')}



Darkening or lightening printed RGB bitmaps
When you print to an EPS file from Designer and select the Output for Separator printing option, you can darken 
or lighten RGB bitmaps in the EPS file by setting a key value in your registry. For darker RGB bitmaps, set the 
MGXGRE key name EnableCMYKBlackOpt to a value of 1. For lighter RGB bitmaps, set the key name to a value of 
0.

To set the value from within Designer.

1 On the Tools menu, click Options. Click the Registry tab.
2 In the Key list box, locate and select Mgxgre as the key.
3 Click New Value, and then enter EnableCMYKBlackOpt as the Value Name.
4 Click Numeric Value Type.

5. Enter the value (0 or 1), and click the Accept entry  button.



Fitting a Document to the Page
If the page size is too large for the target printer’s paper size, Designer reduces the drawing proportionally so 
that all of it fits inside the printable area when Fit to Page in the Print Document dialog box is selected. If this 
option is not selected, the drawing is tiled on as many pages as necessary to print the drawing.

{button Related Topics,PI(`',`RT_To_print_the_current_page')}



Centering a Printout on the Page
The Center on Page option causes the contents of each page in the document to be aligned to page center and 
page middle for this printout only. Center on Page in the Print Document dialog box is especially useful if your 
page size is smaller than your paper size; for example, an on-screen presentation that you want to print out on 
8.5" x 11" paper.

{button Related Topics,PI(`',`RT_To_print_the_current_page')}



Choosing and Setting up the Printer
You can select the target printer and change the setup of the printer from the Print Document dialog box.
Selecting the Target Printer

To change the target printer, click the printer name in the Print Document dialog box. The box opens to show the 
list of installed printers. You can then choose a different target printer.
Setting the Printer’s Properties 

To open the property sheet for the selected printer, click Properties in the Print Document dialog box. You can 
make changes such as changing the orientation (portrait or landscape) and scaling the printout.

{button Related Topics,PI(`',`RT_To_print_the_current_page')}



Printing with the Page Manager
{button Steps...,PI(`',`HT_Printing_with_the_Page_Manager')}

If you prefer to select pages for printing visually rather than by number, you can use the Page Manager. It, with 
its associated ribbon, lets you print selected pages, sort pages, set up selected pages, and create on-screen 
presentations.

{button Related Topics,PI(`',`RT_Printing_with_the_Page_Manager')}



To print selected pages with the Page Manager



Setting up a page 
Setting Up Multiple Pages 
Sorting Pages 
Using Designer for Presentations 



To print selected pages with the Page Manager

1 Open a document.

2 Click the Page Manager tool  in the toolbox. Thumbnail images are displayed for each page in the 
document.

3 Select the thumbnail of each page you want to print. A rectangle appears around each selected page. Press 
and hold CTRL to select more than one page; press and hold SHIFT to select more than one consecutive page.

4 Click the Print button  in the ribbon. The Print Document dialog box opens. The range of pages you 
selected is automatically entered.

5 Type the number of copies you want to print.
6 Choose the options you want.
7 Click Print. The selected pages are sent to the target printer.

{button Related Topics,PI(`',`RT_To_print_selected_pages_with_the_Page_Manager')}



Printing with the Page Manager



Printing Multiple Documents
{button Steps...,PI(`',`HT_Printing_Multiple_Documents')}

If you need to print more than one document, but you do not want to open all the document files at once, you 
can specify which documents to print.
When you print multiple documents, Designer prints one copy of all pages in each selected document. Designer 
handles mixed page orientations (portrait and landscape) automatically.



To print multiple documents
To remove files from the print queue



To print multiple documents

1 In the File menu, click Print. The Print submenu opens.
2 Click Multiple Files. The Print Multiple Files dialog box opens.
3 If necessary, change to the desired drive and directory.
4 Choose the name of a document you want to print.
5 Click Print. The selected document is sent to the printer.
6 Repeat steps 4 and 5 until you have chosen all the documents you want to print.
Tip

While you are printing multiple documents, all commands in the Print submenu are gray.

{button Related Topics,PI(`',`RT_To_print_multiple_documents')}



Printing Multiple Documents



To remove files from the print queue

1 On the View menu, click Show Tasks.
2 Click the name of the file (or files) you want to remove from the queue.

3 Click the Stop button .
Note

You can use this method only if you are printing multiple files.

{button Related Topics,PI(`',`RT_To_remove_files_from_the_print_queue')}



Printing Multiple Documents



Keyboard shortcuts in Designer

Help Context-sensitive help F1

Floating hint window CTRL+F1

File Operations Close drawing window CTRL+F4

Exit Designer ALT+F4

Export CTRL+2

Import CTRL+1

Next drawing window CTRL+F6

New document CTRL+N

Open document CTRL+O

Print page CTRL+P

Print selected objects CTRL+SHIFT+P

Redo CTRL+Y

Save CTRL+S

Save as CTRL+SHIFT+S

Undo CTRL+Z

Ribbons and Align dialog box ALT+1

Dialog Boxes Bitmap ribbon CTRL+W

Coordinates dialog box CTRL+Q

Dimension ribbon CTRL+0 (ZERO)

Draw ribbon CTRL+D

Edit ribbon CTRL+E

Floating Color Palette CTRL+F

Page Manager CTRL+G

Properties dialog box F12

Select dialog box CTRL+SHIFT+F2

Style ribbon CTRL+L

Text dialog box CTRL+SHIFT+T

Text ribbon CTRL+T

Clipboard Copy CTRL+C

Cut CTRL+X

Delete DELETE

Paste CTRL+V

Alignment Align dialog box ALT+1

Align bottom ALT+8

Align center ALT+5

Align left ALT+3

Align middle ALT+6

Align right ALT+7

Align to rulers ALT+2

Align top ALT+4

Justify horizontally ALT+9



Justify vertically ALT+0 (ZERO)

Align to page center CTRL+SHIFT+5

Align to page middle CTRL+SHIFT+6

Align to page left CTRL+SHIFT+3

Align to page top CTRL+SHIFT+4

Align to page right CTRL+SHIFT+7

Align to page bottom CTRL+SHIFT+8

Justify to page horizontally CTRL+SHIFT+9

Justify to page vertically CTRL+SHIFT+0 
(ZERO)

Viewing Add view SHIFT+F4

Crosshairs CTRL+H

Move down one layer SHIFT+PAGE DOWN

Move up one layer SHIFT+PAGE UP

Refresh the screen F3

Scroll down PAGE DOWN

Scroll up PAGE UP

View actual size CTRL+F8

View all pages (Page 
Manager)

CTRL+G

View first page CTRL+HOME

View full screen F4

View last page CTRL+END

View next page CTRL+PAGE UP

View page SHIFT+F6

View previous SHIFT+F3

View previous page CTRL+PAGE DOWN

View used area CTRL+SHIFT+F3

Zoom in F6

Zoom out CTRL+SHIFT+F6

Text Align to bottom CTRL+SHIFT+B

Align to center CTRL+SHIFT+C

Align to left CTRL+SHIFT+L

Align to middle CTRL+SHIFT+M

Align to right CTRL+SHIFT+R

Align to top CTRL+SHIFT+O

Bold CTRL+B

Force justify horizontal CTRL+SHIFT+F

Full justify horizontal CTRL+SHIFT+J

Italics CTRL+I

Move to beginning of line HOME

Move to end of line END

Small caps CTRL+M

Subscript CTRL+SHIFT+K



Superscript CTRL+K

Text dialog box CTRL+SHIFT+T

Underline CTRL+U

Object Options Corner CTRL+5

Symmetrical curve CTRL+7

Unlocked cusp CTRL+6

Locked cusp CTRL+4

Convert to curves CTRL+R

Cusp CTRL+6

Connect closed F11

Connect open CTRL+F11

Disconnect closed SHIFT+F11

Flip horizontal F7

Flip vertical SHIFT+F7

Group objects F5

Move to bottom F9

Move to top F10

Reverse order CTRL+SHIFT+F9

Rotate preset amount F8

Select all objects (current 
page)

CTRL+A (OR F2)

Select all objects (except 
currently selected)

CTRL+SHIFT+A
(OR SHIFT+F2)

Select dialog box CTRL+SHIFT+F2

Snap points on CTRL+F7

Snap points off CTRL+SHIFT+F7

Step down SHIFT+F9

Step up SHIFT+F10

Ungroup objects SHIFT+F5
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To scroll quickly to a term in this glossary, click the applicable letter.
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Anchor point
B
B-Spline
Back up
Bézier curve
Bitmap
Bleed
Blend
Bounding box
Byte
C
Cancel
Cartesian coordinates
Cartridge



Cascade windows
Chaining
Check box
Cicero
Click
Client application
ClipArt
ClipArt Manager
Clipboard
CMYK
Color correction
Color model
Color palette
Command
Container
Continuous tone
Control menu
Control menu box
Control panel (Slideshow)
Control panel (Windows)
Control point
Copy
Crop
Crop marks
Cursor
Cusp
Cut
D
Default settings
Deselect
Dialog box
Didot point
Dimension line
Direction keys
Disabled
Dither
Dot gain
Double click
DPI
Drag
Drawing window
E
End style
F
File type
Font
Freeform text



G
Gradient
Gray value
Grayscale
Grid
Guides
H
Halftone
Handles
Hatch pattern
Highlight
Hint line
HLS
Hourglass cursor
Hue
I
Icon
Image
Irregular polygon
K
Kern
L
Layer
Lightness
Line screen
Line style
Linear gradient
List box
M
Map
Master page
Menu
Menu bar
Midtones
Minimize and maximize boxes
Monochrome
N
Non-proportional resize
O
Oblique
Original file
Outline fonts
Output device
P
Page orientation
Paper size
Parallel



Paste
Paste link
Path object
Perpendicular
Pica
Pivot point
Pixel
Point size
Pointer
Polar coordinates
Polygon
Press
Print area
Print spooler
Process color
Property
Proportional resize
Proportional typeface
R
Radial gradient
Refresh
Regular polygon
Repel text
Resize
Resolution
RGB
Ribbon
Rulers
S
Saturation
Scanner
Screen fonts
Scroll
Scroll bars and scroll arrows
Select
Keyboard shortcuts
Simple line
Skew
Slider
Snap points
Snap to rulers
Spline
Spool
Square gradient
Status bar
Submenu
T



Tangent
Text block
Text cursor
Threshold
Title bar
Toggle
Toolbox
Trapping
TrueType font
Type 1 font
Typeface
V
Value
Vector-based drawing
UCR
W
Window



Active window

The window in which you work is the active window. The active window receives the next action. Generally, the 
active window has a different title bar color than other windows. A window can be an application's main window, 
a dialog box, a floating window (like the Hint window), or the ClipArt Manager or Floating Color Palette.



Anchor point

A point through which a line or curve passes. Anchors define the shape of an object. An anchor can form a 
corner, a curve, or a cusp along the edge of an object. You can view and drag anchors during Point or Curve 
Reshaping.



Back up

To make a duplicate of a file before saving it, ensuring that the previous version of the file is not overwritten by 
the newer version.



Bézier curve

A curve that can be reshaped with control points.



Bitmap

An image composed of individual pixels (dots) on the screen.



Bleed

An image that extends beyond the edge of the paper (bleeds off) after the final trim.



Blend 

Transforming one object into another object by averaging the shapes, sizes, and colors of the two objects.



Bounding box

The invisible rectangle that encloses a selected object. When you move, resize, or duplicate an object, the 
bounding box appears as a dashed blue box around the object.



Byte

A common unit of computer measurement consisting of eight bits.



Cancel

A command button used to close a dialog box without making any changes. The Esc key also closes a dialog box.



Cartesian coordinates

A coordinate system based on the familiar vertical and horizontal axes. The vertical axis is Y, and the horizontal 
axis is X.



Cartridge

A small box you can plug into some printers to provide them with additional fonts.



Cascade windows

A command that diagonally stacks windows so that the title bars show.



Chaining

Also called Connect-A-Draw. A drawing method that joins the ends of objects even if you choose another drawing
method.
Chaining is also sometimes used to described linked text containers through which text flows.



Check box

A square box in a dialog box that can be toggled on or off.



Cicero

A typography measuring unit used mostly in non-English speaking countries. There are 12 didots per cicero. 
There are approximately 5.63 ciceros per inch and approximately 67.553 didots per inch.



Click

To quickly press and release the left mouse button. When you click the mouse button, you should hear and feel a
click.



ClipArt

A collection of already drawn objects. These objects are available using the ClipArt Manager in Designer. You can 
also create objects and add them to new or existing catalogs in the ClipArt Manager.



ClipArt Manager

Designer's organizer for all picture files including ClipArt and photographic images.



Clipboard

Designer uses the Windows clipboard, which is a data exchange storage area for objects that are cut or copied 
from Designer or another Windows application.



CMYK

Cyan, magenta, yellow, black. See also Color model.



Color correction

Any process that compensates for deficiencies in the color separation process and process inks.



 Color model

A method of representing the color spectrum. Two of the most common primary color models are the RGB (red, 
green, and blue) and CMYK (cyan, magenta, yellow, and black) models.



 Color palette

A collection of commonly used colors, similar to an artist's palette.



Command

A word or phrase usually found in a menu that opens a dialog box, enters a mode, or carries out an action.



Container

An invisible boundary surrounding container (block) text and text in an object.



 Continuous tone

Images, such as color or black-and-white photographs, where the colors and shades flow continuously from one 
to another. Continuous-tone images cannot be printed in the conventional offset printing process; they must first 
be converted to halftones or some other black-and-white format.



Control menu

A menu common to most windows. You use the Control menu to resize, move, minimize, maximize, or close 
Designer's windows. Some of Designer's windows, such as the Color Palette have other commands in the Control 
menu.



Control menu box

The box, located in the upper left corner of a window, that opens the Control menu.



Control panel (Slideshow)

A panel you can display during a slideshow that allows you to jump to any page or change the slideshow 
preferences.



 Control panel (Windows)

A Windows tool containing commands for installing printers and fonts, setting up printers and ports, and 
choosing program options.



Control points

Pairs of points attached to each anchor along the edge of an object. Control points act like magnets, influencing 
the curve of the object’s edge where it passes through the anchor. You can view and drag control points only 
during Curve Reshaping.



Copy

An Edit menu command that copies the selected objects to the Windows Clipboard. Copy does not change the 
appearance of the drawing.



Crop

To define part of a bitmap you want to keep and remove the rest of the bitmap.



Crop marks

Marks on film or paper that indicate the page size and trim boundaries to the printer. Also called trim marks.



 Cursor

The entry point for placing text. Sometimes used to describe any mouse pointer.



Cusp

An anchor point where two Bézier curves intersect at different angles. The result is an elbow shape or corner.



Cut

A command in the Edit menu that removes a selected object and moves it to the Windows Clipboard.



Default settings

The preset options built into a program. Use the Preferences command in the Edit menu to change many of 
Designer's default settings.



Deselect

To move the pointer away from all selected objects and click the left mouse button so that the surrounding 
handles disappear. Commands and tools no longer affect the objects because the objects are not selected.



Dialog box

A window that appears when the program needs information from you before it can carry out an action.



Didot point

A typography measuring unit used mostly in non-English speaking countries. There are 12 didots per cicero. 
There are approximately 5.63 ciceros per inch and approximately 67.553 didots per inch.



Disabled

An option or command that appears in gray type and is not available.



Direction keys

The Arrow keys (Up, Down, Right, and Left) and the Home, End, Page Up, and Page Down keys. When used
alone, the arrow keys move the mouse pointer across the image on the screen in the direction indicated.



Dither

To create the illusion of a color by placing dots of other colors very close together.
Technically, on palette-based devices, such as 256-color displays, colors are dithered using a sweeping palette (a
palette of colors evenly spaced through the color spectrum). Only colors that are in the sweeping palette are not 
dithered.



Dot gain

An increase in the size of halftone dots when they print. Dot gain produces unwanted shadows and colors.



Double click

To rapidly press and release the mouse button twice without moving the mouse.



DPI

The number of dots (pixels) per inch on the display or hard copy. Most laser printers print at 300 dpi. High-
resolution phototypesetters provide 1270 and 2540 dpi.



Drag

To point with the mouse, press and hold the left mouse button, and move the mouse. For example, you drag to 
move an object, select a range, and move ClipArt from the ClipArt Manager into your document.



Driver

A program that translates data from software for use with a specific hardware device. 



End style

The marker at the ends of lines and open objects. For example, arrowheads and lines are end styles.



Extension

The period and one to three characters at the end of a filename that identify the kind of information in the file. 
For example, DS4 is the extension for Designer drawing files.
Also, the lines in dimension lines that are drawn from the object being measured to the line showing the 
dimension.



File type

A format used to define an image file. Designer recognizes different file types such as text, Windows Metafile 
(WMF), Computer Graphics Metafile (CGM), TIFF, BMP, Targa (TGA), GIF, and EPS.



Font

A specific set of characters in a specific typeface design.



Freeform text

A text object that has no container. Freeform text cannot flow from one container to another, nor does it use 
margins, word-wrap, or indents. Resizing a freeform text object changes the size of the text.



Gradient

A gradual fade in color intensity or a gradual fade from one color to another.



Gray value

The amount of gray in an image, where a gray value of 100% is black and a gray value of 0% is white.



Grayscale

An image having multiple shades of gray. Also, the ability of a scanner to capture more than just the values of 
white and black.



Grid

A series of horizontal and vertical dots that criss-cross the drawing area. You can snap objects to the grid for 
more exact placement.



Guides

The horizontal line and vertical line that you can drag onto the screen but not print. You can use guides as cues 
for where to place objects, or you can snap objects to guides for more exact placement.



Halftone

An image made of tiny dots of different sizes (like a photograph in a newspaper). The dots in a halftone are 
equally spaced, so larger dots compose the shadows and smaller dots create the highlights. Halftones can be 
color or black and white.



Handles

Square boxes that appear on the corners and sides of the bounding box of an object when in edit mode. You use 
handles to resize an object.



Hatch pattern

A fill pattern composed of lines occurring at regular intervals. Hatch patterns can be output to a plotter.



Highlight

The brightest value in a continuous-tone or halftone image.



Hint line

A one-line message that provides information about a feature. Hint lines are in a floating window or at the 
bottom of the main Designer window. You control their location with the Hint Line command in the Display menu.



HLS

Hue, lightness, saturation. See also Color model.



 Hourglass cursor

The pointer changes to an hourglass symbol to indicate that the program is performing an operation, such as 
saving a file. Sometimes Designer displays a compass with a spinning ball rather than the hourglass cursor. 
When the cursor returns to a pointer, you can continue working.



Hue

The quality of a color that makes it different from other colors. For example, an apple's hue is red even though its
color value might not be 100% red. The color you use to describe an object is its hue. Lightness and saturation, 
the two other components of color, do not affect the hue. See also Lightness and Saturation.



Icon

A small graphic symbol that represents a software program. You open the program by double clicking the icon.



Image

Also called a bitmap or bitmap image. Images are composed of thousands of tiny dots called pixels. Picture 
Publisher edits and creates images.



Irregular polygon

A closed object composed of straight lines of different lengths.



Kern

To adjust the spacing between text characters.



Layer

A plane of a drawing that can be stacked on other planes. A drawing with three layers is like three overhead 
transparencies stacked on one another.



Drawing window

A window that displays your drawing. Drawing windows are displayed in the working area of the Designer 
window and can be manipulated like any window.



Lightness

The amount of white or black in a color. Lightness of 100% and 0% creates white and black, respectively. 
Lightness is one of the three components of perceived color. Hue and saturation are the others. See also Hue and
Saturation.



Line art

Images with only two gray values: black and white. If you save a continuous-tone image as line art, the colors in 
the image are reduced to black and white.



Line screen

Also known as screen ruling. This is a measure of the distance between the centers of halftone dots as they 
repeat along the screen angle. For example, in a 65-line screen at a 45° angle (a typical line screen, or screen 
ruling, for a black-and-white halftone in a newspaper), there are 65 halftone dots in an inch. Low (coarse) line 
screens, from 65 to 85, do not produce an illusion of grayscale as successfully as medium screens, from 100 to 
120, or high screens, from 133 to 150.



Line style

The pattern used to draw a line. For example, solid and dashed.



Linear gradient

A gradual fade or color transition in a single direction from one side of an object to the other side. 



List box

A box containing a list of names. List boxes usually appear in dialog boxes or windows within a program.



Map

A graph representing the mapping of color values in an image. A map changes the input values to new output 
values. If unedited, the graph represents a mapping of 1:1 (an input of 50% gray is output at 50% gray, for 
example). You can alter values by manipulating points on the curve (so that an input of 50% gray is output at 
75% gray, for example).



Master page

A special page whose contents appear on every page of the document. Master page objects appear both on 
screen and when printed.



Menu

A list of commands organized under a title in the menu bar. For example, the Help menu lists commands that 
provide on-line help. 



Menu bar

The bar at the top of the Designer window (under the title bar) containing menu titles.



Midtones

The middle values, between the highlights and the shadows, in an image.



Minimize and maximize boxes

The boxes located in the upper right corner of each window that are used to reduce or enlarge the window. The 
frame around the window also is used to resize the window.



Monochrome

A single color. Monochrome typically refers to the color black on a white background.



Non-proportional resize

To resize an object using the side handles so that the original proportions change.



Oblique

An extrusion effect that extends an object backward.



Original file

A file containing the source (original) object created with the server application. The original object can be linked
to or embedded into a document.



Outline fonts

Fonts that produce text on the screen as it appears when printed (WYSIWYG, or What You See Is What You Get).



Output device

Any device that accepts a printed document from Designer. For example, a printer, plotter, and imagesetter.



Page orientation

The position of an image on paper. Portrait (vertical) orientation displays a page taller than it is wide. Landscape 
(horizontal) orientation displays a page wider than it is tall.



Paper size

The physical size of the paper in a printing device.



Parallel

Two straight lines at the same angle that do not intersect.



Paste

A command in the Edit menu to insert an image stored in the Windows Clipboard into an image window.



Paste link

A command used by the receiving program to paste and link an object at the same time.



Perpendicular

Two lines that intersect at 90 degrees.



Pica

A measurement of line length. There are six picas in one inch.



Pivot point

The point around which an object is rotated. In Designer, the pivot point can be moved or changed.



Pixel

A picture element. The smallest unit (dot) of a bitmapped image.



Point size

A measurement of the height of characters in a font. There are approximately 72 points in an inch.



Pointer

A graphic symbol used to show the current screen location of the mouse. You move the pointer by moving the 
mouse. The pointer's appearance changes depending on the action being performed.



Polar coordinates

A coordinate system defining each point by its distance from the origin, and its angle from the horizontal axis.



Polygon

A closed object made of straight lines, such as a square, triangle, or star.



Press

To press and hold the mouse button momentarily.



Print area

The area that can be printed.



Print spooler

A Windows accessory that creates a print file before printing begins.



Process color

Also called full color. The type of printing that uses four different printing plates (cyan, magenta, yellow, and 
black) which, when combined, produce a color image.



Property

An attribute of objects such as size, color, or weight. You can assign any property you wish to objects. The 
default property is "Name." You can create other properties and assign values to them. See also Value.



Proportional resize

To resize an object using the corner handles so that the object's proportions do not change.



Proportional typeface

A typeface in which the widths vary from character to character. For example, a w is wider than an l.



Radial gradient

A gradual fade or color transition in all directions, from a central point to the outer edges of an object. The result 
is a concentric, circular pattern.



Refresh

To redraw the current page. This lets you clear the screen of unwanted fragments that can result from 
manipulating objects.



Regular polygon

A closed object composed of straight lines of equal length



Repel Text

An object attribute that forces text to automatically warp around that object.



Resize

To change the size of an object. Dragging a corner handle changes the size proportionally, while dragging a side 
handle changes the size non-proportionally. Dragging a handle into an object makes it smaller; dragging a handle
away from an object makes it larger.



Resolution

A measurement of data for monitors (usually expressed as pixels per square inch) and printers (dots per square 
inch).



RGB

Red, green, and blue. See also Color model.



Ribbon

The area at the top of the window that displays options associated with the current tool.



Rulers

Measuring guides at the top and left of the Designer window that allow precise placement of objects.



Saturation

The intensity or purity of a color. For example, a "reddish" apple is not as saturated as a "red" apple. Zero 
saturation means that the color has been replaced by its corresponding gray value (black-and-white television 
images are good examples of colors with zero saturation). Pure saturation (100%) means the color contains no 
gray. Saturation is one of the three components of color; hue and lightness are the others. See also Hue and 
Lightness.



Scanner

A device that transfers images from video or paper into the digital format used by computers.



Screen fonts

Fonts specially created to appear correctly on screen.



Scroll

To move the visible portion of the drawing area.



Scroll bars and scroll arrows

The bars and arrows at the right side and bottom of windows that allow you to travel vertically and horizontally 
across the window.



Select

To choose an object. A selected object displays handles.



Keyboard shortcuts

A function key or a mnemonic key, often used with Alt, Ctrl, or Shift, that executes a command quickly. 
Keyboard shortcuts appear in the Hint window or in the hint line at the bottom of the Designer window.



Simple line

A linear object made of only one line or curve.



Skew

To slant a selected object horizontally or vertically.



Snap points

Points on an object that attract endpoints as you draw or move an object.



Snap to rulers

An option that causes the increments of the rulers to attract the mouse and the bounding box of selected objects
that you drag close to the increment. The grid corresponds to these points. The bounding box is attracted to 
ruler increments only if you select Dragging Snap in the Options-Rulers/Snap dialog box.



Spline

A type of smooth curve based on at least three points. The curve touches the first and last points and is pulled 
by the middle point.



Slider

A bar in a dialog box that you can move to change an option.



Spool

To send a page to a file before printing. When spooling is complete, the page begins to print and you may work 
in the image window again or select another print operation.



Square gradient

A gradual fade or color transition in all directions, from a specified central point to the object's outer edges. The 
result is a concentric, rectangular pattern.



Status bar

Provides current information about your drawing and quick access to various commands such as line weight, 
object fill, and coordinates.
Choose Status Bar on the View menu and choose Single to display the single-line status bar. Choose Double from
the Status Bar submenu to display the double-line status bar.



Submenu

A submenu opens when you choose a command with an arrow opposite it. Submenus provide additional 
commands related to the desired task you want to accomplish.



Tangent

A straight line that touches a curve at only one point and does not intersect the curve.



Text block

Text in a container or object.



Text cursor

A blinking vertical bar that indicates where to begin entering or editing text.



Threshold

The cutoff point at which the overall color values are either shown or deleted.



Title bar

The bar across the top of a window that contains the program name (Designer) and the filename. The title bar 
also contains the window's Control menu box and maximize and minimize boxes.



Toggle

To alternately turn a function on and off.



 Toolbox

The area of the main Designer window containing the eight Designer tools: Edit, Draw, Dimension, Text, Bitmap, 
Style, Page Manager, and View. The toolbox also displays any tools you add to the default toolbox.



Trapping

The intentional overlapping of two adjoining colors to minimize the effects or poor registration and to cause inks 
to transfer properly to the paper in conventional offset printing. Evidence of poor trapping is a small margin of 
white space where one color ends and another begins. Techniques of trapping include overprinting, choking, and 
spreading.



TrueType font

An outline font that displays correctly and prints on almost any printer.



Type 1 font

An outline font designed specifically for PostScript printers.



Type style

A standard variation within a typeface family. Common styles include roman (also called plain, normal, or 
regular), italic, bold, and bold italic. Each style within a typeface family is a unique typeface design of its own. 



Typeface

The design of a set of characters. Bitstream Charter Roman and Bitstream Charter Italic are examples of 
typefaces. They share a common typeface family: Bitstream Charter; and they each have a particular style: 
roman (also called plain, normal, or regular) and italic.



UCR

Undercolor removal. An option used when equal amounts of CMY values appear together, creating a brown hue. 
UCR replaces the brown with black to reduce the amount of ink used in printing and increase details in shadows.



Value

A word or number assigned to one of an object's properties. A value can be different for different properties. For 
example, a drawing of an elephant has the value "Elephant" when the property Name is selected; has the value 
"African" when the property Type is selected; and has the value "2500" when the property "Weight" is selected.



Vector-based drawing

A type of drawing that uses lines and mathematical calculations to create drawings. Vector drawings are more 
precise, usually create smaller file sizes, and are generally better for computer-based drawing because they 
always appear (in print and on screen) at the highest possible resolution.



Window

A rectangular area on the screen that displays the Designer program. The Designer window can contain several 
different drawing windows within its working area.



WYSIWYG

A close similarity between the screen image and the printed output of that image. WYSIWYG is an acronym for 
What You See Is What You Get.



Client application

An application capable of accepting objects from OLE-compatible server applications



Compound document

A document containing multiple objects created with different OLE-compatible server applications



Embedded object

An object containing a graphic representation of the object and all the information required by the server 
application to re-create the original object



Linked object

An object containing a graphic representation of the object and information identifying the original server data 
file and application



Server application

An application capable of copying OLE-compatible objects to the Clipboard.



Path object

An object (opened or closed) that has more than one line segment.



Dimension line

A line that measures the distance of an object or some part of the object. Dimension lines can be aligned to the 
object, or can measure the horizontal or vertical component of the object.



Designer 6.0 registry keys and values
{button Steps...,PI(`',`HT_Registry_settings')}

Designer lets you change these entries in the system registry. 

Key name: Process
Registry location: HKEY_CURRENT_USER\Software\Micrografx\Designer\6.0

PrintingGradientStep=4
The lower the number, the smaller the gradient step becomes on output devices. The default is 4. You should consider the 
resolution of the output device. For example, with an output device with 2500 lines per inch and a PrintingGradientStep 
setting of 4, you get a large file with a very fine-resolution gradient. You should experiment with this setting to find an 
appropriate setting.

Key name: Preferences
Registry location: HKEY_CURRENT_USER\Software\Micrografx\Designer\6.0

InitialEmbeddedWidth=5080
InitialEmbeddedHeight=7620

Describes the default width and height of a new Designer 6.0 embedded OLE object. Specifically, these values govern the 
initial size of an object when you choose to Edit/Insert Object a “Micrografx Designer 6.0 Drawing” from another OLE 
container. These units are in HIMETRIC, where 1in=2540. Therefore, the default size is 2in x 3in.

Key name: MGX Font Adjust
Registry location: HKEY_LOCAL_MACHINE\Software\Micrografx\Designer\6.0

ATF Century Schoolbook=1.13,0.0

The value is a width and height value for character spacing. The first value is inter-character spacing. The second value is 
paragraph/line spacing.

Key name: MGX Font Aliases
Registry location: HKEY_LOCAL_MACHINE\Software\Micrografx\Designer\6.0

ATF Century Schoolbook=CenturySchbk SWA

The value is a font name to replace the MGX font name from Designer 3.x. If you prefer a different font than that supplied, 
you can change to a font already on your system. Generally, however, it is not advisable to use this option.

Key name: Mgxgre
Registry location: HKEY_CURRENT_USER\Software\Micrografx\Designer\6.0

EnablePSAdapt=1

This entry lets you disable PSAdapt. With a value of 1, the default, Designer writes PostScript printer output directly. A 
value of 0 uses the PostScript driver to generate the PostScript output.

PSBinaryBmp=0

This entry lets you create smaller PostScript files by using binary bitmaps. One-bit bitmaps and EPS files will always use 
HEX-ASCII. A value of 0, the default, outputs all bitmaps as HEX-ASCII. A value of 1 outputs 8, 24, or 32 bit bitmaps as 
binary.

PSBmpThreshold=635

The value can be any printer resolution, in dots per inch. Color bitmaps will be sent to monochrome printers with this dpi or 
higher. If you have a 300 dpi monochrome printer but want to send color bitmaps to it for color separations, set this value 
to 300. If you have an 800 dpi monochrome printer, you can set this value to 801 to force monochrome bitmaps to be sent 
to the printer instead of color. Color bitmaps are always sent to color printers and EPS files. The default value is 635.

UseGDIForBLTPrinting=1

This entry was added to fix problems with printing bitmaps imported into Designer 6.0. A value of 1, the default, causes 
GDI to be used to dither printed images. A value of 0 causes the internal MGXFRAME bitmap code to do the dithering 
itself. GDI dithering appears to produce results that are identical to printing the same bitmap after importing it into Designer
3.1.

This setting only applies to bitmaps printed through GDI and does not affect either screen or Postscript Adaptation Layer 



processing.

WMFGradientRes=40

Valid options are any desired gradient-step size. This option sets the gradient step size for metafiles like 
PrintingGradientStep does for print output. The default is 100.

WMFImageFill=1

This entry specifies whether image fills will be retained in metafiles. A value of 0 substitutes the image fill with a solid gray 
color. A value of 1, the default, retains bitmap fills in metafiles.

PCLBorderTextAsCurves=1

Value is 0 or 1. Most PCL printers will not clip text characters across a page border; if the character is partly off the page, it 
does not print at all. Therefore, Designer's default behavior is now to send lines of text that cross the physical page border 
to non-postscript printers as curves. Set this value to 0 if you are using a non-postscript printer that does not have this 
character-clipping problem, or if you are using your printer driver's "Print True Type as Graphics" option. This option, found 
on many drivers, solves the clipping problem for TrueType fonts and can produce slightly higher-quality output.

DoNotInvertMonoBmps=0

Certain PCL drivers erroneously invert monochrome bitmaps when they are printed from Designer. When Designer detects
that the driver may not support the correct processing of foreground and background colors for monochrome bitmaps, it 
promotes the bitmap to a color bitmap, and its color table is adjusted so that the device can dither the desired foreground 
and background colors appropriately. This is the default behavior of Designer. Set the value to 1 to turn the modification off 
and obtain the old behavior.

PrintColorTextAsCurves=0

Many GDI printer drivers can only output text in pure colors: white, black, red, green, blue, cyan, magenta, and yellow. 
Setting this value to 1 causes text which is not one of the above colors to be output to GDI devices as curves so that the 
correct color will be used. This functionality only works to GDI printers for non-printer fonts. Default to 0 (do not convert to 
curves in any case) for backwards compatibility.

EnableCMYKBlackOpt = 0

The existing RGB to CMYK color conversion model makes no use of the K component unless the color is a shade of gray.  
Setting value of the EnableCMYKBlackOpt flag to 1 causes K to be set to the minimum of C, M, & Y and the CMY values to
be adjusted correspondingly.    Setting this switch on (to 1) should improve the quality of output to EPS and other CMYK 
devices.

Defaults to 0 (signifying no use of K component) for backwards compatibility. 

CMYKUndercolor = -15
CMYKBlackGeneration = 25

You can now control the degree of undercolor removal and black generation performed as colors are converted from RGB 
to CMYK for Separator/EPS output.    The basic formula for RGB to CMYK translation goes like this:

                c = 1 - r;
                m = 1 - g;
                y = 1 - b;
                k = min(c,m,y);

Then, undercolor removal is performed to modify the amount of black subtracted from each of c, m & y:

                c = min (1, max (0, c - UCR(k));
                m = min (1, max (0, m - UCR(k));
                y = min (1, max (0, y - UCR(k));

Finally, the black component of the color is adjusted via a black generation function:

                k = min (1, max (0, BG(k));

For DS60, both the UCR(k) and the BG(k) functions are defined as user supplied percentages of k.    You supply a 
percentage from -100 to 100 for both the CMYKUndercolorRemoval and CMYKBlackGeneration registry keys, and the 
functions are defined as:

                UCR(k) = k + ((CMYKUndercolorRemoval * k) / 100);
                BG(k) = k + ((CMYKBlackGeneration * k) / 100);

This allows you to modify the amount of black subtracted from the c, m, & y components and the amount of black assigned
to the k component.    

Positive CMYKUndercolor values increase the amount of black subtracted from the c, m, & y components, while negative 
values decrease the amount of black subtracted.    The default value for CMYKUndercolor is -15, to lessen the amount of 
black removed from the c, m, & y    components by 15%.



Positive CMYKBlackGeneration values increase the amount of black added to the k component, while negative values 
decrease the amount of black generated.    The default value for CMYKBlackGeneration is 25, to increase the amount of 
black added to the k component by 25%.

The defaults chosen were taken from PP and its interface to bitmap separation.    Both of these registry keys must be 
specified in the [Mgxgre] section of the registry.    In addition, EnableCMYKBlackOpt must be set to 1 for these two values 
to be used.

Key name: Translation
Registry location: HKEY_CURRENT_USER\Software\Micrografx\Designer\6.0

ExportPageFill=0

If this entry is 1 then the page fill will be exported along with the other selected symbols. The default is 0.

GDSFDoIntercharSpacing=1

By default, GDSF outputs an intercharacter spacing attribute along with text. Setting the value to 0 turns the output of the 
spacing attribute off.    The default value is 1 which causes the spacing attribute to be output.

Key name: Import
Registry location: HKEY_CURRENT_USER\Software\Micrografx\Designer\6.0

CenterSymbols=1

If the option is set to 1, the default, all imported symbols are centered on the current page in the same way as they were in 
Designer 4.0. If the imported file contains layers and CollapseLayers is set to 0, then this behavior is overridden and the 
imported symbols retain their original positioning.

If the option is set to 0, the imported symbols appear at the origin for formats that do not save page information and are 
properly placed on the page for formats that do (such as DRW, DS4, and DSF).

CollapseLayers=0

If the option is set to 1, then Designer 6.0 duplicates Designer 4.0's behavior by collapsing all the layers and putting the 
symbols on the current layer.

If the option is set to 0, the default, Designer reacts according to the answer to the question, "Does the imported file 
contain only one layer?"

If yes, Designer puts the symbols on the current layer, even if the current layer already contains symbols. If no, Designer 
appends the new layers following the existing layers.

Note that if the imported file is a DS4 file and the first page references a master page, then the master page is treated as a
separate layer when importing the file.

The filters that support layers on import are IGS, DRW, DXF, and DS4.

{button Related Topics,PI(`',`RT_registry_topics')}



Introduction to Reshaping
{button Steps...,PI(`',`HT_Introduction_to_Reshaping')}

You can change the shape of text, ClipArt, imported objects, and objects you have drawn. You cannot reshape 
bitmaps.
Think of an object as a piece of string lying flat on a table. You can change the shape of the string by pulling it, or
even cutting it and pulling one of the cut ends.
An object’s edge has just enough points to retain the original shape. If you remove even one point, the shape will
change. Complicated shapes, such as letters of the alphabet, can have hundreds of points.
The biggest difference between reshaping string and a Designer object is the way Designer handles curved 
edges. If you move a point that is on a curve, the curve is retained; if you move a point that is on a straight line, 
the adjoining lines remain straight.
If you are new to reshaping objects, take some time to experiment and practice. Start with straight lines and 
move to curves. After a little practice, you’ll find reshaping is one of the most valuable features in Designer.
Two Reshaping Modes

An object must be in Point or Curve Reshape mode before you can reshape it. The mode you should use depends
upon the results you want.
Point Reshaping

When you select an object for point reshaping, you can drag its anchors.

You can reshape any object using this method, but rectangles, ellipses, and arcs reshape in predefined ways 
when you drag their anchors.
Curve Reshaping

When you select an object for curve reshaping, you can drag its control     points.   

To use curve reshaping on special objects such as text, rectangles, ellipses, or arcs, you must first convert them 
to curves.
Moving a single anchor

Moving an anchor is the simplest way to reshape an object. As you drag an anchor, the lines connecting it to 
other anchors change.



Moving multiple anchors

You can move several anchors simultaneously by selecting the anchors and dragging one of them.

To select: Do this:
One anchor Click the anchor.
Multiple anchors Drag a box around the anchors.

or
Press and hold SHIFT and click the anchors.

All anchors On the Edit menu, click Select All.
or
Press CTRL+A.

All except currently selected Press and hold SHIFT and click Select All on the Edit menu.
or
Press CTRL+SHIFT+A.

Tip

If you start to drag a box around anchors and then change your mind, press ESC to cancel the box.

{button Related Topics,PI(`',`RT_Introduction_to_Reshaping')}



To select an object for Point Reshaping
To select an object for Curve Reshaping
To reshape by moving an anchor
To reshape by moving multiple anchors



Wireframe-Reshape View 
Point Reshaping
Curve Reshaping
Special objects



To select an object for Point Reshaping

1 Select the object.

2 In the Toolbox, click the Edit tool .

3 On the Ribbon, click the Point Reshape button .
or

double click the object
or

select the object, press and hold CTRL, and click.

{button Related Topics,PI(`',`RT_To_select_an_object_for_Point_Reshaping')}



To select an object for Curve Reshaping
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To select an object for Curve Reshaping

1 Select the object.

2 In the Toolbox, click the Edit tool .

3 On the Ribbon, click the Curve Reshape button .
or select the object, press and hold CTRL+SHIFT, and click.
Tip

Anchors appear on an object when the object is in a reshape mode. If you are not certain which reshape 
mode the object is in, check the pointer. The pointer is shaped like an anchor in Point Reshape mode and a control 
point in Curve Reshape mode.

{button Related Topics,PI(`',`RT_To_select_an_object_for_Curve_Reshaping')}



To select an object for Point Reshaping
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To reshape by moving an anchor

1 Select the object that you want to reshape.

2 In the Toolbox, click the Edit tool .

3 On the ribbon, click the Point Reshape button .
or

double click the object
or

hold CTRL and click the object.
If the object shows a solid anchor (indicating a special Point Reshape case), click the right mouse button and 
click To Curves. This cancels the special reshape definition and displays the object’s hollow anchors.

4 Click an anchor to select it. It turns solid.
5 Drag the anchor to a new location. The object’s shape changes.
Tips

To create a copy of an anchor, press and hold SHIFT as you drag it.

To constrain an anchor’s angular movement to 15-degree increments, press and hold CTRL as you drag it.

{button Related Topics,PI(`',`RT_To_reshape_by_moving_an_anchor')}



To move multiple anchors
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To move multiple anchors

1 Select the object that you want to reshape.

2 In the Toolbox, click the Edit tool .

3 On the ribbon, click the Point Reshape button  or double click the object or hold CTRL and click the 
object.
If the object shows a solid anchor (indicating a special Point Reshape case), click the right mouse button and 
click To Curves. This cancels the special reshape definition and displays the object’s hollow anchors.

4 Drag a box around the anchors you want to select.
or

Click the first anchor you want to select
5 Press and hold SHIFT, and click the other anchors you want to select. Selected anchors become solid.
6 Drag any selected anchor. All anchors follow the movement.
Tip

If you start to drag a box around anchors and then change your mind, press ESC to cancel the box.

{button Related Topics,PI(`',`RT_To_move_multiple_anchors')}
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Wireframe-Reshape View
{button Steps...,PI(`',`HT_Wireframe_Reshape_View')}

The Wireframe button  turns the wireframe-reshape view on and off. This view shows only the outline of an 
object you are reshaping, not its fill or color. Using the wireframe view, the default setting, can speed the display 
of objects that have many anchors.

{button Related Topics,PI(`',`RT_Wireframe_Reshape_View')}



To change the wireframe-reshape view setting



Curve Reshaping
Point Reshaping



To change the wireframe-reshape view setting

1 Select the object.

2 In the Toolbox, click the Edit tool .

3 On the ribbon, click either the Point Reshape  or Curve Reshape 

 button.

4 Click the Wireframe button .

{button Related Topics,PI(`',`RT_To_change_the_wireframe_reshape_view_setting')}
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Overview of Point Reshaping
{button Steps...,PI(`',`HT_Overview_of_Point_Reshaping')}

The Point Reshape mode lets you change the shape of an object by dragging one or more of its anchors.
Note
Special objects can be reshaped only in specific ways in Point Reshape mode. You can identify these special 
cases because they show solid anchors when selected for Point Reshaping.

{button Related Topics,PI(`',`RT_Overview_of_Point_Reshaping')}



To select an object for Point Reshaping
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Wireframe-Reshape View 
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Reshaping Curves and Corners
{button Steps...,PI(`',`HT_Reshaping_Curves_and_Corners')}

Converting a corner to a curve

You can produce symmetrical curves in Point Reshape mode by converting an anchor to a symmetrical curve 
point. After you convert an anchor to a symmetrical curve point, dragging the point reshapes the connected 
edges as curves.
Converting a curve to a corner

You can remove the curve from an object where it passes through an anchor    by converting the anchor from a 
curve to a corner. The corner anchor acts like a hinge.

{button Related Topics,PI(`',`RT_Reshaping_Curves_and_Corners')}



To select an object for Point Reshaping
To convert a corner to a symmetrical curve
To convert a curve to a corner
To convert a special object to curves
To smooth an object
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To convert a corner to a symmetrical curve

1 Select the object that you want to reshape.

2 In the Toolbox, click the Edit tool .
If the object shows a solid anchor (indicating a special Point-Reshape case), click the right mouse button and 
click To Curves. This cancels the special reshape definition and displays the object’s hollow anchors.

3 On the ribbon, select the Point Reshape button  or double click the object or hold CTRL and click the 
object.

4 Click an anchor to select it. It turns solid.

5 On the ribbon, click the Symmetrical Curve button . The lines touching the anchor become symmetrical 
curves.

{button Related Topics,PI(`',`RT_To_convert_a_corner_to_a_symmetrical_curve')}
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To convert a curve to a corner

1 Select the object that you want to reshape.

2 In the Toolbox, click the Edit tool .
If the object shows a solid anchor (indicating a special Point-Reshape case), click the right mouse button and 
click To Curves. This cancels the special reshape definition and displays the object’s hollow anchors.

3 Select the anchor.
4 Click the Corner button on the Ribbon.

{button Related Topics,PI(`',`RT_To_convert_a_curve_to_a_corner')}
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Overview of Special Objects
{button Steps...,PI(`',`HT_Overview_of_Special_Objects')}

Rectangles, ellipses, and arcs can be reshaped only in specific ways in Point Reshape mode. You can identify 
these special cases because they show solid anchors when selected for Point Reshaping.

The special Point Reshape mode for rectangles lets you round or sharpen the corners of a rectangle by 
dragging the solid anchor toward the center of the rectangle.

The special Point Reshape mode for ellipses lets you change an ellipse into a pie-shaped wedge or an arc. 
To change the ellipse into a pie-shaped wedge, drag the solid anchor toward the center of the ellipse. To change the
ellipse into an arc, drag the solid anchor around the outside of the ellipse.

The special Point Reshape mode for arcs lets you change an arc into a pie-shaped wedge by dragging 
either of the two solid anchors toward the inside of the arc.

To reshape a rectangle, ellipse, or arc in other ways, you must first convert it to a curve.

{button Related Topics,PI(`',`RT_Overview_of_Special_Objects')}



To convert a special object to curves
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Converting Special Objects to Curves



To convert a special object to curves

Select the object, click the Edit tool 

, and click the Curve Reshape buttonl 

.
or

Select the object, click the Edit tool , click the Point Reshape button 

, and click the To Curves button 
.

or

Double click the object to put it in reshape mode, click the right mouse button, and click To Curves on the 
mouse menu.

or

Select the object. On the Change menu, click Convert To Curves or select the object and press CTRL+R 
(keyboard shortcut).

{button Related Topics,PI(`',`RT_To_convert_a_special_object_to_curves')}
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Converting Special Objects to Curves
{button Steps...,PI(`',`HT_Converting_Special_Objects_to_Curves')}

The Convert To Curves command (keyboard shortcut CTRL+R) and Convert to Curves button convert an object 
such as text, a rectangle, or an ellipse into a conventional object. This lets you edit the object with reshape 
points. It also does the following.

Converts dimension lines to groups.

Converts a Windows metafile to Designer objects.

Converts other shapes to path objects and changes them so that Designer does not remember any 
previous transforms done to them.

Note

You cannot convert an object back into a special object, except by using Undo.

{button Related Topics,PI(`',`RT_Converting_Special_Objects_to_Curves')}



To convert a special object to curves
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Overview of Curve Reshaping
{button Steps...,PI(`',`HT_Overview_of_Curve_Reshaping')}

The Curve Reshape mode lets you change the shape of an object by dragging its Bézier control points. This type 
of reshaping creates curved edges. The further you drag a Bézier control point, the more you curve an edge.
Take some time to practice reshaping Bézier curves. It’s a skill that’s worth learning if you plan to draw and edit 
curved objects.

{button Related Topics,PI(`',`RT_Overview_of_Curve_Reshaping')}



To select an object for Curve Reshaping
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Displaying an Anchor’s Control Points
{button Steps...,PI(`',`HT_Displaying_an_Anchor_s_Control_Points')}

An anchor’s control points are visible only during curve reshaping. If an object is not in Curve Reshape mode, you

can put it in Curve Reshape mode by selecting the object, clicking the Edit tooL , and clicking the Curve 
Reshape button 

.
To display an edge’s control points, click one of the edge’s anchors. Because there are Bézier control points for 
each anchor on a edge, you must decide which anchor’s control points you want to use to reshape the edge. 
After a little experience with control-point reshaping, this choice will usually be obvious.

Bézier control points look like small checkerboards. Dragging a control point changes the shape of the edge 
associated with the point. Control points are always connected to anchors. Think of a control point as a magnet 
that attracts the edge. When you drag a control point, its anchor does not change position.

Tip

When you move the mouse pointer over a control point, Designer draws a preview line between the control
point and its anchor. This lets you quickly identify the anchor to which a control point is connected.

{button Related Topics,PI(`',`RT_Displaying_an_Anchor_s_Control_Points')}



To select an object for Curve Reshaping
To smooth an object
To reshape a curve symmetrically
To reshape a curve
To reshape a warped object
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To reshape a curve

1 Select the object that you want to reshape.

2 In the Toolbox, click the Edit tool .

3  On the Ribbon click the Curve Reshape button  or Hold CTRL+SHIFT and click the object.
4 Select an anchor on the edge that you want to reshape. Checkerboard-shaped control points appear near the 

anchor.
5 Drag the control points to change the edge’s shape.

{button Related Topics,PI(`',`RT_To_reshape_a_curve')}
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Creating Symmetrical Curves
{button Steps...,PI(`',`HT_Creating_Symmetrical_Curves')}

An anchor on a curve has two control points. The Symmetrical Curve button  (keyboard shortcut CTRL+7) 
causes the second control point to mirror the movement of the first. You can use the Symmetrical Curve button 

    to help maintain the curve of an object.

{button Related Topics,PI(`',`RT_Creating_Symmetrical_Curves')}



To select an object for Curve Reshaping
To reshape a curve
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To smooth an object
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To reshape a curve symmetrically

1 Select the object that you want to reshape.

2 In the Toolbox, click the Edit tool .

3 On the Ribbon, click the Curve Reshape button  or Hold CTRL+SHIFT and click the object.
4 Select an anchor through which the curve passes.

5 Click the Symmetrical Curve button  .
When you drag one of the control points, the other control point mirrors the movement.

{button Related Topics,PI(`',`RT_To_reshape_a_curve_symmetrically')}



Introduction to Reshaping
To select an object for Curve Reshaping
To convert a corner to a symmetrical curve
To convert a curve to a corner
To convert a special object to curves



Creating a Corner
{button Steps...,PI(`',`HT_Creating_a_Corner')}

You can create a corner, or non-curving anchor, at any point on a curve with the Corner button (keyboard 
shortcut Ctrl+5). Lines that pass through non-curving anchors lose their curvature.

You can also create a corner at the end of a line to remove a curve on a line.

{button Related Topics,PI(`',`RT_Creating_a_Corner')}
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To create a corner

1 Select the object that you want to reshape.

2 In the Toolbox, click the Edit tool .

3 On the ribbon, click the Curve Reshape button  or hold CTRL+SHIFT and click the object.
4 Select an anchor on the curve.

5 Click the Corner button . The lines touching the anchor become straight so that a corner is formed at the 
anchor.

{button Related Topics,PI(`',`RT_To_create_a_corner')}



To select an object for Point Reshaping
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Creating a Cusp
{button Steps...,PI(`',`HT_Creating_a_Cusp')}

A cusp is an anchor where two Bézier curves intersect at different angles, resulting in an elbow shape. Cusps are 
created by moving one control point independently of the second control point. You can unlock an anchor’s 
control points so you can move them independently using the Unlocked Cusp button (keyboard shortcut Ctrl+6).

After creating the shape that you want by moving the control points independently, you can re-lock the control 
points using the Locked Cusp button  (keyboard shortcut CTRL+4). Locking control points locks the angular 
relationship between the points so that when you drag one of the points, the opposite moves also as required to 
keep the angle between the two points the same. An anchor’s control points are locked automatically by 
converting the anchor to a symmetrical curve or corner.

{button Related Topics,PI(`',`RT_Creating_a_Cusp')}
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To create a cusp

1 Select the object that you want to reshape.

2 In the Toolbox, click the Edit tool .

3 On the ribbon, click the Curve Reshape button  or Hold CTRL+SHIFT and click the object.
4 Select an anchor on the curve.

5 Click the Unlocked Cusp button .
6 Drag one of the control points. Half of the cusp is formed.
7 Drag the second control point to create the second half of the cusp.
Tip
To lock or unlock a control point, press and hold SHIFT while dragging the point. The locked or unlocked status of 
the point switches while the SHIFT key is pressed.

{button Related Topics,PI(`',`RT_To_create_a_cusp')}
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Reshaping Text
{button Steps...,PI(`',`HT_Reshaping_Text1')}

You can convert text to curves to reshape it like a non-text object. To convert text to curves, select the text 
object, open the Change Menu, and click Convert To Curves.

Note

After you convert text to curves, you cannot convert it back to text.

{button Related Topics,PI(`',`RT_Reshaping_Text1')}
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To reshape a warped object

1 Select the object.

2 In the Toolbox, click the Edit tool .

3 Click the Warp button .

4 Click the Warp Type button .

5 Click the Bézier Warp button .

{button Related Topics,PI(`',`RT_To_reshape_a_warped_object')}
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Adding and Deleting Anchors
{button Steps...,PI(`',`HT_Adding_and_Deleting_Anchors')}

You can add new or delete existing anchors to help in reshaping. Use the Add Point  and Remove Point 

 buttons on the Edit ribbon to add and delete anchors. You can add and remove anchors in either Point or Curve 
Reshape modes.

Anchor deleted

{button Related Topics,PI(`',`RT_Adding_and_Deleting_Anchors')}
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To add a new anchor to an object

1 Select the object.

2 In the Toolbox, click the Edit tool .

3 On the ribbon, click the Point Reshape or Curve Reshape button .
If the object shows a solid anchor (indicating a special Point Reshape case), click the right mouse button and 
click To Curves. This cancels the special reshape definition and displays the object’s hollow anchors.

4 Click the Add Point button .
5 Click where you want to add anchor.
You also can add anchors to an object by pointing where you want an anchor, holding CTRL, and clicking the left 
mouse button.

{button Related Topics,PI(`',`RT_To_add_a_new_anchor_to_an_object')}
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To delete an anchor

1 If necessary, double-click the object to allow point reshaping.
2 Click the anchor you want to delete.

3 On the ribbon, click the Remove Point button . Only the selected anchors are deleted.
Tip

Select the anchor and press the DEL key.

{button Related Topics,PI(`',`RT_To_delete_an_anchor')}
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Slicing an Object
{button Steps...,PI(`',`HT_Slicing_an_object')}

Slicing opens a closed object and creates two endpoints wherever the slice occurs. You can slice a line in either 
Point or Curve Reshape modes.

 

{button Related Topics,PI(`',`RT_Slicing_an_object')}



To select an object for Point Reshaping
To add a new anchor to an object
To delete an anchor



Breaking Apart at an Anchor
Adding and Deleting Anchors
Introduction to Reshaping



To slice an object

1 Select the object.

2 In the Toolbox, click the Edit tool .

3 On the ribbon, click the Point Reshape  or Curve Reshape button 

.
If the object shows a solid anchor (indicating a special Point Reshape case), click the right mouse button and 
click To Curves. This cancels the special reshape definition and displays the object’s hollow anchors.

4 Click the Slice button .
5 Drag across the line to be sliced. A new, solid anchor appears at the sliced location.
Note

You can slice only one line at a time. Make sure you click the Slice button 

 before making each slice.

{button Related Topics,PI(`',`RT_To_slice_an_object')}
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Breaking Apart at an Anchor
{button Steps...,PI(`',`HT_Breaking_Apart_at_an_Anchor')}

You can slice an object at an anchor. After you slice the object, the single anchor becomes two anchors that you 
can move separately.

 

{button Related Topics,PI(`',`RT_Breaking_Apart_at_an_Anchor')}
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To break apart an object at an anchor

1 Select the object you want to slice.

2 In the Toolbox, click the Edit tool .

3 On the ribbon, click the Point Reshape  or Curve Reshape button 

.
If the object shows a solid anchor (indicating a special Point-Reshape case), click the right mouse button and 
click To Curves. This converts the special object to curves and displays the object’s hollow anchors.

4 Select the anchor to break apart.

5 Click the Slice button . The line is now severed at the anchor.

{button Related Topics,PI(`',`RT_To_break_apart_an_object_at_an_Anchor')}
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Joining Endpoints of an Open Object
{button Steps...,PI(`',`HT_Joining_Endpoints_of_an_Open_Object')}

You can join the two endpoints of an open object by using the Join Points button . The two points are joined 
with a straight line. 

 

{button Related Topics,PI(`',`RT_Joining_Endpoints_of_an_Open_Object')}
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To join endpoints of an open object

1 Select the object that you want to join.

2 In the Toolbox, click the Edit tool .

3 On the ribbon, click the Point Reshape  or Curve Reshape button 

.
4 Select one of the endpoints. It turns solid.
5 Press and hold SHIFT, and select the other endpoint. It turns solid.

6 Click the Join Points button . The object is now closed and filled with the default interior fill.

{button Related Topics,PI(`',`RT_To_join_endpoints_of_an_open_object')}
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Smoothing an Object
{button Steps...,PI(`',`HT_Smoothing_an_Object')}

If an object or curve contains many twists and turns, you can smooth its appearance by eliminating some of its 
anchors.
Objects produced by tracing bitmaps sometimes have an undesirably large number of anchors. By reducing the 
number of anchors in a traced object, you often can improve the object’s appearance. Reducing the number of 
anchors in an object also can improve its printing speed.

{button Related Topics,PI(`',`RT_Smoothing_an_Object')}
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To smooth an object

1 Select the object.
2 On the Change menu, click Reduce Points.
3 In the Reduce Points dialog box, drag the sliding bar toward Fewer Points. The further you drag the sliding 

bar, the more points Designer tries to eliminate.
The Adjusted Number of Points value shows the effect of the point reduction. If the original and adjusted point 
counts do not change, even when you slide the bar all of the way to Fewer Points, then Designer cannot reduce 
the number of points in the object.
Tip

 If you don’t like the effect of the point reduction, You can restore the original shape. On the Edit menu, click 
Undo Reduce Points.

{button Related Topics,PI(`',`RT_To_smooth_an_object')}
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TEXT.DOC
This document contains the Text section of Designer 6.0 Help.



Using Text
Designer’s text features are easy to use and give you a high degree of flexibility. For example, you can design 
brochures, logos, charts, slides, posters, technical illustrations, scale drawings, product specs, schematics, 
blueprints, and even newsletters with Designer.



Fonts Defined
Designer uses scaleable fonts, the highest-quality fonts available. They display as WYSIWYG (what you see is 
what you get) and print exactly as they appear on the screen, regardless of the printer you use.
A font is a collection of letters, numerals, punctuation marks, and special characters that make up a complete 
character set of a given size and style of typeface.
For example, 10-point Garamond Bold is a font, where "10 points" is the size, "Garamond" is the typeface, and 
"Bold" is the style. 10-point Garamond Bold-Italic is considered a different font.
A typewriter is a good example of a font. The letters, numbers, and symbols on a typewriter are one font.
A typeface is a collection of fonts of the same type. Traditionally, typefaces were available in sizes of 6 to 72 
points. For example, the typeface "Garamond" might contain 12 different fonts.
Conventions for Font and Typeface

Now that computers are commonly used for typesetting, the meaning of the words "font" and "typeface" has 
become so blurred that the words are now virtually interchangeable. For example, typefaces that accompany 
many computer programs are commonly called "fonts."

{button Related Topics,PI(`',`RT_Fonts_Defined')}
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Choosing and Changing Fonts
{button Steps...,PI(`',`HT_Choosing_and_Changing_Fonts')}

Designer recognizes fonts that are loaded with the ABC Graphics Suite installer, fonts installed with Adobe Type 
Manager, and TrueType fonts installed with the Windows Control Panel.
In addition to being used by Designer, the fonts you add with any of these methods are used by other Windows 
applications such as Microsoft Word and Wordpad.
Adding many fonts gives you more choices, but a large number of fonts uses more memory and increases the 
time needed to load Designer and other Windows programs.

{button Related Topics,PI(`',`RT_Choosing_and_Changing_Fonts')}
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Using TrueType Fonts
You can use TrueType fonts with Designer. See the Windows documentation for more information about installing 
and removing TrueType fonts.



Types of Fonts
{button Steps...,PI(`',`HT_Choosing_and_Changing_Fonts')}

Designer works with two different types of fonts: scaleable outline fonts and device fonts.
Outline Fonts

Outline fonts are composed of curves much like the curves of other Designer objects. Outline fonts can be 
resized to any shape or size. They are the highest-quality fonts available and print just as you see them on 
screen. Outline fonts print more slowly and require more memory than cartridge or device fonts. Designer’s fonts
are in TrueType format.
TrueType fonts (that accompanied Windows 95, for example) are scaleable outline fonts that display correctly 
and print on any supported printer.
Device Fonts

Device fonts are fonts stored in your printer’s memory or plug-in cartridge. They are very fast and sometimes 
scaleable. Device fonts are loaded when you load the device driver. Device fonts might appear differently on 
screen than they do when you print.
Designer uses Arial as the default font, but you can change the default by modifying an entry in your system 
registry. On the Registry tab of the Options dialog box, add the Value Name DefaultFont to the Mgxgre key, 
and set its value to the name of the font you want to use (for example, Times New Roman).

{button Related Topics,PI(`',`RT_Types_of_Fonts')}
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Using an Unavailable Font
If you open or import a document containing a font that is not installed on your system, Designer substitutes a 
similar font that is available. If you edit the text, the original name of the font appears in the Font list box with a 
question mark beside it to remind you that Designer is substituting a different font. For more information, see 
Font Mapping.



Typeface Tips
Choosing a typeface depends largely on the subject matter and your individual tastes. Here are a few basic 
principles for you to follow.

Don’t use too many typefaces and font sizes in a design. Three or four typefaces are enough.

Don’t use all capital letters for large blocks of text.

Never set black letters (Old English), scripts, or cursives in all capitals.

Use decorative fonts such as Marriage or Uncial to convey short, informal, or specialized messages. Use 
decorative fonts sparingly.

Use sans serif fonts such as Helvetica or Swiss for on-screen presentations.

Roman typefaces such as Times and Century Schoolbook suggest dignity and integrity.

Sans serif typefaces such as Optimum and Helvetica have a modern, contemporary flavor.



Text Pointer and Text Cursor
The I-beam text pointer is used for text actions such as drawing a text container, positioning the text cursor, and
highlighting text.

When no objects are selected, simply clicking the Text tool  (or pressing the keyboard shortcut CTRL+T) 
displays the text pointer. When an object is selected, you must click the Text tool and then click the Text Mode 
button to display the text pointer.
The text cursor, which you use to enter and edit text, is a blinking vertical line. The text cursor is displayed by 
clicking in the drawing area with the text pointer.



Changing Units of Measure
{button Steps...,PI(`',`HT_Changing_Units_of_Measure')}

You can change typographical units of measure to suit your needs. Changing the units does not change the 
appearance of the text, only the measuring system.



To change the units of measure



To change the units of measure

1 Click the Text tool  in the Toolbox.

2 On the Ribbon toolbar, click the Text Attributes button .

3 In the dialog box, click the Units button .
4 Select the desired unit.

Tip

After you make the change, every panel of the Text dialog box reflects the new unit.

{button Related Topics,PI(`',`RT_To_change_the_units_of_measure')}
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Entering and Editing Text
{button Steps...,PI(`',`HT_Entering_and_Editing_Text')}

There are two types of text in Designer: freeform text and block text.
Freeform and block text let you create text objects (any object composed of text) in slightly different ways. Block 
text is created inside a container, while freeform text has no container.
Freeform Text

Use freeform text when you want to create titles, short sentences, or labels, for example. To create freeform text,
click the Text tool, click the Text Mode button (if necessary to display the text pointer), click in the drawing area 
to insert the text cursor, and type the text.

Freeform text cannot flow from one text object to another, nor does it use margins, "word wrap," or indents. 
Resizing a freeform text object changes the size of the text. You cannot wrap freeform text around an object 
(repel text).
Block Text

Block text is useful when you want to create large blocks of text. To create block text, click the Text tool, click the
Text Mode button (if necessary to display the text pointer), draw a box to contain the text, and type the text.



You can connect text blocks so that the text flows from one container to another, and you can assign margins. 
Resizing block text changes the size of the container, but not the text.

{button Related Topics,PI(`',`RT_Entering_and_Editing_Text')}
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To add freeform text

1 Click the Text tool  in the Toolbox.

2 Click the Text Mode button  to display the text pointer, if necessary.
3 Point where you want the text to begin. Click the left mouse button to display the text cursor.
4 Type the text. If you make a mistake, press BACKSPACE to erase it.
5 Press ESC or double click the left mouse button away from the text when you finish entering the text.

{button Related Topics,PI(`',`RT_To_add_freeform_text')}
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Adding Block Text
{button Steps...,PI(`',`HT_Entering_and_Editing_Text')}

You add block text by creating a container and typing text inside it. If you add more text than can fit in the text 
container, it extends below the box and is invisible. Enlarge the container or flow the extra text to another 
container to see it. See Flowing Text for more information.
You can enter or edit text only when the text cursor is visible. All text is entered in the drawing area. Zoom in to 
view and edit the characters, if necessary (or use the Edit Text window as described in Editing Text in a Window.
The appearance of the text depends on the font, size, and style settings. To set new defaults for text attributes, 
deselect all objects and then choose the desired font, size, style, and so on.



To add a text block

1 Click the Text tool  in the Toolbox.
2 Click the Text Mode button to display the text pointer, if necessary.
3 Point where you want the text to begin.
4 Press and hold the left mouse button, and drag the pointer to create a box with dashed lines. The box is the 

text container.
5 Release the mouse button when you finish the box. The text cursor appears inside the container.
6 Type the text.
7 Press ESC when you finish entering the text.

{button Related Topics,PI(`',`RT_To_add_a_text_block')}
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Converting between Block and Freeform Text
{button Steps...,PI(`',`HT_Converting_between_Block_and_Freeform_Text')}

You can use the Clipboard to convert block text to freeform text and freeform text to block text. Each paragraph 
of block text converts to a single line of freeform text.



To convert between block text and freeform text
To add a text block



To convert between block text and freeform text

1 Highlight the text you want to convert.
2 On the Edit menu, click Copy (or Cut) to place the text on the Clipboard.
3 Double click anywhere outside the text area to deselect all text.

4 Click the Text tool  in the Toolbox.
5 Move the text pointer where you want to place the freeform text, and click the left mouse button to place 
the text cursor.

6 On the Edit menu, click Paste. The text appears in the new format.
7 Press ESC when you finish editing.
Tip

In step 5, you can draw a container to contain the text. Press and hold the left mouse button, and drag a 
container in which to place block text. Release the mouse button.

{button Related Topics,PI(`',`RT_To_convert_between_block_text_and_freeform_text')}
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Selecting Text
{button Steps...,PI(`',`HT_Selecting_Text')}

You can select text so that it can be modified. There are two ways to select text: select a text object as you 
would any object in Designer or highlight a portion of the text.

{button Related Topics,PI(`',`RT_Selecting_Text')}
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Selecting a Text Object
{button Steps...,PI(`',`HT_Selecting_Text')}

To select a text object, you must be in select mode. You are in select mode when the pointer is a select pointer. 
To switch from the text pointer to the select pointer, press ESC.
To select a text object, point to the text with the select pointer and click the left mouse button. Eight blue 
handles appear around a text object when it is selected. Select a text object when you want to change all of the 
text in a text object, or when you want to move the block. For example, if you select a text object and click the 
Bold button, all of the text is bolded.



Highlighting a Portion of Text
{button Steps...,PI(`',`HT_Selecting_Text')}

To highlight text, the pointer must be a text pointer. To display the text pointer, click the Text tool     and then
click the Text Mode button 

 (if necessary).
Highlight text when you want to change only part of the text in a text block. Only the highlighted text is affected 
so, for example, you can replace the highlighted text (by typing new text), delete the highlighted text, or italicize
one word in a block.
You can highlight text and change its size, font, color, style (italics or bold, for example), alignment, or letter 
spacing.

 



To highlight text

1 Click the Text tool  in the Toolbox.

2 Click the Text Mode button  to display the text pointer, if necessary.
3 Click the text in the drawing area to insert the text cursor and point where you want to begin highlighting.

4 Press and hold the left mouse button and drag the text cursor to the right (and down if you want to highlight 
text on another line). The text is highlighted as you drag.

5 Release the left mouse button.
6 Make the desired changes to the highlighted text or press DEL to delete it.
7 Press ESC when you finish editing the text.
Tips

If you type while text is highlighted, the highlighted text is deleted and replaced with the new text.

To highlight all text in a block, click to position the text cursor in the block and press CTRL+A.

You can also use the arrow keys to highlight text. Click to position the text cursor in the text and use the 
following keys to highlight portions of the text.

Press To Highlight
SHIFT+LEFT ARROW To the left of the text cursor
SHIFT+RIGHT ARROW To the right of the text cursor
SHIFT+HOME To the beginning of the line
SHIFT+END To the end of the line
SHIFT+UP ARROW orMultiple lines
SHIFT+DOWN ARROW

{button Related Topics,PI(`',`RT_To_highlight_text')}
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Resizing a Text Container
{button Steps...,PI(`',`HT_Resizing_a_Text_Container')}

You can resize the text container around block text to change the text flow. Resizing a text container does not 
otherwise change the appearance of the text.
To display the text container around block text so that you can resize it, click the text block once with the text 
pointer, or double click the text block with the select pointer.

Dragging a container handle resizes the container. The text reflows to accommodate the new container size, but 
the text size and style attributes do not change.



To resize a text container



To resize a text container

1 Display the text container, if necessary.
2 Move the pointer to a container handle.
3 Drag the handle to a new position.
4 Release the mouse button.
5 Repeat steps 2 through 4 to adjust the other handle, if desired.
6 Press ESC when you finish resizing the container.

{button Related Topics,PI(`',`RT_To_resize_a_text_container')}



Resizing a Text Container



Inserting and Deleting Text
{button Steps...,PI(`',`HT_Inserting_and_Deleting_Text')}

Use the text cursor as a guide when inserting or deleting text. To position the text cursor, click in the text where 
you want the cursor. You can reposition the cursor in the text by pressing the arrow keys or by clicking at another
point in the text.
Tip

Press HOME to position the text cursor at the beginning of a line. Press END to position the text cursor at 
the end of a line.



To insert text
To delete text



To insert text

1 Click the Text tool  in the Toolbox.

2 Click the Text Mode button  to display the text pointer, if necessary.
3 Point where you want to insert text and click the left mouse button. The text cursor is positioned in the text.
4 Type the new text.
5 Press ESC when you finish editing the text.

{button Related Topics,PI(`',`RT_To_insert_text')}



Inserting and Deleting Text



To delete text

1 Click the Text tool  in the Toolbox.

2 Click the Text Mode button  to display the text pointer, if necessary.
3 Point to the right of the text to delete and click the left mouse button. The text cursor is positioned in the 

text.
4 Press BACKSPACE to delete the text to the left of the text cursor.
5 Press ESC when you finish editing the text.
Tip

You can press DEL to delete text to the right of the text cursor.

{button Related Topics,PI(`',`RT_To_insert_text')}



Editing Text in a Window
{button Steps...,PI(`',`HT_Editing_Text_in_a_Window')}

The Edit Text window provides a method of editing text that can be quicker and more convenient than editing 
text in the drawing area. The Edit Text window makes it easy to edit text to which you have applied graphic 
effects such as warping, because it displays the text without those effects. You can also use the Edit Text window
to edit text that is too small to view without zooming in.
The Edit Text window shows and lets you apply style attributes such as bold and italic.

You can edit both freeform and block text in the Edit Text window. To open the Edit Text window for all text except 
warped text, press and hold SHIFT and click the text with the text pointer. To open the Edit Text window for warped 
text, just click the text with the text pointer (without pressing SHIFT).

Using the Edit Text Window

Use the text cursor as a guide when adding, changing, or deleting text in the Edit Text window. Position the 
cursor by pressing the HOME, END, and arrow keys, or by clicking in the text where you want the cursor.
Highlight text in the Edit Text window as you would in the drawing area: position the text pointer at the beginning
of the text and drag it over the text you want to highlight.



To open the Edit Text window
To apply style attributes to text in the Edit Text window



To open the Edit Text window

1 Click the Text tool  in the Toolbox.

2 Click the Text Mode button  to display the text pointer, if necessary.
3 Point to the text with the text pointer.
4 Press and hold SHIFT, and click with the left mouse button. The Edit Text window opens.
5 Edit the text in the window.
Tip

If the text cursor is positioned within text, press ESC before following the procedure given above.

{button Related Topics,PI(`',`RT_To_open_the_Edit_Text_window')}
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To apply style attributes to text in the Edit Text window

1 Highlight the text you want to change.
2 Click the right mouse button. A shortcut menu opens.
3 Choose the desired style from the menu.

{button Related Topics,PI(`',`RT_To_apply_style_attributes_to_text_in_the_Edit_Text_window')}
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Importing Text
{button Steps...,PI(`',`HT_Importing_Text')}

You can compose text in a word processing or other Windows program and import it into your Designer drawing.
There are two ways to bring text into Designer. You can paste text into Designer from the Clipboard, or you can 
import text as a plain (ASCII) or Rich Text Format (RTF) text file.
Text can be imported as freeform or block text. If you import ASCII text (for example, a TXT file), it appears in the
current font and style. If you import RTF text, it appears in the font and style in which it was originally created.

{button Related Topics,PI(`',`RT_Importing_Text')}



To import text from a text file
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Pasting Text
Pasting Text inside an Object



To import text from a text file

1 Click the Text tool  in the Toolbox.
2 Click the Text Mode button to display the text pointer, if necessary.
3 Click a text object to insert the text cursor.

or

Begin a new text object (click for freeform, drag for block text).
4 On the Tools menu, click Import. The Import dialog box opens.
5 Select Files of type ASCII Text (*.TXT) to import regular ASCII text or select Rich Text Format (*.RTF) to import 

RTF text.
6 Highlight the file to import and click Import. The text appears.
7 Press ESC when you finish editing.
Tip

You can press CTRL+1 to open the Import dialog box quickly.

{button Related Topics,PI(`',`RT_To_import_text_from_a_text_file')}



Importing Text
Pasting Text
To apply style attributes to text in the Edit Text window



Pasting Text
{button Steps...,PI(`',`HT_Importing_Text')}

You can copy text from another program and paste it into Designer as freeform or block text.

{button Related Topics,PI(`',`RT_Pasting_Text')}
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Importing Text



To paste text as freeform text

1 Copy the text you want in another program.
2 Change to Designer.
3 Press CTRL+V to paste the text into Designer
4 Press ESC when you finish editing the text.

{button Related Topics,PI(`',`RT_To_import_text_from_a_text_file')}



To paste text as block text

1 Copy the text you want in another program.
2 Change to Designer.

3 Click the Text tool  in the Toolbox.
4 Click the Text Mode button to display the text pointer, if necessary.
5 Point where you want the text to begin.
6 Press and hold the left mouse button, and drag the pointer to create a box with dashed lines. The box is 
the text container.
7 Release the mouse button when you finish the box. The text cursor appears inside the container.
8 Press CTRL+V to paste the text into Designer

9 Press ESC when you finish editing the text.

{button Related Topics,PI(`',`RT_To_import_text_from_a_text_file')}



Pasting Text inside an Object
{button Steps...,PI(`',`HT_Importing_Text')}

You can paste text inside a container that matches a closed object’s outline. See "Text Inside of an Object" for 
more information on text inside of object outlines.

{button Related Topics,PI(`',`RT_Importing_Text')}
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To paste text inside an object

1 Copy or cut text to the Clipboard.
2 Select a closed object.

3 Click the Text tool  in the Toolbox.

4 Click the Shape Text button  on the Ribbon toolbar.
5 On the Edit menu, click Paste.
6 Press ESC when you finish editing the text.

{button Related Topics,PI(`',`RT_To_paste_text_inside_of_an_object')}
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Selecting Fonts, Sizes, and Styles
{button Steps...,PI(`',`HT_Selecting_Fonts_Sizes_and_Styles')}

You can specify type characteristics before you enter text, or you can change them for existing text. A text object
can contain any combination of fonts, font sizes, and styles.
You can select fonts, font sizes, and styles with the Text Ribbon toolbar, the Text dialog box, or the shortcut 
menu.

{button Related Topics,PI(`',`RT_Selecting_Fonts_Sizes_and_Styles')}
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Fonts
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Fonts
{button Steps...,PI(`',`HT_Selecting_Fonts_Sizes_and_Styles')}

The available fonts are listed in the Font List box. The icon preceding the font name describes the type of font.
Icon Type of font

TrueType font
Adobe Type 1 font
Printer (device) font

Notes

If a blue question mark icon appears, it indicates that selected text saved in the document is in a font that 
is not currently installed on your computer.

To locate a font in the Font list box quickly, open the list box and type the first letter of the font name.



Font Sizes
{button Steps...,PI(`',`HT_Selecting_Fonts_Sizes_and_Styles')}

You select the size of the font in the Font Size list box. You can select a size from 2 to 3,000 points by clicking the
arrows beside the box, or you can type a custom size (10.5, for example).
You also can resize a selected text object using the corner handles, or stretch it with the middle or side handles. 
The new size appears in the Font Size list box.

Tip

You can also click the Font Recall button 
 and select one of the last ten fonts used.



Font Styles
{button Steps...,PI(`',`HT_Selecting_Fonts_Sizes_and_Styles')}

The following styles are available in Designer.



To apply text attributes with the Text Ribbon toolbar

1 Click the Text tool  in the Toolbox.
2 Select the text object or highlight the text you want to change.
3 Click the attribute in the Text Ribbon toolbar that you want to apply. The changes are made to the selected 

text.
Tip

You can use keyboard shortcuts for applying attributes to selected and highlighted text. Press the keyboard
shortcut once to apply the style. Press it again to remove the style.

Action Keyboard shortcut
Bold CTRL+B
Italic CTRL+I
Underline CTRL+U
Small Caps CTRL+M
Superscript CTRL+K
Subscript CTRL+SHIFT+K

{button Related Topics,PI(`',`RT_To_apply_text_attributes_with_the_Text_ribbon')}
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To select type attributes with the Text dialog box

1 Click the Text tool  in the Toolbox.
2 Select the text object or highlight the text you want to change.

3 Click the Text Attributes button  in the Ribbon toolbar. The Text dialog box opens.

4 Click the Fonts button  to display the Fonts panel, if necessary.
5 Choose the attributes you want to apply and click Apply. The changes are made to the selected text.
Tips

Press CTRL+SHIFT+T to open the Text dialog box quickly.

You do not need to close the dialog box to apply the changes.

{button Related Topics,PI(`',`RT_To_select_type_attributes_with_the_Text_dialog_box')}
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To apply a text attribute using the shortcut menu

1 Select the text object or highlight the text you want to change.
2 Click the right mouse button. The shortcut menu appears.
3 Choose the attribute you want to apply on the shortcut menu. The changes are made to the selected text.

{button Related Topics,PI(`',`RT_To_apply_a_text_attribute_using_the_popup_menu')}
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To change text line and interior color

1 Select or highlight the text you want to change.

2 Click the Style tool  in the Toolbox.
3 Point to a color in the Color Palette and click the left mouse button to change the interior color. 
4 Point to a color in the Color Palette and click the right mouse button to change the line color.
Tip

To set a color to invisible or unfilled, click the X in the Color Palette toolbar.

You can use the Fonts panel of the Text dialog box to set the text foreground color (fill color) and 
background color (color outside the text itself) of a selected text object, but not of text you have highlighted.

{button Related Topics,PI(`',`RT_To_change_text_line_and_interior_color')}
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To change text background color

1 Select or highlight the text you want to change.

2 Click the Text Attributes button  on the Text Ribbon toolbar. The Text dialog box opens.

3 Click the Fonts button  to display the Fonts panel, if necessary.
4 Click the Background Color box. A palette displays.
5 Point to a color in the palette and click the left mouse button.
6 Click Apply.
Tip

You do not need to close the dialog box to apply the changes.

{button Related Topics,PI(`',`RT_To_change_text_background_color')}
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Two Types of Background Colors
{button Steps...,PI(`',`HT_Two_Types_of_Background_Colors')}

Some interior fills, such as hatch fills and object fills, have both a foreground and background color. Don’t 
confuse this type of background color with the text background color that you set in Fonts panel of the Text 
dialog box. 
If you have applied a hatch fill or object fill to text, clicking a color in the Color Palette with the left mouse button 
alone sets the foreground interior color. To set the background interior color, point to a color, press and hold 
SHIFT, and click the left mouse button.

{button Related Topics,PI(`',`RT_Two_Types_of_Background_Colors')}
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Setting Margins
{button Steps...,PI(`',`HT_Setting_Margins')}

You can add margins to paragraphs in block text. Margins determine the distance between block text and its 
bounding box. You can highlight paragraphs to give different paragraphs in the same block different margins. 
The default margin is none.

{button Related Topics,PI(`',`RT_Setting_Margins')}
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Setting Indents



To adjust the margins

1 Click the Text tool  in the Toolbox.
2 Select or highlight the text you want to change.

3 Click the Text Attributes button  in the Text Ribbon toolbar. The Text dialog box opens.

4 Click the Margins button  to display the Margins panel, if necessary.
5 Type new numbers in the Left and Right Margin boxes.
6 Click Apply. The text block changes to reflect the new margin settings.
Tip

You do not need to close the dialog box to apply the changes.

{button Related Topics,PI(`',`RT_To_adjust_the_margins')}
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Setting Indents
{button Steps...,PI(`',`HT_Setting_Margins')}

You can move the first line of selected paragraphs in block text to the left or right of the left margin by changing 
the first line indent. If you select a text object, the first line of each paragraph separated by a return is indented. 
If you highlight a portion of one or more paragraphs, only the first lines of those paragraphs are indented.

A positive indent moves the text toward the right (away from the left margin); a negative indent moves the text 
toward the left (inside of the left margin).

{button Related Topics,PI(`',`RT_Setting_Indents')}
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To indent the first line of a paragraph

1 Click the Text tool  in the Toolbox.
2 Select or highlight the text you want to change.

3 Click the Text Attributes button  in the Text Ribbon toolbar. The Text dialog box opens.

4 Click the Margins button  to display the Margins panel, if necessary.
5 Type a positive number in the First Indent box to indent the first line of each paragraph to the right; type a 

negative number to indent to the left.
6 Click Apply to indent the text.
Tip

In step 3, if you prefer you can open the Text dialog box by clicking Margins in the Format menu.

You do not need to close the dialog box to apply the changes.

{button Related Topics,PI(`',`RT_To_indent_the_first_line_of_a_paragraph')}
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Changing Line and Character Spacing
{button Steps...,PI(`',`HT_Changing_Line_and_Character_Spacing')}

Each font in designer has its own default line and character spacing. You can change the spacing between 
characters, words, lines, and paragraphs.

{button Related Topics,PI(`',`RT_Changing_Line_and_Character_Spacing')}
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Line Spacing
{button Steps...,PI(`',`HT_Changing_Line_and_Character_Spacing')}

The space between lines of text is called leading. Leading is measured (in points) from baseline to baseline. The 
default is the current font size plus approximately 15% of the font size (the percent may vary from font to font). 
For example, if the current font is 10 points, then the default leading is approximately 11.5 points.
You can change the leading in selected block text or specify leading for block text you are going to enter. If a 
selected block text contains different sizes of text, Designer displays leading for the largest font.
Note

You cannot change the leading of freeform text.

{button Related Topics,PI(`',`RT_Line_Spacing')}
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To change text leading

1 Click the Text tool  in the Toolbox.
2 Select or highlight the text you want to change.

3 Click the Text Attributes button  in the Text Ribbon toolbar. The Text dialog box opens.

4 Click the Spacing button  to display the Spacing panel, if necessary.
5 Click the button beside the line leading box and type a new number for the amount of leading.
6 Click Apply to change the leading.
Tips

You do not need to close the dialog box to apply the changes.

You also can change block text leading manually. Insert the text cursor into the block and press and hold 
SHIFT while dragging the bottom container handle up or down. Press CTRL while dragging to change the spacing 
between paragraphs.

{button Related Topics,PI(`',`RT_To_change_text_leading')}
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Paragraph Spacing
{button Steps...,PI(`',`HT_Changing_Line_and_Character_Spacing')}

You can change the amount of space between paragraphs with the paragraph spacing options in the Spacing 
panel of the Text dialog box. Spacing is measured in the currently selected unit (points, for example).
Note

If Before Paragraph or After Paragraph is set to zero, Designer automatically uses the current leading for 
the paragraph, which results in no extra space before or after the paragraph.

{button Related Topics,PI(`',`RT_Paragraph_Spacing')}
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Character and Word Spacing
{button Steps...,PI(`',`HT_Changing_Line_and_Character_Spacing')}

You can increase or decrease the spacing between words and characters by changing the "normal" spacing 
percentage. The default for words is 100% spacing; the default for characters is 100% spacing. Decreasing the 
percentage decreases the spacing between letters or words; increasing the percentage increases the spacing.
Tip

You can also manually change character spacing in block text. Insert the text cursor into the block and 
press and hold SHIFT while dragging the right container handle left or right. Press CTRL while dragging to change 
the spacing between words.

 

{button Related Topics,PI(`',`RT_Character_and_Word_Spacing')}
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To change word and character spacing

1 Click the Text tool  in the Toolbox.
2 Select or highlight the text you want to change.

3 Click the Text Attributes button  in the Text Ribbon toolbar. The Text dialog box opens.

4 Click the Spacing button  to display the Spacing panel, if necessary.
5 Type a new number in the Inter Word or Inter Character spacing box.

6 Click Apply to change the spacing.
Tips

You do not need to close the dialog box to apply the changes.

{button Related Topics,PI(`',`RT_To_change_word_and_character_spacing')}
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Kerning
{button Steps...,PI(`',`HT_Changing_Line_and_Character_Spacing')}

Changing the spacing between certain pairs of characters is called kerning. Kerning adjusts the spacing between 
particular characters that look better when they are closer together. The illustration below shows characters that
are commonly kerned.

{button Related Topics,PI(`',`RT_Kerning')}
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To kern text

1 Click the Text tool  in the Toolbox.

2 Click the Text Mode button  to display the text pointer, if necessary.
3 Point to the characters to kern, and press the left mouse button to place the text cursor between them.
4 Press and hold CTRL and press the LEFT ARROW or RIGHT ARROW to move the characters closer together or 

farther apart, respectively.
Tip

Use the View tool to zoom in on the text you want to kern. The closer you zoom, the easier it is to see the 
kerning effect.

{button Related Topics,PI(`',`RT_To_kern_text')}
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Using Automatic Hyphenation
{button Steps...,PI(`',`HT_Using_Automatic_Hyphenation')}

Designer can automatically hyphenate words to help decrease the raggedness of left justified text, and to help 
maintain character and word spacing in justified text.

{button Related Topics,PI(`',`RT_Using_Automatic_Hyphenation')}
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To use automatic hyphenation

1 Click the Text tool  in the Toolbox.
2 Select or highlight the text you want to hyphenate.

3 Click the Text Attributes button  in the Text Ribbon toolbar. The Text dialog box opens.

4 Click the Spacing button  to display the Spacing panel, if necessary.
5 Select the Use Automatic Hyphenation option.

6 Click Apply to change the spacing.
Tip

You do not need to close the dialog box to apply the changes.

{button Related Topics,PI(`',`RT_To_use_automatic_hyphenation')}
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Setting Tabs
{button Steps...,PI(`',`HT_Setting_Tabs')}

Tab stops are relative to the text object. For example, if the first tab stop is .5 picas, the first tab is .5 picas from 
the left margin. If the second tab stop is 1.0 picas, it is 1.0 picas from the left margin, and so on. Text objects 
maintain their original tab positions even if you move the object.

{button Related Topics,PI(`',`RT_Setting_Tabs')}
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To set tab stops

1 Click the Text tool  in the Toolbox.

2 Click the Text Attributes button  in the Text Ribbon toolbar to open the Text dialog box.

3 Click the Tab Stops button  to display the Tab Stops panel, if necessary.
4 Select the type of tab stop, if you want.
5 Type a position for the tab stop in the Position box.

6 Click the Add Tab button  to add a single tab stop, or click the Repeat Tab button 
 to add repeating tab stops.

7 Click Apply to enter the tab stops.
Tip

You do not need to close the dialog box to apply the changes.

{button Related Topics,PI(`',`RT_To_set_tab_stops')}
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Setting Leaders
{button Steps...,PI(`',`HT_Setting_Tabs')}

Leaders are characters such as periods ( . ), hyphens ( - ), and underscores ( _ ) that appear to the left of 
tabulated text.

{button Related Topics,PI(`',`RT_Setting_Leaders')}
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To set leaders

1 Click the Text tool  in the Toolbox.

2 Click the Text Attributes button  in the Text Ribbon toolbar to open the Text dialog box.

3 Click the Tab Stops button  to display the Tab Stops panel, if necessary.
4 Select a current tab in the Current Tabs area.
5 Select a leader in the Leader box.

6 Click the Add Tab button . A dialog box appears asking if you want to overwrite the existing tab.
7 Click Yes. The previous tab is replaced with the new one with the leaders you chose associated with it
8 Click Apply to put the new tab stops in selected text.

Tip

You do not need to close the dialog box to apply the changes.

{button Related Topics,PI(`',`RT_To_set_leaders')}
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Using Drop Caps
{button Steps...,PI(`',`HT_Using_Drop_Caps')}

A drop cap is an enlarged first capital letter in a selection of text. A drop cap is created by lowering the baseline 
of the first character in a paragraph so that it aligns with the baseline of the last indented line.
You create drop caps by increasing the percentage of the current font height. For example, 200% doubles the 
size of the first letter of the paragraph.



To create an initial drop cap



To create an initial drop cap

1 Click the Text tool  in the Toolbox.
2 Select or highlight the text you want to change.

3 Click the Text Attributes button  to open the Text dialog box.

4 Click the Spacing button  to display the Spacing panel, if necessary.
5 Select the Use Drop Caps option.

5 Change the percentage for the drop cap size.
6 Click Apply.
Tip

You do not need to close the dialog box to apply the changes.

{button Related Topics,PI(`',`RT_To_create_an_initial_drop_cap')}
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Aligning Text
{button Steps...,PI(`',`HT_Aligning_Text')}

You can align both freeform and block text. You can also align text that is inside of a container or along a path.
You can use the text alignment options in the Text Ribbon toolbar or in the Margins panel of the Text dialog box. 

{button Related Topics,PI(`',`RT_Aligning_Text')}
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To set text alignment

1 Select the text you want to align or deselect all text if you want to set the alignment for subsequent text.

2 Click the Text tool  in the Toolbox.

3 Click the Text Attributes button  in the Text Ribbon toolbar.

4 Click the Margins button  in the dialog box.
5 Click a horizontal alignment button.
6 Click a vertical alignment button.
7 Click Apply to apply your choices to selected text.

Tip

You do not need to close the dialog box to apply the changes.

{button Related Topics,PI(`',`RT_To_open_the_Margins_panel_in_the_Text_dialog_box')}
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Aligning Freeform Text
You can choose an alignment option before or after you enter freeform text. If you select an alignment option 
before entering text, the text is aligned to the cursor’s position. For example, if the text is aligned at the right, 
the cursor does not move and text appears to the left of the cursor as you type.
If you select a freeform text object or highlight only the text you want to align, the alignment is based on the 
bounding box that surrounds the text. The bounding box is as wide as the longest line of text and as tall as the 
number of lines of text.
Note

Freeform text cannot be justified vertically or horizontally.

{button Related Topics,PI(`',`RT_Aligning_Freeform_Text')}
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Aligning within a Text Block
You can choose an alignment option before or after you enter block text. You can set the alignment option before
entering text or select a text block and change the alignment of the entire block. You also can highlight only the 
paragraphs you want to align. Text is aligned to the container.
Text in a shape is aligned after it is pasted into the shape. The text is aligned within the edges of the shape.

{button Related Topics,PI(`',`RT_Aligning_within_a_Text_Block')}
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Alignment Options
You can align text horizontally or vertically. Horizontal text alignment aligns text from left to right and vertical 
alignment aligns text from top to bottom.

Horizontal alignment options

Vertical alignment options

The keyboard shortcuts for aligning text are listed in the table below.
Action Keyboard shortcut
Align to left CTRL+SHIFT+L
Align to center CTRL+SHIFT+C
Align to right CTRL+SHIFT+R
Align to top CTRL+SHIFT+O
Align to middle CTRL+SHIFT+M
Align to bottom CTRL+SHIFT+B
Full justify horizontal CTRL+SHIFT+J
Force justify horizontal CTRL+SHIFT+F

Note

Vertically justified text ignores previous leading settings.

{button Related Topics,PI(`',`RT_Alignment_Options')}
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Fitting Text to a Path
{button Steps...,PI(`',`HT_Fitting_Text_to_a_Path')}

Designer’s fit-to-path features let you align text to any shape, including curves, circles, and angles to create 
complex effects. You can either enter the text directly onto a path or fit existing freeform text to a path. After 
fitting text to a path, you can still edit the text and change text attributes.
It is easy to get the text fit that you want because Designer previews on your page the effect of alignment 
settings as you choose or change them.
Because Designer remembers the path that you used to align the text, you can reshape the path object, or even 
delete it, without affecting the aligned text.

You can edit text on a path just as you would any other text. For example, you can change the path alignment, 
color, font, or kerning of the text. You can also delete the shape used to arrange the text if you do not want the 
object to be visible.

{button Related Topics,PI(`',`RT_Fitting_Text_to_a_Path')}
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Entering Text along a Path
{button Steps...,PI(`',`HT_Fitting_Text_to_a_Path')}

The Path Text button lets you type text directly onto an object’s path. The text is fitted to the path using the 
current settings. After entering text, you can easily change the fitting options to get the text alignment that you 
want.

{button Related Topics,PI(`',`RT_Entering_Text_along_a_Path')}
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To enter text directly along an object’s path

1 Select the object along which you want to place the text.

2 Click the Text tool  in the Toolbox.

3 Click the Path Text button . The text cursor appears on the path.
4 Type the text, which appears along the object as you type.
5 Press ESC when you finish.
Tip

You can use the Edit Text window rather than typing directly on the screen. That can make it easier and 
faster to enter and edit text.

{button Related Topics,PI(`',`RT_To_enter_text_directly_along_an_object_s_path')}
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The Path Fit Palette
{button Steps...,PI(`',`HT_Fitting_Text_to_a_Path')}

The Path Fit palette makes it easy to produce quickly the text effects that you want when aligning existing text to
a path or when editing the alignment of text already fit to a path. The Path Fit palette provides "quick choice" 
buttons that let you specify combinations of the following.

Text alignment: left, right, or center

Text position: above (outside) or below (inside) the path

Text orientation: normal or upside down
If you are fitting freeform text to a path, you must select both the freeform text and the path object to enable the
Path Fit button. If you are editing the alignment of text already fit to a path, you can enable the Path Fit button 
either by selecting the fitted text or by selecting the fitted text and path object.
The quick choice buttons show a sample path and an arrow to indicate the text arrangement. The location of the 
arrow in relation to the sample path indicates the text alignment and position. The direction of the arrow 
indicates the text orientation (which side is up).

{button Related Topics,PI(`',`RT_The_Path_Fit_Palette')}



Fitting Text to a Path
Entering Text along a Path
The Choose Position Ribbon Toolbar



The Choose Position Ribbon Toolbar
{button Steps...,PI(`',`HT_Fitting_Text_to_a_Path')}

If the quick choice buttons do not provide the text alignment that you want, you can custom align the text with 
the buttons in the Choose Position Ribbon toolbar. The buttons in the Ribbon let you set separately the 
alignment, position, offset, direction, and pitch of the text. The Choose Position button also lets you manually 
adjust the alignment point by dragging it along the path.
Click Choose Position in the Path Fit palette to display the Choose Position Ribbon toolbar. After creating the path 
fit that you want, double click the left mouse button or press ESC to clear the Choose Position Ribbon toolbar.

{button Related Topics,PI(`',`RT_The_Choose_Position_Ribbon')}
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To set text alignment for text on a path

1 Select the text you want to align.

2 Click the Text tool  in the Toolbox.

3 Click the Path Fit button . A palette opens.
4 Click Choose Position. The Choose Position Ribbon toolbar opens.
5 Click an alignment button for the alignment you want.

6 Press ESC when you finish.
Tips

The Left Align button 

 positions text so the left edge of the text aligns to the alignment point.

The Center Align button 

 centers text around the alignment point.

The Right Align button 

 positions text so the right edge of the text aligns to the alignment point.

You can press TAB to cycle through the Left, Center, and Right alignment settings.

You can click Choose Position in the Path Fit palette and click to specify a custom alignment point.

{button Related Topics,PI(`',`RT_To_set_text_alignment_for_text_on_a_path')}
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To set text position for text on a path

1 Select the text you want to change the position of.

2 Click the Text tool  in the Toolbox.

3 Click the Path Fit button . A palette opens.
4 Click Choose Position. The Choose Position Ribbon toolbar opens.
5 Click the Above Path button  or Below Path button 

 to specify the position for the text.
Tips

The Above button 

 positions the text above an open path object or outside of a closed path object.

The Below button 

 positions the text below an open path object or inside of a closed path object.
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To change the offset of text on a path

1 Select the text you want to change the offset of.

2 Click the Text tool  in the Toolbox.

3 Click the Path Fit button . A palette opens.
4 Click Choose Position. The Choose Position Ribbon toolbar opens.
5 Enter the offset percentage you want in the Offset Percentage box.

Tips

An offset of 0% aligns the text on the path.

The alignment offset is relative to whether the text is positioned above or below the path. A positive offset 
(to the limit of 500%) shifts the text away from the path. A negative offset 0% (to the limit of -50%) shifts the text 
past the path.

{button Related Topics,PI(`',`RT_To_change_the_offset_of_text_on_a_path')}



Fitting Text to a Path
Entering Text along a Path
The Path Fit Palette
The Choose Position Ribbon Toolbar
To enter text directly along an object's path
To set text alignment for text on a path
To set text position for text on a path
To change the direction of text on a path
To change the alignment pitch of text on a path
To reposition the alignment point of text on a path
To remove text from a path
To place existing freeform text along an existing object's path



To change the direction of text on a path

1 Select the text you want to change the offset of.

2 Click the Text tool  in the Toolbox.

3 Click the Path Fit button . A palette opens.
4 Click Choose Position. The Choose Position Ribbon toolbar opens.

5 Click the Reverse button  or Forward button 

 to set the direction you want.
Tips

The Reverse button 

 aligns text in a counter clockwise direction for most simple paths. This generally displays the text upside down 
in relation to the top of the path.

The Forward button 

 aligns text in a clockwise direction for most simple paths. This generally displays the text upright in relation to 
the top of the path.

{button Related Topics,PI(`',`RT_To_change_the_direction_of_text_on_a_path')}
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To change the alignment pitch of text on a path

1 Select the text you want to change the alignment pitch of.

2 Click the Text tool  in the Toolbox.

3 Click the Path Fit button . A palette opens.
4 Click Choose Position. The Choose Position Ribbon toolbar opens.
5 Click the alignment button to set the alignment you want.

Tips

The Rotate button 

 aligns the text by rotating the characters along the path.

The Skew Vert button 
 aligns the text by skewing the characters vertically.

The Skew Horz button 
 aligns the text by skewing the characters horizontally.

The No Rotation button 
 aligns the text without skewing or rotating the characters. This produces the fastest redraw. Use this pitch as

a draft mode while you are modifying the alignment point. After the alignment point is set correctly, choose the 
pitch setting you want.

{button Related Topics,PI(`',`RT_To_change_the_alignment_pitch_of_text_on_a_path')}
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To reposition the alignment point of text on a path

1 Select the text you want to change the alignment pitch of.

2 Click the Text tool  in the Toolbox.

3 Click the Path Fit button . A palette opens.
4 Click Choose Position. The Choose Position Ribbon toolbar opens.
5 Drag the alignment point to a new location or click any point along the path.
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To remove text from a path

1 Select the text you want to remove from a path.

2 Click the Text tool  in the Toolbox.

3 Click the Path Fit button . A palette opens.
4 Click Remove Curve. The text is removed from the path. It is now freeform text.

{button Related Topics,PI(`',`RT_To_remove_text_from_a_path')}
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To place existing freeform text along an existing object’s path

1 Select both the freeform text and the object to which you want to align it.

2 Click the Text tool  in the Toolbox.

3 Click the Path Fit button . The Path Fit palette opens.
4 Click the desired quick choice button. The text is put along the path.
Tips

You can click Choose Position and specify a custom alignment.

Subscripts, superscripts, and small caps are not retained in text that is fit to a path.

{button Related Topics,PI(`',`RT_To_place_existing_freeform_text_along_an_existing_object_s_path')}
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Text Inside of an Object
{button Steps...,PI(`',`HT_Text_Inside_of_an_Object')}

Text inside of an object is a form of block text. A container is created that matches the edges of the object. You 
can create margins based on the distance of the text from the container.
You can flow text inside of an object from one container to another. For example, you can flow a block of text 
inside an object to a block of text outside the object. See "Flowing Text" for more information.
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To place text inside of an object

1 Select a closed object.

2 Click the Text tool  in the Toolbox.
3 Click the Shape Text button in the Ribbon toolbar. The text cursor appears inside the selected object.
4 Type, paste, or import the text.
5 Press ESC when you finish.
Tip

After you place text inside of an object, you can move or delete the object without affecting the text. Point 
inside the object, press ALT and click the left mouse button. Text Object appears in the status bar at the bottom of 
the Designer window when the text is selected; the type of object (shape) appears when the object is selected. 
Press DEL to delete the object when it is selected.

{button Related Topics,PI(`',`RT_To_place_text_inside_of_an_object')}
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Splitting and Joining Text
{button Steps...,PI(`',`HT_Splitting_and_Joining_Text')}

You can break multi-line text objects into individual objects, or join multiple text objects into a single, multi-line 
object.
Splitting and joining text is useful when you want to quickly enter or import several lines of text and position 
them later. For example, if your drawing has a dozen labels, it is easier to enter the labels as a single object, and 
then split it and move the labels individually.
Splitting Text

Text blocks and freeform text that contain multiple lines can be broken into multiple freeform text objects, each 
containing a single line.
Joining Text

Text blocks and freeform text can be joined into a single text object. When you join text blocks, all text conforms 
to the shape of the first selected text block (or the first created text block, if they are selected at the same time).
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To split a multi-line text object

1 Select the text object.
2 On the Change menu, point to Text and click Split Text. Each line of text becomes a separate text object.

{button Related Topics,PI(`',`RT_To_split_a_multi_line_text_object')}
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To join text objects

1 Select the text objects to join.
2 On the Change menu, point to Text and click Join Text. The text becomes one object based on the location of 

the first text object.

{button Related Topics,PI(`',`RT_To_split_a_multi_line_text_object')}
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Rotating and Skewing Text
{button Steps...,PI(`',`HT_Rotating_and_Skewing_Text')}

You can rotate and skew a text object as you would any other object. Rotating or skewing a text object does not 
change the text size or style.
Rotating Text

You manually rotate a text object by displaying the object’s rotating/skew handles and dragging a corner handle.
Skewing Text

You manually skew a text object by displaying the object’s rotating/skew handles and dragging a side handle.
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To rotate a text object manually

1 Select the freeform or block text you want to rotate. Then click it again (that is, click the currently selected 
text object).

2 Drag the pivot point to a new location, even outside the object, if you want.
3 Point to a corner handle of the object.
4 Drag the handle in a circular motion around the object.
Tip

Alternatively, to prepare text to be rotated, you can select the text, click the Edit tool, and click the 
Rotate/Skew button 

 in the Ribbon toolbar.

See Rotating Manually and Skewing Manually for addition information, including details on numerically 
rotating objects.

{button Related Topics,PI(`',`RT_To_rotate_a_text_object_manually')}
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To skew a text object manually

1 Select the freeform or block text you want to skew. Then click it again (that is, click the currently selected 
text object).

2 Point to a side handle of the object.
3 Drag the handle to skew the object.
Tip

Alternatively, to prepare text to be rotated, you can select the text, click the Edit tool 

, and click the Rotate/Skew button 

 in the Ribbon toolbar.

See Rotating Manually and Skewing Manually for addition information, including details on numerically 
rotating objects.

{button Related Topics,PI(`',`RT_To_skew_a_text_object_manually')}
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Reshaping Block Text
{button Steps...,PI(`',`HT_Reshaping_Block_Text')}

You can reshape a block text container to change its text flow. Text containers are reshaped as curved objects 
using the Curve Reshape button in the Edit Ribbon toolbar. The options available for reshaping a text container 
include adding and deleting anchors, creating corners and symmetrical curves, and creating locked or unlocked 
cusps.
See Overview of Curve Reshaping for full details on reshaping curved objects.
Reshaping a text container does not change the size or style of the text in the container.
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To reshape a block text object with anchors

1 Select the block text you want to reshape.

2 Click the Edit tool  in the Toolbox and click the Curve Reshape button 

 in the Ribbon toolbar.
3 Point to an unselected anchor.
4 Press the left mouse button and drag the point to a new location. The text container’s shape changes.
5 Release the mouse button when you finish. The text reflows to maintain its margins.
6 Repeat steps 3 through 5 to reshape other edges of the container.
Tip

You can also reshape a text container by dragging its control points.

{button Related Topics,PI(`',`RT_To_reshape_a_block_text_object_with_anchors')}
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To reshape a block text object with control points

1 Select the block text you want to reshape.

2 Click the Edit tool  in the Toolbox and click the Curve Reshape button 

 in the Ribbon toolbar.
3 Click an anchor to select it. It turns solid.
4 Drag a control point. The text container’s shape changes.
5 Release the mouse button when you finish. The text reflows to maintain its margins.
6 Repeat steps 3 through 5 to reshape other edges of the container.

{button Related Topics,PI(`',`RT_To_reshape_a_block_text_object_with_control_points')}
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Warping Text
{button Steps...,PI(`',`HT_Warping_Text')}

You can warp freeform text to manipulate the text graphically.

 
For full details on warping objects, see Warping Effects.
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To warp freeform text

1 Select the freeform text that you want to warp.

2 Click the Edit tool  in the Toolbox and click the Warp button 

 in the Ribbon toolbar. A blue warp envelope appears over the text.
3 Point to a handle and drag it to change the envelope.
4 Repeat step 3 to create the desired warp.
5 Press ESC to remove the envelope when you finish.
Tip

To open the Edit Text window to edit warped text, click the text with the text pointer.

{button Related Topics,PI(`',`RT_To_warp_freeform_text')}
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Special Text Effects
{button Steps...,PI(`',`HT_Special_Text_Effects')}

Designer lets you create a variety of special effects, including wrapping text around an object and flowing text 
from one container to another.

{button Related Topics,PI(`',`RT_To_Special_Text_Effects')}
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Wrapping Text around an Object
{button Steps...,PI(`',`HT_Special_Text_Effects')}

You can force block text to automatically wrap around an object.
An object can be made to repel block text so that the object is not overwritten by text. This forces the text to 
wrap around an object. 



To repel text

1 Select the object for the text to wrap around.
2 On the Change menu, point to Text and click Repel Text. The text wraps around the object.
Tips

Objects repel text regardless of the layer. For example, an object on layer one repels text on layer two. 
Even objects on layers that are not visible repel text.

You cannot repel freeform text or text inside an object. Also, you cannot repel text from grouped objects or 
bitmaps.

To turn off repel text mode for a particular object, select the object and repeat the steps above.

{button Related Topics,PI(`',`RT_To_repel_text')}
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Flowing Text
{button Steps...,PI(`',`HT_Special_Text_Effects')}

Block text is always surrounded by an invisible boundary called a container. You can connect text containers so 
that block text flows from one container to another. You can flow text among any number of text containers 
(including text in shapes). You can either connect existing text containers or create a new text container that 
flows from an existing one. You cannot flow to a different page.
Text overflows a container when there is more text than can fit into the container. When you edit text, an 
overflow handle (a small "+") appears at the lower right border of the container to show that there is overflowing
text. Text flows from the back object to the front object. If you don’t reorder the objects, text flows from the first 
drawn to the last drawn object.



To create a new flowing text container

1 Click the Text tool  in the Toolbox.
2 Click the Text Mode button to display the text pointer, if necessary.
3 Click the text with the text pointer.
4 Click the overflow handle to create a second block of the same size near the original.
Tip

If you wish, you can point to the overflow handle, press and hold the left mouse button, and drag a second 
block of the same size to a new location.

{button Related Topics,PI(`',`RT_To_create_a_new_flowing_text_container')}
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Flowing Text between Current Containers
{button Steps...,PI(`',`HT_Special_Text_Effects')}

If you have already created two or more text blocks, you can connect them so that text flows from one to the 
other. If you add or delete text in one container, the other text blocks also adjust.



To flow text from one container to another

1 Select the text containers to connect.
2 On the Change menu, point to Text and click Flow Text. The text containers are connected.
Tip

You can flow text through any number of text containers at the same time. Text flows from the back 
container (the one drawn first) to the front container.

{button Related Topics,PI(`',`RT_To_flow_text_from_one_container_to_another')}
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Checking Spelling
{button Steps...,PI(`',`HT_Checking_Spelling')}

You can check the spelling in all of your drawings and documents created in Designer.
Designer can check the spelling of all the text in the document, or just the text you select. For example, if you 
want to check one word, highlight the word and click the Spelling button.
Designer checks spelling by comparing words in your document with words in a dictionary. The default dictionary
is a file containing thousands of words. If Designer finds a word in your drawing that is not in the dictionary, the 
word is displayed as a possible misspelling.
There are many types of words that are not in the dictionary. Proper names, words with numbers, foreign words, 
and some abbreviations are commonly displayed as possible misspellings. You can use the Add button to add a 
displayed word to the dictionary so that it will not be considered a misspelling in the future.

{button Related Topics,PI(`',`RT_Checking_Spelling')}
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Using Dictionaries



To check spelling in a drawing

1 Select the text you want to check.

2 Click the Text tool  in the Toolbox.

3 Click the Spelling button  in the Ribbon toolbar. If a misspelled word is found, Designer opens the 
Spelling dialog box.
4 Type the correct spelling for the word in the Change To box and click Change.

or

Click Ignore or Ignore All to ignore the word or every instance of the word, respectively.

Select one of the words in the Suggestions box and click Change or Change All.

Click Add to add the word to the dictionary and continue.
Tips

Designer checks the spelling of text objects only. Text that has been converted to curves is not checked.

To check the entire document, leave all text unselected.

As a shortcut for steps 2 and 3, click the Spelling button 

 on the Standard toolbar.

{button Related Topics,PI(`',`RT_To_check_spelling_in_a_drawing')}
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To ignore misspelled words

Click Ignore to skip the word in the Not in Dictionary area without changing it.
or
Click Ignore All to ignore the current word and all other occurrences of the word without prompting you.

{button Related Topics,PI(`',`RT_To_ignore_misspelled_words')}
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To change the misspelled word

Click the Change button to change the highlighted word in your document to the word in the Change To 
box.

or
Click Change All to make the same change to all subsequent occurrences of the word without prompting 

you.

{button Related Topics,PI(`',`RT_To_change_the_misspelled_word')}
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To add the misspelled word to the dictionary

Click Add to add the word in the Change To box to the currently selected dictionary.
Tip

The currently selected dictionary appears in the Add Words to list box.

{button Related Topics,PI(`',`RT_To_add_the_misspelled_word_to_the_dictionary')}
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Using Dictionaries
{button Steps...,PI(`',`HT_Checking_Spelling')}

The default dictionary is called the standard dictionary. You can enlarge the standard dictionary by adding words 
with the Add option.
You can create additional dictionaries, or custom dictionaries, to use with the standard dictionary. For example, if 
you are working on a drawing containing chemical names and abbreviations, you can create a custom dictionary 
called "CHEMICAL.DIC" to use in addition to the standard dictionary.



To create a new custom dictionary

1 Click the Text tool  in the Toolbox.

2 Click the Spelling button  in the Ribbon toolbar. The Spelling dialog box opens.
3 Click the Options button to open the Options - Spelling dialog box.
4 Click New. The Save As dialog box opens.
5 Type a name for the dictionary. (Designer automatically adds the "dic" extension.)
6 Click Save. Designer adds the dictionary to the list of Custom Dictionaries.
Tip

If someone has given you a custom dictionary with their words in it, you can add it using the Add button in 
the Options - Spelling dialog box, selecting the dictionary, and choosing Open. Designer adds the dictionary to the 
list of Custom Dictionaries.

{button Related Topics,PI(`',`RT_To_add_a_custom_dictionary')}
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To use a custom dictionary

1 Click the Text tool  in the Toolbox.

2 Click the Spelling button  in the Ribbon toolbar. The Spelling dialog box opens.
3 Click the Options button to open the Options - Spelling dialog box.
4 Click the check box in front of the dictionary you want to use.
Tip

Designer consults all dictionaries in the Add Words to list box.

{button Related Topics,PI(`',`RT_To_use_a_custom_dictionary')}
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Using Special Characters
{button Steps...,PI(`',`HT_Using_Special_Characters')}

Special characters such as umlauts, trademark symbols, fractions, and open and close quotation marks do not 
appear on most keyboards. When you want to use a special character, you either must insert them by entering 
their code on the numeric keypad or by using the program called Character Map that accompanies Windows.
Although most fonts contain a complete set of special characters, some fonts do not. For example, if you are 
using a font that does not contain the special symbol "µ," you must change to a font that does contain it in order 
to insert that object.
Using the Keypad

Each character in a font is associated with a number. For example, "µ" has the number 0181, regardless of the 
font. The number is called an ANSI (American National Standards Institute) character code.
Dingbats

Text fonts use the standard ANSI character codes. Non-text fonts such as dingbats are assigned character codes, 
but there is no standard. You must use either the keypad or the Windows Character Map to insert non-text 
characters.
The Windows Character Map

The Windows Character Map is a program included with Windows 3.1. You can use it to select characters to copy 
to the Clipboard and paste into your text. Consult your Windows documentation for more information.
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To insert a character with the keypad

1 Select the font to use.
2 Place the text cursor where you want the special character.
3 Turn on NUM LOCK on the keypad, if necessary.
4 Press and hold ALT and type 0 (zero) and the three digit character code. For example, to insert the copyright 

symbol, press and hold ALT and type 0169 on the keypad.
5 Release ALT. The special character is inserted in the text.
Tip

You must use the numeric keypad in step 4. You cannot use the number keys that are above the letters on 
your keyboard.

{button Related Topics,PI(`',`RT_To_insert_a_character_with_the_keypad')}
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Converting Text to Curves
{button Steps...,PI(`',`HT_Converting_Text_to_Curves')}

You can convert outline fonts into standard Designer objects. This lets you reshape text just as you would any 
other Designer object.
Converting text to curves is useful when you want to reshape text or create a drawing that can be opened on a 
computer that does not have the original typeface. You can convert both freeform and block text to curves.
All fonts included with Designer are scaleable outline fonts. The most common outline fonts are TrueType and 
Type 1. If you try to convert a non-outline font, Designer substitutes the default font before converting it.
You can change the default font by modifying an entry in your system registry. On the Registry tab of the Options
dialog box, add the Value Name DefaultFont to the Mgxgre key, and set its value to the name of the font you 
want to use (for example, Times New Roman).
After you convert text to curves, the objects are no longer text objects. You cannot insert or delete text, check 
the spelling, change any of the paragraph options, or make any other text edits. Text converted to object outlines
can be changed back to text only with the Undo command.

{button Related Topics,PI(`',`RT_Converting_Text_to_Curves')}



To convert text to object outlines



Registry settings



To convert text to object outlines

1 Select the text to convert.
2 On the Change menu, click Convert to Curves.
3 On the Change menu, point to Combine and click Disconnect. You can now click individual characters to 

select them. The text converts to an object outline.

{button Related Topics,PI(`',`RT_To_convert_text_to_object_outlines')}



Converting Text to Curves



Warping Effects
{button Steps...,PI(`',`HT_Warping_Effects')}

Warping lets you distort an object by changing the surface on which it was drawn. For example, if you write your 
name on a deflated balloon and then inflate the balloon, your name becomes warped.
You can use warping to create effects that are difficult to draw, such as a water droplet or a hilly surface. You can
also use warping to create unusual text effects, such as text being pulled down a drain. A warped effect can be 
edited like any two-dimensional object. You can warp grouped or connected objects.

When you warp an object, Designer places a warp envelope over it. The envelope appears as a blue warping 
grid. As you change the envelope, the object changes underneath.
You can reshape the warp envelope with lines, curves, or Bézier control points. The default reshape method is 
the last one used.

You can add an unwarped, rectangular envelope to an object. The previous, warped envelope is replaced with a 
new envelope. The object underneath is unchanged.
You can use the Remove Warp button to remove the last warp envelope you added. Removing a warp envelope 
restores the object underneath to its previous shape. If you have applied a series of warp envelopes to an object,
you can remove them one at a time in reverse order with the Remove Warp button.
You can increase the number of horizontal and vertical lines in a warp envelope to give you more control over the
warp.

{button Related Topics,PI(`',`RT_Warping_Effects')}



To warp an object
To reshape the warp envelope
To add a new warp envelope
To remove a warp envelope
To increase the density of a warp envelope



Blending Effects



To warp an object

1 Select the object to warp.

2 Click the Edit tool  in the toolbox.

3 Click the Warp button  in the ribbon. A blue warp envelope appears over the object.
4 Point to a handle and drag it to change the envelope.
5 Repeat step 4 to create the desired warp.
6 Double click or press ESC when you finish to remove the envelope.

{button Related Topics,PI(`',`RT_To_warp_an_object')}



Warping Effects
Selecting an Object



To reshape the warp envelope

1 Select the object to warp.

2 Click the Edit tool  in the toolbox.

3 Click the Warp button  in the ribbon. A blue warp envelope appears over the object.
4 Click the Warp Type button and choose how you want to reshape the warp envelope.

Click the Line Warp button  to reshape the envelope with lines and no curves.

Click the Curve Warp button  to create curving lines when you reshape points on the envelope.

Click the Bézier Warp button  to reshape the envelope with Bézier control points. You can use the Cusp, 
Curve, and Symmetrical Curve buttons to modify the control points' movements, if you want. 

5 Point to a handle and drag it to change the envelope.
6 Repeat steps 4 and 5 to create the desired warp.
7 Double click or press ESC when you finish to remove the envelope.
Tip

Editing an object, including using Bézier curves, is described in Introduction to Reshaping.

{button Related Topics,PI(`',`RT_To_warp_an_object')}



To add a new warp envelope

1 Select the object to warp.

2 Click the Edit tool  in the toolbox.

3 Click the Warp button  in the ribbon. A blue warp envelope appears over the object.
4 Point to a handle and drag it to change the envelope.
5 Repeat step 4 to create the desired warp.

6 Click the Add Warp button . The previous, warped envelope is replaced with a new envelope. The object 
underneath is unchanged.

7 Repeat steps 4 through 6 to create the desired warp.
8 Double click or press ESC when you finish to remove the envelope.

{button Related Topics,PI(`',`RT_To_warp_an_object')}



To remove a warp envelope

1 Select the object to warp.

2 Click the Edit tool  in the toolbox.

3 Click the Warp button  in the ribbon. A blue warp envelope appears over the object.
4 Point to a handle and drag it to change the envelope.

5 Click the Remove Warp button . The object is restored to its previous shape.
6 Double click or press ESC when you finish to remove the envelope.

{button Related Topics,PI(`',`RT_To_warp_an_object')}



To increasing the density of a warp envelope

1 Select the object to warp.

2 Click the Edit tool  in the toolbox.

3 Click the Warp button  in the ribbon. A blue warp envelope appears over the object.

4 Click the Add Horizontal Lines button  to double the number of horizontal envelope grid lines.
Or

Click the Add Vertical Lines button  to double the number of vertical grid lines.
5 Point to a handle and drag it to change the envelope.
6 Repeat step 5 to create the desired warp.
7 Double click or press ESC when you finish to remove the envelope.

{button Related Topics,PI(`',`RT_To_warp_an_object')}



WhatsNew section of Designer 6.0 Help
Note: Though included in this section's table of contents, the Office Compatibility topic resides in a 
separate help file (Microsoft requirement).



ABC Media Manager support
Designer 6.0 uses ABC Media Manager instead of a built-in utility for managing ClipArt and other graphic-image 
formats. When you use ABC Media Manager to move Designer objects to other applications, all properties of the 
objects are retained. 
To use ABC Media Manager with Designer

Click ClipArt on the Tools menu, or click the ClipArt Manager button 
 on the Standard toolbar.



Microsoft Office Binder support
Designer 6.0 supports Microsoft’s Office Binder. Office Binder uses the metaphor of a loose-leaf binder to let you 
combine documents from several different Office 95 applications into a single project.
For example, let's say that you have two Designer drawings, a three-page Word for Windows document, and a 
single-page Excel spreadsheet. You have been asked to create a book that contains a cover page and all of the 
documents, in the following order:
Page 1 The cover page
Page 2 The first Designer drawing
Pages 3-5 The Word for Windows document
Page 6 The second Designer drawing
Page 7 The Excel spreadsheet
Using Office Binder, you can build your book and print it with all the pages numbered sequentially.
To create a blank binder

1 On the Windows Start menu, click New Office Document.
2 Double-click the Blank Binder icon.
Note

The New Office Document item is added to the Start menu when you install Office 95.
To include a Designer document in a binder you are building

1 Open the folder containing the Designer document.
2 Drag the document to the left edge of the binder. You can edit the document by double-clicking it in the 

binder.



Quick Viewer support
After installing Designer 6.0, you can use the Windows 95 Quick View feature to view Designer 6.0 documents 
contained in a folder or an Explorer window. You also can view drawings made with earlier versions of Micrografx 
Designer.
To view a Designer drawing

1 Open the folder containing the Designer drawing.
2 Click the right mouse button on the icon of the drawing.
3 On the shortcut menu, click Quick View.
Tips

To select several drawings for viewing at the same time (each in a separate viewing window), hold down 
CTRL while clicking each document' icon.

When the Quick Viewer window is open, you can drag Designer drawings and drop them on the window to 
view them.

The Designer Quick Viewer lets you:

View drawings one at a time in a single window. On the View menu, click Replace Window to turn on the 
checkmark.

View each drawing in a separate viewing window. On the View menu, click Replace Window to turn off the 
checkmark.

Show or hide the viewer's toolbar. On the viewer's View menu, click Toolbar.

Open the currently displayed drawing in Designer so you can make changes. On the viewer's File menu, 
click Open As Designer File, or click the Open 

 button on the viewer's toolbar.

View multiple-page drawings. To move through the pages, click the Previous Page button 
 or next page 
 button on the viewer's toolbar.



Terminology changes from earlier versions

Designer's Button Hints are now referred to as Tool Tips.

"Preferences" are now referred to as "Options." (The Options dialog box is accessible from the Tools menu.)

The term "Symbol" is now "Object."

The Ribbon is now an Office-style toolbar. For brevity, Designer Help sometimes calls the Ribbon toolbar 
"the Ribbon."

The Toolbox is now an Office-style toolbar. Designer Help still calls it "the Toolbox."

The Status bar is now an Office-style toolbar. Designer Help still calls it "the Status bar."

Designer’s Button Hints are now referred to as Tool Tips.



Menu changes from earilier versions

The Edit menu has new options for inserting, editing, and managing OLE objects.

The Display menu has been renamed as the View menu. The View menu contains some zoom options, and 
it lets you show or hide specific toolbars.

A new Format menu lets you change object attributes such as line weight and fill type.

The Symbol menu has been renamed as the Object menu.

A new Tools menu lets you check spelling, change option settings, customize toolbars, manage ClipArt, and
import and export files.

The Snap to Ruler and Snap to Guides commands have been moved from the View menu to the Tools 
menu.



Keyboard changes from earlier versions

Duplication has been changed from SHIFT+DRAG to CTRL+DRAG, except when duplicating anchors.

Constraint has been changed from CTRL+DRAG to SHIFT+DRAG, except when constraining anchors.

Add Snap Points has been changed from CTRL+N to CTRL+F7.

Remove Snap Points has been changed from SHIFT+CTRL+N to CTRL+ SHIFT+F7.

The Redo command is now CTRL+Y.

The keyboard shortcut to activate the Style ribbon is now CTRL+L.

New document has been added (CTRL+N).



New color-separation options for PostScript printing
Offers a Color Separation option (in the Print Document dialog box) so that color-separation utilities can separate
colors in Designer's PostScript output. You can use this option when printing to an EPS file.



Other Designer 6.0 updates
Version 6.0 has these additional changes from earlier versions.

The progress indicator that was displayed in the Ribbon in Designer 4.1 has been replaced by a Task 
Manager dialog box. The Task Manager lets you monitor and control background tasks. To display the Task Manager,
click the Task Manager button 

 or click Show Tasks on the View menu.

You can now restrict the number of colors when tracing a bitmap, and a new Noise option helps eliminate 
stray pixels introduced by a poor-quality bitmap image.

{button Related Topics,PI(`',`RT_Other_Designer_Updates')}



Read Me file for ABC Graphics Suite



Updating Embedded Objects in PageMaker 5
If you add fill colors or resize an embedded Designer OLE object in PageMaker 5, and then choose Update or Exit 
and Return, only the fill color is updated in PageMaker 5. This is only a problem with PageMaker 5.



Printing Embedded or Linked Objects in WordPerfect for Windows 5.2
You may experience printing problems in WordPerfect for Windows 5.2 if you are

Using the WordPerfect printer driver, and

Printing an embedded or linked Designer 4.x object with a solid color other than black, and
Using a 256-color video driver

You may be able to print the object using a standard VGA driver.



Gradient and Hatch Export Problems
If you experience problems exporting certain gradients to the DRW format:

On the Registry tab of the Options dialog box, add the Value Name SimulateDRWGradient to the Translation
key, and give it a numeric value of 1. Gradients will be simulated, which will take longer and result in a larger output
file, but it will correct the appearance of any gradients that do not export properly.

If you experience problems exporting certain hatches to the WMF format:

On the Registry tab of the Options dialog box, add the Value Name SimulateWMFHatch to the Translation 
key, and give it a numeric value of 1. Hatches will be simulated, which will take longer and result in a larger output 
file, but it will correct the appearance of any hatches that do not export properly.

{button Related Topics,PI(`',`RT_registry_topics')}



Underlines Disappearing
Text underlines may disappear if you apply some attributes, such as italic, or convert the text to curves, rotate it,
or change the color of an edge.



Font mapping
There are several instances where a font used in a document may not be available.

Documents might be opened or imported on a computer that does not have the fonts used in the 
document

The current printer might not support the fonts used in the document

Operations such as warping or changing fill and line styles might cause text to be converted to curves, but 
the font does not support curve manipulation.

Any time a font is not available or cannot be used, Designer substitutes Arial as the default font. If you edit the 
text, the original name of the font appears in the Font list box with a "?" beside it to remind you that Designer is 
substituting a different font.
You can change the default by modifying an entry in your system registry. On the Registry tab of the Options 
dialog box, add the Value Name DefaultFont to the Mgxgre key, and set its value to the name of the font you 
want to use (for example, Times New Roman).

{button Related Topics,PI(`',`RT_registry_topics')}



3-D objects from Designer 4.0 documents
Designer 6.0 displays a message when you open a Designer 4.0 file that contains one or more 3-D objects. The 
3-D objects are changed into a 2-D representation that Designer 6.0 can use. The 3-D data is not retained in the 
Designer 6.0 file, but the appearance of the 3-D objects is maintained by the representation. The title of the 
opened document in Designer 6.0 is changed to Untitled to prevent accidental erasure of the original Designer 
4.0 file.



Using Designer for Presentations
{button Steps...,PI(`',`HT_Using_Designer_for_Presentations')}

You can make any presentation an on-screen presentation, or slideshow. Designer uses the full screen to display 
a slideshow.
You can assign different effects, called transitions, that control how one slide replaces another in the slideshow. 
You can run a slideshow within Designer, or you can create a standalone slideshow to run on any computer that 
has Windows installed.
The Page Manager ribbon provides the tools you need to modify and produce a slideshow.

When viewing a single page, you can click the Page Manager tool  (keyboard shortcut CTRL+G) to display 
reduced "thumbnail" images of all the pages in your document. From the reduced view, you can double click on 
any page to display that page in the page view.
To create a presentation, you put all the pages, or slides, in one document, and sort them into the correct order. 
Then you add transition effects and run the presentation.
To fill the screen with your slide, use the screen size as your page size (usually a landscape orientation). To make 
all the slides in your document a consistent size and orientation, use the Master Page.

{button Related Topics,PI(`',`RT_Using_Designer_for_Presentations')}



To set up your document for an on-screen slideshow



Selecting Pages
Assigning Transition Effects
Running a Slideshow
Setting Slideshow Options
Creating a Standalone Slideshow



To set up your document for an on-screen slideshow

1 Create a new document.
2 Click the Page button at the bottom left of the window and choose Master Page. The Master Page displays.
3 On the File menu, click Page Setup. The Page Setup dialog box opens.
4 Choose Screen Size in the Page Size list box.
5 Adjust the margins, if desired.

6 If you want a background color or fill, choose the Page Fill option and click the Page Fill button . The Solid 
tab of the Fill dialog box opens. Choose any fill style and click OK to close the Solid tab.

7 Click OK to close the Page Setup dialog box.
8 Place any items on the Master Page that you want repeated on every slide, such as a title, border, or logo.
9 When you finish defining the Master Page, click the Page button at the bottom left of the window and choose 

Page 1. You are now ready to build the slideshow. Place each drawing or image that you want to appear as a 
slide on a different page of the document.

Tip

After you have your slides defined, you can add transition effects and control the speed and direction of 
the transition for each slide. You also can choose whether the presentation advances manually or automatically.

{button Related Topics,PI(`',`RT_To_set_up_your_document_for_an_on_screen_slideshow')}



Using Designer for Presentations



Selecting Pages
{button Steps...,PI(`',`HT_Selecting_Pages2')}

To select a single page in Page Manager, click the desired page.

{button Related Topics,PI(`',`RT_Selecting_Pages2')}



To select multiple pages in Page Manager
To select multiple pages that are not next to each other
To sort the pages



Setting Options



To select multiple pages in Page Manager

1 Click the first page you want to select.
2 Press and hold SHIFT and click the last page you want to select. Designer selects every page between the 

two pages you selected.

{button Related Topics,PI(`',`RT_To_select_multiple_pages_in_Page_Manager')}



Selecting Pages
Setting Options



To select multiple pages that are not next to each other

1 Click the first page you want to select.
2 Press and hold CTRL and click the other pages you want to select. Only the pages you click are selected.
Tip

To deselect a page in Page Manager, press CTRL and click the page you want to deselect.

{button Related Topics,PI(`',`RT_To_select_multiple_pages_in_Page_Manager')}



To sort the pages

Select and drag to move a page to the beginning, end, or middle of the sequence. A vertical cursor bar 
displays as you drag the page to a different point in the sequence, indicating the position to which it will be moved. 
As you sort slides, they are automatically renumbered.

Tips

If your document has more slides than fit on the Page Manager screen, use the scroll bar to display the 
other slides.

To insert a slide between two existing slides, you can add a new slide and then drag to move the new blank
slide into the correct sequence.

{button Related Topics,PI(`',`RT_To_select_multiple_pages_in_Page_Manager')}



Setting Slideshow Preferences
{button Steps...,PI(`',`HT_Selecting_Pages2')}

The Page Manager Preferences button  lets you choose overall options that affect all slides in the 
presentation. Click the button to open the Slideshow Preferences dialog box. This dialog box lets you:

Select whether or not to use a pointer icon, and select the pointer you want to use 

Select a visible or audible cue for the next advancing slide

Speed up or slow down overall transition speeds between slides

Override automatic advancing in your presentation

{button Related Topics,PI(`',`RT_Setting_Options')}



Selecting Pages
Setting Slideshow Options



Assigning Transition Effects
{button Steps...,PI(`',`HT_Assigning_Transition_Effects')}

Transition effects add energy and excitement to the way slides replace one another during a slideshow.
You can set transition effects with the transition buttons in the Page Manager ribbon or with the Transitions 
Effects dialog box. If you are unfamiliar with creating slideshows with Designer, use the Transition Effects dialog 
box to set transitions. The Transition Effects dialog box provides a preview window that shows how the transition 
looks.
Transition List Box

The Transition list box shows the transition effect assigned to a selected slide. You can select one or more slides 
and then choose a different transition effect by clicking the arrow beside the list box and highlighting the new 
transition effect.
Directions

The Directions button shows the direction in which a selected transition moves. The direction is not relevant for 
some transition effects; in such cases, the button does not appear.

{button Related Topics,PI(`',`RT_Assigning_Transition_Effects')}



To set transition effects using the Page Manager ribbon
To open the Transition Effects dialog box
To assign a transition effect to selected slides with the dialog box
To assign a transition effect to all slides with the dialog box
To assign a transition effect to a group of slides with the dialog box



Setting the Speed
Using the Transition Effects Dialog Box



To set transition effects using the Page Manager ribbon

1 Select the slide or slides to which you want an effect to apply
2 Click the appropriate buttons in the ribbon.
Tip

To find out what effect is already assigned to a slide, select the slide and examine the settings in the 
ribbon.

{button Related Topics,PI(`',`RT_To_set_transition_effects_using_the_Page_Manager_ribbon')}



Assigning Transition Effects
Setting the Speed
Using the Transition Effects Dialog Box



Setting the Speed
{button Steps...,PI(`',`HT_Assigning_Transition_Effects')}

The Speed list box shows the current speed of a selected transition effect. You can change the speed of the 
transition for selected slides by choosing the speed you want from the Speed list box.
Manual or Timed

When you click the Timed button , the number value for Duration specifies the time in seconds that each 
slide is to be displayed in a slideshow that advances automatically. Different slides can have different durations. 
If you want to advance the slides manually, click the Manual button 

.

{button Related Topics,PI(`',`RT_Setting_the_Speed')}



Assigning Transition Effects
Using the Transition Effects Dialog Box



Using the Transition Effects Dialog Box
{button Steps...,PI(`',`HT_Assigning_Transition_Effects')}

You also can apply transition effects with the Transition Effects dialog box. The dialog box lets you assign an 
effect to all slides, to selected slides, or to a specified group of slides. The preview window of the dialog box 
shows how the transition effect looks.

{button Related Topics,PI(`',`RT_Using_the_Transition_Effects_Dialog_Box')}



Assigning Transition Effects
Setting the Speed



To open the Transition Effects dialog box

In the Page Manager ribbon, click the Transition button 
.

Tip

You can expand or contract the Transition Effects dialog box by clicking the Details button 

 at the top right of the box. The expanded view shows the sequence number, title of the slide (page name), and
the assigned effect, including speed and duration. The expanded view lets you review the current transition effects 
for all slides at once, and you can choose multiple slide titles and assign transition effects to them.

{button Related Topics,PI(`',`RT_To_set_transition_effects_using_the_Page_Manager_ribbon')}



To assign a transition effect to selected slides with the dialog box

1 Select the slides to which you want to assign the transition effect.

2 Click the Transition button  in the ribbon. The Transition Effects dialog box opens.
3 Choose the transition settings that you want.
4 Click Apply to assign your transition choice to the selected slides.
5 Click Close to close the dialog box.
Tip

The effect, direction, and speed you choose are demonstrated in the preview.

{button Related Topics,PI(`',`RT_To_set_transition_effects_using_the_Page_Manager_ribbon')}



To assign a transition effect to all slides with the dialog box

1 Click the Transition button  in the ribbon. The Transition Effects dialog box opens.
2 Choose the transition settings that you want.
3 Select Apply Effect to All Slides.
4 Click Apply to assign your transition choice to the slides.
5 Click Close to close the dialog box.

{button Related Topics,PI(`',`RT_To_set_transition_effects_using_the_Page_Manager_ribbon')}



To assign a transition effect to a group of slides with the dialog box

1 Click the Transition button  in the ribbon. The Transition Effects dialog box opens.

2 Click the Details button  to expand the dialog box.
3 Choose the transition settings that you want.
4 Select the slides to which you want to assign the transition effect by holding CTRL and clicking the entries in 

the slide title list box.
5 Click Apply to assign your transition choice to the selected slides.
6 Click Close to close the dialog box.

{button Related Topics,PI(`',`RT_To_set_transition_effects_using_the_Page_Manager_ribbon')}



Running a Slideshow
{button Steps...,PI(`',`HT_Running_a_Slideshow')}

You can review the sequence of slides and the transition effects on each one. After running the slideshow to 
review it, you can make changes to the order and to the transition effects and then run it again to review the 
changes. To stop a slideshow, press ESC.
If you want to view only a particular portion, select the range of slides you want to view and click the Run 
Slideshow button .

{button Related Topics,PI(`',`RT_Running_a_Slideshow')}



To run the presentation
To play an embedded object while running a slideshow



Chalkboard Scribble Feature
Playing an    Embedded OLE Object
Controlling a Slideshow
Using the Slideshow Control Panel



To run the presentation

1 Click the Run Slideshow button  in the ribbon. Designer runs a slideshow of the current document, starting
with the first slide.

2 Use the RIGHT ARROW key or right mouse button to advance slides forward and the LEFT ARROW key or left 
mouse button to move backward.

3 Press ESC to return to Designer.
Tip

Press SHIFT and click the Run SlideShow button 

 to start the show from the selected slide.

{button Related Topics,PI(`',`RT_To_run_the_presentation')}



Running a Slideshow
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Using the Slideshow Control Panel



Chalkboard Scribble Feature
{button Steps...,PI(`',`HT_Running_a_Slideshow')}

When a slideshow is running, you can use the mouse to paint freehand lines on the screen to highlight, 
underline, circle, or otherwise emphasize something in your presentation. Your scribbles appear in bright green.
The scribbles are temporary; they do not change your document. To erase the scribbles from the screen, press 
the DEL key.

{button Related Topics,PI(`',`RT_Chalkboard_Scribble_Feature')}
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Playing an Embedded OLE Object
{button Steps...,PI(`',`HT_Running_a_Slideshow')}

You can insert OLE (object linking and embedding) objects into your slides that can be played as a part of your 
presentation. Examples of objects that can be played are sound, video, animation, or background music.

{button Related Topics,PI(`',`RT_Playing_an_Embedded_OLE_Object')}



Running a Slideshow
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To play an embedded object while running a slideshow

Click the object.
Tip

To play an embedded object that is displayed on the current page (not during a slideshow), you can double
click the object.

For more information on object linking and embedding, see OLE (Object Linking and Embedding).

{button Related Topics,PI(`',`RT_To_run_the_presentation')}



Controlling a Slideshow
{button Steps...,PI(`',`HT_Running_a_Slideshow')}

You can use the following keys to control an on-screen slideshow.
To do this: Press this:

Advance to the next slide RIGHT ARROW or right mouse button 
Return to the previous slide LEFT ARROW or left mouse button
Pause a slideshow PAUSE (press again to resume)
Return to first slide HOME

Advance to last slide END

Stop a slideshow or close the Slideshow Control Panel ESC

Open the Slideshow Control Panel F1

Erase scribbles DEL

Tip

If you want to use the above keys when the Slideshow Control Panel is open, click away from the Slideshow
Control Panel to make it inactive.

{button Related Topics,PI(`',`RT_Controlling_a_Slideshow')}
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Using the Slideshow Control Panel
{button Steps...,PI(`',`HT_Running_a_Slideshow')}

Whether you choose to run your slideshow with the Run Slideshow button  or as a standalone executable 
file, you can open the Slideshow Control Panel by pressing F1 while a slideshow is running. To close the 
Slideshow Control Panel, press ESC or double click the Control menu box.
You can use the following buttons in the Slideshow Control Panel to control a slideshow (if the title bar is 
highlighted to show that it is active).
Click this: To do this:

Home Display the first slide
Rewind Display the previous slide with a single click, or rewind when you press and hold the left mouse 

button
Fast Forward Display the next slide with a single click, or fast forward when you press and hold the left

mouse button
End Display the last slide
Stop Stop the slideshow
Play (or press ENTER) Restart from the slide number and title displayed in the list box
Pause Pause a timed advanced slideshow (press again to resume)

The list box opens when you click the down arrow to show the titles and sequence numbers of the slides. You can
display a different slide in the slideshow by choosing the title of the slide you want and pressing Play. The 
Slideshow Control Panel also shows the number of the current slide and the total number of slides in the 
slideshow.
Options

The Options button  in the Slideshow Control Panel works just like the Options button 

 in the Page Manager ribbon. 

{button Related Topics,PI(`',`RT_Using_the_Slideshow_Control_Panel')}



Running a Slideshow
Chalkboard Scribble Feature
Playing an    Embedded OLE Object
Controlling a Slideshow



Setting Slideshow Options
{button Steps...,PI(`',`HT_Setting_Slideshow_Options')}

Slideshows have their own set of options. To set the slideshow options, click the Options button  in the 
ribbon or the Options button 

 in the Slideshow Control Panel.
Designer provides the same options for standalone slideshows. When you create a standalone slideshow, you 
can click Options in the Create Standalone dialog box.
Show Pointer

Shows or hides the pointer. You can choose from several pointer images.
Next Slide Ready

Each time Designer displays a slide, it is preparing the next slide to display. If you have complex drawings on a 
slide, it may not be ready to display when you go to that slide.
Designer can alert you when the next slide is ready by displaying a small arrow in the lower right corner, by 
making an audible sound, or by giving both signals.
Change Transitions

If you are creating a standalone slideshow to take to another computer, you may want to adjust the transition 
speed for all the slides at once.
If you plan to create the slideshow on one computer and present it on another computer with performance that 
is much faster or slower, the transition speed may be too fast or too slow.
Automatic Advancement Override

While you are working on your slideshow, you can choose to always advance slides manually. This option 
overrides any automatic advance options you set in the Transition Effects dialog box.
Run Continuously

Select Run Continuously to set the slideshow so that it repeats until interrupted manually.



To show a pointer during a slideshow



To show a pointer during a slideshow

Select the Show Pointer option in the Slideshow Options dialog box. Then choose the pointer shape that 
you want by displaying that shape in the pointer box. Click the arrows beside the box to scroll the slideshow pointer 
choices.

Tip

As you move the mouse during the slideshow, the pointer moves on the screen. You can use the mouse to 
point out key ideas to your audience.

{button Related Topics,PI(`',`RT_To_show_a_pointer_during_a_slideshow')}



Setting Slideshow Options



Creating a Standalone Slideshow
{button Steps...,PI(`',`HT_Creating_a_Standalone_Slideshow')}

Designer lets you create a single executable file that contains your entire slideshow, complete with all options 
and transition effects. After this file is created, you can take your slideshow to any computer that has Windows 
installed and run the standalone slideshow, even if Designer is not installed on the computer.
When you create a standalone slideshow, all slides are converted to bitmap images. While bitmap images 
generally require more disk space, they are much faster to display on your screen, and they eliminate the 
potential problem of having the necessary fonts installed on another computer. You can improve a slideshow’s 
performance on your own computer by creating a standalone slideshow to play outside of Designer.

The Create Standalone dialog box includes the Setup button  and the Options button 

.
Setup

Click the Setup button  if you want to open the Standalone Setup dialog box and change the screen 
resolution.
Designer creates standalone slideshows with the same number of colors currently displayed by your graphics 
board and monitor in Windows. If you install the slideshow on a computer that displays fewer colors, the colors 
are dithered.
Designer gives you the option of changing the slideshow’s resolution for the target screen (on which you will be 
playing the slideshow). The default resolution is the resolution currently displayed. If you change the resolution, 
make sure it is supported by the target screen.
If you create your standalone slideshow at a lower resolution than the target screen (for example, created at 
640x480 and played at 800x600), the slideshow is centered on the screen. If, however, you do the opposite (for 
example, create the slideshow at 800x600 but play it at 640x480), the edges of your slides will be clipped.
Options

The Options button  in the Create Standalone Slideshow dialog box works just like the Options button 

 in the Page Manager ribbon, except that any changes apply only to the standalone slideshow.

{button Related Topics,PI(`',`RT_Creating_a_Standalone_Slideshow')}



To create a standalone slideshow
To copy a slideshow file to diskettes
To install a slideshow file from diskettes
To run a standalone slideshow



Copying a Standalone Slideshow to Diskettes
Running a Standalone Slideshow



To create a standalone slideshow

1 Click the Create Standalone button  in the ribbon. The Create Standalone dialog box opens.
2 Type a filename for the standalone slideshow. The extension EXE is added to the filename.
3 Choose the drive and directory in which you want to store the file. The file is stored in the current directory if 

you do not make a choice.

4 Click the Options button , if desired, to change the options for the standalone slideshow.

{button Related Topics,PI(`',`RT_To_create_a_standalone_slideshow')}
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Copying a Standalone Slideshow to Diskettes
{button Steps...,PI(`',`HT_Creating_a_Standalone_Slideshow')}

You can copy your standalone slideshow to diskettes so that you can easily carry a copy of the file with you and 
install it on another computer. If you find that the file is too large to fit on just one diskette, Designer provides a 
way to take one slideshow file and split it across several diskettes.
Before copying a slideshow file to diskettes, you must create the file on your hard drive (see Creating a 
Standalone Slideshow). Use the Windows Explorer to find out how large the executable file is so that you can 
have enough diskettes on hand.

{button Related Topics,PI(`',`RT_Copying_a_Standalone_Slideshow_to_Diskettes')}



Creating a Standalone Slideshow
Running a Standalone Slideshow



To copy a slideshow file to diskettes

1 Click the Copy to Diskette button . The Copy to Diskette dialog box opens.
2 Highlight the EXE file that contains your standalone slideshow. Choose a different drive and directory if 

necessary.
3 Choose a target diskette drive to which you want to copy.
Tip

If more than one diskette is necessary, you are prompted to remove one diskette and insert another as 
needed. Designer copies a file called LOADSHOW.EXE to the first diskette.

{button Related Topics,PI(`',`RT_To_create_a_standalone_slideshow')}



To install a slideshow file from diskettes

1 Insert the first diskette with the file LOADSHOW.EXE.
2 On the Windows Start menu, click Run.
3 Type the name of the diskette drive followed by LOADSHOW.EXE. For example, A:\LOADSHOW.EXE or B:\

LOADSHOW.EXE.
4 Click OK to run the installer program. Follow the instructions on the screen.

{button Related Topics,PI(`',`RT_To_create_a_standalone_slideshow')}



Running a Standalone Slideshow
{button Steps...,PI(`',`HT_Creating_a_Standalone_Slideshow')}

A standalone slideshow requires Windows to run.

{button Related Topics,PI(`',`RT_Running_a_Standalone_Slideshow')}
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To run a standalone slideshow

1 On the Windows Start menu, click Run.
2 Type the path and the name of the slideshow file.

or

Click the Browse button. Locate the slideshow file and click OK.

{button Related Topics,PI(`',`RT_To_create_a_standalone_slideshow')}




